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Chapter 123

Introduction to 
Color Grading
For over thirty years, DaVinci has pioneered the development of 
color correction hardware and software designed to enhance visual 
images acquired from film and video. 

This release of DaVinci Resolve possesses our newest and most evolved professional color correction 
tools yet. However, for all its technological sophistication, DaVinci Resolve is merely a tool that requires 
the hands of a skilled artist to realize its full potential.

Subsequent chapters of this user manual cover the DaVinci Resolve grading tools in the Color page 
in great detail, but before getting into the specifics of color balancing and contrast adjustment, 
Power Windows, and Custom Curves, it’s important to step back and consider what these tools are for, 
and why you’re learning to use this application in the first place.

This introduction is for those of you who are new to this process we call color correction, 
or color grading. If you’re a veteran colorist then you might want to skip ahead, but if you’re just 
starting out, the following sections are intended to describe the many goals of color correction, and 
how the DaVinci Resolve toolset has been designed to address them; making it fast and efficient to 
alter images in innumerable ways as we elevate raw footage to cinematic art.
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The Goals of Color Correction
If reality is a fire hose of visual information, then digital cinema and broadcast would be represented 
by a garden hose. Color correction, therefore, could be considered the process of choosing which 
parts of the fire hose of raw image data to fit into the garden hose of our displays in order to create a 
pleasing image for the viewer. 

Maximizing the Look of Your Media
Clearly, the most fundamental aspect of the color correction process is that of making every clip 
look its best. While the job of the cinematographer is to light and expose the image with an artistic 
intent, your job is to realize this intent by making adjustments to the color and contrast of the 
image, so that the final result is as close to what the director and cinematographer had in mind as 
is humanly possible. In the process, you have the opportunity to overcome inconsistencies with 
exposure and white balance that were, for various reasons, unavoidable. Furthermore, you can make 
subtle adjustments to add warmth or contrast that was not available during the shoot, but that the 
cinematographer would have liked.

Increasingly, color correction is seen as a critical stage in the post-production process. For example, 
the newer generation of digital cinema cameras are capable of shooting raw colorspace image data, 
or RGB image data with a log exposure, in order to preserve the maximum amount of image data for 
manipulation during the color correction process. However, when you acquire image data this way, 
it must be transformed into a viewable image via color correction in the same way that film negative 
must first be developed and printed to positive film.

Log encoded source 	 Normalized and corrected

Source footage courtesy of Gianluca Bertone DP, www.bertonevisuals.com

Of course, there are also situations in which you may find it necessary to attempt to fix source media 
with far more substantial problems in color and exposure. In these cases, the tools exist to make far 
more involved adjustments to the image; however, the quality of your results will depend heavily on 
the data quality and “latitude” of your source media. 

For example, Blackmagic URSA, ARRI ALEXA, and RED DRAGON cameras record quite a bit of image 
data, making extreme corrections far more possible than more heavily compressed camera formats 
such as the Canon 5D. However, in either case, DaVinci Resolve provides the tools to process images in 
many different ways to adjust the image for a better look.
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Underexposed source 	 Balanced and gain corrected

Whether clips need changes large or small, the primary DaVinci Resolve toolset adjusts the 
characteristics of hue, saturation, and contrast in a variety of ways. In the Color Wheels palette, 
Color balance wheels let you adjust all three color channels at once, altering the color temperature 
of the scene at specific ranges of tonal detail referred to as lift, gamma, and gain. Alternately, the 
slider‑based Primaries Bars mode lets you make the same kinds of controls via independently 
adjustable red, green, and blue lift, gamma, and gain controls.

Primary correction wheels, Primary correction bars

All of these controls let you adjust the color tone of the shadows, midtones, and highlights 
independently from each other.
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Cool look	 Warm look

Meanwhile, the Master Lift, Gamma, and Gain wheels work together to let you alter image contrast in 
different ways: deepening shadows, lightening highlights, and brightening or darkening the midtones 
in between to create whatever image tonality you prefer for a given scene.

High contrast	 Low contrast

Source footage courtesy of Gianluca Bertone DP, www.bertonevisuals.com

Separate saturation controls let you increase or decrease color intensity throughout the scene, while 
the Lum vs. Sat and Sat vs. Sat curves give you the ability to fine-tune saturation very specifically.

High Saturation	 Low Saturation

For more information on these controls, which are essential to the color correction process,  
see Chapter 129, “Primaries Palette.”
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Emphasizing What’s Important
Another important aspect of the color correction process is the ability to make adjustments 
to emphasize or de-emphasize specific elements within the frame. It’s similar in concept to 
equalization in audio mixing, in that you’re choosing which color values to boost or suppress using a 
variety of techniques.

This can be done to direct the viewer’s gaze, for example by surrounding a specific part of the image 
with a window, which lets you restrict specific adjustments made to the inside and outside of the 
window’s shape.

Drawing a window to isolate a region of the picture to highlight

Specific alterations can also be made to prevent audience distraction. For example, a low-saturation 
monochromatic tint may be a pleasing look overall, but in the soft wash of color, the viewer might lose 
track of the watch that’s preoccupying the protagonist. Using tools such as the Hue curves and HSL 
Qualifier, you can quickly and easily tune the color of the woman’s hands and of the watch to guide the 
viewer’s eye, and bring some needed depth to the scene.

Source image	� Curves and HSL qualification used to 
distinguish hands and highlight watch

For more information on Power Windows, see Chapter 135, “Secondary Windows.” For more 
information on Hue curves, see Chapter 132, “Curves.”
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Audience Expectations
There is another family of tools, the HSL, RGB, and Luma Qualifiers, that provide even more specific 
control, and they’re useful for adjusting ranges of color to either play into or against the audience 
expectations for color in a scene. Substantial research into what has been termed “memory color” 
shows that people have finely tuned expectations for the hues of particular subjects, such as 
flesh tone, foliage greens, and sky blues. Deviation from these expectations can create a sense of 
something being not quite right, which can be either detrimental or beneficial, depending on your 
goals for a particular scene.

HSL Qualification is effectively a chroma keyer that lets you sample the image to create a key that’s 
used to define where to apply a specific correction. For example, if you’re happy with the rest of the 
image, but the skin tone of the actor has an unhealthy green tinge to it as a result, you can isolate the 
color of that actor’s skin and adjust it to a healthier hue.

Source Image	 HSL qualification on the skin

Skin now has warmer grade

Another common example is the adjustment of skies. If you’re aiming for a gorgeous summer day, a 
washed out sky in the source media can be a bit of a bummer. However, using qualification it’s easy to 
isolate that wedge of blue, then push and pull it into just the right amount of summertime joy.

Originally graded scene	 HSL qualification of the sky
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Corrected and sky enhanced

For more information on using qualifiers, see Chapter 134, “Secondary Qualifiers.”

Balancing Scenes
It’s rare when the uncorrected shots of a scene match one another perfectly. Even the most carefully 
exposed angles of coverage can have small variances that need to be evened out. On the other end 
of the spectrum, run-and-gun programs using available light often result in edited scenes with huge 
changes in lighting and color as each shot cuts away to the next. 

Small or large, unintended variations from one shot to the next can call undue attention to the editing, 
and jar the audience’s attention in ways that throw them out of the program. Evening out these 
differences and balancing the clips in each scene to match is another of the fundamental tasks of 
the colorist. You know you’re finished when the color in the scene flows unnoticeably from one clip 
to the next.

DaVinci Resolve has a variety of tools that you can use to help you compare images with one another, 
the most important of which is the Gallery, in which you can save still images of clips that you can then 
compare to other clips using an adjustable split screen.

Timeline thumbnail view of unbalanced clips

Thumbnail view of balanced clips

By using the Gallery to play stills, either split or whole (flipping back and forth between the clip you’re 
adjusting and the still), it becomes easier to use the extensive DaVinci Resolve toolset to match the 
color and exposure of every clip in a scene.
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Split screen of two shots	 Left image corrected to match right

An additional set of features let you manage grades by copying them from clip to clip, or by linking 
similar clips, either automatically, or manually using groups.

Link icon indicates clips are grouped for grading

For more information on using the Still Store, see Chapter 124, “Using the Color Page.” For more 
information on grade management, see Chapter 139, “Grade Management.”

Adding Style
Of course, it’s not all about subtlety and correction. It’s often appropriate, when grading music videos 
and commercials, for instance, to add some radical style to a piece. Here, too, DaVinci Resolve provides 
an abundance of features for manipulating unexpected aspects of the image; for example, by abusing 
the Custom Curves to create the illusion of chemical cross‑processing.

Custom Curves controls
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Original image	 Image enhanced with Curves

DaVinci Resolve’s node-based image processing makes it possible to use more exotic node structures 
to create effects using composite modes, such as a colored glow generated by adding two differently 
graded versions of the same image together using a Layer node.

Node tree adding two different treatments together

Original image	 Enhanced and balanced final

You can also create complex node trees to build specific mattes, to use for isolating specific elements 
of the image. For example, if you wanted to isolate an actor in color against a background turned 
monochromatic, you can create multiple keys (pulled via HSL Qualification) and combine them using a 
Key Mixer node to build that effect.

2783Color  |  Chapter 123  Introduction to Color Grading



Node tree to isolate the man’s face and clothes

Original image	� The final effect, desaturating 
everything except for the man

Finally, DaVinci Resolve doesn’t just have tools governing color and contrast. A Blur palette provides 
controls over blurring, sharpening, or adding mist to all or part of the image. When combined with the 
other tools that are available for isolation and color adjustment, these are powerful additions to your 
creative arsenal.

Defocus effect created in real time

For more information on all of these features, see Chapters 124 through 140 of this manual.
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Quality Control
Lastly, it’s important to keep in mind that, for all the creative possibilities that DaVinci Resolve affords, 
it’s still important that the final deliverables that you give to your client has appropriate signal levels 
relative to their requirements. In particular, programs destined for broadcast have specific outer 
boundaries of luma and chroma that you must not exceed, or you’ll risk having a show rejected for QC 
(quality control) violations. 

However, even if you’re not delivering a show for broadcast, it’s important to be aware of the 
mathematical limitations of a digital video signal to make sure you’re not clipping or crushing image 
detail through overzealous adjustments that you may, in fact, want to preserve.

For example, if you take a look at the next two images, you can see the perils of overzealous 
adjustments when compared to a clip that, while graded creatively, has been adjusted with respect to 
the mathematical boundaries of image data.

Image graded to preserve detail in highlights	 Image graded with highlight detail blown out

Here, too, DaVinci Resolve provides tools designed to help you exercise control over the fine-tuning 
of the image. A Video Scopes window provides the standard Waveform, Parade, Vectorscope, and 
Histograms that are used to analyze your image data. These scopes let you see the boundaries of 
what’s possible, and make it easy to spot subtle problems, and compare the characteristics of one 
image to another.

Video scopes
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When the time comes that you want to start clipping data in the highlights and shadows, as part 
of a creative look, the Soft Clip controls let you introduce a subtle or large roll-off, compressing the 
extremes of the signal so that what clipping you do is softer and more pleasing.

For more information about the video scopes and the Soft Clip controls, see Chapter 124, “Using the 
Color Page.” and Chapter 131, “Curves.”

Never Stop Experimenting
So now that you’ve gotten an extremely brief overview of the grading process as seen through 
the toolset of DaVinci Resolve, we invite you to use this manual to explore DaVinci Resolve more 
thoroughly. You may discover that, the more you work with the different features that are available, 
the more unexpected uses you’ll find for different controls that you thought you knew well.

Have fun.
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Chapter 124

Using the Color Page
Given the origin of DaVinci Resolve as a professional 
grading application, the Color page is at the heart of the 
DaVinci Resolve experience. 

Within the Color page are all of the controls available for manipulating color and contrast, reducing 
noise, creating limited secondary color corrections, building image effects of different kinds, adjusting 
clip geometry, and making many other corrective and stylistic adjustments.

In this chapter, you’ll learn how to understand the Color page interface, how to customize it, and how 
to work within it to play through and navigate your project’s timeline. You’ll also learn how to analyze 
and compare clips in preparation for grading using stills, playheads, and DaVinci Resolve’s own 
internal video scopes.
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The Color Page Interface
The Color page is divided into seven main areas that work together to let you build a grade. This 
section provides an overview of what these areas are and how they function.

The default layout of the Color page

The Interface Toolbar
At the very top of the Color page is a toolbar with buttons that let you show and hide different parts of 
the user interface. These buttons are as follows, from left to right:

The Interface toolbar

Gallery: Opens and closes the Gallery panel.

LUTs: Opens and closes the LUT Browser.

Media Pool: Opens and closes the Media Pool.

Clips: Opens and closes the Thumbnail timeline. To the right is a drop-down 
menu that lets you choose a timeline filtering option for the Thumbnail timeline.

Quick Export: Opens the Quick Export window.
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Timeline: Opens and closes the Mini-Timeline.

Nodes: Opens and closes the Node Editor.

Open FX: Opens and closes the Open FX panel.

Lightbox: Opens and closes the Lightbox.

Showing Which Panel Has Focus
Whenever you click somewhere on the DaVinci Resolve interface using the pointer, or use a keyboard 
shortcut to “select” a particular panel (such as in the Edit page), you give that panel of the user 
interface “focus.” A panel with focus will capture specific keyboard shortcuts to do something within 
that panel, as opposed to doing something elsewhere in the interface. A highlight appears at the 
top edge to show you which panel has focus so that you can keep track of which part of the current 
page is taking precedence, and you can switch focus as necessary to do what you need to do. You can 
turn the Focus Indicator on and off in Preferences > User > UI Settings > Show focus indicators in the 
user interface. 

The focus indicator shown at the top edge of the Media Pool, 
shown next to a Viewer that doesn’t have focus

Viewer
The Viewer shows the frame at the current position of the playhead in the Timeline. At the top of the 
Viewer is a header that displays the Project and Timeline names, as well as a Viewer Timecode display 
that shows the source timecode of each clip by default. The Timeline name is also a drop-down display 
that lets you switch to any other timeline in the project. A scrubber bar underneath the image lets 
you drag the playhead across the entire duration of the clip, while transport controls underneath that 
let you control playback. A toolbar at the top provides controls governing Image Wipes, Split‑Screen 
controls, and Highlight display. Additional controls let you loop playback, switch Unmix mode on and 
off, turn audio playback on and off, and choose which onscreen controls are currently displayed. More 
information about using the Viewer appears later in this chapter.
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The default Viewer with transport controls

You can also put the Viewer into one of three alternate modes to be able to see a larger image as you 
work. All three of these modes are available from the Workspace > Viewer Mode submenu.

	— Enhanced Viewer: (Option-F to toggle this on and off) hides everything to the left and right of 
the Viewer, giving you a large working area for tasks such as window positioning and rotoscoping, 
while keeping the palettes and their controls visible as you work.

The Color page in Enhanced Viewer mode
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	— Full Screen Viewer: (Shift-F to toggle this on and off) is available to provide more working area 
for tasks such as window positioning and rotoscoping. Full Screen Viewer also lets you display 
the Open FX panel at full height, and you can turn the Node Editor on and off to access different 
effects controls while you work.

The Color page in Full Screen Viewer mode

	— Cinema Viewer: (P to toggle this on and off) expands the Viewer to fill your workstation’s entire 
monitor. This is useful if you want to play the current Timeline without any distractions. When 
you move the pointer over the image, transport controls and a jog bar appear to let you control 
playback. For DITs, a contextual menu is available by right-clicking anywhere on the image with 
which you can turn on and customize a video scope overlay (which can be dragged to different 
locations on the Viewer).

The Color page in Cinema Viewer mode

Gallery
The Gallery is used for storing still frames to use as reference, and grades you might like to copy; stills 
and grades are stored together. A button lets you open up the Album browser, used for organizing 
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your stills. At the bottom of the Gallery, Memories let you store grade information that you can apply 
using a control panel or keyboard shortcuts. The Gallery on the Color page mirrors the contents of the 
Gallery page. For more information on the Gallery page, see Chapter 138, “Using the Gallery.”

The Gallery has Memories, stills saved in albums and your PowerGrades

LUT Browser
The LUT Browser provides a centralized area for browsing and previewing all of the LUTs installed on 
your workstation. All LUTs appear in the sidebar, by category.

The LUT Browser

By default, all LUTs appear with a test thumbnail that give a preview of that LUT’s effect, but you can 
also get a live preview of how the current clip looks with that LUT by hover scrubbing with the pointer 
over a particular LUT’s thumbnail (this is described in more detail below).

To open the LUT Browser:

	— Click the LUT Browser button in the UI Toolbar at the top of the Color page.

Methods of working with the LUT Browser:

	— To see the LUTs in any category: Click on a LUT category to select it in the sidebar, and its LUTs 
will appear in the browser area.

	— To make a LUT a favorite: Hover the mouse over a LUT and click the star badge that appears at 
the upper right-hand corner, or right-click any LUT and choose Add to Favorites. That LUT will then 
appear when you select the Favorites category.

2792Color  |  Chapter 124  Using the Color Page



	— To search or filter for specific LUTs: Open a bin that has the LUT you’re looking for, then click 
the magnifying glass icon to open the search field, and type text that will identify the LUTs 
you’re looking for.

	— To see LUTs in Column or Thumbnail view: Click the Column or Thumbnail buttons at the top 
right of the LUT Browser to choose how to view LUTs in the browser area.

	— To sort LUTs in Thumbnail view: Click the Thumbnail Sort drop-down menu and choose which 
criteria you want to sort LUTs by. The options are Filename, Type, Relative Path, File Path, Usage, 
Date Modified. There are also options for ascending and descending sort modes.

	— To sort LUTs in Column view: Click the column header to sort by that column. Click a header 
repeatedly to toggle between ascending and descending modes.

	— To update the thumbnail of a LUT with an image from a clip: Choose a clip and frame that 
you want to use as the new thumbnail for a particular LUT, then right-click that LUT and choose 
Update Thumbnail With Timeline Frame.

	— To reset the thumbnail of a LUT to use the standard thumbnail: Right-click a LUT and choose 
Reset Thumbnail to go back to using the standard test image.

	— To refresh a LUT category with new LUTs that may have been installed: Select a LUT 
category, then right-click anywhere within the browser area and choose Refresh to refresh the 
contents of that category from disk.

Methods of adding LUTs to a grade from the LUT Browser:

	— To apply a LUT to the current node: Select a clip in the Thumbnail timeline, then right-click a LUT 
and choose Apply LUT to Current Node from the contextual menu.

	— To apply a LUT to a specific node: Drag a LUT from the LUT Browser and drop it onto the node 
you want to apply a LUT to. If you drag a LUT onto a node that already has a LUT, the previous LUT 
will be overwritten by the new one.

Media Pool
The Media Pool is available in the Color page, making it easy to drag and drop clips you want to use 
as external mattes right into the Node Editor, for easy and fast connection to create various Color 
page effects. When opened, the Media Pool replaces the Gallery, fitting into the same area. In most 
respects, the Media Pool in the Color page works the same as the Media Pool on nearly every other 
page of DaVinci Resolve.

The Media Pool is available in the Color page.

When you drag a clip from the Color page Media Pool to the Node Editor, two things happen:
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	— That clip is turned into an external matte in the current grade, which you can use as a matte for 
secondary adjustments, or as a compositing layer (in conjunction with the Layer mixer) for mixing 
textures or images with your grade.

	— That clip is also automatically attached to the Media Pool clip that corresponds to the clip you’re 
grading as a clip matte, to help you keep track of which clips are using other clips as mattes.

For more information about the Media Pool, see Chapter 18, “Adding and Organizing Media with the 
Media Pool.”

Node Editor
The Node Editor is where you assemble one or more individual corrections (nodes) together into 
a complete multi-correction grade (node tree). This is a powerful way of assembling grades, since 
different types of nodes let you create different combinations of corrections and very specific 
adjustments by reordering operations, combining keys, or changing the layer order of different 
adjustments. For more information about the Node Editor, see the “Node Editor Basics” section of 
Chapter 139, “Node Editing Basics.”

Node Editor to construct your grade processing signal flow

Timeline
The Timeline provides several ways of navigating the clips in your project, as well as keeping track 
of what has been done to which clips. The Timeline is divided into two parts, each of which shows 
different information and provides differing controls, and each of which can be opened or closed 
separately via the Clips and Timeline buttons on the Interface toolbar.

The Thumbnail timeline with a Mini-Timeline below
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Thumbnail Timeline
At the top is the Thumbnail timeline, in which each clip is represented by a single frame. The Thumbnail 
timeline (or its alter-ego, the Lightbox) provides the easiest way of selecting which clip you want 
to work on and of making clip selections for various grade management operations. The currently 
selected clip that reveals its controls in the various palettes of the Color page is highlighted in orange.

Much valuable information appears above and below each thumbnail, such as each clip’s clip number, 
source timecode, track number, whether it’s been flagged, whether it’s automatically linked or part of 
a group, whether it’s been tracked, and so on.

A clip thumbnail in the 
Thumbnail timeline

What’s displayed underneath each thumbnail can be changed by double-clicking the space underneath 
each thumbnail. There are several options; you can keep double-clicking to cycle among them:

	— Clip format or codec (the default)

	— Clip Name (clip name or file name, depending on what View > Show File Names is set to) or 
Multicam Angle (if you’re working with multicam clips)

	— Version name or number

Mini-Timeline
Underneath, the Mini-Timeline shows a small representation of the video tracks of the Timeline in the 
Edit page wherein each clip is as long as its actual duration. This provides the best representation 
of the structure of the current timeline, in which clip length shows duration and multiple tracks are 
displayed, so you can see which clips are superimposed. A Timeline Ruler lets you scrub the playhead 
across multiple clips and can be zoomed out enough to show every clip in your entire program.

The Mini-Timeline lets you see timeline structure, and 
small track header controls let you enable tracks, disable 
tracks, and set the playhead to ignore specific tracks

Small track labels at the left of each track in the Mini-Timeline let you enable or disable tracks by 
clicking them (enabled tracks have white labels, disabled tracks have gray labels). Option-clicking one 
of these controls sets that track to be enabled but ignored by the playhead when you use the Next 
and Previous Clip commands, in the event you want to ignore clips you don’t need to grade (tracks in 
this mode show a red label).
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Within the Mini-Timeline the currently selected clip is highlighted in orange, and you can click any 
clip to select it. A scroll bar at the bottom lets you navigate to the left and right, while using the 
scroll wheel of your mouse zooms in and out. The Mini-Timeline shows at most six tracks of video. 
If your project has more tracks than that, you can scroll up and down to reveal the hidden tracks. 
Any markers that were placed on clips or the Timeline in the Edit page appear here, and you can click 
any marker to reveal and edit its color and notes.

As seen above, a colored outline appears around the clip number of shots that have been graded, and 
this outline is doubled if there are additional versions applied to that clip.

For more detailed information about the Color page Timeline, see Chapter 126, “Color Page Timeline 
and Lightbox.”

Palette Area
Most everyday tools and functions for grading are distributed among a series of palettes found in the 
palette area of the Color page. These palettes can be accessed via a series of palette buttons running 
along the Palette bar at the top of this area.

All palettes seen in the Palette bar

These buttons also give you feedback about which palettes have adjustments for the current selected 
node in the Node Editor. Palettes with adjustments show a small orange dot in the corresponding 
palette button.

An orange dot in a palette button lets you 
know there are adjustments in that palette
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Left Palettes
A series of palettes at the bottom left of the Color page provide access to different sets of grading 
tools, used principally for manipulating color, contrast, and raw media format settings. Each individual 
palette is opened by clicking the corresponding icon at the top of the Palette panel.

Left palette selection buttons

Camera Raw palette: For making metadata adjustments to raw media formats

Color Match palette: Automatic grading based using test charts

Primaries: Graphical color balance controls and master wheels, along with a Slider 
mode for adjusting YRGB Lift/Gamma/Gain

HDR palette: Advanced primary grading controls designed for wide-gamut media and 
SDR or HDR mastering

RGB Mixer: For mixing color channels into one another

Motion Effects palette: With controls for noise reduction and artificial motion blur

The five available palettes can be used individually or together depending on what you’re trying 
to accomplish. For more information on most of these palettes, see Chapter 129, “Primaries Palette.” 
For more information on the Motion Effects palette, see Chapter 151, “The Motion Effects and Blur 
Palettes.”

Center Palettes
At 1920x1080 resolution or higher, a second set of palettes is organized at the bottom center of the 
Color page. These palettes span a wide range of functionality, and the adjustments you make with 
them can be combined with those made using the Color palettes.

Center palette selection buttons
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NOTE:  At lower resolutions, the Left and Center palettes are merged to fit the 
DaVinci Resolve interface into a smaller area.

Curves palette Color Warper palette

Qualifier palette Window palette

Tracker palette Magic Matte palette

Blur palette Key palette

Sizing palette Stereoscopic 3D palett

Keyframe Editor, Video Scopes, and Information
The bottom right of the Color page can be switched between one of three things:

 

The three controls for displaying the Keyframe 
Editor, video scopes, or Information palette

Keyframe Editor: Provides an interface for animating Color, Sizing, and Stereo Format 
adjustments over time. Each node in the Node Editor corresponds to a track in the 
Keyframe Editor, which lets you animate each node’s adjustments independently. 
Furthermore, each node’s track can be opened up to reveal parameter groups, so 
that you can animate subsets of an individual node’s functions independently of other 
functions within the same node. 

For more information about keyframing, see Chapter 145, “Keyframing in the 
Color Page.”

Video scopes: Provides a docked area where you can expose one video scope at a 
time for reference while you work. You can also “undock” the video scopes into a stand-
alone window, in which you can show four different scopes at a time. More information 
about using the video scopes appears later in this chapter.

Information: Provides a way of seeing clip and system information while you work.
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Dual Monitor Layout
The Color page has a dual monitor layout that provides maximum space for the Viewer, Node Editor, 
and Control palettes on the primary monitor, and a simultaneously displayed Gallery, Lightbox, 
Keyframe Editor, Metadata Editor, and Video Scope panel on the secondary monitor.

To enter dual screen mode:

	— Choose Workspace > Dual Screen > On.

The Color page in dual screen mode

To switch which UI elements appear on which monitors:

	— Choose Workspace > Primary Display > (Monitor Name), which reverses the contents of both 
monitors in dual screen mode.
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The Info Palette and Clip Information
The Info palette is hidden by default. Clicking the Info palette button at the far right of the toolbar 
reveals it. The Info palette has two tabs that display different information. There are no user-editable 
controls in the Info palette.

 

Info palette displaying Clip Info and System Status

Clip Info
The first tab displays information about whichever clip is currently selected in the Timeline. 
This information is not editable, but is provided for reference, and includes:

	— File Name: The name of the media file on disk. If the current clip is a Multicam clip, this shows the 
name of the currently selected angle.

	— Reel Name: The reel name of that clip, if one is being read properly.

	— Start T/C: The source timecode value of the first frame in the clip.

	— End T/C: The source timecode value of the last frame in the clip.

	— Duration: The duration of the clip, in timecode.

	— Frames: The duration of the clip, in frames.

	— Version: The name of the remote or local version used by that clip.

	— Frame Rate: The frame rate used by that clip.

	— Source Res: The native resolution of the source clip.

	— Codec: The codec or format used by the source clip.

2800Color  |  Chapter 124  Using the Color Page



System Info
The second tab displays information about operational modes currently in use by DaVinci Resolve. 
It’s meant to provide the status of different DaVinci Resolve features that can be enabled, disabled, or 
cycled among various options. This information includes:

	— Clips: The total number of clips in the Timeline.

	— Proxy: The status of Proxy mode (On or Off).

	— Clip Cache: The status of the Clip Cache mode (Off, All, Dissolves, User, User & D).

	— Ref Transform: The status of Reference Still reposition. 

	— Ref Mode: The status of the Reference mode (Gallery, Timeline, Offline).

	— Wipe Style: The currently selected Wipe Style for split screens (Wipe-H, Wipe-V, Wipe-M, Wipe-A).

	— Convergence: The current Convergence setting (Linked Zoom, Opposite)

	— Stereo Grade: The currently displayed Eye and Gang mode (Left or Right - Gang or Solo).

	— Stereo Display: The current Stereo Display mode (Mono or Stereo).

Clip Details
You can right-click the currently selected clip in the Thumbnail Timeline and choose View Clip Details 
to show a small window with all of that clip’s information available at a glance. You can drag this 
window anywhere you like, even to another display.

The Clip Details window

This information is not editable, but is provided for easy reference, and includes:

	— File Name: The name of the media file on disk appears at top.

	— Start Timecode: The source timecode value of the first frame in the clip.

	— End Timecode: The source timecode value of the last frame in the clip.

	— Duration: The duration of the clip, in timecode.

	— Frames: The duration of the clip, in frames.

	— Reel Name: The reel name of that clip, if one is being read properly.

	— Version: The name of the remote or local version used by that clip.
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	— Format: The format used by the source clip, along with the frame size and bit depth.

	— Codec: The codec used by the source clip.

	— Folder: Which directory on disk the source media resides in.

	— Description: The description field of the Metadata Editor.

	— Comments: The Comments field of the Metadata Editor.

	— EDL Comments: EDL comments for that event, if any exist.

Customizing the Color Page
The various sections of the Color page can be resized, hidden, and rearranged as needed to 
accommodate different working styles. This section covers all of the methods that are available for 
Color page customization.

You can easily resize the Viewer, Gallery, and Nodes Editor relative to one another to make the 
Viewer larger, expand the width of the Node Editor to have more workspace, or to create more or less 
room for stills in the Gallery.

To resize the Viewer, Gallery, and Node Editor:

	— Move the pointer over the vertical divider between any two areas. When the resize icon appears, 
drag the divider to the left or right to make one area larger while making the other smaller.

You can also fully expand the Gallery, the Memories, the Node Editor, and the Keyframe Editor to 
replace completely whichever interface area is adjacent.

To expand the Keyframe Editor, Viewer, and Gallery:

	— Click the Expand control at the upper right of whichever interface area you want to expand. Once 
expanded, clicking the Expand control again will collapse that interface area back to its original 
size, revealing whatever was hidden.

In Display mode, you can completely hide the Viewer, pushing the Gallery all the way to the right 
side of the DaVinci Resolve window, and expanding the Node Editor to take the rest of the space.

To toggle Display mode, do one of the following:

	— Right-click in the empty area of the Node Editor, and choose Toggle Display Mode from the contextual 
menu. Do this again to toggle Display Mode off and return the interface to the way it was.

	— Press SHIFT UP and DISPLAY/CURSOR, above the fourth trackball of the Center panel of the 
DaVinci control panel.

To show and hide the Mini-Timeline:

	— Click the Timeline button at the right of the palette button bar.

To show and hide the Color page Viewer upper toolbar:

	— Click the Viewer option menu and choose Show Viewer Options to uncheck it.

To return all pages to their default layout:

	— Choose Workspace > Reset UI Layout.
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Undo and Redo in DaVinci Resolve
No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of 
steps you’ve taken or commands you’ve executed, and reapply them if you change your mind. 
DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or 
opening a particular project. When you close a project, its entire undo history is purged. The next time 
you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three separate 
sets of undo “stacks” to help you manage your work.

	— The Media, Cut, Edit, and Fairlight pages share the same multiple-undo stack, which lets 
you backtrack out of changes made in the Media Pool, the Timeline, the Metadata Editor, 
and the Viewers.

	— Each clip in the Fusion page has its own undo stack so that you can undo changes you make to the 
composition of each clip, independently.

	— Each clip in the Color page has its own undo stack so that you can undo changes you make to 
grades in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there may be 
a limit to what you can remember). To take advantage of this, there are three ways you can undo work 
to go to a previous state of your project, no matter what page you’re in.

To simply undo or redo changes you’ve made one at a time:

	— Choose Edit > Undo (Command-Z) to undo the previous change.

	— Choose Edit > Redo (Shift-Command-Z) to redo to the next change.

	— On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

TIP:  If you have the DaVinci control panel, there is one other control that lets you 
control the undo stack more directly when using the trackballs, rings, and pots. Pressing 
RESTORE POINT manually adds a memory of the current state of the grade to the undo 
stack. Since discrete undo states are difficult to predict when you’re making ongoing 
adjustments with the trackball and ring controls, pressing RESTORE POINT lets you set 
predictable states of the grade that you can fall back on.
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Chapter 125

Viewers, Monitoring, 
and Video Scopes
Viewers let you see what you’re working on, provide a UI for 
transport controls and image comparison, draw windows and 
drag on-screen controls, and provide a variety of warnings 
and information not found anywhere else. 

However, at the same time, professional workflows require real time monitoring via supported video 
I/O devices on a calibrated display. Lastly, video scopes provide a more precise analysis of the state 
of the video signal you’re viewing, and DaVinci Resolve has built-in scopes you can use for creative 
decision making and troubleshooting.

This chapter covers the Color page Viewer, external monitoring and display calibration, and video 
scopes in more detail. 
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Using the Viewer
The Viewer is your window into the Timeline. The clip and frame at the current position of the playhead 
appears in the Viewer. The Viewer also provides a workspace for picking colors, adjusting Windows, 
using split screen stills for reference, and many other display-oriented tasks. If you have a video out 
interface connected to a broadcast display or projector, then the contents of the Viewer are typically 
mirrored by the video output.

The Viewer Title Bar
The Viewer title bar has controls and indicators making it easy to control and keep track of what it is 
you’re looking at.

The Color page title bar with its controls

The Viewer title bar has the following controls:

	— Zoom and Fit menu: Lets you zoom to a specific percentage, or choose Fit to fit the image to the 
total available area of the Viewer.

	— Playback frame rate indicator: A dot shows green if playback performance matches the frame 
rate of the project, or red if playback performance drops below real time. To the right, the current 
frame rate is displayed.
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	— Timeline name and selection drop-down: The name of the currently open timeline is displayed. 
A drop-down to the right lets you open any other timeline in the current project to take its place.

	— Timecode viewer and drop-down: A second timecode viewer lets you choose an alternate 
timecode/frame count/KeyKode value to display simultaneously to the timecode viewer next to 
the transport controls below. A drop-down lets you pick whether to display source (clip) or record 
(timeline) timecode.

	— Bypass Color and Fusion and drop-down: Lets you disable grades and/or Fusion effects.

	— Expand Viewer drop-down: Expands the Viewer to take up the full area of your workstation’s 
display above the palettes.

	— Option menu: Has options that affect the Viewer’s functionality. 

The Color Viewer’s option menu, showing all the Viewer-related commands.

Turning Grades and/or 
Fusion Effects Off
The Bypass Color Grades and Fusion Effects button/drop-down commands in the Viewer’s title bar 
are also available via View > Bypass Color and Fusion menu commands. Turning off Fusion effects in 
the Color page is an easy way to improve playback performance on low power systems when you just 
need to make a quick set of grading adjustments. Toggling grades off and on is also a convenient way 
to quickly get a before-and-after look at a shot where the “before” goes all the way back to the source.

If you choose Toggle Bypass or click the Viewer control, you’ll turn off whatever is checked in the 
optional menu, which lets you choose whether or not you want to bypass both Color and Fusion, or 
just one or the other.
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(Left) Menu commands for bypassing Color and Fusion, (Right) Edit page Timeline Viewer controls

TIP:  If you’re giving your client a before and after look at work you’re doing on a grade, 
a more effective technique is to select the specific nodes (one or more) that you want to 
toggle on and off, and press Command-D (Enable/Disable Selected Nodes.)

Viewing Isolated Channels
Use the Show Viewer Channels submenu in the Viewer’s option menu to switch the Color page Viewer 
among RGB, R, G, or B channels. This can be useful when evaluating a single channel of an image for 
noise or other artifacts, or for doing color matching by comparing and adjusting the individual red, 
green, and blue channels of two different clips.

The Viewer Toolbar
The Color page also exposes a toolbar at the top of the image (underneath the title bar) that makes 
it easy to enable and disable image wipe, split screen, and highlight viewing by clicking one of these 
buttons, which then exposes additional controls relating to each of these modes of operation 
(described elsewhere in this chapter). Those options can be shown or hidden by clicking the Viewer 
option menu and unchecking Show Viewer Options.

The Color page Viewer toolbar showing the 
Wipe, Split Screen, and Highlight controls. 
The Highlight options are seen in the bar below.

In the process, these buttons provide an easy reference for when a comparison mode is enabled. In 
each of these Viewer modes, the appropriate controls for customizing that view appear to the right of 
the Viewer toolbar.
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Showing Marker Overlays 
and Annotations
The Color page Viewer supports viewing Marker Overlays and Annotations for Timeline and Clip 
markers. From the Viewer’s 3-dot option menu select Show Marker Overlays, or from the Viewer 
overlay controls drop-down (bottom left) select the annotation mode.

When Show Marker Overlays is checked, the Color Viewer 
will display any Marker Overlays (upper left) and annotations.

The Onscreen Control (OSC) Menu
The Onscreen Control drop-down menu lets you choose which onscreen controls you want to display 
and adjust in the Viewer. Some palettes automatically enable corresponding onscreen controls when 
you open them. For example, opening the Window palette displays the Power Window onscreen 
controls, and opening the Qualifier palette displays the Qualifier onscreen controls.

The onscreen control menu for the Viewer
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There are a variety of choices, each corresponding to different adjustments you can make:

Off: All onscreen controls are hidden from view, giving you an unimpeded display of the 
image in the Viewer.

Qualifier: Turns on the Color Sample cursor, which lets you choose a color using the 
fourth trackball of the DaVinci control panel. For more about using Color Sample controls, 
see Chapter 134, “Secondary Qualifiers.”

Power Window: Turns the Power Windows onscreen control on and off. For more about 
adjusting windows in the Viewer, see Chapter 135, “Secondary Windows.” under 
“Power Windows.”

Image Wipe: Toggles mouse control of dragging the split screen directly on the Viewer 
on and off. For more about working with split screens, see “Comparing Clips in the 
Viewer” later in this chapter.

Open FX Overlay: Shows and hides whatever onscreen controls are exposed by an 
Open FX plugin in the currently selected node.

Color Chart: Shows and hides the color chart overlay that lets you identify a color 
chart in the picture that you want to use with the Color Match palette to create an 
automatic grade.

Annotations: Shows the annotation tools in the toolbar. Drawing annotations on 
a frame without a marker creates a new Timeline marker. For more about using 
Annotations, see Chapter 40, “Marking and Finding Clips in the Timeline.”

TIP:  As you work, you may find you want to temporarily hide or show the onscreen controls 
so you can get an uncluttered look at the image you’re adjusting. You can toggle any set of 
onscreen controls off and on without selecting Off in the menu by pressing Shift-` (tilde).

Toggling Viewer Overlays On and Off
Pressing Shift-` (Tilde) turns the current Viewer overlay on and off. The View > Viewer Overlay 
submenu contains commands for showing, hiding, and switching different overlays in the Color page 
Viewer. While most of the options in this menu are unassigned by default, they can be assigned to keys 
using the Keyboard Customization window.

Onscreen Controls and External Displays
DaVinci Resolve has been designed for use with calibrated external displays connected to video 
output interfaces, and for most colorists working on broadcast or theatrical programs, this is the 
recommended way to work for color critical evaluation. 

Because of this, many of the onscreen controls associated with tasks such as color sampling, window 
adjustment, and key manipulation are mirrored to your video output, making it possible to hide the 
Viewer on your computer’s monitor and work with only an external display.
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To choose whether onscreen controls are mirrored to video out or disabled:

Choose an option from the Window Outline submenu in the Viewer’s option menu. There are three options:

	— Off: Hides the window outline on both the external display and the Viewer.

	— On: The default, shows the window outline on both the external display and the Viewer.

	— Only UI: Hides the window outline on your external display, but leaves it in the Viewer.

To show clip flags on video output:

Turn on the “Show clip flags on video output” checkbox option in the Color page Viewer’s Option 
menu. This enables drawing one or more small colored flag overlays in the bottom-left corner of video 
output. This way, you can always see which clips are flagged on your grading hero display as you work, 
if that helps you to keep track of whatever you’re using flags to stay on top of. This is off by default.

Limitations When Grading With the Viewer 
on a Computer Display
Most computer displays do not operate at the color critical tolerances or specifications 
required for quality control for streaming, broadcast, or theatrical delivery. An additional 
issue, however, is that depending on your combination of workstation and computer 
display, the Viewer does not necessarily display each clip’s image data as it is displayed by 
the calibration that your operating system applies to your computer display, depending on 
which OS you’re running DaVinci Resolve on. This makes your computer display potentially 
unsuitable for monitoring projects destined for the sRGB standard of the web in its default 
state. For example, if you grade a project using the Color page Viewer on your computer 
display, the resulting clip may not look the same in the QuickTime player, or in other post-
production applications.

You can address this in one of two ways:

	— If you’re using DaVinci Resolve on macOS, you can turn on “Use Mac Display Color 
Profile for viewers” in the Hardware Configuration panel of the System Settings. 
This lets DaVinci Resolve use whichever of the color profiles you choose in the Color 
tab of the Displays panel in the macOS System Preferences, thereby taking advantage 
of ColorSync on macOS to let DaVinci Resolve display color the way your computer 
monitor does. This now works for all color profiles that ship with macOS, as well as color 
profiles that have been generated by calibration software, such as that available from 
X-rite, Datacolor, or other applications. On supported computers, there’s also an option 
to “Use 10-bit precision in viewers,” if available, that you can turn on. With this option 
enabled, rendered output displayed in QuickTime Player will match what is seen in the 
DaVinci Resolve Viewer.

	— Alternately, you can apply a dedicated Color Viewer LUT for calibration, using the 1D/3D 
Color Viewer Lookup Table drop-down menu that’s found in the Color Management 
panel of the Project Settings. This lets you analyze your computer display for calibration 
in the same way you would calibrate an external display, using a probe and color 
management software, and apply the resulting calibration LUT in DaVinci Resolve. 
Keep in mind that monitor calibration can only make a high quality display standards 
compliant; it cannot make up for a display gamut that’s too small. For more information, 
see the “Lookup Tables” section of Chapter 4, “System and User Preferences.”
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Strictly speaking, if you’re doing professional work, you should restrict your grading using 
a calibrated, 10- or 12-bit class A external broadcast display of some type, connected via 
a Blackmagic Design video interface. Assuming everything is running properly, an image 
that is output to video from DaVinci Resolve should match an image output to video from 
any other post-production application you’re using, and this should be your basis for 
comparison when examining the output of two different applications.

Zooming into the Viewer
When using the Viewer to sample tricky colors or draw a detailed PowerCurve, it can be advantageous 
to zoom into the image.

To zoom into or out of the Viewer, do one of the following:

	— Move the pointer to within the Viewer, and then roll the scroll wheel to zoom in or out of the image.

	— Press Command-Equal to zoom in, or Command-Minus to zoom out.

To pan around the Viewer:

	— Move the pointer to within the Viewer, then middle-click and drag to pan around the image.

To reset the size of the Viewer image:

	— Choose 100% (Actual Size) (Option-Shift-Z) from the sizing drop-down menu in the upper left of 
the Viewer.

	— Choose View > Zoom > Zoom to Fit (Shift-Z).

To enable or disable image zoom being sent to video out:

	— Choose “Gang viewer zoom with video output” from the Option menu of the Viewer to zoom the 
image shown on video out identically to the zoom level of the Viewer, enabling you to evaluate a 
zoomed-in portion of the image on your suite’s hero display.

Using the Jog Bar and 
Transport Controls
One of the principal uses of the Viewer is to control playback. The jog bar, directly underneath the 
image in the Viewer, contains a playhead that you can drag to the left and right to navigate quickly 
through the currently selected clip as fast as you can move the pointer. The playhead in the jog bar 
is locked to the playheads found in the Timeline and Keyframe Editor. Moving one playhead moves 
all three.

How much of the Timeline the jog bar navigates depends on whether the Node Editor is set to Clip or 
Timeline mode. In Clip mode, the jog bar width equals the duration of the currently selected clip. In 
Timeline mode, the jog bar width equals the total duration of the entire Timeline.

A row of transport controls below the jog bar provides more specific control over timeline playback.
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	— Previous clip: Moves the playhead to the first frame of the previous clip.

	— Reverse: Initiates 100% playback in reverse.

	— Stop: Stops playback.

	— Play: Initiates 100% playback.

	— Next clip: Moves the playhead to the first frame of the next clip.

	— Loop: Lets you restrict playback to the current clip, looping to the first frame if you’re playing 
forward to the end of a clip, or looping to the last frame if you’re playing in reverse to the 
beginning of a clip.

Two other buttons let you control audio playback and clip display in the Viewer:

	— Unmix: Turning on Unmix disables all transitions, composited superimpositions, and effects 
that mix two or more clips together. Unmix allows you to judge the appearance of a clip without 
distraction whenever you need to make an adjustment based on how the clip looks on its own, 
or whenever you need to make changes based on frames that would otherwise be hidden 
underneath a transition such as a dissolve or fade from black. When you’re ready to see how your 
grades work in context with transitions and composites again, turn Unmix off.

	— Mute: Audio playback can be turned on or off by clicking on the speaker icon, or adjust the level 
by right-clicking on the speaker icon and dragging the slider.

Navigating Using the Arrow Keys
You can use the Arrow Keys of the keyboard to navigate clips and the Timeline in different ways.

	— Up/Down Arrow: Moves the playhead to the first frame of the previous or next clip.

	— Left/Right Arrow: Moves the playhead back or forward one frame at a time.

	— Shift-Left/Right Arrow: Moves the playhead back or forward one second at a time.

Controlling Playback Using the 
Spacebar and JKL Keys
You can also use the spacebar to start and stop playback, or the JKL keyboard shortcut convention for 
controlling playback, where J plays in reverse, K stops playback, and L plays forward. There are many 
additional uses of these keyboard shortcuts; for more information see “Using JKL to Control Playback” 
in Chapter 36, “Preparing Clips for Editing and Viewer Playback.”

Fast Review on the Color Page
The Fast Review playback command (Playback > Fast Review) is now available on the Color page. 
Intended to help you watch through long sequences of clips quickly, clicking this option begins 
accelerated playback through the Timeline, where the speed of playback is relative to the length of 
each clip you’re playing through. Long clips play faster, whereas shorter clips play closer to real time.
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Navigating Using Timecode
You can also use absolute or relative timecode entry to move the playhead in the Color page Viewer. 
When entering timecode, type each pair of hour, minute, second, and frame values consecutively, with 
a period representing a pair of zeros for fast entry. The last pair of timecode values (or period) you 
enter is always assumed to be the frame number, with any untyped values assumed to be zero. It’s 
not necessary to enter colons or semicolons. For more information, see “Moving the Playhead Using 
Timecode” in Chapter 36, “Preparing Clips for Editing and Viewer Playback.”

Viewer and Transport 
Timecode Displays
The Viewer has two timecode displays, each of which defaults to a different timecode setting. 
A timecode display at the top, the Header timecode display, shows the Source timecode by default. 
The timecode display at the bottom, the Transport timecode display, shows the Record timecode by 
default. The bottom timecode display can be changed to show one of four different options, which are 
similar to those found in the Data Burn-In palette.

To change a timecode display to a different setting:

The top timecode display is a drop-down menu that can be changed to whatever timecode, frame 
number, or KeyKode you want to display. The bottom timecode display can also be changed by right-
clicking on it and choosing the type of value to show from the contextual menu that appears. There 
are the following options:

	— Timeline Timecode: The timecode corresponding to the playhead’s position in 
the overall Timeline.

	— Source Timecode: The timecode corresponding to the playhead’s position relative to the 
currently selected clip.

	— Timeline Frame: The frame count corresponding to the playhead’s position in the 
overall Timeline.

	— Source Frame: The frame count corresponding to the playhead’s position relative to the currently 
selected clip.

	— KeyKode: The KeyKode number corresponding to the media’s KeyKode track, if there is one.

	— Show Timecode at 30 FPS: Displays 24 fps timecode, via 3:2 pulldown, as 29.97 fps timecode. Has 
no effect on video playback.

	— Copy and Paste Timecode: Two commands make it easy to copy and paste timecode values.

In the same way, the top timecode display can alternately be changed to show KeyKode, if it’s available, 
within a DPX media file’s header.
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Enhanced, Full, and Cinema Viewing
You can expand the Viewer into Enhanced Viewing mode by choosing Workspace > Viewer Mode 
> Enhanced Viewer mode (Option-F), or by pressing CURRENT/VIEWER on the T-bar panel of the 
DaVinci control panel.

Enhanced Viewing Mode
In Enhanced Viewing mode, the Viewer works exactly as it does at its regular size, but it expands to 
fill up the entire area of the screen above the palettes and Keyframe Editor. To exit Enhanced Viewing 
mode, press (Option-F) again.

This can be useful if you need a closer view of the image for purposes of making detailed corrections, 
examining noise patterns up close, making a tricky color selection, or drawing a complicated 
PowerCurve.

Color page in Enhanced Viewer mode

Full Viewing Mode
In Full Viewing mode (available by choosing Workspace > Viewer Mode > Full Page Viewer, pressing 
Shift-F, or Option-clicking the Enhanced Viewing mode button), the Viewer takes up even more room 
by hiding the palette controls, but leaves room for the transport controls, the Onscreen Control drop-
down menu, the timecode display, and the page buttons along the bottom of the DaVinci Resolve UI. 
This mode is useful when you need an even closer look at the image, but you still want access to a 
minimal set of onscreen controls.
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Color page in Full Viewer mode

Cinema Viewing Mode
Another option, Cinema mode, allows for full-screen viewing. Cinema mode is available by choosing 
Workspace > Viewer Mode > Cinema Mode Viewer (P). In Cinema mode, the menu bar is hidden, 
and the image is presented full screen without any of the ordinary onscreen controls. Moving the 
pointer over the screen reveals a set of hidden onscreen controls that include a play button, jog bar, 
mute button, and exit button (which lets you turn off Cinema mode). You also have the option of 
superimposing scopes over the image, which can be valuable in on-set situations.

Color page in Cinema mode

Cinema mode is useful for doing detailed reviews of media in on-set and digital dailies workflows 
when working remotely without a secondary video display.

TIP:  If you’d like to superimpose timecode over the image in Cinema mode for reference, 
you can use the controls within the Data Burn-In window (Workspace > Data Burn-In) to set 
up whatever information you’d like to display during playback.
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Safe Area Overlays in the Viewer
You can show or hide a series of safe area overlays in the Viewer. All safe area overlay options are 
found in the View > Safe Area menu. Each safe area overlay option can be individually enabled or 
disabled from this menu.

Viewer displaying extents, center, safe, action and title area overlays

	— On/Off: Turns all currently selected safe area marker options on or off at once.

	— Extents: An outline showing the exact outer edge of the frame. Especially useful when the safe 
markers are set to an aspect ratio other than that currently used by the Viewer.

	— Action: An outline showing the outer 90% action safe area of the frame.

	— Title: An outline showing the outer 80% title safe area of the frame.

	— Center: A crosshairs showing the center of the frame.

	— Aspect: Enables use of the View > Select Aspect Ratio submenu to change the aspect ratio of the 
safe area markers. You can choose among the following aspect ratios: 1.33 (a.k.a. 4:3), 1.66, 1.77 
(a.k.a. 16:9), 1.85, and 2.35.

You can also access these options directly using the DaVinci control panel.

Use Gray Background
Checking the “Use gray background in viewers” box in the User Preference’s UI Settings sets the 
empty area of the Viewer (if there is any) to a lighter gray, making it easier to see which parts of the 
Viewer are black because of blanking, and which parts are simply empty because of the way the image 
is zoomed or panned.
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Monitor Calibration
If you use Light Illusion’s LightSpace CMS or SpectraCal’s Calman for display calibration, you can now 
use DaVinci Resolve as a sync-able pattern generator. This means you can use DaVinci Resolve to 
output color patches, synchronized by LightSpace, to your display through whichever video interface 
is connected to your computer. These synchronized color patches will be analyzed by a monitor probe 
that’s also controlled by LightSpace, which stores the probe data and compares it to the original color 
values of the output color values in order to characterize that display.

To use this feature, you must first have a licensed copy of LightSpace CMS, which is a Windows 
application. Synchronization depends on a wired or wireless LAN being available to connect the 
LightSpace application with DaVinci Resolve.

To synchronize LightSpace CMS to DaVinci Resolve as a pattern generator client:

1	 Open LightSpace on the Windows computer that’s running it.

2	 When LightSpace is open, click the Network Manager button. A window appears displaying the 
two network IP addresses used by LightSpace. Note these, and click the Enable button.

The Network Manager dialog 
in LightSpace CMS 

3	 In DaVinci Resolve, choose Workspace > Monitor Calibration > LightSpace. 

4	 When the LightSpace dialog opens, enter the second of the two network IP addresses LightSpace 
lists into the Remote Machine field, and make sure the Port number matches. Then click the 
Connect button.

The Calibration dialog in DaVinci Resolve, 
connected to LightSpace CMS via WiFi
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If everything is working correctly, the LightSpace dialog in DaVinci Resolve should show the 
word “Connected,” and the Network Manager dialog in LightSpace should show that there is 1 
available client/s. 

You can now close the Network Manager dialog in LightSpace and follow the procedures outlined 
in the LightSpace CMS documentation for characterizing your display and building and exporting 
a display LUT (in the .cube format) that you can use as a display LUT in DaVinci Resolve. Alternately, 
you can export a display LUT from LightSpace that can be loaded onto an outboard video 
processing device.

5	 When you’re finished, click Disconnect in the LightSpace dialog, and then click Cancel to close 
the window.

Viewing Broadcast Safe Exceptions
Choosing View > Display Broadcast Safe Exceptions sets the Color Page Viewer to show a false-color 
overlay that indicates in blue the regions of the picture that violate the currently selected broadcast 
safe level in the Color Management panel of the Project Settings. 

Areas of the image that violate broadcast safe are highlighted in blue

More information about broadcast safe limiting in the Color Management panel of the Project 
Settings see Chapter 127, “Automated Grading Commands and Imported Grades.”

Comparing Clips in the Viewer
The ability to compare different clips to one another is an important part of the color correction 
process. DaVinci Resolve provides three different ways of doing so. You can use the Gallery to display 
two clips for split screen comparison. You can also use different reference modes to see a timeline clip 
or reference movie directly as part of a split screen comparison. Finally, you can use the Split Screen 
controls to display multi-frame arrangements in the Viewer.
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Saving and Wiping Stills in the Gallery and Timeline
The Gallery on the Color page provides fast access to stills that you’ve saved from various clips in the 
Timeline. While the dedicated Gallery page provides a more comprehensive interface for browsing 
presaved “looks,” as well as for importing stills from other projects, you can save, organize, and 
browse stills directly within the Gallery of the Color page.

Stills are saved in the DPX file format. Once you’ve saved one or more stills, you can set up split screen 
wipes in the Viewer, which will be mirrored to your external display. 

Stills from the Gallery can be compared to the current 
shot, making it easier to match grades.

This section provides an abbreviated summary of still store and split screen functionality to get you 
started quickly.

To save a still, do one of the following:

	— Choose Color > Stills > Grab Still (Option-Command-G).

	— Right-click on the Viewer and choose Grab Still.

To wipe a still, do one of the following:

	— Select a still in the Gallery, and click the Image Wipe button on the top Viewer toolbar. 

	— Choose Color > Stills > Play Still (Command-W), or right-click in the Viewer and choose Toggle Wipe.

	— Double-click a still in the Gallery.

To adjust a wipe in the Viewer, do one of the following:

	— Drag the pointer within the Viewer to move the wipe.

To customize a wipe in the Viewer: 

The different wipe customization modes
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Click one of the Wipe mode buttons in the Viewer toolbar. There are the following modes:

Horizontal: Lets you compare both halves of the wipe to either side of a vertical border. 
Dragging the pointer moves the wipe border left and right.

Vertical: Lets you compare both halves of the wipe above and below a horizontal border. 
Dragging the pointer moves the wipe border up and down.

Diagonal: Lets you compare both halves of the wipe via an adjustable diagonal border. 
Dragging the pointer repositions the wipe to the left and right. Hold the option key down 
and drag while moving the pointer around in a circle to rotate the border of the wipe to 
any angle you like.

Mix: Lets you blend both images together to compare them. Dragging the pointer 
controls the fade percentage from one image to the other.

Alpha: Lets you use a qualifier to define transparency in the image of the current clip 
while comparing it to a Gallery still used as the background. Add a node to the grade 
and use the qualifier to key a particular color you want to turn transparent (the green of 
a green screen, for example). Then, connect that node’s KEY output to the Alpha Output 
that appears in the Node Editor. The part of the foreground image isolated by the key 
becomes transparent, allowing the Gallery still in the background to show through. 
This can be useful for previewing how the lighting or grade of a foreground VFX plate 
looks when the image is composited against a particular background image stored in 
the Gallery.

Difference (A/B): Lets you view only the pixels that change due to an operation on the 
node. For example, if you select this highlight and adjust the gain, only the pixels that the 
gain modified would be visible in the Viewer.

Box: Lets you view the current clip as a picture-in-picture effect against the still in 
the background. Dragging the pointer resizes the crop box around the outside of the 
reference image.

Venetian Blind: Lets you compare both images being wiped via alternating horizontal 
strips. Drag the pointer up or down to change the size of the alternating strips. Good for 
quickly comparing vertical color uniformity, focusing on color and contrast changes that 
occur from top to bottom.

Checkerboard: Lets you compare both images being wiped via an alternating 
checkerboard. Drag the mouse left or right to alternate between images by squeezing 
each check horizontally. Good for comparing color uniformity across the width and 
height of two images.

Choose one of the following from the Wipe Style submenu in the Viewer’s option menu.

	— Wipe Style: Cycles among the Horizontal, Vertical, Diagonal, Mix, Alpha, Difference, Box, Venetian 
Blind, and Checkerboard modes.

	— Invert Wipe: Reverses each half of the wipe (Option-W).
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Hover Scrub in the Gallery
When Live Preview is enabled in the Gallery option menu, the Hover Scrub Preview submenu lets you 
choose how you want Live Preview to be shown by a thumbnail in the Gallery and in the Viewer when 
you hover the pointer over a still or LUT in the LUT Browser:

	— You can choose to scrub both the thumbnail you’re hovering over and the Viewer, letting 
you preview the current still’s grade or a LUT over the duration of the current clip in both the 
thumbnail and Viewer. 

	— You can choose to scrub just the thumbnail, leaving the Viewer to show just the grade or LUT over 
the frame at the position of the playhead.

	— You can disable scrubbing altogether, in which case both the thumbnail and the Viewer will only 
show the grade or LUT over the frame at the position of the playhead.

Copying Grades from Stills in the Gallery
Stills also store the grade from the clip they came from, and can be used to copy grades from one clip 
to another, or to store grades that you might want to use later.

To copy a grade from a still to a clip, do one of the following:

	— Select one or more clips in the Timeline, then right-click a still in the Gallery and choose 
Apply Grade.

	— Select one or more clips in the Timeline, then middle-click a still in the Gallery.

When you copy a still in this way, the saved grade completely overwrites the grade in the target 
clip, unless you’ve used the “Preserve number of nodes” option, found in the contextual menu of 
the Gallery. For more detailed information on using the Gallery, including options for organizing 
the Gallery browser, instructions for using Albums, Power Grades, and Memories, as well as other 
methods of copying grades and performing advanced grade management tasks, see Chapter 138, 
“Using the Gallery.” and see Chapter 139, “Grade Management.”

Different Viewer Reference Modes for Wipes
While it’s common to use the Gallery to wipe against reference stills, by changing the reference 
mode you can also create a wipe against a clip in the Timeline, or against an Offline Reference Clip or 
Timeline, if one has been assigned to the current Timeline.

To change the Viewer reference mode, do one of the following:

	— Choose an option from the Reference Wipe Mode submenu in the Viewer’s option menu.

	— Choose an option from the Reference Mode icons at the top of the Viewer.

There are three reference modes:

	— Gallery: The default reference mode. Lets you wipe the current clip against a Gallery still.

	— Timeline: Lets you wipe the current clip against another clip in the Timeline using the Wipe 
Timeline Clip command (see below).

	— Offline: Lets you wipe the current clip against an offline video that’s been assigned to the current 
Timeline. For more information on assigning Offline References to a timeline for comparison,  
see Chapter 55, “Preparing Timelines for Import and Comparison.”
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Wiping Between Clips in the Timeline
If you want to wipe the current clip against another clip in the Timeline without saving a still to the 
Gallery first, there’s a special procedure you can follow.

To wipe between two clips using the Timeline reference mode:

1	 Click the thumbnail of the first clip you want to compare.

2	 (Optional) A “Gang timeline wipe with current clip” option, available from the Viewer option menu, 
lets you maintain the offset between the current clip and a timeline clip you’re wiping against when 
you move the current clip selection to other clips. With this option enabled, the offset between the 
timeline wiped clip and the current clip is maintained when you move the clip selection. You can 
step the timeline reference clip forward one frame by pressing Command-Option-Right Arrow, and 
back one frame by pressing Command-Option-Left Arrow. This allows for precise positioning. When 
this option is disabled, the timeline wiped clip stays where it is regardless of what clip you select. 

3	 Right-click the thumbnail of the second clip you want to compare against, and choose Wipe 
Timeline Clip from the contextual menu.

Both clips appear split screened against one another.

NOTE:  Wipe Timeline Clip only appears in the contextual menu if you right-click on a 
thumbnail in the Timeline that has not been selected as the current clip.

Change a Timeline Wipe Using the Timelines Album of the Gallery
While you’re using the Wipe Timeline Clip to show a wipe of the current clip against any other clip in the 
Timeline, you can open the Timelines album of the Gallery and click different clips to change which timeline 
clip you’re wiping against (outlined in blue) without changing the current clip (outlined in orange).

Using Split Screen Modes
A set of split screen modes provides additional ways of comparing multiple images in the Viewer at the 
same time. These provide side-by-side and grid comparisons of multiple shots and multiple versions, 
all of which are output to video for monitoring on your external video display. For example, you can 
use the Split Screen Versions mode to display every single version that’s applied to the current clip in 
a grid, for easy evaluation. The currently selected clip in the Timeline is highlighted in gray, so you can 
keep track of what you’re doing.

To enable a split screen mode, do one of the following:

	— Click the Split Screen button on the top Viewer toolbar, and choose a split screen method from the 
drop-down menu that appears in the Viewer toolbar at the right.

	— Choose an option from the Split Screen submenu in the Viewer’s option menu.

	— Press Option-Command-W to turn Split Screen on and off, using the last selected option.

	— Right-click the Viewer and choose an option from the Split Screen submenu in the contextual menu.

NOTE:  When any of the split screen modes are selected, you cannot see any other onscreen 
controls in the Viewer, such as Power Window shapes, until you first disable split screen.
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Four shots shown in a grid using the Split Screen > Selected Clips mode

Viewing and Choosing the Current Selection
In any of the split screen modes, the current selection is indicated by a gray outline. This outline can 
be disabled for a more direct comparison by choosing Split Screen > Show Outline in the Viewer’s 
option menu to toggle the outline off and on.

In certain modes, you can also double-click a particular frame of the split screen view to change the 
current clip, choose the active version, or apply a gallery grade.

Available Split Screen Modes
You can choose from among the following split screen modes:

	— Current Group: Shows up to 16 clips that share the same group as the current clip. Double-
clicking a frame does nothing in this mode.

	— Highlight Modes: Shows a four-up display that lets you simultaneously see (clockwise) the clip’s 
RGB image, the gray matte, the high contrast matte, and a difference matte generated by the 
node’s input compared against its output. Double-clicking a frame does nothing in this mode.

Viewing a key using the Split Screen > Highlight Modes
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	— Neighbor Clips: Shows four clips that immediately surround the current clip. The previous two 
clips appear as the upper left- and right-hand clips, the current clip appears at the lower left-
hand corner, and the next clip appears at the lower right. Double-clicking a frame does nothing 
in this mode. The “Neighboring Clips in Split Screen” parameter in the Color panel of the User 
Preferences lets you customize how many neighboring clips appear in this mode.

	— Playheads: Shows simultaneous comparisons in the Color page Viewer of up to four playheads 
displayed in the Mini-timeline when you choose multiple playheads from the Color > Active 
Playhead submenu. For every playhead you expose (up to 4), the frame at each playhead will be 
displayed in a 2-up, 3-up, or 4-up grid. An outline in the Viewer (if enabled) shows which playhead 
is currently active. This is useful both for comparing multiple clips, as well as for comparing 
different frames within the same clip. Switching between the active playheads can be done by 
clicking on the clips in the split screen Viewer

Placing three playheads in the Mini-timeline

	— Selected Album: When you choose this option, a split screen of the grades of every still in that 
album are shown in the Viewer as they appear applied to the current clip. Double-clicking a frame 
applies that gallery grade to the current clip. Up to 16 grades will be shown.

	— Selected Clips: Shows all currently selected clips in the Timeline, up to 16 at one time. Clicking a 
clip moves the playhead to the first frame of that clip.

	— Selected LUTs:  Lets you simultaneously display previews of different LUTs effect on the current 
clip as a split screen in the Viewer by using the LUTs browser to Command-click up to 16 LUTs you 
want to preview.

The Selected LUTs split screen option lets you preview a bunch of LUT looks at once
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	— Selected Still Grades: When you choose this option, the act of selecting stills in the Gallery of the 
Color page shows each of the grades associated with those stills as they appear applied to the 
current clip, in a split screen arrangement. Double-clicking a frame applies that gallery grade to 
the current clip.

Previewing four gallery grades using the Split Screen > Gallery Grades mode

	— Selected Still Images: Lets you view the current clip against a variety of other stills in the Gallery 
that you select. This is not a grading preview, you’re actually doing a split screen of the selected 
still images in the Gallery.

	— Version: Shows up to 16 versions for the current clip, all at once, making it easy to evaluate a 
series of different versions in relation to one another. If you have more then 16 versions, you 
deserve some manner of award. Double-clicking a version changes the active version.

	— Versions and Original: Shows up to the first 15 versions for the current clip, along with the 
original ungraded clip at the upper left-hand corner. Double-clicking a version changes the active 
version, but you cannot double-click to select the original.

Marker Overlays and Navigation
If you part the playhead on top of a marker in the Timeline of the Color page, that marker’s 
information appears in a Viewer overlay, just as in the Edit page, making it easier to read notes and see 
what information is available. These overlays can be easily hidden by clicking the Viewer option menu 
and turning off “Show marker overlays.” 

Timeline Marker List Available in 
Color Page Viewer Option Menu
The Option menu of the Color page Viewer has a submenu that lists all Timeline Markers in the 
currently open timeline. This makes it easy to run down client notes. 
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Timeline markers list available for quick access in the Viewer’s Option menu

Using Video Scopes
While not directly tied to use of the Viewers, video scopes nonetheless work hand in hand to help 
you evaluate the images you’re working on. DaVinci Resolve has a set of five real-time video scopes 
that you can use to monitor the internal data levels of clips in your project as you work. Each 
scope provides an unambiguous graphical analysis of different characteristics of the video signal, 
showing you the relative strength and range of individual color components including luma, chroma, 
saturation, hue, gamut, white point, and the red, green, and blue channels that, together, comprise 
the color and contrast of the images in your program. 

Video Scope Location
By default, you can view any one of these scopes at a time at the bottom right corner of the Color 
page, by clicking the Video Scope button in the palette button bar.

The video scope, docked next to the other palettes at the bottom of the Color page
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Optionally, you can click the Expand button at the top right of the video scope to open the video 
scopes into a floating window, within which you can display all four video scopes together, or 
individually, on any monitor connected to your workstation.

Video scopes in a floating window in HDR (ST.2084/HLG) mode

Additionally, the video scopes can appear docked on a second display as part of many of the dual-
screen layouts available in DaVinci Resolve. However, if you have three computer displays and 
you’re using dual screen layouts, you still have the option to open the floating Scopes window and 
place it on your third display, as large as you need.

The video scopes aren’t just available in the Color page. They’re also available in the Media and 
Deliver pages for whenever you need to evaluate the video signal more objectively, such as when 
you’re setting up to capture from tape or scan from film, or when you’re setting up for output.

To open video scopes from the Media, Color, or Deliver pages, do one of the following:

	— Choose Workspace > Video Scopes > On/Off (Command-Shift-W) to open video scopes into a 
floating window.

	— Choose Workspace > Dual Screen > On to open video scopes as part of a dual screen layout.

Video Scope Measurement Using Scales
Because you’re evaluating the internal state of the image data, by default the numeric scales of the 
WFM and Parade scopes always reflect 10-bit full range data from 0–1023, regardless of the Video/
Data Level setting you’ve selected in the Master Settings panel of the Project Settings. This gives you 
a window into how the image is being processed by DaVinci Resolve prior to being output via your 
computer’s video I/O interface.

If you’re working on an HDR (High Dynamic Range) grade, you can choose HDR (ST.2084/HLG) from 
the Video Scopes option menu (this feature is only available in Studio version). This replaces the 
10-bit scale of the Waveform, Parade, and Histogram video scopes with a scale based on nit values 
(or cd/m2) instead. 
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(Left) The Parade scope 
showing the data range scale, 
(Right) The Parade scope 
showing the HDR “nit” scale

Changing Waveform Scales
A Waveform Scale Style submenu in the Video Scopes option menu (the three dots menu) lets you 
choose how you want the numeric scale at the left of Waveform and Parade scopes to be represented. 
There are options for 10-bit display (the default), 12-bit display, Percentage (0 to 100), millivolt (mV), and 
HDR (ST.2084/HLG). Aside from the added flexibility this gives you, this also means that it’s no longer 
necessary to go to the Preferences to change the scope to have an HDR scale shown in nits (cd/m2).

Waveform scale options

IMPORTANT:  If you are working in a non-DaVinci Resolve Color managed workflow and 
activate the HDR (ST.2084/HLG) scopes, the waveform will always reflect HDR levels, even if 
you’ve manually selected the output color space as Rec.709, and thus not be 100% accurate.

Changing Vectorscope Scales
A Vectorscope Scale Style submenu in the Video Scopes option menu (the three dots menu) 
lets you choose how you want the hue reference indicators to be displayed.
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Vectorscope scale options

There are four available graticule options:

	— Off: Disables all graticule overlays in the Vectorscope, giving you a clean view of the Vectorscope 
graph against black.

	— Standard: The default layout. Cross hairs indicate the center of the scope, while boxes indicate 
the center target of each primary and secondary hue (red, magenta, blue, cyan, green, yellow). 
An outer circle provides a general frame of reference for the angle that any part of the graph 
might fall along.

	— Simplified: Shows a crosshairs to indicate the center of the scope and smaller crosshairs 
to indicate each primary and secondary hue. Useful when you want references without 
extra complications.

	— Hue Vectors: A graticule designed to provide a more useful colorist reference for creative 
decisions and image comparison. This isn’t simply decorative. Graticule lines stretch along the 
reference angle of each primary and secondary hue from the hue targets to the center, providing 
a more immediately useful frame of reference when comparing different vector scope graphs 
to one another. These reference lines fade out within the region of average saturation in most 
images, so they don’t get in the way of discerning faint details. The center crosshairs are aligned 
with the red‑cyan and yellow-blue axes, indicating the naturalistic warm to cool axis that lies 
between them. Tic marks indicate both the 75% and 100% levels of image saturation for each hue.

You also have the option of choosing whether or not the primary and secondary hue targets are 
shown for 75% image saturation, 100% image saturation, or both, and whether or not you want to 
show the text labels for each hue.

Displaying Scopes With Data or Video Levels
For projects being worked on at video levels, a setting in the video scope option menu’s Waveform 
Scale Style submenu lets you toggle between displaying video scopes scaled to either Data Levels 
(the default) or Video Levels (by turning on Video Level Scopes). This only affects how your scopes are 
displayed; it has no effect on monitored or rendered output.
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The Waveform scope shown at default Data Levels,

The same waveform shown with Video Level Scopes turned on

Video Scope Performance and Detail
All video scopes were updated for DaVinci Resolve 16 to show more detail with faster performance 
than in previous versions. While they’re GPU-accelerated, the video scopes require a certain amount 
of video processing power to operate. Depending on which combination of video scopes and scope 
options you have selected, you may notice your real time processing capabilities ever so slightly 
affected. Closing the video scopes frees up all processing for color correction and effects. On 
high‑powered workstations, you probably won’t notice a difference, but on less powerful computers, 
closing the scopes might make a small difference.

Two global settings in the video scope option menu affect the performance and detail of all video 
scopes equally. 

	— On slower workstations, a quality submenu lets you choose High, Medium, or Low quality 
scope drawing, to trade off legibility for performance. High quality shows you the most 
information about the video signal, while an Auto option makes a selection based on your 
workstation’s capabilities.

The Quality setting in the video scope option menu
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	— All video scopes have a Low Pass Filter setting in the video scope option menu that filters out a 
signal’s noise to make the scope graphs clearer to read. While this can act as an “x-ray” to better 
see detail in the scope graph interiors, it can make the highlight and shadow excursions on the 
graph seem a bit shy of where they actually are, so it’s recommended to enable the “Extents” 
option of whichever scope you’re using to get an unambiguous look at the maximum excursions in 
your scopes. Extents draws an outline highlighting all graph excursions to show you the true level 
of all overshoots and undershoots in the video signal, even when the Low Pass Filter is on.

The Waveform scope with Low Pass Filter turned off

The Waveform scope with Low Pass Filter turned on

Display Qualifier Focus in Video Scope Graphs
The Display Qualifier Focus setting in the video scope option menu helps you identify which features 
in the video image correspond to which parts of the video scopes. With Display Qualifier Focus turned 
on, choosing the Qualifier mode of the Viewer and moving the eyedropper around the image draws 
circles around the sampled pixels as they appear in the currently visible video scope graph. If multiple 
video scopes are visible, each scope will have an indication of the location of the sampled pixels that’s 
specific to each scope.
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Hovering the eyedropper over a feature in the Viewer 	� The regional analysis of those pixels 
shown in the overlaid red, blue, and green 
waveforms of the Waveform scope.

Explanation of Each Video Scope
There are five available video scopes, each of which shows a different analysis of the video signal 
you’re adjusting.

Waveform Monitor
Overlays waveform analyses of the Y (luma/luminance), CBCR (the color difference channels of Y’CBCR), 
or RGB (red, green, and blue) channels over one another so that you can see how they align. 

The Waveform scope showing Y’ (luma) only, 
with colorization and extents enabled

The Y option presents a true Luma scope that can have Colorize enabled to show false color, which lets 
you see which colors in the Viewer image are where in the video scope graph. 

For the RGB scopes, the relative heights of the red, green, and blue graphs indicate is identical to the 
description seen for the Parade scope below, and with color enabled the red, green, and blue graphs 
are tinted with the color they represent. This makes it easy to see where all three graphs align, by 
looking for where parts of the waveform monitor appear in white, which is the result of the red, green, 
and blue graphs lining up and adding their color together.
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Parade
The Parade scope shows separate waveforms side by side that analyze the strength of individual video 
signal components. The Parade scope can be set to analyze RGB, YRGB, and Y’CBCR. 

By showing a comparison of the intensity of the luma, red, green, and blue channels, the Parade 
scope makes it possible to detect and compare imbalances by comparing the relative heights of the 
RGB graphs in the highlights (the top of the R, G, and B graphs), shadows (the bottom of the R, G, and 
B graphs), and midtones (the middle of the R, G, and B graphs) for the purposes of identifying color 
casts and performing scene-by-scene correction. 

When the YRGB channels are taken altogether, the bottom of all graphs indicates the black point of 
the image, while the tops of all graphs indicate the white point. It then follows that the difference 
between the height of the bottom and top of all graphs indicates the overall contrast ratio of the 
image you’re evaluating. Tall parade graphs indicate a wide contrast ratio, while short parade graphs 
indicate a narrow contrast ratio.

The Parade scope showing YRGB waveforms, 
with colorization and extents enabled

Vectorscope
Measures the overall range of hue and saturation within an image. Measurements are relative to 
a centered graticule that you can enable that’s overlaid on the scope, which provides a frame of 
reference via crosshairs. DaVinci Resolve has a traditional vectorscope, the graph of which emulates 
a trace-drawn graph, with 75 percent color bar targets indicating the angle of each of the primary 
and secondary colors around the edge of the graph, and an optional skin tone reference graticule 
(otherwise known as the In-phase reference). 

The Vectorscope can have Colorize enabled to show false color which lets you see which colors in the 
Viewer image are where in the video scope graph.

More saturated colors in the frame stretch those parts of the graph farther toward the edge, while less 
saturated colors remain closer to the center of the vectorscope, which represents 0 saturation. By judging 
how many parts of the vectorscope graph stick out at different angles, you can see how many hues 
there are in the image, with the specific angle of each part of the graph showing you which hues they 
are. Furthermore, by judging how well centered the middle of the vectorscope graph is relative to the 
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crosshairs, you can get an idea of whether there’s a color imbalance in the image. If the vectorscope graph 
is off-centered, the direction in which it leans lets you know that there’s a color cast (tint) in the image.

The Vectorscope shown in 2x mode, with combined 
highlights, mid-tones, and shadows extents

Histogram (RGB/YRGB parade histogram)
Displays a statistical analysis of how many pixels of each color channel lie at each percentage of 
tonality, plotted along a digital scale from 0 percent (black) to 100 percent (white). Comparing the left, 
middle, and right parts of the Y, R, G, and B graphs (Y is optional) lets you evaluate the color balance in 
the shadows, midtones, and highlights of the image. 

The Histogram scope set to YRGB

Taken altogether, the left of all graphs indicates the black point of the image, while the right of all 
graphs indicate the white point. It then follows that the difference between the width of the left and 
right of all graphs indicates the overall contrast ratio of the image you’re evaluating. Wide histogram 
graphs indicate a wide contrast ratio, while narrow histogram graphs indicate a narrow contrast ratio.
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CIE Chromaticity Scope
DaVinci Resolve contains CIE 1931 xy and CIE 1976 uv scopes, which let you see the current image 
analysis as a graph superimposed against a triangle that represents the tristimulus values of the color 
gamut you’re working within, along with an indication of the current white point. A label shows the 
currently selected gamut, with the specific coordinates of these Red, Green, and Blue values as well 
as the White point, while the overall “horseshoe” shape represents the entire range of visible light, all 
plotted against an xy graph. 

The white point ordinarily appears atop a curve along the center of the shape. This curve indicates 
the black body locus, along which the various color temperatures of an image’s white point correlate, 
from orange-ish warm to blue-ish cool. This black body locus corresponds to the color temperatures 
obtained by progressively heating carbon to different temperatures.

You also have the option of showing a second gamut triangle, in cases where you want to compare 
the current analysis to two different gamuts. This can be useful when you need to create deliverables 
in multiple gamuts, and you want to see which parts of the video signal are safe in all gamuts and 
which parts are exceeding the smaller of the two. When you do this, both gamuts are labeled, and the 
coordinates of the Red, Green, and Blue values of both gamuts are listed to the side.

The CIE 1931 xy scope showing both P3 and Rec. 709 gamuts

In a way, the Chromaticity scope is a 3D scope, but it’s drawn as if you’re looking down at the top 
of a 3D shape that plots every color value in an image in X, Y, Z space, but you can only perceive 
the 2D outline around the widest parts of this shape drawn on an X, Y plot. The graph does 
indeed represent every single value found within a 3D plot of the image data, but the triangle only 
indicates the widest “slice” of the current gamut and of this 3D shape within the mid-tones. 

What this means is that while the Chromaticity scope’s graph gives you a rough idea of whether 
or not the current image is within gamut relative to your delivery spec, it’s not exact and it’s not 
foolproof, as part of the image data could fall within this wide triangle and yet overshoot the 
required gamut elsewhere in the highlights at the top or the shadows near the bottom of the 3D 
shape you’re looking down on. On the other hand, if any part of the graph does extend past the 
boundaries of the gamut triangle, then that definitely indicates a gamut violation. 

You can add an additional gamut triangle in the scope settings in order to compare the color 
space you’re working in to another color space, for reference.
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Most people who’ve had any exposure to color grading concepts are familiar with the traditional 
CIE 1931 horseshoe graph, which plots the portion of the spectrum visible to the human eye 
according to studies done in the late 1920s (subsequent studies have confirmed this analysis). The 
optional CIE 1976 uv graph is based on an updated color space (CIELUV) that was an attempt by 
the International Commission on Illumination (CIE) to create a more perceptually uniform graph 
of color. Whereas the CIE 1931 analysis visually exaggerates certain parts of a color graph, the CIE 
1976 graph draws all parts of a color graph more or less proportionally to one another. Overall, 
neither analysis is more “correct” than the other, it’s simply a matter of what you prefer to look at.

The CIE 1976 scope showing both P3 and Rec. 709 gamuts

Panning and Zooming 
the Video Scopes
If you want to examine any part of a video scope’s graph in more detail, you can do the following:

	— To zoom into a graph: Hold the Option key down, and roll the scroll control.

	— To pan around a graph: Click and drag with the middle pointer button.

Customizing the Video Scopes
Once you’ve opened the video scopes, there are a variety of ways you can customize how the scopes 
look, and expose additional onscreen graticule information to help you measure what you need.

Methods of customizing the Scopes window:

	— To change the size of the Scopes window: Drag the lower right-hand corner to resize the 
Scopes window to the desired size.
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	— To change how many scopes are displayed at once: Click one of the buttons in the upper right-
hand corner of the Scopes window to set 1, 2, 4, or 9 up arrangements of the video scopes. You 
can also choose how many scopes are simultaneously displayed by choosing Workspace > Video 
Scopes > 1-Up, 2-Up, or 4-Up.

	— To change which scopes appear in which pane: Click the Name drop-down at the upper left 
corner of each scope’s pane, and choose a different scope. If you like, you can instantiate more 
than one of each kind of video scope in multi-scope layouts, for instances where you want to view 
variations on a particular type of scope with different settings. For example, you might want to 
expose three Vectorscopes, setting each to a different tonal range so you can simultaneously view 
Vectorscope analyses of Low (shadows), Mid (midtones), and High (highlights).

Different layout options in the Scope window

Once open, you can resize the Scopes window to make it as large or small as you require, positioning 
on a second display if you want to make it even larger. 

To customize each video scope’s display options:

1	 Click the Option button to the right of the Scope drop-down menu to expose the current scope’s 
Custom Controls window.

Clicking to open the current 
scope’s custom controls

2	 Adjust any of the available controls to customize the look of that particular scope.

3	 Click anywhere outside of the Custom Controls window to make it disappear.

Parade Scope Display Options
The Parade scope has the following options:

	— RGB, YRGB, and YCbCr modes, allowing you to evaluate more channels than before.

	— A colorize checkbox lets you view graphs in monochrome or false-color (indicating red, 
green, and blue).

	— An Extents checkbox draws an outline highlighting all graph excursions, to unambiguously show 
you all overshoots and undershoots in each waveform.

	— The Parade slider makes that scope’s graph brighter or dimmer. Brighter graphs make it easier to 
see fine detail, but harder to see which parts of the graph are stronger and weaker.
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	— The Graticule slider makes that scope’s scale brighter or dimmer, making it more or less visible 
(or distracting) relative to the graph.

	— The Show Reference Levels checkbox lets you turn on adjustable Low and High 
reference level markers by setting the low and high sliders to something other than their 
defaults. This is especially useful for HDR grading where you’re working within a specific peak 
luminance threshold.

Options in the Parade scope Options in the Waveform scope

Waveform Scope Display Options
The Waveform scope has the following options:

	— Y (luma) and CbCr (chrominance) modes to show you the true luma or chroma signals in isolation, 
and RGB to show you only an RGB analysis.

	— In RGB mode, R, G, and B buttons that can be individually toggled on and off to see any 
combination of graphs.

	— A colorize checkbox lets you view overlaid graphs in monochrome or false-color (indicating red, 
green, and blue). If you’re only enabling the Y or C scopes, the different areas of these graphs are 
drawn with color taken from the image being analyzed, which makes it easier to see which part of 
the scope graph corresponds to which part of the image.

	— An Extents checkbox draws an outline highlighting all graph excursions, to unambiguously show 
you all overshoots and undershoots in each waveform.

	— The Waveform slider makes that scope’s graph brighter or dimmer. Brighter graphs make it easier 
to see fine detail, but harder to see which parts of the graph are stronger and weaker.

	— The Graticule slider makes that scope’s scale brighter or dimmer, making it more or less visible (or 
distracting) relative to the graph.

	— The Show Reference Levels checkbox lets you turn on adjustable Low and High reference 
level markers by setting the low and high sliders to something other than their defaults. 
This is especially useful for HDR grading where you’re working within a specific peak 
luminance threshold.
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Vectorscope Display Options
The Vectorscope has the following options:

	— Choose ALL to view the entire tonal range of the image as a Vectorscope graph analysis, or to 
selectively view just the shadows (Low), mid-tones (Mid), or highlights (High) of the image as a 
vectorscope graph analysis.

	— A Colorize checkbox draws the different areas of these graphs with color taken from the image 
being analyzed, which makes it easier to see which part of the scope graph corresponds to which 
part of the image. With colorize turned off, graphs only appear white.

	— An Extents checkbox draws an outline highlighting all graph excursions to unambiguously show 
you all overshoots and undershoots.

	— A Combine checkbox lets you see simultaneous overlapping extents for the highlights, mid-tones, 
and shadows overlaid on one another.

	— The Vectorscope slider makes that scope’s graph brighter or dimmer. Brighter graphs make it 
easier to see fine detail, but harder to see which parts of the graph are stronger and weaker.

	— The Graticule slider makes that scope’s scale brighter or dimmer, making it more or less visible (or 
distracting) relative to the graph.

	— Low Range and High Range sliders let you manually define the boundaries separating shadows 
from mid-tones and highlights. Low Range defaults to 0.30, and High Range defaults to 0.70.

	— Show 2X Zoom zooms the vectorscope graph by 200%, making it easier to see fine detail and use 
the vectorscope with charts.

	— Show Skin Tone Indicator checkbox shows a line at the traditional Inphase angle that is useful as a 
general guidepost for average skin tone hue.

	— Show Graticule checkbox lets you show or hide the circular degrees indicator surrounding the 
outer edge and the cross hairs that indicate the center of the vectorscope.

Options in the Vectorscope Options in the Histogram scope Options in the Chromaticity scope
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Histogram Display Options
The Histogram has the following options:

	— You can view either RGB or YRGB histograms.

	— Gain slider scales that scope’s graph taller or shorter. Taller graphs expand to show greater detail 
in the histogram’s peaks, shorter graphs reduce the apparent detail.

	— Graticule slider makes that scope’s scale brighter or dimmer, making it more or less visible 
(or distracting) relative to the graph.

	— The Show Reference Levels checkbox lets you enable adjustable Low and High reference level 
markers by setting the Low and High sliders to something other than their defaults. These 
reference markers are especially useful for HDR grading where you’re working within a specific 
peak luminance threshold.

CIE Chromaticity Display Options
The CIE Chromaticity scope has the following options: 

	— You can view a chromaticity analysis in either a CIE 1931 xy graph, or a CIE 1976 uv graph.

	— CIE Chromaticity slider makes that scope’s graph brighter or dimmer. Brighter graphs make it 
easier to see fine detail, but harder to see which parts of the graph are stronger and weaker.

	— Graticule slider makes that scope’s scale brighter or dimmer, making it more or less visible (or 
distracting) relative to the graph.

	— Additional Gamut drop-down menu lets you expose a second gamut triangle, for instances where 
you want to compare how an image fits into two different gamut ranges.

	— Show 2X Zoom zooms the CIE graph and graticule by 200%, making it easier to see fine detail and 
use the vectorscope with the charts.

	— Show Graticule checkbox lets you show or hide the circular degrees indicator surrounding the 
outer edge and the cross hairs that indicate the center of the vectorscope.
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Chapter 126

Color Page Timeline 
and Lightbox
The Timeline in the Color page, consisting of the Thumbnail 
Timeline and the Mini‑Timeline, is primarily used for navigating 
the current arrangement of clips, and for keeping track of clip 
properties such as whether they’re graded and ungraded, whether 
they use tracking, which version they’re using, and so on. 

It can also be used for quickly copying grades from one clip to another, for creating groups, and for 
comparing clips in the Viewer.

The Lightbox is the twin sibling of the Thumbnail Timeline, and provides an image‑based method of 
comparing clips, managing grades, and performing a wide variety of organizational tasks.

This chapter covers the use of the Timeline and Lightbox.
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Navigating Using the 
Color Page Timeline
The Color page Timeline consists of two parts that work together, the Thumbnail Timeline and the 
Mini Timeline. These work together to let you examine and navigate the Timeline of your program in 
different ways.

The Color page Timeline

The scroll bar for the Mini-Timeline is independent of the scroll bar for the Thumbnail Timeline, and 
both can be set to show different ranges of clips. Using the scroll control of your pointing device lets 
you zoom into or out of the Mini-Timeline. When zoomed all the way out, the Mini-Timeline displays the 
entire timeline within the available width of the screen, making it a fast way of navigating the entire 
program from the beginning to the end. However, you can zoom into a particular section when you 
need more information about how an intricate arrangement of superimposed clips are organized 
while you’re grading.

Thumbnail Timeline
Provides a concise visual representation of your project where each clip is a single numbered 
thumbnail, regardless of its duration. Clicking a thumbnail moves the playhead to the first frame 
of that clip, while using the Up/Down Arrow keys moves the selection to the previous or next clip. 
Whichever clip is at the current position of the playhead appears with its thumbnail outlined in orange. 
Middle-clicking and dragging as well as using the scroll wheel of your pointing device lets you scroll 
backward and forward through the Thumbnail timeline.

The Color page Thumbnail Timeline

Each thumbnail displays a variety of information above and below it, including a rainbow outline 
around the number of graded clips, the clip format, file name, or grading version text below each 
thumbnail, tracking or stabilization badges, flag badges, and link badges to indicate clip groups or 
automatic remote grade linking, where existent.

Mini-Timeline
Shows a miniature representation of the Timeline in the Edit page, where each clip’s width 
is proportional to its duration, and superimposed clips are shown on top of one another. 
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The Mini‑Timeline can show a maximum of six video tracks; if your edit uses more, a scroll bar lets you 
change which tracks are displayed. Clicking a clip in the Mini-Timeline selects that clip and moves the 
playhead to its first frame. 

The Color page Mini-Timeline

Scrolling, Zooming, and Navigation
A Timeline Ruler contains the top handle of the playhead, displays the record timecode of the current 
edit, and acts as a scrubber bar that typically spans a longer section of the Timeline. The scroll wheel 
of your mouse lets you zoom in and out of your edit, and if you zoom all the way out you can fit every 
clip in the Mini-Timeline into the available width of the ruler, letting you scrub through every clip in the 
Timeline quickly. Clicking anywhere within the ruler instantly jumps the playhead to that frame.

Enabling/Disabling Tracks
The far left of the Mini-Timeline shows numbers for each track, and hovering the pointer over the 
track number of any track in the Mini-Timeline of the Color page reveals a tooltip showing the name 
of that track. Clicking a track number enables/disables that track along with all clips on that track, 
similarly to using the Timeline > Enable/Disable Video Tracks submenu commands (Shift-Command-1 
through 9). Clips on disabled tracks are not rendered in the Viewer or video output, and are hidden 
from the Thumbnail Timeline. If a track has been disabled in the Edit page, it will appear dimmed in the 
Mini-Timeline.

Option-clicking a track number in the Mini-Timeline turns that track number red, letting you hide 
clips from the Thumbnail Timeline without actually disabling the video in your program. This is useful 
in situations where you want to prevent clips in a particular track (such as motion graphics or titles 
rendered from another application) from intercepting the playhead when using the next/previous 
clip commands.

Setting In/Out Points for Looping
You can use the I and O keyboard shortcuts to set custom In and Out points in the Timeline. Once set, 
turning on Loop in the Viewer transport controls enables this range to be looped, whether it’s a partial 
range of one clip, or a range spanning multiple clips together.

Using Multiple Timeline Playheads
DaVinci Resolve supports creating up to four separate playheads in the Mini-Timeline, that you can 
use to jump back and forth among different parts of your timeline. Only one playhead can be selected 
at any given time, and the currently selected playhead corresponds to the current clip, highlighted in 
orange. Each playhead in the Mini-Timeline is labeled with a letter, A through D.

Multiple playheads in the Mini-Timeline for multi-region navigation

2843Color  |  Chapter 126  Color Page Timeline and Lightbox



To add a new playhead to the Mini-Timeline:

	— Choose a playhead from the Color > Active Playheads submenu. That playhead will be placed at 
the same position as the original playhead, but it is now the one that is selected, so dragging 
the new playhead to a new position of the Mini-Timeline will reveal the original playhead you 
were using.

To select another playhead to view:

	— Click on the top handle of any playhead to select it, making that the currently active playhead 
controlled by the transport controls. By default, no keyboard shortcuts are mapped to the four 
playheads that are available, but you can create a custom keyboard mapping that you can use to 
quickly switch among them.

	— Using the DaVinci Advanced control panel, you can use the A, B, C, and D buttons on the jog/
shuttle panel to switch to the playhead you want to control.

To eliminate all additional playheads from the Mini-Timeline:

	— Choose Color > Active Playheads > Reset Playheads.

Show Current Clip With Handles
If you’re working on a project that’s part of a round-trip workflow, and you know you’ll be rendering 
handles for each clip, it can be useful to temporarily expose these handles for the current clip that 
you’re grading, so you can easily apply tracking or keyframing effects to the full frame range of 
each clip.

To show or hide clip handles in the Mini-Timeline of the Color page:

	— Choose View > Show Current Clip With Handles.

(Left) The current clip in the Mini-Timeline, (Right) The same clip 
shown with Show Current Clip With Handles enabled

While this mode is enabled, Unmix is turned on and cannot be disabled, in order to let you view 
the overlapping handles of each clip clearly. The duration of handles that are exposed is defined 
by the Default Handles Length parameter of the Editing panel in the User Preferences. Clip 
Handles can be shown or hidden at any time.

Thumbnail Info
The thumbnails make it easy to find the clips you’re looking for visually, and they always show the 
media as it’s currently graded. The most obvious piece of information is the frame that’s used for each 
clip’s thumbnail. If you feel that a particular clip’s thumbnail isn’t representative of its content, you can 
change it.
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To change the current thumbnail:

	— Move the pointer over a thumbnail, drag to the left or right to scrub through the clip, and stop 
when you find a frame you want to use as the new thumbnail.

Dragging a thumbnail to change 
the representative image

If media is replaced in the middle of a color correction timeline, or if you copy or ripple a grade to a 
range of clips, the thumbnails may not immediately update to accurately represent the current state of 
each clip. In this case, you can manually refresh the thumbnails.

To refresh all thumbnails in the Timeline:

	— Right-click anywhere in the Thumbnail timeline and choose Update All Thumbnails.

You can also choose to display the codec, clip names, and version used by each clip in the Timeline.

To switch the Thumbnail timeline between showing clip names, codecs, and versions:

	— Double-click the thumbnail clip name of any clip to cycle through each clip’s codec, 
clip name, and version.

Additional information appears above and below each thumbnail, providing a way of keeping track 
of which clips have been graded, which clips are using different versions, which clips have been 
cached, and so on.

Each clip thumbnail has a number 
of valuable indications permitting 
quick comparison to other shots. 

The following list explains each piece of information that can appear above, within, or below the 
thumbnails in the Timeline.

	— Clip number: (top left) Each clip’s number appears above its thumbnail. Clips are numbered in 
ascending order according to the position of their first frame, from left to right, regardless of the 
video track in which they appear. 

	— Grade indicator: (top left) If a clip has been graded, a thin rainbow indicator surrounds the 
clip number.
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	— Source Timecode: (top center) The source timecode from the first frame of each clip appears 
above each thumbnail.

	— Cache indication: (red timecode) Any clip that’s marked for caching, whether automatically via 
the Smart cache, or manually, has its timecode turn red to indicate that it will be cached. After it’s 
been cached, the timecode turns blue. 

	— Track number: (top right) The video track in which a clip is edited appears above the thumbnail. 

	— Clip Color dot: (upper right) If a clip has a clip color assigned to it, a colored dot appears 
on top of its thumbnail.

	— Flag icon: (upper left) If a clip has been flagged, a flag icon of the appropriate color appears on 
top of its thumbnail. If a clip has multiple flags, as many as can be drawn appear along the top.

	— Linked media or group icon: (bottom right) If clips are set to use remote versions, and if multiple 
clips share the same source media file, then by default their remote version 1 grade will be 
automatically linked. If the current clip is linked, a small link icon appears below the thumbnail 
of every clip in the Timeline that’s also linked to that clip. When you select another clip that’s not 
linked, the linked clip icons disappear.

	— Tracker icon: (bottom right) If any node within a particular clip’s grade has been tracked, a small 
crosshairs tracker icon appears below the thumbnail.

	— 3D indicator: (bottom right) All stereo 3D clips in the Timeline appear with this icon 
below the thumbnail. The color indicates which eye you’re monitoring; red for the left eye, 
blue for the right eye.

	— Version name/Source format: (bottom left) What text is displayed below each thumbnail can 
be changed by double-clicking the space underneath each thumbnail. There are several options; 
keep double-clicking to cycle among them:

	— Clip format or codec: This is what’s displayed by default.

	— Clip Name: Depending on what View > Show File Names is set to, the clip name or file name is 
displayed. If you’re working with multicam clips, the multicam angle or name is displayed.

	— Version name or number: Provides information about whether a clip is using a remote 
version, or a local version, indicated by an (L). If you’ve given the current version a name, it 
appears; otherwise the version will be labeled “Version” with its number.

Thumbnail Contextual 
Menu Commands
Right-clicking a clip’s thumbnail in the Thumbnail Timeline reveals a contextual menu with many media 
and grade management commands that are available in the Color page. The available options are 
divided into the following rough categories:

	— Commands for managing grade versions

	— Commands for managing groups

	— Commands for editing flags, markers, and clip colors

	— A command for displaying the Node Graph of a clip’s grade

	— Options for controlling the render cache

	— Resolve Color Management clip assignments
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	— LUT Management commands

	— Commands for viewing clip details, editing Clip Attributes, and finding clips in the Media Pool

	— A command for updating clip thumbnails that are slow to update on their own

These capabilities are described in more detail in the other chapters of this manual, but it’s important 
to know that artists working on the Color page have many clip management options available to them, 
without needing to go to other pages.

Sorting and Filtering Clips 
in the Thumbnail Timeline
By default, the Thumbnail Timeline displays every clip of the currently selected edit in the Edit page, 
sorted in A mode (the record order of your edit). However, the sort order and contents of the Timeline 
can be changed and filtered to make it easier for you to find specific groups of clips for grading.

Changing Timelines
If you’re working on a project that has more than one timeline, you can switch timelines right from 
within the Color page.

To switch timelines in the Color page:

	— Choose another timeline from the Timelines drop-down menu at the top of the Viewer.

Timeline selection at the top center of the Viewer

To switch among timelines using the DaVinci control panel:

	— Press the MODES button above the fourth trackball on the Center panel, then press the SWITCH 
TIMELINE soft key. Press MODES to return to the main page of controls when you’re done.

A and C Mode Sorting
By default, the Timeline is set to Record mode sorting, otherwise known as A mode sorting. In this 
mode, clips appear in the Timeline according to the order in which they were edited. This lets you see 
the order of clips as they’ll appear in the final program.

A Mode sorting, i.e., record order
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However, you can change the sort order of the clips in the Timeline to Source mode, or C mode 
sorting. In C mode sorting, all clips are rearranged in ascending order from left to right according to 
their source timecode, and their record timecode is temporarily ignored.

C Mode sorting, i.e., source clip order

Sorting by C mode makes it easy to identify a range of similar clips. For example, if you’re working on 
a narrative project, clips from each angle of coverage in the scene will naturally cluster together. In 
another example, sorting by C mode in a documentary will arrange all of a particular subject’s head 
shots from a specific interview contiguously, one after another, since they all come from the same range 
of timecode on the same source tape. In both examples, the close proximity of similar clips to one 
another that C mode creates makes it easy to copy grades among them, ripple changes, or group them.

When you’re finished, you can switch the Timeline back to A sort mode, and all of the clips will go back 
to being arranged in the order in which they were edited.

To toggle between A and C mode sorting, do one of the following:

	— Choose an option from the View > Timeline Thumbnail Mode submenu.

	— Press Command-Page Down to toggle to C mode sorting.

	— Press A/C MODE on the T-bar panel of the DaVinci control panel.

	— While in C mode, the word “SOURCE” appears at the right in the Timeline Ruler of the Mini-Timeline.

Source mode indicated at the 
right of the Timeline ruler

A checkbox in the Conform Options group in the General Options panel of the Project Settings 
lets you change the behavior of C mode sorting. Opening the Settings window and clicking the 
General Options panel of the Project Settings reveals the Sort Timeline Using Reel Name and 
Timecode checkbox.

General Options panel of the Project Settings
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With this checkbox turned on (the default), all clips in the Timeline are sorted by reel name first, and 
then by source timecode. This way, clips with similar timecode from the same reel will appear next to 
one another in C mode.

If you turn this checkbox off, reel name is ignored, and all clips in the Timeline are sorted only by 
source timecode. This may result in clips from multiple sources being mixed together, but it is useful in 
specific situations. 

For example, when grading dailies from a three camera shoot, you may want to see consecutive clips 
from all three cameras lined up one after the other on the Timeline, so that Cam1_Shot1, Cam2_Shot1, 
and Cam3_Shot1 appear first, followed by Cam1_Shot2, Cam2_Shot2, and Cam3_Shot2, and so on. In 
this situation, you don’t want clips from cameras 2 and 3 to be placed at the end of the Timeline simply 
because of their reel name.

Flags, Clip Colors, and Markers
You have the option of flagging or marking clips in the Color page just like you can in the Edit page, 
in order to keep track of specific media or frames that you may need to do something to later. For 
example, you could flag every closeup of a particular actor with a blemish that you want to spend 
some time fixing with a green flag. 

Methods of flagging, changing colors, and marking clips in the Color page:

	— To add a flag to a clip: Move the playhead to a clip in the Mini-Timeline, and choose a color from 
the Mark > Add Flag submenu, or Right-click any clip’s thumbnail, and choose a flag color from 
the Flags submenu. Flags are not frame-specific, so flagging one clip will result in flags also being 
placed on all other clips that share the same source media in the Media Pool.

	— To remove all of a clip’s flags: Move the playhead to a clip in the Mini-Timeline, and choose 
Mark > Clear Flags, or right-click a clip’s thumbnail and choose Flags > Clear All.

	— To change the clip color: Move the playhead to a clip in the Mini-Timeline, and choose a color 
from the Mark > Set Clip Color submenu, or Right-click any clip’s thumbnail, and choose a color 
from the Clip Color submenu. Clip Colors are clip-specific.

	— To remove a clip’s color: Move the playhead to a clip in the Mini-Timeline, and choose Mark > 
Set Clip Color > Clear Color, or right-click a clip’s thumbnail and choose Clip Color > Clear Color.

	— To mark a frame of a clip: Right-click a clip’s thumbnail and choose a marker color 
from the Marker submenu.

	— To remove a single marker: Right-click a clip’s thumbnail and choose Delete Marker from the 
Marker’s submenu. Alternately, you can select the marker in the Mini-Timeline, and press the 
Delete key.

	— To remove all of a clip’s markers: Right-click that clip and choose Clear All from 
the Markers submenu.

Timeline Filtering
A drop-down button to the right of the Clips button at the top right of the Color page Interface 
Toolbar presents preset options for dynamically filtering which clips are shown in the Timeline. This 
allows you hide all the other clips in the Timeline except for the subset on which you want to focus. 
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Timeline filtering options

For example, once you’ve added flags or markers to clips, it’s easy to hide every other clip in 
the Timeline that doesn’t fit the criteria; for example, hiding clips that don’t have a green flag. 
This does nothing to alter the original edit, and you can return the Timeline to its original state 
at any time.

To filter the Timeline:

	— Click the Timeline Filtering drop-down button to the right of the Clips button at the top left of the 
DaVinci Resolve UI, and choose an available option. While the timeline is filtered, an orange line 
appears underneath the Clips button in the UI toolbar at the top of the page.

To return the Timeline to normal:

	— Click the Timeline Filtering drop-down button, and choose All Clips. 

You can use timeline filtering in conjunction with A or C mode sorting to arrange clips in whatever way 
is best for the task you’re trying to accomplish. Clip filtering can also be used in the Lightbox, and a 
currently selected clip filtering method will simultaneously isolate clips in the Timeline and Lightbox as 
you switch back and forth.

Preset Timeline Filters
DaVinci Resolve comes with several preset criteria by which you can filter the Timeline, which cover 
many common organizational workflows:

	— All Clips: No clips are filtered, and every clip in the current edit is shown.

	— Selected Clips: Filters all currently selected clips.

	— Graded Clips: Filters all clips that have been graded.
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	— Clips with Fusion Composition: Clips with Fusion page effects applied to them.

	— Ungraded clips: Filters all clips that have not yet been graded.

	— Modified clips: Submenu, filters all clips that have been modified within a specified time.

	— Unrendered clips: Filters all clips that have not yet been rendered.

	— Clip Color: Filters all clips that have any color, no color, or a particular color set in the Timeline; 
a submenu presents each color.

	— Flagged Clips: Filters all clips that have any flag, no flag, or a particular flag; a submenu 
presents each color.

	— Marked Clips: Filters all clips that have any marker, no markers, or a particular marker; a submenu 
presents each color.

	— Keywords: Filters all clips that have a specific keyword assigned. A submenu presents a list with 
each keyword that’s used in the Media Pool of the current project.

	— People: Filters all clips that have a specific person assigned from the People Management 
Window. A submenu automatically presents a list of each person that’s been identified.

	— Stereoscopic: Filters stereo 3D clips, a submenu presents options for filtering All Stereo Clips, 
or just Stereo clips that have been Autoaligned, those with Convergence adjustments, those 
with Floating Windows adjustments, or stereoscopic clips with swapped media for the left 
and right eyes.

	— Grouped: Filters all clips belonging to a particular group, a submenu shows all available groups.

	— Tracked: Filters all clips with motion tracking.

	— Noise Reduction: Filters all clips using noise reduction.

	— OpenFX: Filters all clips using OpenFX.

	— Different Frame Rate: Filters all clips with frame rates that don’t match that of the project.

	— Edit Sizing: Filters all clips that have had any Edit Sizing parameters adjusted.

	— Input Sizing: Filters all clips that have had any Input Sizing parameters adjusted.

	— Common Media Pool Source: Filters all clips sharing the same source in the Media Pool 
as the current clip.

	— Matte Nodes: Filters all clips with an exposed Matte node in the Node Editor.

	— Mattes Available: Filters all clips with a matte assigned to them, whether they’re used or not.

	— Collaborative Update Available: (Only available in Collaborative Mode) Filters all clips that have 
been flagged as having been updated during a collaborative workflow.

Creating and Using Smart Filters
If none of the preset filters does what you need, you can create your own custom Smart Filter in order 
to sift out clips based on any of the intrinsic or user-entered metadata that’s available in the Metadata 
Editor, Media Pool, and Color page timeline. Smart Filters work much the same way as Smart Bins, 
and they’re created and edited using the same procedures. For more information on Smart Bins, 
see Chapter 18, “Adding and Organizing Media with the Media Pool.” In fact, Smart Filters can be very 
sophisticated, allowing you to filter the contents of the Thumbnail timeline by multiple criteria, and 
using multiple groups of multiple criteria for situations where you need to find clips that match all of 
one set of criteria, but only one of a second set of criteria. In this way, you can create Smart Filters to 
solve a wide variety of workflow needs as you work in the Color page.

It’s important to point out, however, that as much intrinsic metadata is available to every clip in 
DaVinci Resolve (clip properties including frame rate, frame size, codec, file name, and so on), the more 
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time you take entering extra metadata in the Metadata Editor to prepare your project for work for 
editing and grading (for example, entering scene and take information, and keywords for things like 
character names, day and night, interior and exterior, framing, and so on), the more powerful Smart 
Filters can be in helping you to sift and sort through the contents of a program you’re grading.

Imagine being able to filter out all the closeups associated with a particular person in a program, or 
finding all the establishing shots corresponding to a particular location. If you or an assistant can take 
the time to enter metadata for the source material in a project that identifies these characteristics, 
you’ll be able to work even more quickly to match shots together and find the clips you need for any 
given situation.

To create a Smart Filter:

1	 Click the Timeline Filtering drop-down button to the right of the Clips button at the top right of the 
DaVinci Resolve UI, and choose Create Smart Filter.

2	 In the Create Smart Filter dialog, enter a name for the filter, and use the following controls to 
create one or more filter criteria (you can have as many filter criteria as you like):

The Create Smart Filter dialog

	— Show in all projects checkbox: Lets you create a persistent smart filter that appears in all 
projects in your project library. Smart filters created this way will be found in the User Smart filters 
section inside every project’s Clips button in the Color page. 

	— Match options: For multi-criteria filtering, choosing All ensures that every single criteria you 
specify is met for a clip to be filtered. Any means that if only one out of several criteria is met, that 
clip will be filtered.

	— Filter criteria enable checkbox: Lets you enable or disable any criteria without having 
to delete it.

	— Metadata category drop-down: Lets you choose which category of metadata you want to select 
a criteria from. Each category of metadata that’s available in the Metadata Editor is available from 
this drop-down menu. Additionally, Color Timeline Properties (containing many properties unique 
to the Color page timeline) and Media Pool Properties (containing every column in the Media Pool) 
provide access to additional metadata you can use for filtering.

	— Metadata type drop-down: For choosing which exact type of metadata to use, of the options 
available in the selected metadata category.

	— Metadata criteria drop-down: Lets you choose the criteria by which to filter, depending on 
the metadata you’ve selected. Options include “true/false,” integer ranges, date ranges, string 
searches, flag and marker colors, and so on.

2852Color  |  Chapter 126  Color Page Timeline and Lightbox



	— Add filter criteria button: Lets you add additional criteria to create multi-criteria filters. You 
could use multiple criteria to, for example, find all clips from Scene 2, that also contain the 
keyword “Diana,” that also have the keyword “CU” in order to find all the Scene 2 close-ups of 
Diana. Additionally, if you Option-click this button, you can add a nested match option in order to 
create even more sophisticated filters, where the filter must match all of one set of criteria, and 
any of another set of criteria.

A complicated Smart Filter with multiple criteria and a second match option setting

As you’re editing the filter criteria, the Thumbnail timeline automatically updates to show you how 
the Smart Filter you’re creating is working.

3	 When you’re done editing the filter criteria, click Create Smart Filter. The resulting Smart Filter 
appears at the bottom of the Filter drop-down menu, and is turned on by default.

Methods of modifying existing Smart Filters:

	— To rename a Smart Filter: Click the Timeline Filtering drop-down and choose the Smart Filter you 
want to rename from the Rename Smart Filter submenu, then change the name in the Smart Filter 
Name dialog, and click OK.

	— To edit a Smart Filter: Click the Timeline Filtering drop-down and choose the Smart Filter you 
want to edit from the Edit Smart Filter submenu, then edit the filter criteria, and click OK.

	— To delete a Smart Filter: Click the Timeline Filtering drop-down and choose the Smart Filter you 
want to delete from the Delete Smart Filter submenu. It’s immediately deleted.

Submenus available for modifying Smart Filters
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Using the Lightbox
The Lightbox shows you all clips in the Timeline as a grid of thumbnails, arranged in rows from left to 
right and top to bottom. This lets you quickly evaluate, compare, and search for clips you want to use 
when making selections, creating groups, flagging clips, or when scanning for a particular scene or 
looking for an individual clip.

The Color page Lightbox displays all the clips in the Timeline.

At the right of the Lightbox is a vertically oriented Timeline Ruler letting you know the timecode value 
at the beginning of each row of clips. At the top right is a Zoom slider that lets you change the size of 
the thumbnails.

Selecting a clip in the Lightbox is the same as selecting a clip in the Timeline, and right-clicking a clip 
in the Lightbox shows the same contextual menu items you’d see if you right-clicked a clip in the 
Timeline. Furthermore, you can also grade the current clip in the Lightbox using a control panel, or by 
exposing the color controls to grade the current clip using a mouse or other input device.

Methods of using the Lightbox:

	— To show or hide the Lightbox: Click the Lightbox button in the toolbar.

	— To show color controls in the Lightbox: Click the Show Color Controls button in the UI control 
bar above the Lightbox.

The Color Controls button, with 
the sidebar and Thumbnail 
Info buttons below
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	— To show thumbnail info in the Lightbox: Click the Clip Info button, which is the second control 
at the upper left-hand corner of the Lightbox, to turn each clip’s thumbnail Info off and on.

	— To resize clips in the Lightbox: Drag the Zoom slider to the right to increase thumbnail size, or to 
the left to decrease thumbnail size.

The Lightbox button, Zoom slider, 
and Monitor Output buttons

The contents of the Lightbox can be filtered using the same options that are available for filtering the 
Thumbnail timeline.

To filter the Lightbox:

1	 Click the Show sidebar button at the upper left-hand corner of the Lightbox. This reveals all of the 
filtering options that are available in the Lightbox, including custom Smart Filters you’ve created.

2	 Click one of the options appearing in the sidebar. The Lightbox should immediately update to 
show just those clips that match the selected criteria.

3	 To go back to seeing every clip in the Timeline, click All Clips. The Lightbox can also be output to 
video, in order to see its contents on a broadcast display or projector.

The Lightbox sidebar, with controls 
for filtering the Lightbox
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To output the contents of the Lightbox to video: 

	— Click the Output Lightbox to Video button at the upper right-hand corner of the Lightbox.

The button for outputting 
the Lightbox to video

For more information about clip selections, groups, and grade management, see Chapter 139, “Grade 
Management.”
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Chapter 127

Automated Grading 
Commands and 
Imported Grades
While DaVinci Resolve has a wide variety of manual grading controls 
that afford you control over just about every component of digital 
imagery, DaVinci has spent a lot of time investigating ways of 
increasing colorist efficiency by creating automated grading tools. 

Furthermore, with integrated editing bringing professional editors into the world of editing, grading, 
and finishing in DaVinci Resolve, the same automated tools being developed to help colorists go home 
earlier can also be used to give non‑colorists a hand in taking care of simple grading tasks.
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Color Match Palette
If the camera and lighting departments had the foresight to shoot a color test chart for each of the 
major lighting setups in the project you’re grading, DaVinci Resolve lets you superimpose a sampling 
grid over a chart in a clip and mathematically analyze the sampled colors to generate an automatic 
correction. Using controls in the Color Match palette, you can specify the Source Gamma, Target 
Gamma, and Target Color Space to make sure that the resulting correction is correct for the camera 
you used, and the project you’ve set up.

The Color Match palette works with several standardized color charts:

	— Datacolor SpyderCheckr 24

	— DSC Labs ChromaDumonde 24+4

	— DSC Labs SMPTE OneShot

	— X-Rite ColorChecker Classic

	— X-Rite ColorChecker Classic - Legacy

	— X-Rite ColorChecker Video

	— X-Rite ColorChecker Passport Video

The X-Rite ColorChecker, Datacolor SpyderCheckr, 
and DSC Labs SMPTE OneShot charts compared, all of 
which are supported by the Color Match palette

The result is analyzed to generate an automatic color correction to use to create a neutral grade 
for the image, to use as a starting point for the rest of your grade.
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Tips for Properly Shooting a Color Chart
The results you get using Color Match are completely dependent on how the charts were shot in the 
field. If the charts were properly shot, you’ll get great results. If the charts were improperly shot, the 
results will be unpredictable.

To get the best results using Color Match, adhere to the following guidelines:

	— The chart must be lit evenly such that the lighting on each patch is the same intensity (level) and 
color. Any shadows or changes in lighting color across the chart will result in Color Match trying to 
compensate for these changes, and an inaccurate match will result. When viewing a chart being lit 
prior to a shoot shooting via a waveform monitor, the top of each individual patch as seen on the 
scope should appear as a rectangle with a “flat top.”

Poorly lit chart with irregularly topped waveforms

Well lit chart with flat-topped waveforms
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	— No patches on the chart should be clipped in any of the RGB color channels. A clipped channel will 
force Color Match to use incorrect RGB values, and the resulting match will be inaccurate. 

	— The white patch on the recorded chart should be captured between 70–95 IRE/percent. Correct 
exposure is essential to getting a good result, and while Color Match does allow for some 
adjustment via the White Level option, this will only give accurate results if the original chart is 
shot so that the white patch sits within the 70–95 IRE/percent range when viewed on a waveform 
monitor. It is not recommended that a white patch be shot with a signal level above 95 IRE/
percent, since this usually means that one of the RGB channels is close to or actually clipping 
which will cause an inaccurate match. 

	— The Source Gamma setting must be set to match the encoded OETF (opto-electrical transfer 
function, or gamma) of the recorded image. To be able to create an accurate adjustment, the Color 
Match function requires image data that is scene linear (linear to light). Most captured or recorded 
image data is encoded with a tone curve (gamma curve) to maximize the efficiency of the bit 
depth being used, and different cameras use different gamma curves to maximize the image data 
from different sensors. Since the Color Match algorithm converts image data into a scene linear 
space before creating an adjustment, it needs to undo the gamma curve created by the camera 
or debayering process. If the wrong Source Gamma setting is selected in the Match Color palette, 
then the data will not be linearized correctly and the resulting match will be inaccurate.

	— Lighting in the scene with an unusual spectral response or a strong color cast can cause an 
inaccurate match. Scenes lit with lights that have an unusual spectral response (such as cheap 
fluorescent bulbs, cheap LED lighting, or mercury vapor fixtures that exhibit a very narrow or 
spiky spectral power distribution) can cause metameric errors in both the camera’s response 
and the Color Match function, resulting in the creation of an inaccurate adjustment. The most 
accurate results are obtained when the scene uses lighting with a chromaticity that is close to 
the black body locus (with a highly correlated color temperature) and a relatively smooth spectral 
power distribution. In other words, use high-quality lighting that doesn’t have spikes in specific 
parts of the spectrum.

	— Large differences between the color temperature of the lighting shining directly on the chart and 
ambient lighting elsewhere in the scene can cause perceptual errors. Often the problem is one of 
perception and not an incorrect color adjustment. For example, outdoor scenes being artificially 
lit with instruments shining extremely warm light (low color temperatures of 3200K or less) but 
that have cooler ambient lighting may appear overly blue if matched with a Target Color Temp 
of 6500K. This happens because the chart under direct lighting is lit at the lower (yellower) color 
temperature, but areas of the scene in shadow are much cooler because of the ambient “blue” 
light from the sky; the result is an automatic color adjustment that’s correct for the chart, but 
exaggerated in the background.
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How to Use Color Match
The following procedure shows how to use the Color Match palette and overlay to 
create a color correction.

The Color Match palette

To sample a color chart to make an automatic correction:

1	 Select the clip with a chart you want to sample. If necessary, you can use the View > Show Current 
Clip With Handles option to show additional frames at the beginning of the current clip to reveal a 
color chart in the leader of your media. 

2	 If necessary, choose an option from the Source Gamma drop-down menu that corresponds to the 
gamma with which the media was recorded. 

3	 Then, choose a target gamma and color space that corresponds to the format you want this clip to 
be matched to. 

4	 Click the Viewer tool drop-down, choose the Color Chart overlay, and use its corner-pinning 
controls to line the sampling boxes up with the color patches of the chart. 

Aligning the Color Match target with the chart in the video

5	 When you’re finished, click the Match button, and the clip will be automatically corrected.
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A clip before and after automatic color matching

TIP:  Keep in mind that not every shot needs to have a chart. If the lighting of the 
location used in a scene is consistent, you really only need a single chart analysis to 
generate a correction that you can copy to all other clips in the same scene. Of course, 
if you are using multiple cameras in a scene, you should have a chart analysis for each 
separate camera if you want to try and match them more closely together. If you’re 
shooting a scene that takes all day, you may also want to shoot charts at significant 
time changes corresponding to the lighting changes that are happening.

Configuration Controls
Here’s a more detailed explanation of each of the parameters found in the Color Match palette.

	— Source Gamma: Defines the source gamma the media was recorded with. You must select the 
correct gamma or the results will not be as accurate.

	— Target Gamma: Lets you select a target gamma that you want the corrected clip to use. While this 
will most likely be the gamma you’re outputting the finished program at, you can choose other 
target gamma values for specialized workflows.

	— Target Color Space: The color space you’ll be outputting the finished program with.
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	— Color Temp: An adjustable color temperature control that lets you manually adjust the target 
color balance of the resulting correction to be warmer (lower values) or cooler (higher values). 
The default is 6500K.

	— White Level: A checkbox that’s disabled by default, which lets you manually choose the target 
white point that the automatic correction should use. Raising or lowering this value will stretch or 
compress the contrast of the final correction. 

	— Match button: Once you’ve chosen the appropriate settings, and aligned the color match target 
with the chart that was recorded, click to execute the match.

	— Chart type drop-down menu: You can choose from among the supported chart types in 
this drop-down. At the time of this writing, these include the Datacolor SpyderCheckr24, 
theChromaDuMonde 24+4, the DSC Labs SMPTE OneShot, the X-Rite ColorChecker Classic, the 
X-Rite ColorChecker Classic - Legacy, the X-Rite ColorChecker Video, and the X-Rite ColorChecker 
Passport Video.

	— Reset All button: Resets all controls and adjustments in this palette.

Reset Controls
The Color Match option menu has a variety of commands you can use to reset your work in the 
Color Match palette.

	— Reset Match Configuration: Resets the Configuration parameters described above.

	— Reset Applied Match: Resets the matching operation without resetting the 
Configuration controls.

Automatic Adjustments 
in the Primaries Palette
There are four controls found in the Primaries palette that can be used for automatically making 
different color adjustments, in order to give you a head start whenever you’re trying to neutralize a 
color cast in the image or choose better black and white points for exposure.

White Balance Eyedropper
The White Balance eyedropper, found at the bottom-left corner of the Primaries palette next to the 
Automatic Correction button, provides an automated way of neutralizing a color cast in your image 
that you can guide by manually selecting a feature in the image that is supposed to be white.

To auto white balance an image with an undesirable color cast or tint:

1	 Click the White Balance eyedropper button. The pointer turns into the White Balance eyedropper.

The White Balance 
eyedropper
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2	 In the Viewer, click on any feature that is supposed to be white such as a white wall, white trim 
around a window, white blinds, a white shirt, and so on. As you drag the eyedropper around, the 
RGB values appear as a tooltip to give you a better idea of what the color is of the feature you’re 
about to click on. Make sure the feature you click on is (a) supposed to be white, and not off-white, 
and (b) that it corresponds to an image detail that’s not clipped, because that can make parts of 
the image seem white that aren’t really.

As a result, the white balance of the image should appear much more neutral than before. Note 
that this adjustment is not applied via any of the controls in the Primaries palette; it’s an invisible, 
self-contained adjustment.

Pick Black Point and Pick White Point
The Pick Black Point and Pick White Point eyedropper controls, found at the upper left-hand corner 
of the Lift and Gain controls of the Wheels and Bars modes of the Primaries palette, let you adjust 
contrast by lowering the black point or raising the white point of the image, and also correct for 
unwanted color casts in the shadows or highlights of the image.

NOTE:  It’s easy, using the Pick Black and White Point controls, to inadvertently boost the 
highlights or lower the shadows so much that you end up clipping part of the image. To give 
these controls the best chance of succeeding, it’s advisable to find the absolute brightest or 
darkest parts of the image to sample, according to the following instructions.

To automatically adjust the black point of an image:

1	 Click the Pick Black Point control. The pointer turns into the Black Point tool.

The Auto Pick Black 
Point control

2	 In the Viewer, click on any feature that is supposed to be black such as the deepest part of a 
shadow in the background or within a fold of clothing, black fabric, or something painted black. 
As you drag the Black Point tool around, the RGB values appear as a tooltip to give you a better 
idea of what the color is of the feature you’re about to click on. Make sure the feature you click on 
is (a) supposed to be black, and not some very dark hue, and (b) that it corresponds to an image 
detail that’s not clipped, because that can make parts of the image seem black that aren’t really.

As a result, the darkest parts of the image should appear much darker than before, and any 
color imbalance in the shadows should be neutralized. Unlike the White Balance eyedropper, this 
adjustment is applied via the Lift controls in the Wheels and Bars mode, which should appear with 
some manner of adjustment as a result.
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To automatically adjust the white point of an image:

1	 Click the White Point control. The pointer turns into the White Point tool.

The Auto Pick White 
Point control

2	 In the Viewer, click on any feature that is supposed to be white such as a white wall, white trim 
around a window, white blinds, a white shirt, and so on. As you drag the White Point tool around, 
the RGB values appear as a tooltip to give you a better idea of what the color is of the feature 
you’re about to click on. Make sure the feature you click on is (a) supposed to be white, and not 
off-white, and (b) that it corresponds to an image detail that’s not clipped, because that can make 
parts of the image seem white that aren’t really.

As a result, the lightest parts of the image should appear much lighter than before, and any color 
imbalance in the highlights should be neutralized. Unlike the White Balance eyedropper, this 
adjustment is applied via the Gain controls in the Wheels and Bars mode, which should appear 
with some manner of adjustment as a result.

Auto Color
The Auto Color command provides a quick way to automatically balance the blacks and whites of a clip 
based on the current frame at the position of the playhead. As of DaVinci Resolve 16, the A button in 
the Primaries palette and the Shot Match command available from the Thumbnail Timeline contextual 
menu both now use advanced algorithms, based on the DaVinci Neural Engine, to provide superior 
results when automatically adjusting color balance and contrast. These controls have been developed 
to provide optimal results when working in the Rec. 709 color space, and at a gamma of 2.4, so they 
work well in conjunction with using Resolve Color Management (RCM) to normalize media first.

	— The A button performs an automatic analysis of the current frame at the playhead to give a more 
consistently useful neutral starting point for further adjustment.

	— The Shot Match command matches one or more clips to the color and contrast of a graded or 
ungraded target clip. This updated version of Shot Match has been designed to be used after 
you’ve used the A button on each clip in the operation, the clips you’re matching and the clip 
you’re matching to.

If you’re in need of a fast neutral starting point for a range of clips, you can also use these 
commands together, grading a target clip using the A button, and then using Shot Match to match 
a range of clips in the same scene to the automatically graded example. Please note that these 
commands are intended to provide you with a reasonably neutral starting point for continued 
grading; they’re not meant to create creative or artistic grades.

The Auto Color button
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To make an automatic correction, do one of the following:

	— Open the Primaries palette to any mode, and click the A button in the lower left-hand corner.

	— Choose Color > Auto Color (Option-Shift-C).

	— Press the AUTO COLOR button on the T-bar panel.

The advantage of Auto Color is that it gives you an immediate result for any clip without the 
requirement for sampling the image or having a specific test pattern to analyze, but the disadvantage 
is that this lack of guidance makes the usefulness of this command somewhat hit-or-miss. When it 
works, it can work very well to give you a neutral starting point for further grading. When it fails, 
you’re better off resetting the resulting adjustment and grading the old fashioned way.

Legacy Auto Color
The previous methods for doing Auto Color and Shot Match are available from the Color 
panel of the User Preferences, via two checkboxes named “Use Legacy Auto Color/Shot 
Match.” With these enabled, DaVinci Resolve looks for the darkest levels in the image to 
neutralize the RGB color balance in the blacks, and the brightest levels to neutralize the RGB 
color balance in the highlights. Furthermore, Master Lift and Master Gain are adjusted to 
maximize image contrast at the outer boundaries of 0 and 100 percent. Using this control 
with the Primaries Bars mode open makes it easier to see what’s been changed after these 
automatic adjustments are made.

Shot Match
The previously available automated color correction commands, Auto Color and Color Match, are both 
useful for adjusting a selected clip to give it a clean, neutral starting point when you’re either in a 
hurry, or if you’re having trouble manually working out a solution. However, this is only the first step in 
grading a scene.

After you make a general adjustment to improve the color of a clip in a scene, one of the other 
principal tasks of the colorist is to adjust all of the clips in that scene so that they match the clip you 
started with, such that they all look like they were shot at the same time and in the same place. This is 
called scene-to-scene color correction, scene balancing, or shot matching. While there are abundant 
tools in DaVinci Resolve to ease the process of doing this manually, wouldn’t it be nice if you could just 
select a series of clips that you want to match, and have the software do the work?

That’s exactly what Shot Match has been designed to do. Whether you’re a colorist in a hurry, trying to 
blast through a low-budget feature with an absurd schedule, a DIT making best light dailies who just 
wants to make them match a little more closely before sending media off to editorial, or an editor who 
isn’t fast at color correction who needs to give a rough cut a quick color balance before showing the 
project to the client for the first time, the Shot Match feature of DaVinci Resolve has been created to 
quickly make different clips in a timeline match one another more closely, with a minimum of steps.

As of DaVinci Resolve 16, the Shot Match command available from the Thumbnail Timeline contextual 
menu uses an advanced algorithm, based on the DaVinci Neural Engine, to provide superior results 
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when automatically adjusting color balance and contrast. This control has been developed to provide 
optimal results when working in the Rec. 709 color space, and at a gamma of 2.4, so they work well in 
conjunction with using Resolve Color Management (RCM) to normalize media first.

The updated version of Shot Match has been designed to be used after you’ve used the A button on 
each clip in the operation, on both the clips you’re matching and the clip you’re matching to.

(Top) Original scene, (Bottom) After using shot match to match all selected clips to clip 62

Legacy Auto Color
The previous methods for doing Auto Color and Shot Match are available from the Color 
panel of the User Preferences, via two checkboxes named “Use Legacy Auto Color/Shot 
Match.” With these enabled, DaVinci Resolve looks for the darkest levels in the image to 
neutralize the RGB color balance in the blacks, and the brightest levels to neutralize the RGB 
color balance in the highlights. Furthermore, Master Lift and Master Gain are adjusted to 
maximize image contrast at the outer boundaries of 0 and 100 percent. Using this control 
with the Primaries Bars mode open makes it easier to see what’s been changed after these 
automatic adjustments are made.

Shot Match Guidelines
Keep in mind that Shot Match isn’t supposed to make your clips look good, it’s supposed to make 
them look the same as the clip you choose to match to, or to at least get as close as possible without 
creating a color correction that will do harm to the image. The purpose of Shot Match is to make it 
easier for you to match a scene’s worth of clips together so you have a starting point for building the 
rest of the look you want for that scene, on top of this initial match.

The clip you choose to match to may have a correction applied to it, but for the best results, you 
should limit yourself to simple Lift/Gamma/Gain primary adjustments. If you make Custom curve 
or secondary adjustments to the image, it will be much more difficult for Shot Match to give you a 
good result.

Shot Match works best with normalized clips. If you’ve got a timeline edited with log-encoded clips, 
you may want to use DaVinci Color Management to normalize all the clips in the Timeline before you 
use Shot Match, to get the most accurate results. It’s certainly possible to use Shot Match with log-
encoded media, but the flat color signal of log-encoded media may make it harder to get good results, 
depending on the scene. 
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Furthermore, Shot Match is not the right tool to use to try and match un-normalized log-encoded 
clips that use different types of log encoding, such as LogC and RedLogCine, or to try and match 
normalized and un-normalized clips. Because log-encoding is similar to a set of red, green, and blue 
curve operations, Shot Match is not equipped to achieve a successful result in this situation.

Shot Match is not designed to apply corrections to clips that already have node adjustments. The 
results will be unpredictable, and probably won’t match. While the clip you’re matching to may have 
simple primary adjustments applied to it, the other selected clips that are being matched should be 
completely ungraded.

Lastly, Shot Match has been designed to do no harm to the image. This means if you use Shot Match 
to try and match an underexposed interior shot to an exterior shot exposed at high noon on a sunlit 
day, the Shot Match algorithm will do its best to “split the difference” in order to make the difference 
between these two clips less jarring, while at the same time taking care not to stretch the color and 
contrast adjustments being made to the underexposed clips to the point where the image falls apart.

How to Use Shot Match
There’s no way to easily describe what Shot Match does. It’s a complex algorithm designed to try and 
deal with an impossibly varied number of different situations. As a result, Shot Match doesn’t apply 
adjustments to any of the user-editable controls in the Color page. Instead, the image adjustment 
created by Shot Match is applied invisibly, as the very last adjustment to the node that was selected 
when Shot Match was used, similar to a LUT.

A Shot Match adjustment 
applied to a clip

The procedure for using Shot Match is deceptively simple. However, getting a good result requires 
some careful thought in terms of choosing which clips to match to one another.

To match one or more selected clips to a specific clip:

1	 Following the guidelines presented in this section, Command-click or Shift-click one or more 
clips that you want to be matched. The clip you want to match to may or may not be part of the 
selection. You may select as few as one clip, or as many as you like.

Selecting clips you want to be matched
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TIP:  If you want to make it easier to notice the before and after, you can turn on 
Split Screen, and choose Selected Clips from the mode drop-down in the Viewer 
Options. This lets you see all the clips you’re about to match in a grid.

2	 Next, right-click the clip you want to match all of the selected clips to, and choose Shot Match to 
This Clip.

Shot Match command used on the clip you 
want to match the other selected clips to

If the resulting automated match looks good and plays well, then congratulations, you’ve got an 
excellent starting point for additional grading. However, keep in mind that even if the resulting match 
isn’t perfect, it may have taken care of enough inconsistencies between the clip you’re matching to 
and the clips that are being matched, that you need only make smaller, easier-to-spot adjustments in 
order to nail the final match between the shots in a scene. Either way, you can save time.

Suggestions for Using Shot Match
It’s certainly possible to select every clip in a scene and use Shot Match, and the results may be 
wonderful depending on what kind of visuals are in the scene. However, for other scenes, this may not 
always get you the best results. 

Be strategic about which clips you select to match to one another. Don’t use Shot Match on shots that 
you know already have the same lighting, as you’ll risk having Shot Match make a minor adjustment 
that may actually make the shots match less well. Think of Shot Match as a tool for matching 
clips that look different.

It can also help to use Shot Match an angle at a time, and to do a small test before committing yourself 
to matching a bunch of clips. For example, suppose you have a scene consisting of angle A (an over of 
character 1), angle B (an over of character 2), and angle C (a master shot), and you want to match the 
scene entire scene to angle C since it has the best lighting. First, match one shot from angle B to your 
favorite shot from angle C, and see how you like the result. If it’s good, then go ahead and select every 
angle B clip and match them to angle C, before moving on to test one shot from angle A. This way, if 
there’s ever an angle that doesn’t work well using Shot Match, you can try matching it to one of the 
other angles in the scene that you’ve already matched to see if you get a better result.

NOTE:  Keep in mind that, since each clip in the Timeline has its own undo stack, you cannot 
undo a shot match operation applied to multiple clips all at once.

Beware of clips with large areas of color in the background that don’t match any of the other angles 
in a scene, such as a shot-reverse-shot sequence that cuts between someone standing in a back yard 
and someone standing against a purple wall. You can try it to see what happens, but this kind of color 
distribution can often throw Shot Match results off.
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Broadcast Safe
If you regularly deliver to restrictive QC standards, then you can enable Broadcast Safe in the 
Color Management panel of the Project Settings while you grade to limit both the luma and chroma of 
the video signal to one of three levels of acceptable overshoots and undershoots.

The Broadcast Safe parameters in the Color 
Management panel of the Project Settings

	— Broadcast safe IRE (mV) levels: A drop-down menu for choosing one of three levels 
of aggressiveness when limiting the signal. Choose the range that corresponds to your 
QC requirements. The options are “–20 - 120” (permissive), “–10 - 110” (conservative), and 
“0 - 100” (very conservative).

	— Make Broadcast Safe: A checkbox that turns broadcast safe limiting on and off.

NOTE:  The clipping imposed by Broadcast Safe itself does not have an inherently soft 
roll-off. For best results, Broadcast Safe should be used in conjunction with the Soft Clip 
controls in the Color page, or a Soft Clip LUT. For more information see Chapter 4, “System 
and User Preferences.”

Using CDL Grades 
There are two instances where primary grading adjustments may be applied to a clip outside 
of adjustments that you make within the Node Editor of the Color page. If you import a CDL 
(Color Decision List), then the CDL adjustment for each clip is made available to you via a contextual 
menu command in the Thumbnail timeline of the Color page. For more information, see Chapter 146, 
“Copying and Importing Grades Using ColorTrace.”
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Using ARRI Looks 
If you’ve ingested ARRIRAW media or QuickTime-wrapped Apple ProRes from an Amira, Alexa SXT 
or Alexa LF, or MXF-wrapped Apple ProRes from Alexa Mini LF with embedded ARRI Look metadata 
(CDL + LUT), the embedded look can be copied to the currently selected node in the Color page.

To copy an ARRI look from the source media to the current node:

1	 Select a node in the Node Editor to which you want to apply the look data.

2	 Right-click that clip’s thumbnail and choose Apply ARRI CDL and LUT. A LUT and Color Wheels 
adjustment will be applied to the selected node.

Using the Apply ARRI 
CDL and LUT command 
copies a look from the 
source media to a node 
in the Node Editor
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Chapter 128

Camera Raw Palette
The Camera Raw palette lets you make clip-specific adjustments to 
the parameters that are used to debayer a raw clip into an image 
that can be graded in DaVinci Resolve.
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Introduction to the 
Camera Raw Palette
When a timeline uses clips that are linked to camera raw source media recorded from cameras from 
Blackmagic Design, RED, ARRI, Sony, and Vision Research, all clips in raw media formats are initially 
debayered using the settings found in the Camera Raw panel of the Project Settings.

However, if there are individual clips that you want to apply different raw settings to, for example 
altering the ISO to pull more detail out of the highlights or shadows, then you can use the controls 
found in the Camera Raw palette to individually alter the parameters found within.

 

The Camera Raw palette showing the available parameters for Blackmagic RAW media.

The Camera Raw palette is automatically set to the mode (seen within the Mode drop-down menu) 
that is appropriate to the clip that’s currently selected. If the current clip is not in a raw format, then 
the parameters within the Camera Raw palette are disabled.

All settings that currently populate the Camera Raw palette are also accessible from the 
DaVinci control panel.

To access camera raw settings on the DaVinci control panel:

1	 Press the CAMERA RAW soft key on the Center panel.

2	 Use the Center panel knobs to make camera raw parameter adjustments.

3	 When you’re finished, press the MAIN soft key to return to the main page of controls.

This section covers general use of the Camera Raw palette. For in-depth documentation about specific 
camera raw parameters, see Chapter 7, “Camera Raw Settings.”
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Copying, Versioning, and 
Protecting Camera Raw Settings
Ordinarily, a clip’s camera raw settings are copied along with its grade, or saved inside stills grabbed 
from that clip, when you use the various grade management techniques covered in Chapter 138, 
“Grade Management.” 

When you create new versions, you copy the current Camera Raw settings to the new version, but 
any changes you make are specific to that version, so each version can have individual Camera Raw 
adjustments. For example, you could compare the results of two different camera raw adjustments on 
the same clip.

Camera Raw master settings for BRAW media

If you’re copying and rippling grades among multiple clips, you can also protect each clip’s camera 
raw settings from being overwritten using the “Copy Grade: Preserve Camera Raw Settings” 
option found in the contextual menu of the Gallery. For more information on the Copy Grade 
settings, see Chapter 139, “Grade Management.”

Making Changes to Clip 
Camera Raw Settings
If you want to make individual adjustments to a particular clip’s camera raw settings, choose “Clip” 
from the Decode Using drop-down menu in the Camera Raw palette. This makes all the parameters 
in the Camera Raw palette editable, and changes you make override the project-wide camera 
raw settings.

Changes to the parameters in the Camera Raw palette can also be rippled across multiple 
clips at once.
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To ripple camera raw adjustments across multiple clips:

1	 First, you must select a range of clips in the Color page timeline.

2	 Open the Camera Raw palette, and make whatever adjustments are necessary to the current clip. 
The name of each parameter you adjust changes to amber, showing you which parameters have 
been modified, and which have not.

3	 To ripple your changes, do one of the following:

	— Click the Use Changes button to ripple only the altered parameters (in amber) to the 
other clips you’ve selected in the Timeline. This preserves differences between clips in the 
parameters you haven’t adjusted (in gray).

	— Click the Use Settings button to ripple every parameter of the current clip to the other clips 
you’ve selected, overwriting all the camera raw settings at once. 

The Use Changes and Use Settings 
buttons in the Camera Raw palette

Clip Decoder Settings
There’s much more information on the various format-specific Master settings, as well as the 
occasionally format-specific Clip Decoder settings, in Chapter 7, “Camera Raw Settings.” However, with 
the exception of the RED Clip Decoder settings that appear for R3D clips, most other formats share 
a set of DaVinci Resolve-specific controls that provide wide-latitude access to the raw image data for 
purposes of making different kinds of adjustments. 

Camera Raw Clip Decoder settings for BRAW media

While specific raw formats have individual controls, the standard controls include:

	— Color Temp: Designed to alter the “warmth” of the image. Adjustable in degrees Kelvin. Lower 
values correct for “warmer” lighting, while higher values correct for “cool” lighting. +6500 is unity. 
The range is +2000 to +50,000.

	— Tint: Color balance correction for images with a green or magenta color cast, such as fluorescent 
or sodium vapor bulbs. 0 is unity. The range is –150 to +150.
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	— Exposure: Increases or lowers image lightness in units relative to ƒ-stops. If your intended 
exposure adjustment lifts image data above the maximum white level, don’t worry; all image data 
is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –5 to +5.

	— Sharpness: A debayer-specific sharpness filter applied to provide the appearance of enhanced 
image detail. 20 is unity. The range is 0 to 100.

	— Highlights: Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-range 
media by lowering this parameter, and achieves a smooth blend between the retrieved highlights 
and the unadjusted midtones for a naturalistic result. 0 is unity. The range is –100 through +100.

	— Shadows: Lets you selectively lighten or darken shadow detail. Raising this value retrieves 
shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The range is 
–100 through +100.

	— Color Boost: A non-uniform saturation operation that affects regions of low saturation more 
than regions of high saturation. This is sometimes referred to as a vibrance operation. 0 is unity, 
showing the original color values. Raising color boost from 0-100 increases color intensity, but 
low-saturation parts of the image are raised more aggressively. Lowering Color Boost from 
0 to -100 decreases color intensity, but low-saturation parts of the image are lowered more 
aggressively. 0 is unity, showing unaltered saturation. The range is –100  through +100.

	— Saturation: A uniform saturation operation that raises (above 50) or lowers (below 50) the 
color intensity of every color value within the image. 50 is unity, showing unaltered saturation. 
The range is -100 (completely desaturated) through +100 (saturation is doubled).

	— Midtone Detail: When this parameter is raised, the contrast of regions of the image with high 
edge detail is raised to increase the perception of image sharpness, sometimes referred to as 
definition. When this parameter is lowered to a negative value, regions of the image with low 
amounts of detail are softened while areas of high-detail are left alone. 0 is unity. The range is 
–100 through +100.

	— Lift: Adjusts the black point of the media, raising it or lowering it while scaling all midtone values 
between it and the white point. Regardless of how you adjust this control, all image data is 
preserved and can be retrieved in subsequent adjustments. The range is –100 to +100. 

	— Gain: Adjusts the white point of the media, raising or lowering it while scaling all midtone values 
between it and the black point. Regardless of how you adjust this control, all image data is 
preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

	— Contrast: Raising contrast reduces shadows and raises highlights, while leaving midtones at 
50 percent unaffected. Regardless of how you adjust this control, all image data is preserved and 
can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

Resetting Camera Raw Settings
If you’ve made changes to the parameters of the Camera Raw palette and you decide you need to 
reset them, there are two options, found in the Options menu.

	— Reset: Resets all parameters in the Camera Raw palette to their default settings.

	— Revert: Similar to the “Original Memory” command, Revert changes all camera raw parameters 
back to the state they were at when you first selected the current clip.
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Updating Sidecar Settings for 
Blackmagic RAW (BRAW) Clips
Blackmagic RAW clips support both embedded look metadata within the .braw media clip and external 
look metadata in .sidecar files. Ordinarily, these files travel in pairs whenever you manage BRAW 
media, and whenever a .sidecar file is present, its settings override those of the embedded metadata 
within the actual .braw clip. Since the .sidecar metadata is in human-readable JSON formatted text, it’s 
easy to edit and accommodates a wide variety of onset to post-production workflows.

The .braw and .sidecar files as seen in the file system

If you like, you can make changes to the raw look metadata of a .braw clip and upgrade the 
.sidecar metadata from within the Color page of DaVinci Resolve, so the media on disk reflects 
these changes in any other BRAW compatible application.

To update the .sidecar raw look metadata:

1	 Open the Color page, select a .braw clip in the Thumbnail timeline, and open 
the Camera Raw palette.

2	 Set Decode Using to Clip to enable the palette controls.

3	 Make whatever adjustments you want to make using the controls of the Camera Raw palette.

4	 When you’re done, click the Update Sidecar button.

The Update Sidecar button in the 
Camera Raw palette for .braw media
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Chapter 129

Primaries Palette
This chapter focuses on the core color adjustments that you’ll 
be making to create “primary” corrections that alter the overall 
color and contrast of the image using both the Lift/Gamma/Gain 
adjustments in the Wheels and Bars modes of the Primaries 
palette, and the Shadow/Midtone/Highlight/Offset controls in the 
Log mode, both of which have traditionally formed the foundation 
of most grades.
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Introduction to the Primaries Palette
If you’ve had any exposure to color correction tools in any application, the Lift/Gamma/Gain 
controls found within the Wheels mode of the Primaries palette should look familiar. These controls 
correspond to the most traditional and basic color correction functionality available in DaVinci Resolve 
and are designed to let users without control panels have easy access to color balance and YRGB 
contrast manipulation using a mouse, tablet, or trackpad.

Color Balance controls for primary grading, in Wheels mode

As the name implies, the Primaries palette has been designed for the kind of overall “primary” 
color adjustments to the image that typically serve as the foundation of any grade. “Secondary” 
adjustments then refer to more specific adjustments made to isolated subjects within the image. 
However, it’s a time-tested practice that you do everything you can to get the overall image right 
using one or more primary corrections before moving on to more specific detail work built on top of 
these initial adjustments. For one thing, it’s a more structured, organized way to work. However, it’s 
also the most efficient way to make sure you’re tackling the image in a holistic way, that maximizes 
improvements while minimizing stress on the video signal.

The Primaries palette has three distinct modes of operation:

	— Wheels mode contains the traditional DaVinci YRGB Lift/Gamma/Gain controls that allow tonally 
specific yet widely overlapping regions of adjustment. Wheels mode also provides access to the 
RGB Offset/Printer Points color balance and master controls.

	— Bars mode gives access to the same YRGB Lift/Gamma/Gain and Offset controls as the Primaries 
Wheels mode, but the Bars interface lets you make vertical slider-driven adjustments to individual 
YRGB lift, YRGB gamma, and YRGB gain channels, as well as providing a slider and button-driven 
interface for the RGB Offset/Printer Points controls.

	— Log mode is the home of the RGB Offset/Printer Points color balance and master controls that 
adjust the overall signal in a linear, film-oriented way. Log mode provides Shadow/Midtone/
Highlight/Offset controls that offer more restrictive yet customizable regions of adjustment 
intended for making adjustments to log-encoded image data.

Which mode you use depends entirely on how you like to work, and what kinds of adjustments you 
need to make.
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HDR Grading With the Primaries Palette
Starting in DaVinci Resolve 17, some of the palettes of the Color page with which color adjustments 
are made have been made “color space aware.” This means that the functionality of the palette will 
be mostly the same no matter what Timeline Color Space you’re using, or whether you’re grading to 
create SDR or HDR output. However, not every color palette has been made color space aware, and so 
when using various grading controls in the Color page to grade wide-latitude images for HDR output, 
if you find the controls aren’t working smoothly, you may find it useful to enable the HDR Mode of the 
node you’re working on by right-clicking that node in the Node Editor and choosing HDR Mode from 
the contextual menu (this is only available in Resolve Studio). 

This setting forcibly adapts that node’s controls to work within an expanded HDR range. Practically 
speaking, this makes it easier to work with wide-latitude signals using controls that operate by letting 
you make adjustments at different tonal ranges such as Lift/Gamma/Gain or the Log controls.

Which Do I Start With, the Primaries or HDR Palette?
The HDR palette, introduced in DaVinci Resolve 17, has also been developed to work as a powerful 
method of creating primary adjustments to serve as the foundation of your grade. While the Global 
and Zones controls of the HDR palette operate from a different philosophy of signal adjustment, 
they’re designed to let you tackle the same issues, so it’s a completely valid choice to start out using 
the HDR palette instead of the Primaries palette. So, which to use?

Ultimately, this is going to come down to your comfort with the HDR palette, and your experience with 
the Primaries palette. If your muscle memory of working with the Primaries palette continues to make 
it the fastest way for you to dial in your adjustments, there’s no reason to stop using it now. In fact, 
the Offset/Printer Points controls in the HDR palette continue to be adjustments that are distinctly 
different from the functionality found within the HDR palette.

However, you should also give the HDR palette a try, because it has powerful primary grading 
capabilities that aren’t possible with the Primaries palette modes. Even if the functionality is new to 
you, if you give it a week you’ll find innumerable advantages to the HDR palette’s way of doing things, 
even though it requires some new ways of looking at the process.

The bottom line, however, is that you’ll probably continue using both palettes. If you do, keep in 
mind that in each Corrector node’s order of image processing operations, the HDR palette controls 
are processed before the Primaries palette controls, largely because the HDR palette’s more 
“photographic” approach to grading has been intentionally designed to meet the needs of primary 
color adjustment in our new world of wide-gamut HDR mastering and output, so it’s been fit into the 
image processing pipeline as the new foundation of all adjustments.
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Shared Controls in 
the Primaries Palette
This section explains, in a generic way, how to use the common control interface conventions used by 
the Wheels, Bars, and Log modes to make adjustments. It also describes the use of parameters that 
are shared among all three modes.

Switching Between Primaries Tools
The icons in the upper right of the Primaries palette allow you to switch between the Primaries tools at 
the click of a button.

Primaries: Color Wheels

Primaries: Color Bars

Primaries: Log Wheels

Color Balance Controls
Whether you’re using the Wheels or Log controls, Color Balance controls provide a way to adjust 
all three color channels of a particular range of the image simultaneously with a single move of the 
pointer, according to the mode that’s currently selected. There are also a variety of keyboard modifiers 
that let you make specific adjustments via the GUI. These controls also correspond to the trackballs 
found on any of the DaVinci or third-party control panels, should you have one connected.

Methods of making adjustments using the Color Balance controls:

	— Click and drag anywhere within the color ring: Moves the Color Balance indicator relative to its 
previous position, and rebalances the three color channels in whatever range of image tonality is 
governed by that control. You don’t need to drag the Color Balance indicator itself. This simulates 
the kind of relative control you get when using a trackball to manipulate these parameters. As the 
Color Balance indicator moves, the RGB parameters underneath change independently to reflect 
the independent adjustments being made to each channel.

	— Shift-click and drag within the color ring: Jumps the Color Balance indicator to the absolute 
position of the pointer, letting you make faster, more extreme adjustments to the color balance 
governed by that control.

	— Double-click within the color ring: Resets the color adjustment without resetting the 
corresponding contrast adjustment for that control.

	— Command-click and drag within the color ring: Adjusts YRGB contrast identically as if you were 
dragging that control’s master ring.

	— Click the reset control at the upper-right of a color ring: Resets both the Color Balance control 
and its corresponding master ring.
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Master Wheels
The Master Wheels, located below the Color Balance controls, let you adjust the YRGB channels for a 
particular range of image tonality together. This has the practical effect of letting you adjust image 
lightness and contrast.

Lift, Gamma, and Gain or Shadow, Midtone, and Highlight, plus Offset master wheels to adjust contrast

The Master Wheels correspond to the rings surrounding the trackballs on all of the DaVinci control 
panels, which let you modify image contrast via YRGB adjustment (as opposed to modifying image 
contrast via Y-only adjustment, discussed later in this chapter).

To adjust a Master Wheel:

	— Dragging a Master Wheel to the left makes the corresponding tonal region of the image 
darker, and dragging it to the right makes that tonal region of the image lighter. The effect 
will vary according to the mode you’re in. As you make an adjustment, the YRGB parameters 
located underneath all change together to reflect the simultaneous adjustment you’re making 
to all channels.

Numeric Parameters
Each Color Balance Control and Master Wheel pair of controls also have a set of four YRGB number 
fields underneath that display the YRGB adjustment being made by both controls. These four values 
encompass every color and master adjustment you can make with these controls, and they also 
directly correspond to the Bars interface that mirrors the Wheels controls. 

These fields can be edited like any other parameter on the Color page. Even though these values 
display two decimal places of precision because of space restrictions in the interface, they really 
contain three decimal places of precision since these are floating point operations; you just can’t see 
the third decimal place.

To edit YRGB values directly:

	— You can double-click on a field to edit its value numerically.

	— You can insert the text cursor next to a value in this field, and use the Up and Down Arrow keys to 
adjust the value one digit at a time.

	— You can cut, copy, and paste values among fields.

	— You can click on the field and drag left or right to adjust its value with a virtual slider. 

The number fields for each 
Color Balance Control and 
Master Wheel are editable.
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Shared Adjustment Controls
The three modes of the Primaries palette also share two strips of controls for making more specific 
adjustments to different aspects of the image, such as Contrast, Saturation, Hue, Highlight retrieval, 
Color boost, and so on. 

Like most parameters in DaVinci Resolve, clicking and dragging a parameter’s name or value to the left 
or right lowers and raises that parameter with a virtual slider, while double-clicking that parameter’s 
number lets you edit it numerically, and double-clicking that parameter’s name resets the parameter 
to its default position.

The top adjustment controls

	— Temp: A specifically constrained Gain color balance adjustment that lets you adjust the image 
along a warm/orange to cool/blue axis corresponding to the naturalistic spectrum of color 
temperatures used for lighting. Raising this parameter performs a Gain color balance adjustment 
toward orange, while lowering this parameter to a negative value performs a Gain color balance 
adjustment toward a blue/cyan split. 0 is unity. The range is –4000 to +4000.

	— Tint: A specifically constrained Gain color balance adjustment that lets you adjust the image along 
a magenta to green axis corresponding to the unnatural spectrum of color temperatures found 
in artificial lighting sources such as fluorescent and sodium vapor lighting fixtures. Raising this 
parameter performs a Gain color balance adjustment toward magenta (sometimes referred to 
as “minus green” to correct for fluorescent lighting), while lowering this parameter to a negative 
value performs a Gain color balance adjustment toward green (“plus green” to correct for other 
kinds of lighting). 0 is unity. The range is –100 to +100.

	— Contrast: The Contrast parameters let you quickly narrow or widen image contrast about a 
user-definable pivot point. Regardless of which mode you’re in, these parameters are identical. 
Contrast and pivot can also be adjusted using the DaVinci control panel via the CONTRAST and 
PIVOT knobs on the Center panel’s default page, regardless of whether you’re in Lift/Gamma/Gain 
or Log mode. 

This one parameter lets you increase or reduce the distance between the darkest and lightest 
values of an image, raising or lowering image contrast. The effect is similar to using the Lift and 
Gain master controls to make simultaneous opposing adjustments. Bright and dark parts of the 
image are pushed apart or brought together about a center point defined by the Pivot parameter. 
The “Use S-curve for contrast” setting in the General Options panel of the Project Settings (on by 
default) sets the contrast control to apply an “S-curve” to the image, such that the shadows and 
highlights of a signal will not be clipped when you increase the value. If you would prefer for these 
contrast adjustments to be made linearly, and for the signal to be allowed to clip when you reach 
the upper and lower boundaries of the video signal, you can turn this checkbox off.

	— Pivot: Changes the center of tonality about which dark and bright parts of the image are 
stretched or narrowed during a contrast adjustment. Darker images may require a lower Pivot 
value to avoid crushing the shadows too much when stretching image contrast, while lighter 
images may benefit from a higher Pivot value to increase shadow density adequately.

	— Midtone Detail (MD): When this parameter is raised, the contrast of regions of the image with 
high edge detail is raised to increase the perception of image sharpness, sometimes referred to 
as definition. When this parameter is lowered to a negative value, regions of the image with low 
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amounts of detail are softened while areas of high-detail are left alone. 0 is unity. The range is 
–100 through +100.

The bottom adjustment controls

	— Color Boost: A non-uniform saturation operation that affects regions of low saturation more 
than regions of high saturation. This is sometimes referred to as a vibrance operation. 0 is unity, 
showing the original color values. Raising color boost from 0-100 increases color intensity, but 
low-saturation parts of the image are raised more aggressively. Lowering color boost from 
0 to -100 decreases color intensity, but low-saturation parts of the image are lowered more 
aggressively. 0 is unity, showing unaltered saturation. The range is –100  through +100.

	— Shadows: Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow 
detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The range is –100 
through +100.

	— Highlights: Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-range 
media by lowering this parameter, and achieves a smooth blend between the retrieved highlights 
and the unadjusted midtones for a naturalistic result. 0 is unity. The range is –100 through +100.

	— Saturation: A uniform saturation operation that raises (above 50) or lowers (below 50) the 
color intensity of every color value within the image. 50 is unity, showing unaltered saturation. 
The range is 0 (completely desaturated) through +100 (saturation is doubled).

	— Hue: Rotates all hues of the image around the full perimeter of the color wheel. The default 
setting of 50 shows the original distribution of hues. Raising or lowering this value rotates all hues 
forward or backward along the hue distribution as seen on a color wheel.

	— Lum Mix: Lets you control the balance between YRGB contrast adjustments you’ve made using 
the Master Wheels or ganged Custom curves, and Y-only adjustments to contrast made using the 
Y channel Lift/Gamma/Gain controls of the Primaries palette or the unganged Luma curve. At the 
default of 100, YRGB and Y-only adjustments to contrast contribute equally. Reducing this value 
diminishes the effect of Y-only contrast adjustments until, at 0, Y-only contrast adjustments are 
turned off. 

Additionally, you’ll notice that at the default Lum Mix setting of 100, individual adjustments to 
R, G, or B using the RGB sliders or unganged Custom curves result in automatic adjustments 
being made to the other two color channels in order to maintain constant Luma levels. At a Lum 
Mix setting of 0, individual color channel adjustments have no effect on the other color channels.

Auto Correction
The Auto Color command provides a quick way to automatically balance the blacks and whites of a 
clip based on the current frame at the position of the playhead. As of DaVinci Resolve 16, the A button 
in the Primaries palette and the Shot Match command that is available from the Thumbnail Timeline 
contextual menu both now use advanced algorithms, based on the DaVinci Neural Engine, to provide 
superior results when automatically adjusting color balance and contrast. These controls have been 
developed to provide optimal results when working in the Rec. 709 color space, and at a gamma of 2.4, 
so they work well in conjunction with using Resolve Color Management (RCM) to normalize media first.

For more information on using these, see Chapter 127, “Automated Grading Commands and 
Imported Grades.”
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Reset Controls
The Reset control, found at the upper right-hand corner of the Primaries palette, lets you reset every 
single setting in the entire palette. However, there are a variety of parameter-specific reset controls 
available to make more targeted resets.

	— Each pair of Color Balance and Master Wheel controls have a reset control that resets both.

	— Each numeric parameter can be individually reset by double-clicking the name of the parameter.

	— The numeric parameters underneath each Color Balance and Master Wheel control pair can be 
reset by double-clicking the color label that appears underneath them.

Color Wheels and Bars
The Color Wheel palette’s Primaries Wheels mode lets you rebalance color and adjust contrast via the 
traditional DaVinci controls, which govern three overlapping tonal ranges referred to as Lift, Gamma, 
and Gain. The Lift/Gamma/Gain color balance and Master Wheel controls are tied to the YRGB Lift/
Gamma/Gain sliders found in the Primaries palette; adjustments made to one set of controls are 
mirrored in the other.

Though they may look different, the Wheels and Bars controls both 
actually adjust the same components, but in different ways.
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These tonal ranges are defined by image lightness, on a scale where 0 is absolute black and 1023 
is absolute white. The following illustration shows an approximation of how the Lift, Gamma, and 
Gain tonal zones broadly overlap, and how each zone’s influence falls off towards the opposing 
extremes of image tonality.

Lift Gamma Gain

Graphic displays the relationship of the Lift, Gamma, and Gain controls 
over the image brightness range that they control

The Lift color balance control region of influence starts at black, and then falls off through the 
middle grays to diminish to no influence at white. Meanwhile, the Gamma color balance control 
has its greatest influence over the image in the middle grays, and its influence diminishes towards 
black and white. Lastly, the Gain control is the inverse of Lift, having its greatest effect on the 
image at white, with its influence falling off to diminish at black.

Because these tonal ranges overlap so broadly, you can make very soft, subtle, naturalistic 
adjustments using these controls. Furthermore, you can capitalize on their overlap by moving an 
adjacent color balance control toward a color that’s complementary to an adjustment you’ve just 
made to restrict further how much of the image is affected.

The following image shows the interaction of extreme corrections made to a grayscale image 
using all three Color Balance controls. Lift has been pushed toward green, Gamma has been 
pushed toward blue, and Gain has been pushed toward red.

Extreme adjustments showing the overlap of the Lift, Gamma, and Gain color balance controls

Notice how, even though these corrections are extreme, the colors blend smoothly. This is 
the reason for the broad overlap among all three controls, and why Lift, Gamma, and Gain are 
so effective in making corrections to the ambient color temperature of a scene to account for 
inconsistencies in lighting or camera settings.
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3-Way Master Wheel Adjustments
The Master Wheels located below the Color Balance controls let you precisely modify image contrast 
by YRGB adjustments, which individually alter the black point, the white point, and distribution of 
midtones that fall in-between. 

These controls correspond to the rings surrounding the trackballs 
on the DaVinci control panel.

	— Lift: Lets you adjust the perceived shadow density of the image by altering the black point of the 
image. Dragging the Lift master wheel to the left makes the darkest values in the image darker, 
increasing the distance between the black and white points of the image, and stretching all the 
midtone values in-between. Dragging the Lift master wheel to the right makes the darkest values 
in the image lighter, reducing contrast and squeezing all the midtone values between the black 
and white points.

	— Gamma: Lets you adjust the overall perceived lightness of the image by altering the distribution 
of midtones that fall between the Lift and Gain master wheel settings. Dragging the Gamma 
master wheel to the left darkens the overall image, while dragging it to the right brightens it. Most 
Gamma contrast adjustments have a minimal effect on the black and white point of the image, but 
large adjustments may push either boundary of image lightness farther out. This interaction is 
described in more detail below.

	— Gain: Lets you adjust the lightness of the highlights by altering the white point of the image. 
Dragging the Gain master wheel to the left makes the lightest values of the image darker, 
squeezing the midtones between the white and black points of the image. Dragging Gain to the 
right makes the lightest values even lighter, eventually clipping at maximum white.

Waveform display shows the clips contrast range

These contrast adjustments are not limited by one another. For example, raising or lowering the 
Gamma master wheel by a large amount may push the highlights of the image higher or the shadows 
of the image lower, regardless of the current Lift or Gain contrast setting. 

As a result, these controls are somewhat interactive, and you may find yourself going back and forth 
between controls as you make your final contrast adjustments. This is one of the reasons a control 
panel is valuable, as it allows you to adjust all three settings simultaneously.
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Offset Color and Master Controls
The fourth set of Color Balance and Master Wheel controls is actually shared with the Log controls 
and with the Offset sliders in the Primaries palette. These are the Offset controls, which let you make 
linear adjustments to rebalance the entire tonal range of the RGB channels. There is no Y-only control 
for Offset, only a Master RGB adjustment.

	— The Offset color balance control: Works as a simultaneous adjustment to all three Offset sliders 
located in the Primaries palette; adjustments made to the Offset color balance control also alter 
the Offset sliders. Used subtly, this makes it easy to neutralize color imbalances in the darkest 
part of the image, while simultaneously rebalancing every other part of the image. Used more 
dramatically, this control makes it easy to add a color wash throughout the entire image.

	— The Offset master wheel: Acts as a global adjustment to image lightness, an operation 
sometimes referred to as setup, raising or lowering all RGB channels together.

When using a DaVinci Micro or Mini control panel, the Offset color balance and master controls are 
adjusted via either the third trackball and ring while in Offset mode, or the fourth trackball and ring of 
the DaVinci Advanced Panel in Offset mode.

Color Bars Mode
The Bars mode contains the original set of DaVinci Resolve color adjustment sliders. These sliders 
serve two uses. First, they’re highly visible indicators of the individual YRGB channel adjustments 
that are made using the trackballs, rings, and knobs of a grading control panel. Second, they provide 
control of individual YRGB Lift/Gamma/Gain parameters using a mouse, tablet, or trackpad.

Primary grading controls

The main controls of the Bars mode are the individual Luma (or Y), Red, Green, and Blue sliders, 
four each for Lift, Gamma, and Gain. These sliders provide precise Lift/Gamma/Gain style control 
over each of the YRGB channels of the image. When used in conjunction with a Parade Scope 
video analysis of the image, these controls can enable you to fix irregular color imbalances in 
specific channels quickly.
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Additionally, the Luma (Y) Lift/Gamma/Gain sliders allow easy Y-only adjustments to contrast, 
where an increase in contrast results in perceptually diminished color saturation. These 
correspond to the three knobs arranged vertically to the left of the Trackball panel of the DaVinci 
Advanced control panel, or the three left-most knobs of the DaVinci Micro or Mini control panels.

Making Y-only adjustments to contrast is a great way to increase contrast when you’re going for 
muted saturation or a gritty look. This kind of adjustment is also useful in situations where you’re 
trying to increase shadow density without increasing image colorfulness.

Log Wheels Mode
The Shadow/Midtone/Highlight color balance and Master Wheel controls operate independently of 
the Lift/Gamma/Gain color balance and Master Wheel controls found in the Primaries mode. While the 
Log mode uses the same types of controls as the Primaries mode, the way each control affects the 
image is very different. 

To switch between the Primaries and Log modes of the Wheels:

	— Choose an option from the mode drop-down, click the right mode button, or press Option-Z.

Log color balance controls, with behavior that is very 
different from the Wheels mode color balance controls

There are two ways of using the Log mode controls. The first takes advantage of the way these 
controls work to make fast, filmic adjustments to log-encoded media prior to it being normalized 
or “de-logged” by operations that are performed using nodes appearing after it in the image 
processing pipeline of your node tree. Normalizing or de-logging the image can be done via Color 
Space Transform operations, LUTs, and manual adjustments if you’re grading using DaVinci YRGB 
color science. If you’re using color management, they can be done via the Output Color Space 
setting of Resolve Color Management (RCM), or via the ACES Output Device Transform (ODT).

The other way of using the Log controls is to take advantage of the more restrictive, but 
adjustable tonal range of the Shadow/Midtone/Highlight controls to stylize normalized clips by 
tinting or adjusting the contrast of tonally-specific regions of the image.
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Whether or Not to Use Legacy Log 
Grading Ranges and Curve
DaVinci Resolve 12.5 introduced a modification to the Log grading controls that provides 
smoother, more pleasing results using the same controls. To maintain backward 
compatibility with older projects, a “Use legacy Log grading ranges and curve” checkbox 
in the General Options panel of the Project Settings lets you switch your project between 
the older Log control behavior and the newer one. Older projects that are opened in 
DaVinci Resolve have this checkbox turned on by default, while new projects have this 
turned off by default.

Using the Log Mode Controls 
to Grade Log-Encoded Media
The Log controls are so named because they’re designed to work specifically with media with Log-C 
or similar gamma and color encoding, derived from the Cineon Log gamma curve, developed by 
Kodak to digitally store flat-contrast, wide-gamut image data that preserves image detail with a wide 
latitude for adjustment. 

An example of a log-encoded clip (left), and the same clip after being normalized (right)

You can debayer most raw formats to a log-encoded image in order to derive the maximum amount 
of image data and adjustable latitude from that source. For more information, see Chapter 7, “Camera 
Raw Settings.” However, the resulting image needs to be normalized to occupy the final range of color 
and contrast that you intend for the final result. You can do this one of two ways:

	— You can make a very careful curves adjustment in a second node to stretch the log-encoded 
image out to fit the contrast profile you want. By making this adjustment in Node 2, you 
make room for a customizing adjustment made using the Log controls in Node 1, prior to the 
normalization adjustment. This is key.

	— You can also apply a 1D Output or 3D LUT to the first node of a clip to normalize the image. This 
is a faster, if less flexible operation, but a smooth tonal range may be easier to obtain. Since a LUT 
applied within a node is always the last adjustment within that node’s order of operations, you can 
also use Node 1’s Log controls to customize the look of the footage.
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In either case, it’s important that the normalizing adjustment happens after your Log control 
adjustments, for the Log control adjustments to work as they should. With your node tree set up 
in this way, you’ll be monitoring an ordinary-looking image, but taking advantage of the Log mode 
controls’ unique tonal ranges to manipulate the log-encoded image data with great specificity. 

TIP:  Within corrector nodes, LUTs are applied after Log control adjustments, so if you 
want to keep the number of nodes in your node tree to a minimum, you can apply 
a normalizing (or de-logging) LUT to the same node with which you’re making Log 
adjustments, knowing that the LUT will be properly applied after log adjustments. 
For more information, see Chapter 141, “Image Processing Order of Operations.”

When using the Log mode controls, here’s a workflow 
to consider as you learn how they work:

	— First, use the Offset master wheel to set the black point, and use the Contrast and Pivot 
parameters to stretch or compress contrast as necessary to achieve the tonal range you require.

	— Second, use the Offset color balance control to adjust the overall color balance of the 
image to your liking.

	— Third, use the Shadow/Midtone/Highlight color balance and Master Wheel controls to make 
specific, targeted adjustments to the color and contrast of the image in tonal ranges that match 
where that data is in the log-encoded image.

Working in this way, you’ll find that adjustments made with the Offset color balance and Master 
Wheel controls and Contrast controls control the log-encoded image very nicely to create an overall 
adjustment, while the Shadow, Midtone, and Highlight controls allow you to fix specific issues, such as 
shadow balance and density, after your main adjustment has been set.

The following illustration shows an approximation of how the default ranges of the Shadow, Midtone, 
and Highlight controls divide the tonal range of a log-encoded image. 

This graphic shows the tonal range of each of the Log 
controls when used with a log-encoded image
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As you can see, when used with a log-encoded image the color interactions between each adjustment 
overlap very softly, while still allowing more specific adjustments than those made by the Lift/Gamma/
Gain controls.

Furthermore, the boundaries of the Shadows, Midtones, and Highlights Log controls can be 
customized using the Low and High Range parameters. This gives you added flexibility to apply more 
specific contrast and color adjustments.

Once you’ve made an adjustment using Log mode controls along with a normalizing LUT or curve 
adjustment, you can always apply additional nodes and use the Wheels mode of the Primaries palette 
to make further alterations to the now normalized image, working as you normally would with any of 
the other tools in DaVinci Resolve.

TIP:  Internal to each node’s image processing order of operations, the Lift/Gamma/Gain 
adjustments of the Wheels mode are applied prior to the Shadow/Midtone/Highlight/Offset 
adjustments of the Log mode, so if you want to apply Log mode controls before Wheels 
mode controls, then you need to use Wheels controls in a subsequently added node. For 
more information, see Chapter 141, “Image Processing Order of Operations.”

Using the Log Mode Controls to 
Stylize Normalized Media
You can also use the Log mode controls on already normalized images. Although the results you 
get will be somewhat different, this can be a fast way to create interesting stylizations. Whereas the 
broadly overlapping tonal ranges of the Lift, Gamma, and Gain color balance controls allow subtle 
adjustments to be made very easily, the Log palette’s color balance controls affect much more 
restrictive tonal zones that overlap much less when used on normalized images.

The following illustration shows an approximation of how the Shadows, Midtones, and Highlights, by 
default, divide the tonal range of the image into non-overlapping thirds. As you saw in the previous 
section, these divisions were originally intended to map to log-encoded media. However, with 
normalized media these divisions provide a different, and potentially useful, set of ranges from the 
Primaries mode controls.

Shadows Midtones Highlights

High RangeLow Range

This graphic shows an approximation of the tonal range of each of the Log controls 
with the additional low and high range to expand or contract the range.
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With normalized media, the Shadows really do only affect the darkest shadows, falling off at 
approximately the bottom third of image tonality. The Midtones affect only the middle third of grays, 
and the Highlights affect the brightest top third of image values. However, these default ranges of 
image tonality can be adjusted using the Low Range and High Range controls, which are described in 
more detail later.

The following image shows the default interaction of extreme corrections made to a grayscale image 
using the Log mode controls. The Shadows have been pushed toward green, the Midtones have been 
pushed toward blue, and the Highlights have been pushed toward red.

Extreme adjustments showing the overlap of the Shadow, 
Midtone, and Highlight color balance controls

As you can see, with normalized media the color interaction between each adjustment is very subtle. 
The darkest shadows end up bright green, the midtone values are vivid blue, and the highlights are 
almost pure red. This restrictiveness is useful when you want to limit a correction to a specific tonal 
range within the image without needing to use a Luma qualifier. It’s also quite useful for making bold, 
stylistic color adjustments when creating a non-naturalistic look.

TIP:  The Highlights adjustment of the Log controls can also be extremely useful for 
boosting or otherwise controlling the highlights of HDR grades. However, the multiple 
highlight zones of the HDR palette afford a much higher degree of control over this kind of 
adjustment, using similar control panel-friendly controls.
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Adjusting the Default Tone Ranges in Log Mode
When in Log mode, two additional parameters appear in the top shared controls bar that let you 
modify the range of Shadows and Highlights image tonality that each Color Balance control affects, 
in turn narrowing and widening the range of Midtones. Keep in mind that while the ranges can be 
customized, the amount of overlap between each range cannot.

	— Low Range: Moves the border where the Shadows and Midtones meet. Lowering this parameter 
widens the range affected by the Midtones, and narrows the range affected by the Shadows. 
Raising this parameter narrows the Midtones and widens the Shadows.

	— High Range: Moves the border where the Midtones and Highlights meet. Lowering the High 
Range parameter narrows the range affected by the Midtones, and widens the range affected by 
the Highlights. Raising this parameter narrows the Highlights and widens the Midtones.

There are also Saturation and Hue parameters which mimic these settings found within other palettes 
and modes.

Adjusting Contrast in Log Mode
When using the Log mode controls, your primary tools for adjusting image contrast will usually be 
the Offset master wheel and Contrast and Pivot parameters. Using these three controls, you can set a 
black point and adjust the overall contrast very quickly.

The Shadow, Midtone, and Highlight master wheels let you adjust image lightness within the same 
restrictive ranges of image tonality that are defined by the Low Range, High Range, and Pivot 
parameters. These adjustments should appear smooth, if somewhat narrower then the Lift/Gamma/
Gain controls, when used with log-encoded media. However, when used with normalized images, 
severe adjustments made with one master wheel may not always make a smooth transition to the 
next adjacent range of image lightness.

NOTE:  Because these controls are so restrictive when used with normalized images, it’s 
easy to create solarization effects by raising the shadows to be higher than the Midtones, 
or lowering the Highlights to fall below the Midtones, to give two examples.

Log Offset Color and Master Controls
The Log controls share the same Offset color balance and Master Wheel controls that appear in the 
Lift/Gamma/Gain mode of the Wheels and Bars controls. The Offset controls are in fact processed 
as part of the Log controls, but for convenience they’re presented with the Wheels controls because 
they’re so useful.

	— The Offset color balance control: Works as a simultaneous adjustment to all three Offset sliders 
located in the Primaries palette; adjustments made to the Offset color balance control also alter 
the Offset sliders. Used subtly, this makes it easy to neutralize color imbalances in the darkest 
part of the image, while simultaneously rebalancing every other part of the image. Used more 
dramatically, this control makes it easy to add a color wash throughout the entire image.

	— The Offset wheel: Acts as a global adjustment to image lightness, an operation sometimes 
referred to as setup, raising or lowering all YRGB channels together.
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Offset and Printer Points
In Bars mode, the Offset controls are represented by three vertical sliders, which mirror the settings 
of the Offset color balance controls in the Color Wheel palette, except that they provide individual 
control over the Red, Green, and Blue color channels. In fact, this interface also happens to be the 
epicenter of the Printer Points functionality offered by DaVinci Resolve.

When you drag one of the Offset sliders up or down, you raise or lower that color channel in its 
entirety. This can be useful for adjusting color channels that are particularly problematic, but it’s also 
the way you impose the kinds of traditional linear color adjustments that color timers of film have 
employed for decades. In fact, many colorists consider the simplicity of these controls a virtue, and 
embrace the slight shadow or highlight contamination that can result from color balancing in this 
linear way as a creative hallmark of traditional cinema color adjustment.

Offset RGB and master controls

NOTE:  Unlike the other Color Balance control adjustments described in this chapter, 
the Offset controls do not use the Lum Mix parameter to control whether individual 
adjustments to the R, G, or B channels result in automatic adjustments being made to the 
other two color channels in order to maintain constant Luma levels. All Offset and printer 
points adjustments made to a specific color channel affect only that color channel.

Adjusting Printer Points in the Bars Mode
Each Offset slider also has a pair of arrow buttons, one at the top and one at the bottom. These 
buttons provide “Printer Point” adjustment of these values, which let you adjust each Offset channel in 
discrete increments. Printer Points can be useful for projects that have tight integration with a film lab, 
and are designed to emulate color adjustments made using optical printers.

The “plus” and “minus” red, green, and blue 
buttons for making printer point adjustments
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The Offset wheel control underneath the Offset sliders lets you adjust all three sliders at once, 
performing a master or setup adjustment. The Offset sliders, Printer Point buttons, and Offset wheel 
can be adjusted using keyboard shortcuts, or using the DaVinci control panel.

NOTE:  The DaVinci Resolve Advanced and Mini color grading panels each have support for 
adjusting printer points using rotary controls for the Red, Green, and Blue channels, as well 
as All channels together.

Adjusting Printer Points Via Keyboard Shortcuts
One of the best ways of using printer points if you don’t have a color control panel that supports them 
is to enable the numeric keypad to use dedicated keyboard shortcuts just for printer points.

To use the Printer Lights Hotkeys:

	— Choose Color > Printer Light Hotkeys, or press Option-Command-Grave Accent (`)

When you enable Printer Light Hotkeys, there are two sets of shortcuts you can use to manipulate 
printer points. First, if you want to directly manipulate RGB in whole increments, there’s one 
set for that.

Red Green Blue

7 - Plus Red 8 - Plus Green 9 - Plus Blue

4 - Minus Red 5 - Minus Green 6 - Minus Blue

However, if you want to work in the classic way by manipulating cyan, magenta, and yellow in whole 
increments, there’s another set of shortcuts for that, using the remaining keys on the numeric keypad.

Cyan Magenta Yellow

1 - Plus Cyan 2 - Plus Magenta 3 - Plus Yellow

Minus (–) - Minus Cyan 0 - Minus Magenta Period (.) - Minus Yellow

There are also a pair of keyboard modifiers that gives you finer control over printer points 
adjustments made with these special keyboard shortcuts, while retaining the coarser default 
adjustments that let you make bigger changes more quickly:

	— Hold down Command while using these key shortcuts to adjust printer points in 
quarter‑increments.

	— You can use half-increments as well, but you will need to assign the keyboard shortcuts 
for these manually.

2896Color  |  Chapter 129  Primaries Palette



Printer Light Step Project Settings
The increments used by the Printer Point buttons are defined by the Printer Light Step Calibration 
parameters, found in the Color panel of the User Preferences. The default settings are designed 
to emulate traditional film printer adjustments, but these settings can be customized to align 
DaVinci Resolve’s printer points adjustments with those of a particular film lab’s equipment. However, 
if you’re not working with a lab, you can change the Step and Density settings to alter how much of an 
adjustment each printer point makes according to your own preferences. For more information,  
see Chapter 4, “System and User Preferences.”

Controls in the Color panel of the User Preferences to adjust Printer Point functionality

TIP:  If you’re feeling left out because all the cool kids are using printer points and you’re 
unfamiliar with them, making the Parade scope visible is a great way to learn how these 
adjustments work while seeing their specific effects on the red, green, and blue channels of 
the video signal.
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Chapter 130

HDR Palette
This chapter focuses on the global and zone-based adjustments 
found in the HDR palette, which is DaVinci’s newest primary 
grading tool. Despite its name, this palette can be used, as you 
might the Lift/Gamma/Gain mode of the Primaries palette, to 
create the foundational adjustment for any SDR or HDR grade. 

However, its zone‑based nature gives it the power and specificity of curve-based adjustments, 
making the HDR palette suitable for a multitude of creative and corrective tasks. Furthermore, 
this palette’s color space awareness, as well as the perceptually uniform color space in which it’s 
adjustments are made, make this palette uniquely suited for controlling the saturation and highlights 
of HDR mastered images.
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Introduction to the HDR Palette
The HDR palette is specifically designed to enable fast and flexible primary grading of wide-latitude 
media for either SDR or HDR output. It’s “color space aware” in that it works with Resolve Color 
Management to fit the known mapping of source image data within the HDR palette’s own perceptually 
uniform operational color space. Using advanced color processing algorithms, this enables more 
efficient color and contrast adjustments, and perceptually uniform controls that make it easier to 
adjust all colors equally across the spectrum, while maintaining careful control of image saturation. 

The HDR palette

A set of global controls, at the right of the palette, let you make foundational adjustments to the 
overall image, along with a set of Hue, Midtone Detail, Contrast/Pivot, and Black Offset controls at 
the bottom. Additionally, a set of overlapping zone-specific controls let you make color and contrast 
adjustments to specific ranges of image tonality. Altogether, the HDR palette lets you make primary 
grading adjustments that are both photographically naturalistic and as tonally broad or specific as you 
require, while minimizing unwanted artifacts.

Despite its sophistication, the HDR palette uses color balance and slider controls that should be 
familiar to any colorist or editor familiar with the more conventional Lift/Gamma/Gain controls. 
Whether you’re a grading professional or just getting started with color, the HDR palette will enable 
great results with less hassle once you learn how to harness its power.

The controls panel of the HDR palette

TIP:  Due to the increasing ubiquity of HDR-capable media and HDR streaming distribution 
workflows, the node HDR mode and HDR palette are both available without restriction in 
the free downloadable version of DaVinci Resolve.
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What Makes the HDR Palette Special?
Before diving into the detailed use of the HDR palette’s controls, it’s important to understand a 
bit more about how the HDR palette processes image data, so you can better understand what 
advantages this tool presents.

Using the HDR Palette Without Color Management
While the HDR palette has been designed to work hand in hand with color management, you can use 
it in non-color managed workflows so long as you set it up correctly. The HDR palette option menu 
has Color Space and Gamma submenus that let you specify how you want to work. By default, both 
submenus are set to “Timeline” to reflect the color space you’re choosing to work within in display-
referred workflows.

Color Space Aware Controls When Using Color Management
The HDR palette really shines when you enable Resolve Color Management or ACES, because it’s a 
color space aware palette that uses color management to full advantage. Being color space aware 
means that the color and contrast controls of the HDR palette conform themselves to the range 
of each clip’s image data as mapped from the Input Color Space assigned to the source clip to the 
Timeline Color Space your program is working within. Practically, this provides two benefits:

	— The controls of the HDR palette work and feel virtually identical no matter what type of source clip 
you’re adjusting, and no matter which timeline color space you’re choosing to work within.

	— HDR palette adjustments made to one type of media will have a similar result when copied to 
other types of media. This makes makes matching shots and copying looks from one type of 
media to another easier than with previous tools.

NOTE:  Because the HDR palette is color space aware, it’s not necessary to enable the 
HDR setting on nodes for controls to work intuitively while working within a wide gamut 
Timeline Color Space, or delivering to an HDR format like ST.2084. The HDR palette takes 
care of this for you, automatically.

Perceptually Uniform Adjustments
Furthermore, the image data of each clip is converted from the Timeline Color Space to an operational 
color space used by the HDR palette, where the image is adjusted and then converted back to the 
Timeline Color Space again, ready for the next operation. The operational color space that’s used by 
the HDR palette is perceptually uniform, which means that the range of values corresponding to each 
visible hue are distributed evenly throughout this color space.

While the HDR palette works well grading standard dynamic range (SDR) material, the underlying color 
science used by this palette also addresses issues that have inconvenienced colorists grading high 
dynamic range programs using traditional controls. These benefits include:

	— Since the controls of this palette calculate all color transformations within a perceptually uniform 
color space, you will experience finer control over color adjustments in a more photographically 
intuitive way. For example, you may find that yellow hues are easier to grade within this palette, 
since there’s a more even distribution of hues around the circumference of the color wheels.
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	— The HDR palette lets you make contrast adjustments without altering image saturation, meaning 
that unlike when you use the master wheels of the Lift, Gamma, and Gain panel, the HDR palette 
lets you raise image contrast without increasing image saturation, and lower image contrast 
without decreasing image saturation. You’ll find this is particularly useful while boosting highlights 
in HDR grades, since you can now do so without causing extreme saturation increases in your 
highlights. In fact, all adjustments you make to contrast with these controls will adjust the 
image while keeping saturation unerringly constant (that is to say, perceptually speaking; you 
will in fact notice small saturation changes in the Vectorscope). This, of course, excludes the 
saturation controls.

	— The HDR palette’s deep integration with Resolve Color Management also makes matching shots 
and copying looks from one type of media to another easier than with previous tools. Whether 
you’re a professional, or just getting started with color, the HDR palette will enable better results 
with less hassle.

Superior Temp and Tint Controls
Because the HDR palette is color space aware, the Temperature and Tint adjustments in this palette 
are themselves made using the same kind of XYZ to LMS color space transform used by the Chromatic 
Adaptation Resolve FX plugin. The result is that Temp adjustments are photometrically accurate and 
create visual results similar to how the human vision system perceives changes to a scene due to a 
change in the color temperature of lighting.

Customizable Zones
Another unique aspect of the HDR palette is how it can be customized to suit a wide variety of working 
styles, specific tasks, and colorist preferences. Switching to the Zones panel reveals an interface for 
adjusting the Range and Falloff of each currently defined zone, using graphical controls overlaid 
onto a histogram of the current image, while a curve shows the user how the contrast and color 
adjustments they’ve made mathematically affect the RGB channels of the image within each zone. 
While the default zones preset provides an efficient starting point for many kinds of scenes, the 
varying tonal range of image data in different scenes, whether daytime, nighttime, interior, or exterior, 
will often require you to customize these zones to get the best results from adjustments using 
these controls.

The Zones panel lets you customize the tonal ranges that each set of zone controls affect.

Additionally, the sidebar at the left provides controls for adding and removing zones, so users can 
customize this palette to work exactly the way they want. Any customized preset can be saved for easy 
recall. This way, users have the freedom to work in whatever way suits them.
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The Option menu provides fast access to additional ways of customizing this palette’s operation, 
including the selection and management of presets, a choice of methods for numerically editing Color 
Balance adjustments, and a setting that determines whether or not the Global controls are always 
exposed, or should be banked to like the other zone controls.

The HDR Palette Interface
The HDR palette is divided into two panels. The first, containing Color Balance controls and custom 
sliders, is for making color and contrast adjustments. The second, containing the Zones sidebar and 
Zones graph, is for customizing the range and falloff of each of the zones that corresponds to each 
set of controls found on the controls panel. It’s these zones that are used for making detailed image 
adjustments to tonally-specific areas of the picture.

By default, both panels appear within the same palette area, and you can switch between them using 
buttons at the top right of the palette. This is useful when you have limited screen real estate, or 
you’re making simple adjustments. Alternately, you can click a button to expose both panels side-by-
side, occupying both the left and middle palette areas of the Color page.

From left to right, the Side-by-side view 
button, the Controls panel, the Zones panel, 
the Reset control, and the Option menu

This Side-by-side mode makes it easy to see and customize how each zone is mapped to the source 
image data, while making adjustments at the same time.

The HDR palette in Side-by-side mode; at left, the Color/Exposure/
Saturation controls; at right, the Zone Customization controls

An Option menu at the far right of the title bar (shown as three dots) reveals the preset manager for 
this palette, as well as different GUI options for customizing how you want to use this palette. 

Navigating Multiple Zones in the Controls Panel
A row of buttons just under the HDR palette’s title bar show you, of all available zones, which ones 
are currently adjustable using the visible controls below. While the default HDR palette preset has 
six zone-specific Zone controls, plus the Global controls, most users will only have room in the GUI 
for four sets of controls to be visible at any time. Meanwhile, grading control panel users will be 
constrained by how many trackballs their particular control panel has. 
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The Zone bank controls

Since you’ll almost always have more zones available than you have room to adjust them, this interface 
lets you see which zones you’re currently using, which zones are mapped to a control panel, and which 
other zones are available for you to switch to. By default, there are three active zones shown at the 
top, corresponding to the three sets of Zone controls to the left of the Global controls. Zones that are 
available, but hidden, are shown in gray to the left and/or right of the currently visible zones, which 
appear in color. This way, you can bank back and forth among three zones at a time, while always 
having the Global controls available for adjustment.

There’s also a setting in the HDR palette’s Option menu, “Bank Global With Color Wheels,” that lets 
you use all four GUI control clusters in this palette to show Zones controls, making it faster to jump 
among tonally-specific adjustments. In this mode, there are four active zones shown at the top, 
corresponding to the four sets of Zone controls being shown. However, in this mode you must page all 
the way to the right to expose the Global controls, which are banked along with all the other zones.

The Zone bank controls set to show four zones when the 
Global controls are banked with all the other zones

Using these controls, you can switch your visible control among all available zones similarly to how 
audio mixers switch among banks of tracks with a fader panel. 

Methods of switching among different Zone controls:

	— Click any gray zone button to the left of the currently visible zones to move all zones so that the 
leftmost visible zone appears at that one.

	— Click any gray zone button to the right of the currently visible zones to move all zones so that the 
rightmost visible zone appears at that one.

	— Click the Left or Right Arrow buttons to either size of the zones indicators to move all zones one to 
the left or one to the right.
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Making Global Adjustments
Generally speaking, if you’re using the HDR palette to do primary grading, you’ll probably want to 
begin with the Global controls. By default, these are found at the right of the Controls panel.

The graphical Global control cluster 
at the right of the HDR palette

These controls let you take the initial step of making an overall adjustment to the image. To adjust 
color, you have a color balance wheel, temp and tint sliders (to the left and right of the wheel, and 
also numerically below), and saturation adjustments. To adjust image contrast, a Global Exposure 
control lets you stretch overall image contrast up to brighten the image, or compress it down to 
darken it, relative to the current Black Offset level, which pins pixels corresponding to minimum 
black in place. A pair of Contrast/Pivot controls at the bottom of this palette let you manipulate 
overall color contrast by stretching highlights and shadows out or in relative to the pivot point, 
expressed in stops.

While Global color adjustments are somewhat similar to the offset, temp, and tint controls 
found in the Color Wheels or Log Wheels controls, there are important differences, described 
in detail below. The Global Exposure control, on the other hand, operates very differently from 
Master Offset. 

Detailed Explanation of Global controls:

	— Global Color Balance: A color balance control lets you simultaneously adjust the red, green, and 
blue channels, somewhat linearly throughout the tonal range of the image, to freely rebalance 
the color. However, RCMv2 automatically maintains a smooth saturation and exposure rolloff 
in the maximum highlights and minimum shadows, so this effect becomes less pronounced in 
the blackest blacks and the whitest whites of the image (this appears more pronounced in test 
gradients than real world images). While adjustments made with this control won’t lower the 
value of the darkest pixels in the image below the Black Offset level, individual color channels 
may dip below this level in order to preserve colorfulness in darker shadows. The resulting color 
adjustments made with this control are similar to how optical color filters placed over a lens would 
affect an image.
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(Top) The original image, (Bottom) A Global Color Balance adjustment affecting the overall 
image, with a rolloff seen in the shadows and highlights of the superimposed ramp gradient

	— Global Exposure: Brightens or darkens the entire image. Dragging to the right stretches image 
contrast by raising the highlights while keeping the shadows pinned relative to the Black Offset 
value. Dragging to the left lowers image contrast by lowering the highlights while keeping 
shadows pinned relative to the Black Offset value. For more explanation about the function of 
Black Offset, see the following section.

Keep in mind that all contrast adjustments in the HDR palette keep saturation constant as contrast 
increases or decreases. This means that, when making large contrast adjustments to HDR images, 
image saturation will remain perceptually the same.

  

(Top) The original image, (Bottom) Raising Global Exposure
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	— Global Saturation: Raises or lowers the intensity of color throughout the image. Since contrast 
adjustments don’t affect saturation, you must exercise manual control over any desired changes 
to image saturation.

	— Global Color Balance Value Fields: Two numeric values represent how the color balance controls 
center handle position is represented. There are two ways of numerically showing this: as X and 
Y, or as Angle and Strength. You can choose either method from the HDR palette’s Option menu; 
whichever method you choose determines how the center handle of all color balance controls is 
manipulated if you adjust these values directly.

At the bottom of the HDR palette, additional Global Temp and Tint, Hue, Midtone Detail, and Contrast/
Pivot controls let you make other kinds of global adjustments to image color, detail, and contrast, 
in ways that are very similar to the identically named controls in the Color Wheels or Log Wheels 
controls. Additionally, there’s a Black Offset control that lets you set the minimum allowable black level 
in the current shot. 

Global controls found at the bottom of the HDR palette

Detailed explanation of additional Global controls:

	— Temp: This global temp adjustment lets you warm or cool the image with a range from -4000 
to +4000 based on a kelvin scale. Adjustment follows the spectral locus line in the CIE graph: 
the intensity of adjustment is naturalistic. To minimize visual artifacts, this control is capable of 
warming the image more aggressively than cooling it. 

	— Tint: This global tint adjustment lets you add “plus green” or “minus green” adjustments with a 
range from -100 to +100 on an arbitrary scale.

	— Hue: Rotates all hues of the image around the full perimeter of the color wheel. The default 
setting of 50 shows the original distribution of hues. Raising or lowering this value rotates all hues 
forward or backward along the hue distribution as seen on a color wheel. 

	— Midtone Detail: When this parameter is raised, the contrast of regions of the image with high 
edge detail is raised to increase the perception of image sharpness. The effect is sometimes 
referred to as definition. When this parameter is lowered to a negative value, regions of the image 
with low amounts of detail are softened, while areas of high detail are left alone. 0 is unity. The 
range is –100 through +100. 

	— Contrast: This one parameter lets you increase or reduce the distance between the darkest and 
lightest values of an image, raising or lowering image contrast. The effect is similar to using the Lift 
and Gain master controls to make simultaneous opposing adjustments. Bright and dark parts of the 
image are pushed apart or brought together about a center point defined by the Pivot parameter. 
Unlike the Contrast control in the Primaries palette, the Contrast control in the HDR palette ignores 
the “Use S-curve for contrast” setting in the General Options panel of the Project Settings. 

Keep in mind that all contrast adjustments in the HDR palette keep saturation constant as contrast 
increases or decreases. This means that, even when making large contrast adjustments to HDR 
images, image saturation will remain perceptually the same to your eye, with small changes made 
to the actual saturation of the image in order to maintain this perception. Be aware that the tone 
mapping settings in RCMv2 will have an effect on how much saturation is maintained in the top 
highlights and bottom shadows of the image, versus being automatically rolled off at the outer 
boundaries of the signal.
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(Left) The original image, (Right) Raising Contrast, saturation is kept perceptually 
constant, except at the outer boundaries of the signal in the top highlights and 
bottom shadows (depending on how you have your tone mapping set in RCM).

	— Pivot: Changes the center of tonality about which dark and bright parts of the image are 
stretched or narrowed during a contrast adjustment. This lets you change how contrast is 
distributed among the shadows and highlights. The default value of 0 pushes highlights above 
50% gray higher, and shadows below 50% gray lower, in equal proportion to one another. 
Changing the pivot point changes the percentage of image tonality about which contrast is either 
expanded or compressed. 

Darker images may require a lower Pivot value to push more levels up and avoid crushing the 
shadows too much when stretching image contrast, while lighter images may benefit from a 
higher Pivot value to push levels down and increase shadow density. 

 

(Top) Altering contrast by raising Pivot, which redistributes most of the contrast 
expansion down towards shadows, (Bottom) Altering contrast by lowering Pivot, 
which redistributes most of the contrast expansion up towards the highlights

	— Black Offset: Defines the darkest allowable part of the image. No adjustment by any other 
control in the HDR palette will ever go below this level, except for the occasional color channel 
if the shadows become extremely saturated. For more detailed information on this extremely 
important control, see the very next section.
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Black Offset Explained
Of all the Global controls, the Black Offset control is one of the most deceptively important. Black 
Offset lets you define the darkest pixels of the image. Adjustments made to Black Offset do not offset 
the entire signal, they only affect the very darkest portion of the signal, letting you raise or lower 
the black point of the image while smoothly blending the resulting adjustment into the unadjusted 
portion of the image. The result is that you can compress or expand the bottom of your signal.

If you raise Black Offset, you can add “flaring” to the image, similarly to how light flaring within a lens 
might lighten the darkest part of the image. 

(Left) The original image, (Right) Raising Black Offset in order to 
add flaring to the darkest pixels of the image

Alternately, you can lower Black Offset to lower the very darkest pixels in the image. If the source 
image is dark enough, this control can lower the darkest pixels below 0, however this image detail is 
preserved in the color image processing pipeline

The most important thing to understand about this control is that level to which you set Black Offset 
becomes the new level at which Global exposure adjustments are made. In the following example, the 
first image shows the original color of a clip that was exposed to be dark. In the second image, Black 
Offset is adjusted to raise the darkest parts of the image, compressing them relative to the midtones 
and introducing a pleasing flaring effect to the shadows.

(Left) The original image; (Right) The image with Black Offset raised

In the following image, Global Exposure is raised, and you can see in the Waveform scope that the exposure 
change stretches the contrast of the image up, with the darkest pixels “locked” to the Black Offset you set.

(Left) Before, (Right) After raising Global Exposure to stretch image contrast out from the Black Offset level; 
notice that the bottom of the signal continues “touching” the same level after global exposure is raised.
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The Black Offset level you set also becomes the minimum picture level when you lower exposure, 
either using the Global Exposure changes, or when you use any of the “darkening” zone controls 
such as Shadow, Dark, and Black. The following image shows the result of lowering Global Exposure; 
the shadows of the image are compressed more heavily than the highlights as exposure is lowered, 
with the result that the minimum value of the image remains at the Black Offset level you set. With 
shadow detail impressively preserved, this compression rolls off smoothly and nonlinearly through the 
midtones so that the image continues to look as natural as possible.

(Left) Before, (Right) After lowering Global Exposure to compress image contrast down to 
the Black Offset level; notice the signal never goes lower than the Black Offset level

This is also true when using other darkening zone exposure controls, such as the Shadow control, 
which selectively pushes the exposure of the darker part of the image down, while leaving the 
highlights alone. While reducing Shadow exposure, the darkest pixels still compress so that nothing 
goes beneath the Black Offset level you set.

Bottom line, you can adjust Black Offset at any time, either before or after any other Global or Zone 
adjustments, to fine tune the image as necessary.

Making Zone-Based Adjustments
After you’ve made whatever initial global adjustments you want, you can optionally make more tonally-
specific adjustments to the image via the Zone-based color and contrast controls to the left. These 
divide the image into multiple overlapping “zones,” which are somewhat similar in principal to Ansel 
Adams’ zone system, which divides images into tonally-specific regions based on image luminance, 
from pure black, through progressively lighter shadows, to 18% gray as the middle value centering the 
midtones of most images, and then up through progressively lighter highlights on the way to the last 
zone of pure white. 

Simplified illustration of Ansel Adams’ zone system
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While Adams’ zone system was meant to teach people how to think about using the available range 
of the photographic medium when exposing images, the zones of the HDR palette let you put this 
concept into practice by allowing you to make tonally-specific Color Balance, Saturation, and Exposure 
adjustments that only affect the range of shadows or highlights that fall within that zone. 

Using the default preset, the shadows of your image are divided into overlapping Shadow, Dark, 
and Black zones, while the highlights of your image are divided into separate overlapping zones for 
Light, Highlight, and Specular ranges. The chart below illustrates the relationship of these zones to 
one another.

Approximation of the overlapping zones in the HDR palette that can be individually adjusted

NOTE:  All of the examples in this section have Timeline to Output Tone Mapping set to 
None, to keep the ramp gradient linear for purposes of this explanation.

Zone-Based Color Adjustments
Understanding how adjustments made using these overlapping zones interact with one another is key 
to knowing what you can do using the HDR palette. Keep in mind that every zone is customizable, but 
here’s how the default zone definitions work to let you make detailed image adjustments. For clarity, 
Zone adjustments are shown made to a linear ramp gradient image, to demonstrate exactly what 
tonal portion of each image is affected by each control.

	— The Light and Shadow zones are the most broadly defined zones. Together, they cover the entire 
tonal range of your image. They softly overlap one another by two stops at the center of the 
tonal range (50% gray or 18% exposure); this is where adjustments made to Light mix together 
with adjustments made to Shadow, resulting in both adjustments softly blending together. 
Making exposure adjustments to these two zones lets you manipulate overall image contrast 
by selectively compressing/expanding contrast in the shadows and/or highlights relative to one 
another. Using the color controls lets you make broad color adjustments to the upper (highlights) 
and/or lower (shadows) range of image tonality.
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Color adjustments to a ramp gradient show the Light 
(tinted green) and Shadow (tinted orange) zones

	— The Dark and Black zones overlap two progressively lower luminance ranges of the Shadow zone. 
Dark is useful for adjusting the color or contrast of the deeper shadows, while Black is useful as 
a trim that lets you manipulate the very darkest parts of an image. All adjustments you make to 
Dark are mixed with any adjustments made to Shadow, and all adjustments made to Black are 
mixed with the adjustments made to Dark and Shadow. In this way, all color adjustments you 
make to overlapping Shadow zones mix smoothly together to produce the final result, as seen in 
the following ramp gradient.

Color adjustments to a ramp gradient 
show the Dark (tinted blue) overlapping 
the Shadow (tinted orange) zone

	— The Highlight and Specular zones overlap two progressively brighter luminance ranges of the 
Light zone. Highlight lets you adjust the color and/or contrast of the brightest highlights, while 
Specular is useful as a trim that lets you manipulate the very brightest highlights of an image. 
All adjustments you make to Highlight are mixed with any adjustments made to Light, and all 
adjustments made to Specular are mixed with the adjustments made to Highlight and Light. In 
this way, all color adjustments you make to overlapping Highlight zones mix smoothly together to 
produce the final result, as seen in the following ramp gradient.

Color adjustments to a ramp gradient show 
the Highlight (tinted yellow) overlapping 
the Light (tinted green) zone.
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As you can see, each one of these zones allow the specific adjustment of whichever parts of the image 
fall within the luminance range of that zone (as defined on the Zones panel), while providing control 
over how smoothly one adjustment fades into the next, to prevent unwanted contouring. As you 
make adjustments to the Range and Falloff of each zone using the different sets of zone controls, they 
work together to smoothly manipulate the contrast and color of the image, similarly to if you were 
using a more precise and constrained version of the Custom Curves. In fact, you can see the actual 
adjustment you’re making by exposing the Zone graph.

(Left) Raising the Range of the Light zone to expand the Shadow zone’s range 
of influence, (Right) The same adjustment seen in the Zone graph

Working this way allows a tremendous specificity of adjustment, without the need to use curves or 
qualifiers. For example, zone-specific Color Balance controls allow you to grade the highlights and 
shadows separately using the Shadow and Light zone controls to quickly create a warm/cool split 
lighting effect. This makes the creation of dynamic grades more efficient and more creative.

(Left) The original image, (Right) Using the HDR palette to warm the 
highlights and cool the shadows (exaggerated for print)

In this next example, the Dark zone’s Color Balance control is used to add a splash of green to the 
darker shadows of the image, while the Black control is used to neutralize this green in the very 
blackest shadows.

(Left) The original image, (Right) Using the HDR palette to add green to a narrow range of shadows
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Zone-Based Exposure Adjustments
Each zone has its own Exposure control that allows you to stretch image contrast from that zone’s Min 
or Max range boundary either down towards the shadows, or up towards the highlights. As seen on 
the Zone graph (found on the Zone panel), exposure adjustments are made on a scale measured in 
stops, to provide a more photographic experience when grading wide dynamic range material.

The scale of the Zone graph shows you the shadow and highlight ranges, in 
stops, relative to 0 representing 18 percent photographic gray

On this scale, 0 stops corresponds to photographic 18% gray, at the center of each image’s tonal 
range. Shadows then fall to the left over -8 stops, while highlights fall to the right over +8 stops, 
where each stop represents either twice the amount of light (stopping up) or half the amount of light 
(stopping down). 

In conjunction with Resolve Color Management, this range is designed to accommodate any SDR or 
HDR range you’ll be mastering to. All HDR palette controls are designed to accommodate up to 16 
stops of exposure. By comparison, most modern digital cinema cameras claim to be able to capture 
somewhere between 13-19 stops of dynamic range, while a white paper from the ASC states that 
modern film negatives are capable of capturing 14 stops of dynamic range.

Unlike the Lift/Gamma/Gain or Log master level controls, the Exposure adjustment of each zone 
starts at a specific boundary of image tonality, and stretches all the way out through the highlights 
or shadows, through the maximum or minimum signal level allowable. Since Shadow and Light are 
the two zones that are centered on the midtones of the image, they’re the best zones for seeing how 
this works. Because of this, these are also probably the first two zones you’ll want to adjust if you’re 
making more specific exposure changes to the image.

Using the default preset, Shadow exposure adjustments affects everything in the image from stop 1 
down through absolute black. 

(Left) The original image, (Right) Darkening all shadows by lowering the Shadow exposure adjustment
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Meanwhile, Light exposure adjustments affect everything in the image from -1 stops all the way 
through maximum white. 

(Left) The original image, (Right) Lightening all highlights by raising the Light exposure adjustment

This ability to make open-ended adjustments to image contrast in different overlapping ranges of 
shadow and highlight tonality makes these controls uniquely suitable for HDR grading, while also 
being completely suitable when grading at SDR levels. Also, keep in mind that all contrast adjustments 
in the HDR palette keep saturation constant as contrast increases or decreases. 

This is particularly useful when making large contrast adjustments to HDR images, for which a 300 
nit expansion of highlight contrast using the Lift/Gamma/Gain or Log controls would create a huge 
saturation increase. Using the HDR palette to expand highlight contrast keeps image saturation 
perceptually the same, while offering zone-specific saturation controls that let you choose whether to 
increase or decrease the saturation falling within that zone.

Exposure adjustments to zones that overlap other zones are smoothly combined to allow targeted 
contrast adjustments, while making it relatively easy to avoid unwanted artifacts, like contouring or 
solarizing due to overzealous inversion of the curves caused by these operations. 

An Example of Zone-Based Exposure Adjustment
To see this in action, let’s see what happens when we make some overlapping adjustments to the 
Light, Highlight, and Specular zones in order to grade some HDR highlights, focusing our attention on 
the Waveform scope, since it’s difficult to see HDR grades in print. Keep in mind that you won’t usually 
be making Zone-based Exposure adjustments by themselves. This example image has had a Contrast/
Pivot adjustment to push the midtones and shadows down, to give the shadows greater definition. 
Then, Black Offset is raised to lift the darkest shadows up just a little bit, so they can breathe. This 
leaves us with an image that’s mostly under 200 nits to begin with. A perfect starting point for us to 
begin sculpting those highlights.

(Left) The original image; (Right) After changing Contrast/Pivot and raising Black Offset
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Using the default preset, making an exposure adjustment to the Light zone smoothly raises 
everything in the source image above -1 stops on the Zone graph. Practically, it’s stretching up all 
levels above 10 nits on the HDR scope. This smoothly boosts the brighter part of the image, while 
leaving the shadows down where we put them.

(Left) The previous adjustment; (Right) After raising Light Exposure

At this point, making an exposure adjustment to the Highlight zone boosts all levels above 1.5 
stops on the Zone graph. Again, practically speaking, all levels above 100 nits are being boosted, 
brightening the top highlights. In the image, you can see that we’re creating a greater differentiation 
between dimmer and brighter highlights in the image, creating highlight contrast with greater detail 
where once there were simply flat pools of light.

 

(Left) The previous adjustment; (Right) After raising Highlight Exposure

Now, this might be a fine place to stop, but since we’re interested in turning the HDR in this image 
up to 11, we can put the highlights over the top by making one more Exposure adjustment, to the 
Specular zone. The Specular zone starts at 4 stops and is designed to let you boost or attenuate 
only the very brightest, hardest highlights, likely corresponding to specular details such as chrome 
reflections, eye glints, and directly photographed light sources. You won’t always use this control, but 
it’s useful to know about.

In this example, the default Specular Zone Min Range control is outside of the available image data in 
the image (seen as the right edge of the histogram in the Zone graph), so making adjustments with 
this control won’t do anything. However, dragging the Min Range control to intersect the end of the 
histogram will allow these controls to affect the very brightest pixels in the image.
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(Left) The original distribution of zones in the Zone Graph; (Right) Dragging the 
Specular Min Range handle to intersect the brightest highlights in the image 
histogram, to allow the Specular controls to affect that part of the image

Now, the Specular Exposure control lets us push the very brightest pixels of our image up, 
further differentiating them from the other highlights, and widening the audience’s sensation of 
highlight contrast.

 

(Left) The previous adjustment; (Right) After raising Specular Exposure 
to bring the very brightest highlights to 1000 nits

Now, having selectively boosted the Highlight and Specular zones, you might decide that you like 
the differentiation that’s been created among different brightnesses of highlights, but the overall 
highlights are too bright. This is easily fixed by lowering the Light zone’s Exposure adjustment. As a 
result of this one adjustment, all of the highlights are scaled down, while the adjustments you’ve made 
to the Highlight and Specular zones maintain a relative influence on the parts of the image they’re 
brightening. The Shadow, Dark, and Black controls work similarly, but for the shadows.

 

(Left) The previous adjustment; (Right) After lowering Light Exposure, all levels 
smoothly scale down to reduce the brightness of the highlights while keeping the 
differentiation you’ve created with the Highlight and Specular controls.

Now that you’ve seen how all overlapping Zone adjustments work together to create a seamless 
adjustment, it’s time to look at the Zone controls in more detail.
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Zone Controls
Each individual zone also has controls for Color Balance and Saturation, which let you make focused 
adjustments that fall within specific ranges of image tonality, all without needing to use a qualifier. 
Using all of these zones together, you can make fast, precise, and smooth adjustments to the image 
that feel incredibly natural. Despite the name of the palette, this allows careful adjustment of SDR 
images, as well as creative adjustment of the spectacular range of highlights that HDR enables. There 
are also Range and Falloff controls to the left and right of each cluster of controls that let you redefine 
each zone’s area of influence, even if the Zone graph is hidden.

The Shadow and Light zone controls next to 
one another; you can see the Min and Max 
indicators, along with the Range value (in stops) 
at the upper left of each group of controls.

	— Range indicator: An icon and value at the upper-right-hand corner of each zone control cluster 
shows that zone’s range. A numeric value shows the range value, which is the Luminance level 
of image tonality at which that zone’s adjustment begins. This value is expressed in stops, while 
an icon shows you whether it’s a maximum range (affecting shadows) or a minimum range 
(affecting highlights).

	— Clicking the icon shows a temporary preview in the Viewer of which parts of the image will 
be affected by the controls of that zone. Affected areas appear in full color, while unaffected 
areas appear black.

	— Zone-specific Color Balance: A color balance control lets you readjust the relative strength of the 
red, green, and blue channels within the current zone of image tonality.

	— Zone-specific Exposure: Zone-specific Exposure controls work in conjunction with an 
adjustable pivot that defines the Luminance level that each exposure adjustment starts from. 
To accommodate both shadow and highlight adjustments, there are two kinds of pivots, labeled 
Maximum and Minimum range, and indicated using an icon. Max Range controls, such as the 
Shadow control, start at a maximum value with exposure adjustments stretching image contrast 
downward towards the shadows. Min Range controls, such as Light, start at a minimum value with 
exposure adjustments stretching contrast upwards towards the highlights. Each zone also has a 
falloff that specifies how much of that zone overlaps neighboring zones (starting at the pivot level) 
in order to blend overlapping adjustments softly enough to prevent contouring.

	— Zone-specific Saturation: Adjusts the intensity of color within the current zone of image tonality.

	— Min/Max Range: Defines the level of image tonality at which that zone’s adjustment starts. 
This value is expressed in stops. Identical to the Min or Max Range slider in the Zone panel. 
Useful for tweaking Range while the Zones graph is hidden.
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	— Zone Falloff: Defines how softly this zone fades into all overlapping zones. Identical to the 
Falloff slider in the Zone panel, the value is visible in the virtual slider below. Useful for tweaking 
Falloff while the Zones graph is hidden.

	— Zone-specific Color Balance Values: Two values expose the current color balance operation 
numerically. The option menu lets you choose between representing these as X and Y, 
or as Angle and Strength.

Customizing Zones Using 
the Zone Panel
Similarly to the controls of the Log palette, how these zones overlap can be adjusted in order to 
make each zone’s controls work best for the tonal distribution of the images in any given scene. 
Zone overlap is governed by individual pairs of Range and Falloff controls, so you can make precise 
adjustments no matter what the distribution of tonality is in the image you’re grading. All zones are 
organized and customized using the Zone panel, which is divided into the Zones sidebar to the left, 
and the Zone graph to the right.

The Zone panel of the HDR palette

The Zone Sidebar
The Zone sidebar show a list of all the zones in the current preset. This list is sorted by range values, 
with minimum range zones (affecting shadows) appearing at top and maximum range zones (affecting 
highlights) appearing below. Clicking any zone in the list selects that zone, which also selects that 
zone’s boundary handle in the Zone graph at the right.

Zone sidebar controls:

	— Enable Zone toggle: Toggles let you turn each zone on and off. Disabled zones will not 
be rendered.

	— Max/Min button: Defines whether the adjustment of a particular zone affects the image from the 
current range value and below (Max) or the current range value and higher (Min). This setting is 
typically used when creating your own custom preset, to define which zones stretch down toward 
the shadows and which zones stretch up toward the highlights.
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	— Show/Hide Zone button: This button lets you hide sets of zone controls you don’t want to adjust 
any further, leaving more room in the UI and on your control surface for the zones you do want to 
adjust. For example, if you decide you don’t need to use the default Black and Specular zones, you 
can hide them so that only the Dark, Shadow, Light, and Highlight zones are available to switch 
among. Zone controls with adjustments made to them continue to affect the image even if the 
controls are hidden.

	— Delete Zone button: Deletes that zone. This is primarily useful when you’re creating your own 
zone preset. At the time of this writing, you cannot delete any of the default zones found in the 
default Zone preset.

Additionally, you have the option of adding zones, and saving zone presets to create your own custom 
ways of adjusting the image.

To create a new zone:

1	 Open the Zones panel.

2	 Click Create Zone, at the bottom of the Zones sidebar.

3	 When the Create Zone dialog appears, choose the Zone type you want that zone to have (Dark/
Min Zone or Light/Max Zone), enter a Name, and define the Pivot and Falloff values. Pivot, Falloff, 
and Zone type are editable later, so don’t worry if you don’t set them up perfectly the first time.

The Create Zone dialog

4	 Click Create. That zone appears added to the list, which is sorted in the order in which Pivot is 
defined, with Dark Zones appearing at the top, and Light Zones appearing at the bottom.

Zones Graph
The Zone graph is a key component of the HDR palette’s use. Along the bottom, a scale in stops shows 
the range over which the HDR palette operates. At the top, handles let you adjust the editable range 
boundaries that define the tonal range of each zone’s operation, superimposed over a histogram 
showing the current image as input into the current node. Running through the middle of the Zone 
graph, a curve shows you all the Global and Tonal color and contrast adjustments being made by the 
HDR palette in the current grade.

The relationship of the range boundaries with the source image histogram in this graph is extremely 
important. The range boundary for a particular zone must intersect with the part of the source 
histogram you want to adjust for the controls of that zone to have any effect. If any zone boundaries 
lie outside of the histogram, that zone’s controls will do nothing. In the screenshot above, the zone’s 
range boundaries all lie inside of the visible histogram, so each zone’s controls will make a predictable 
adjustment to the image data in that part of the histogram.
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The Zone graph

In the following screenshot, the Zone graph shows that the Specular zone boundary lies outside 
of the source histogram for the image, so adjustments made using the Specular controls will have 
no effect. For this reason, it’s a good idea to check that the zone boundaries intersect the parts of 
the image you want to adjust prior to manipulating the controls, but if you notice that a particular 
zone’s controls aren’t having as much of an effect on the image as you’d like, you can always move 
the zone boundary after the fact to expand the range of the image that’s affected by that zone.

The Specular zone boundary lies outside of the source histogram, 
excluding the Specular controls from affecting the image.

Customizing zone boundaries in this way is one of the most powerful aspects of the HDR palette, 
but don’t worry that you’ll be constantly dragging zone boundaries back and forth for every shot 
you grade. Generally speaking, most well-photographed scenes have similar ranges of image 
tonality in each shot, so zone boundaries that have been customized for one shot from that scene 
will likely be good for most clips in that scene. That said, adjusting zone boundaries is another 
powerful way of tailoring a grade specifically for a clip with a unique range of contrast.
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Zone Controls

	— (Min/Max) Range: Defines the level of image tonality at which that zone’s adjustment starts. 
This value is expressed in stops.

	— Falloff: Adjusts how softly the adjustment in that zone will blend into the image. A value of 0 
results in an immediate transition to the adjustment created in the current zone, with the color 
adjustment being a sharper effect. Higher values will blend the current zone’s adjustment into the 
image more softly, resulting in a more gentle and seamless transition into the effect.

Customizing and Saving Presets
If you’ve customized the Zone graph in a way that’s potentially useful for other grading situations, 
you can save a preset of the Zone settings for future use. Saving, recalling, and managing these 
presets is simple.

Methods of managing presets:

	— To save a preset: Customize the Zone graph to suit your needs, then choose Save As New Preset 
from the HDR palette Option menu.

	— To load a preset: Choose Presets > Name of Preset > Load Preset from the HDR palette 
Option menu. A new preset will be saved.

	— To update a preset: Load a preset, make any changes you need to from the Zone graph, and then 
choose Presets > Name of Preset > Update Preset from the HDR palette Option menu.

	— To delete a preset: Choose Presets > Name of Preset > Delete Preset from the HDR palette Option menu.

	— To select the default preset: Choose Default Preset > Name of Preset from the HDR palette 
Option menu. This preset will now be the one loaded initially into the HDR palette on startup.

Resetting Color and 
Zone Adjustments
In the HDR palette’s Option menu, there’s a Reset submenu with three commands, Reset All, Reset 
Color Adjustments, and Reset Zone Definitions, which are self-explanatory. These are important 
because, during the course of developing a grade, there will be many times when you’ll want to reset 
your color adjustments without changing how you’ve customized the Zone graph, or vice versa.

Additionally, each of the visible reset buttons in the GUI can be used with keyboard modifiers to 
specifically target what to reset. The master reset button in the HDR palette’s title bar resets the entire 
palette when clicked (similar to the Reset All command). However, using keyboard modifiers while 
clicking this button changes what’s reset.

	— Hold down Command+Shift while clicking the master reset button to reset only the Zone graph’s 
Range and Falloff controls, without resetting your color adjustments.

	— Hold down Command+Option while clicking the master reset button to reset only the color 
adjustments, while leaving the zones alone.

Both of these modifiers also work with the zone-specific reset controls found in the Wheels panel, 
letting you reset only the Zone controls or only the Color controls of each specific zone.
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Using the HDR Palette With 
DaVinci Control Panels
To use the HDR palette with the original DaVinci Advanced control panel, press SHIFT + AUTO COLOR. 

To use the HDR palette with the DaVinci Advanced control panel’s 2020 layout, press HDR on the 
Trackball panel. 

Once selected on the Advanced control panel, all of the current control mappings will appear in 
the center panel soft buttons and rotaries, and the trackballs and control rings will be mapped to 
the appropriate zones. The < and > soft keys let you navigate among all the zones available in the 
current preset.

To use the HDR palette with the DaVinci Mini control panel, press the USER button, then press the HDR 
soft button above the left-hand display. All of the HDR palette control mappings will appear in the soft 
knobs and keys, and the trackballs and control rings will be mapped to the color balance and exposure 
controls of the appropriate zones. The PREV ZONE and NEXT ZONE soft keys let you navigate among 
all the zones available in the current preset.
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Chapter 131

Primary 
Grading Controls
This chapter focuses on the more esoteric adjustments you can 
make, mixing colors between channels using the RGB Mixer.

Contents
Introduction to the RGB Mixer Palette�   2924

Preserve Luminance�   2925

Resetting the RGB Mixer�   2925

Swap Channels Buttons�   2925

Using the RGB Mixer in Monochrome Mode�   2926
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Introduction to the 
RGB Mixer Palette
The RGB Mixer palette lets you remix different amounts of image data from one channel to another, 
and has a wide variety of creative and utilitarian uses. Furthermore, the RGB Mixer can be used 
either to remix the color channels, or to add different proportions of each color channel into a 
monochrome image.

RGB Mixer palette

By default, the RGB Mixer palette is set to mix any amount of the Red, Green, and Blue color channels 
into any of the other channels. Each color channel has a dedicated control group of Red, Green, 
and Blue sliders that you use to do the mixing, and the default values of these can be seen in the 
screenshot above.

Each slider has an overall range of –2.00 to +2.00. This means that you also have the option of 
subtracting any combination of color channel values from a particular channel. For example, you can 
lower the Red control group’s Green slider to –.24 to subtract 24 percent of the Green channel from 
the Red channel.
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Preserve Luminance
With the “Preserve Luminance” checkbox turned on, any channel adjustment you make is prevented 
from altering the luma of the image by automatically raising or lowering the other two channels to 
compensate. In the following example, you can see that when “Preserve Luminance” is turned on, 
lowering the Green control group’s Green slider results in the Red and Blue channels being raised by 
the same amount (as seen in the Parade scope). Conversely, raising a color channel’s slider ends up 
lowering the other two channels by the same amount to keep overall image luminosity the same.

The result of an RGB Mixer adjustment with “With luminance level preserved” turned on. 
You can see that lowering the green channel slider also raises red and blue.

Resetting the RGB Mixer
Clicking the Reset button at the top right-hand corner of the RGB Mixer resets each slider to its default 
position, where Red = 1.00 for Red output, Green = 1.00 for Green output, Blue = 1.00 for Blue output, 
and all other sliders = 0.

Swap Channels Buttons
A set of three buttons at the bottom of the RGB Mixer lets you easily swap two channels with one 
another. This can be useful as part of a creative look, or corrective in instances where two channels 
are accidentally reversed.

	— Swap Red and Green: Swaps these two color channels.

	— Swap Green and Blue: Swaps these two color channels.

	— Swap Red and Blue: Swaps these two color channels.
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Using the RGB Mixer in 
Monochrome Mode
When you turn on the Monochrome checkbox, two of the sliders within each Output group are 
disabled. This leaves the Red > Red slider, the Green > Green slider, and the Blue > Blue slider as the 
only available controls.

Keeping in mind that each of the color channels that makes up an image is itself a grayscale channel, 
the RGB sliders in Monochrome mode let you add different proportions of the Red, Green, and Blue 
color channels together to create custom grayscale versions of a shot.

Sliders at their default values when Monochrome mode is enabled

To understand why this is useful, let’s consider the default values of the Red, Green, and Blue sliders. 
To emulate the human eye’s sensitivity to the wavelengths of light, the Rec. 709 video standard 
defines an isolated Luma (Y’) component as consisting of 0.2126 of the Red channel, 0.7152 of the 
Green channel, and 0.0722 of the Blue channels added together. This can be seen in the default values 
(rounded to the nearest integer percentage) of 21, 71, and 7.

This is the standard method of deriving a black and white version of a color image, and in fact 
produces identical results to those obtained by setting the Saturation parameter to 0. 

However, there have traditionally been other ways of mixing the colors of life into different 
grayscale interpretations. For example, photographers often use colored filters in conjunction with 
black & white film stocks, such as a yellow/green filter to emphasize pleasing skin tone for lightly 
complexioned people. A much older example is the use of black & white film stocks with different 
sensitivities (old orthochromatic stocks were not sensitive to red wavelengths, recording only blue and 
green to create an image).
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Using the RGB Mixer with Monochrome mode turned on gives you the ability to mix your own 
custom blends of all three color channels to emphasize the creative characteristics you require. 
For instance, increasing the mix of blue and decreasing red and green can give skin tones a darker, 
metallic sheen. The following screenshots show multiple versions of the same image with different 
monochrome mixes.

Three monochrome mixes of the same image.  
The top image is the result of setting saturation to 0.

Like the parameters in Color mode, you can use the RGB Mixer’s Monochrome mode to subtract 
one color channel from the others, for even more creative effects.
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Chapter 132

Curves
The Color page has a powerful curves interface that provides 
controls for adjusting color and contrast with the Custom Curves, 
as well as a variety of “Hue” or “HSL” curves that let you make 
more targeted adjustments to hue, saturation, and luminance in a 
variety of ways.
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Introduction to Curves
The Curves palette, selectable via one of the toolbar buttons above the Center Palette panel of the 
Color page, has six modes that provide different curve-based methods of manipulating the color and 
contrast of an image. Each curve lets you adjust a customizable region of the image based either on 
image tonality (zones of lightness or darkness), hue (specific colors), or saturation (intensity of color). 
All curves can be adjusted using either the pointer, or knobs on the DaVinci Resolve Mini or Advanced 
control panel.

The Curves palette is color-space-aware when you’re using Resolve Color Management (RCM) or ACES. 
What this means is that the overall range of each curve better fits the overall data range of the current 
clip no matter what Timeline Color Space you’re using, for both SDR and HDR mastering. This makes 
curves adjustments easier, more specific, and a more consistent experience, no matter what your 
workflow happens to be.

TIP:  All curves in DaVinci Resolve can be used to affect the overall image, or limited 
to affect only a specific portion of the image as a part of a secondary operation using 
qualifiers, windows, imported mattes, or any combination of the three.

Adjusting Curves Using the Mouse
All Color curves in DaVinci Resolve use the following controls for basic on-screen adjustment using the 
pointer, controlled either with your mouse, pen, or other input device of choice.

Methods of adjusting curves using the on-screen interface:

	— To add a control point: Click anywhere on a curve. A control point is added at the position of 
the mouse where you clicked, and the curve is altered, if necessary, to match the new control 
point’s position.

	— To add a control point without altering the curve: Hold the Shift key down, and click anywhere 
on or around a curve. A control point is added to the curve at the position of the pointer where 
you clicked, but the curve is not altered.

	— To snap a control point to the neutral diagonal of the curve: (Custom curve only) Hold the 
Option key down while dragging any control point on the curve. A diagonal line appears indicating 
the neutral state of the image, and the control point will snap to it. When you release the Option 
key and then press the Option key again after releasing, the diagonal guide line disappears.

Snapping a curve’s control point back to its neutral 
position by holding down the Option key
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	— To remove a control point: Right-click any control point to make it disappear.

	— To reset a single color channel curve to a completely neutral setting: Click the reset button to 
the right of that color channel’s intensity slider.

	— To reset all color channel curves: Click the Reset Custom Curve button at the upper right-hand 
corner of the Curves palette.

By default, a control point influences the portion of each curve that falls between its neighboring 
two control points. 

Control point adjustments affect the entire portion 
of a curve between adjacent control points.

In the top screenshot, you can see that the control point at the position of the pointer is affecting the 
larger part of the curve that falls between the lower left-hand control point (which is there by default), 
and a user-created control point placed up within the highlights of the curve.

In the bottom screenshot, an additional control point to the left of the one being adjusted limits the 
area of the curve that is adjusted. By careful placement of additional control points, you can make 
extremely targeted adjustments to images using the Custom curves. 

This example highlights the importance of using control points to “lock off” portions of a curve at 
a neutral or nearly neutral position to prevent changes to specific portions of an image, even while 
using other control points to make changes. 

NOTE:  The HSL curves also have an optional adjustment mode using Bezier curves that will 
be covered in those sections.
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Sampling Images to Place Control Points on Curves
Another way you can add control points to curves is to move the pointer to the Viewer, and click 
to sample a color value and place a control point at the position on the currently open curve that 
corresponds to that value. This works with Custom, Hue, and HSL curves. 

Clicking on a feature  
of the image

Creates a control point on  
the currently open curve

Showing Picker RGB Values
While you’re dragging the pointer over the Viewer and looking for a feature to sample, you can enable 
a tooltip that shows you the RGB Value of the pixel under the pointer by right-clicking the Viewer and 
choosing Show Picker RGB Value to toggle this feature on and off. When you turn this feature on, the 
Show RGB Picker Values In submenu in the Viewer’s option menu has options for displaying either 8- 
or 10-bit tristimulus values.

The color picker tooltip 
that appears when you turn 
on Show RGB Picker Values

Curves Histograms
The Custom curves and HSL curves all show a histogram that represents the input of the currently 
selected Correction node, which you can use to guide your adjustments. The Histograms submenu 
of the Curves palette’s Option menu lets you choose to disable these histograms, or to switch the 
histograms between showing the input or the output of the node. If you switch to Output, the 
histograms will update to show you the result of your adjustments, at the expense of seeing the image 
data that the curve is actually working upon.

The Custom curves show a YRGB histogram:

The histogram appearing underneath the 
Custom Curves shows a YRGB histogram analysis
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Each Hue or HSL curve shows a histogram analysis of the two color channels that Curve acts 
upon: hue against saturation level, luminance against saturation level, or saturation level against 
saturation level, to give three different examples. In the case of Hue or HSL curves, these 
histograms make it easy to see which parts of the Curve controls will actually affect image data.

The histogram appearing underneath the Hue vs Sat curve 
plots all saturation levels at each value of hue

Custom Curves
DaVinci’s Custom curves provide smooth adjustment of each clip’s Y, R, G, and B channels. The Custom 
curve mode of the Curves palette is divided into two areas, the Curve Editor to the left, and the Curve 
controls to the right. The editor contains the actual Curve controls you use to adjust the image. 
The controls at the right let you choose which curves you’re adjusting, and adjust their intensity.

The Custom curves seen used to create a gentle “S” curve 
adjustment with four additional control points added

The Custom curves are useful for making more tonally specific, channel-by-channel adjustments 
to an image than can be accomplished using the Color Balance controls. They’re also useful for 
making strange and wonderful stylistic adjustments through unusual alterations to different 
combinations of color channels.

Although the ganged Custom curves appear to be a single curve control, the Custom curve editor 
is actually presented as a series of overlaid curves, and the YRGB curves all appear within a single 
editor. The default, neutral position of the Custom curves is a diagonal line that runs from the 
lower-left black point of the image through the upper-right white point. 
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The neutral diagonal position of the 
curve at which no adjustment is made

The horizontal axis represents the range of image tonality in the original image, from black (at the 
left) to white (at the right), while the vertical axis represents the range of alteration you can make. 
By adding control points to the surface of the curve and raising or lowering it at different regions, you 
are actually remapping the original horizontal “input” value of a color channel to an “output” value of 
your choosing.

Additional controls appear to the right of the curve editor itself. A top row of buttons let you select the 
curve corresponding to an individual color channel for isolated adjustment, while a vertical stack of 
four sliders let you adjust the intensity of each color channel’s curve.

The channel-editing 
buttons and curve intensity 
sliders appear to the 
right of the curve editor

Editing the Top and Bottom Control Points of Curves
You can also edit curves using the default two control points that the curve control starts out with in 
the Curve Editor. The Black Point control (at the lower-left) and the White Point control (at the upper-
right) let you expand and compress the video signal similarly to using the Lift and Gain Master Wheel 
controls in the Color Wheels palette. 

The Curve control at its original state The Black and White Point controls dragged 
to the right and left to expand the signal
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You can use the Black and White Point controls in the following ways:

	— Using the Black Point control: Dragging this control up makes a lift adjustment to raise the black 
point of the signal. Dragging this control to the right makes a lift adjustment to lower the black 
point of the signal.

	— Using the White Point control: Dragging this control down makes a gain adjustment to lower 
the white point of the signal. Dragging this control to the left makes a gain adjustment to raise the 
white point of the signal.

HDR Grading Using Curves
When using various grading controls in the Color page to grade wide-latitude images for HDR 
output, you may find it useful to enable the HDR mode of the node you’re working on by right-clicking 
that node in the Node Editor and choosing HDR mode from the contextual menu (only available in 
Resolve Studio). 

Using a node’s contextual menu to put that node into HDR mode

This setting adapts that node’s controls to work within an expanded HDR range. Practically speaking, 
this makes it easier to work with wide-latitude signals using controls that operate by letting you make 
adjustments at different tonal ranges such as Lift/Gamma/Gain, Custom Curves, Soft Clip, and so on.

Enabling Editable Splines in the Custom Curves
When the Curve palette is in Custom mode, you can choose Editable Splines from the option menu to 
expose Bezier spline handles on any selected control point, which let you make more precise curve 
adjustments whenever necessary.

Custom curve with editable splines enabled
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NOTE:  Beware of making curve adjustments that are too sharp, or with control points 
that are too close together, as they can introduce unwanted contouring within the image, 
causing flattening or solarization in parts of the image that you may not want.

Adding Default Anchors to the Custom Curves
You can also choose Default Anchors from the option menu of the Curve palette in Custom mode to 
place three additional control points on the curve, dividing the curve into five segments that affect the 
shadows, low midtones, medium midtones, high midtones, and highlights of the image.

Custom curve with Default Anchors exposed

Ganging and Unganging Custom Curves
By default, the Custom curves are ganged, so that curve adjustments affect a clip’s YRGB channels all 
together, resulting in an adjustment to image contrast that’s similar to using the Master Wheels in the 
Color Wheels palette. When making this type of adjustment, increasing contrast also increases image 
saturation, while reducing contrast also reduces image saturation. Since curves can be manipulated 
with greater specificity than the three Master Wheels, you can make much finer contrast adjustments 
using the YRGB curves than when using the Master Wheels only.

Turning ganging off lets you use the full power of Custom curves to alter the image. Unlike the Color 
Balance controls, each of which adjust all three color channels simultaneously, the Curve controls let 
you adjust each channel individually when Gang Custom Curves is turned off. 

To disable Custom curve ganging:

	— Click the Curve Edit button that corresponds to the curve channel you want to edit. Clicking any 
Curve Edit button highlights that curve to make it easy for editing when curves overlap one 
another. Once one or more curves is offset from the others, you can freely edit any curve by 
dragging its control points.

Custom Curve Edit 
buttons are to the 
left, the Gang button 
is to the right

2935Color  |  Chapter 132  Curves



To re-enable Custom curve ganging:

	— Click the Gang button to the left of the Curve Edit buttons.

Editing color channels via individual curve adjustments lets you make smooth color-channel 
specific corrections, or you can make radically individual adjustments to create a wide number of 
creative effects.

Turning off curve ganging lets you independently adjust each curve

TIP:  When curve ganging is disabled, the Luma curve allows you to adjust the Y channel 
by itself, which is similar to using the Y-only Lift/Gamma/Gain knobs of the DaVinci Resolve 
Micro, Mini, or Advanced Control Panels. When making this type of adjustment, increasing 
luma contrast results in a perceptual decrease of image saturation.

Copying Custom Curves From 
One Color Channel to Another
Even if you’ve unganged the Custom curves, you can still mirror one curve’s adjustments to another 
by copying it using the “Copy to Red/Green/Blue” commands in the Curve palette’s option menu. 

Curve Intensity Sliders
Four Curve Intensity sliders to the right of the Curve Editor, one for each channel, let you mix between 
the current curve’s effect on the clip, and the original state of the image before you altered the curve. 
The default Intensity of 100 results in that curve exerting its full effect on the image, while an intensity 
of 0 results in that curve having no effect on the image. The Intensity sliders provide an easy way to 
“split the difference” between a curve adjustment and the previous state of the image.

Lowering the Curve Mix slider 
reduces the effect of that curve’s 
adjustment on the image.
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YSFX Sliders
Each of the Custom curves (Y’, R, G, and B) has a vertical YSFX slider at the upper left-hand corner 
of the Curve Editor that lets you invert any or all color channels by any amount you want, to create 
different types of stylized effects.

Image with the Luma channel modified using the vertical YSFX slider

As with all other adjustments in the Color page, YSFX may be combined with Power Windows or 
HSL qualification to limit channel inversions to specific portions of the image for creative purposes.

Soft Clip
The Soft Clip controls consist of four sliders underneath the Curve controls of the Custom curves, 
and give you an interface for adjusting highlight and shadow soft clipping either overall, with 
Ganging enabled, or on a per-channel basis. The Soft Clip controls are intended to provide clip-by-clip 
adjustment, as opposed to the Generate Soft Clip LUT settings, which let you set one soft-clipping 
setting for the entire program. For more information on the Soft Clip LUT setting, see Chapter 4, 
“System and User Preferences.”

High and Low Soft Clip controls 
within the Curves palette

Soft clipping lets you apply a “knee” to any clipping that occurs at the upper or lower extremes of the 
image, and can be used to quickly ease off any unpleasantly harsh loss of detail that occurs as a result 
of blowing out the highlights or crushing the shadows too aggressively.

In the following example, the screenshot at top has had the highlights deliberately blown out by 
excessively boosting the highlight contrast. As you can see, the edges of the clipped area lack detail. 
The screenshot at bottom shows the same image with soft clipping increased for all three color 
channels. The result retrieves detail, compressing the highlights to bring the tops of each color 
channel back within the allowable range.
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Using High Soft Clip to pull highlight details into the viewable range

Ganging and Unganging Soft Clip Controls
Soft clipping can be simultaneously applied to all three color channels by enabling the Ganging 
control (on by default), or you can disable Soft Clip ganging to individually adjust each channel. For 
example, using soft clipping on individual channels can be useful for legalizing RGB out-of-gamut 
errors for channels that over- or undershoot your QC standards.

To disable Soft Clip ganging and edit soft clipping for individual color channels:

	— Click the channel control button corresponding to the color channel you want to edit, and then 
drag the sliders to create the desired adjustment.

To re-enable Soft Clip ganging:

	— Click the Ganging control to the left of the Soft Clip channel controls.

TIP:  Applying too much soft clipping to individual color channels may add an unwanted 
color tint to the corresponding highlights or shadows of an image. To avoid this, use the 
soft clipping parameters with ganging enabled to clip all three color channels equally.

Soft Clip Controls
Whether all channels are ganged or not, soft clipping is controlled via two sliders and two additional 
parameters for each color channel.

High
The High Clipping Point slider lets you adjust the maximum signal level above which the signal is 
clipped. Any pixels above the clipping level are made equal to the clipping level. 
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The High Clipping Point defaults to a digital level of 1023 relative to the DaVinci Resolve internal video 
scopes. Dragging this slider to the left causes the highlights of the image to clip at a lower level, 
resulting in lower, dimmer maximum levels. 

Selecting and adjusting  
the high clip

RGB Parade displays  
the clipped image

At the default position, no clipping occurs and image data that you push above 1023 on the internal 
scopes is preserved and passed through the image processing pipeline to subsequent nodes. 
For example, in the following two screenshots, the highlights in the screenshot at top are blown out 
raising the gain dramatically in Node 1. In the screenshot at bottom, a subsequent adjustment in 
Node 2 lowers the gain and retrieves all the previously clipped values.

The image is clipped using the Gain control in Node 2

The image data that was clipped in Node 1 is retrieved in Node 3 by lowering the 
Gain control. This illustrates the preservation of deliberately clipped data.
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However, if at any point in a node tree you drag the High Clip slider to the left, even by a single 
digit, all image data above the new clipping threshold is discarded from that node forward. In the 
following example, the High Clip slider in Node 1 is lowered. The result is that all clipped image data 
is discarded. As a result, when Node 2 lowers the gain, there is no image detail left to retrieve, and all 
three channels exhibit flattening.

Lowering the High Clip slider in Node 1 forces all image data above the new High Clip threshold 
to be irretrievably discarded. Clipped data cannot be brought back by subsequent nodes.

High Soft
The High Soft slider sets the threshold, below the clipping point, at which highlights begin to 
compress before hard clipping. At unity, no soft clipping occurs. As you raise this value, more and 
more of the clipped highlight values are compressed, rather than clipped, resulting in softer, more 
pleasant “glowing” highlights.

IMPORTANT:  Image data that was clipped “in camera” is not necessarily retrievable using 
the Soft Clip controls, although there may be some preserved overhead in the super-white 
highlights of Y’CbCr-encoded video data.

Low
The Low Soft Clipping Point slider lets you adjust the minimum signal level at which the signal clips. 
This defaults to a digital level of 0 relative to the DaVinci Resolve internal video scopes. Dragging 
this slider to the right causes the shadows of the image to clip at a higher level, resulting in lighter 
minimum levels, and a lower-contrast image with lighter (possibly milky) shadows.

Low Soft
The Low Soft slider sets the threshold, above the minimum clipping point, at which shadows begin to 
compress before hard clipping. At unity, no soft clipping occurs. As you drag this slider to the right, 
more and more of the clipped shadow values are compressed, rather than clipped, resulting in a 
softer, more pleasant rolloff in the shadows.
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The HSL Curves
Three sets of Hue curves, and additional Lum vs. Sat, Sat vs. Sat, and Sat vs Lum curves, let you make 
different types of curve-based alterations to the image. Whereas the Custom curves let you make 
adjustments to the color channels of an image based on tonality (for example, boosting the Red 
channel in the highlights while lowering it in the shadows), the Hue curves let you make adjustments 
to the hue, saturation, or luma of elements in an image based on their hue.

Curves controls including six-vector selection and bezier handle button

For example, you could use the Hue vs. Sat curve to selectively lower the saturation of everything 
that’s blue, while raising the saturation of everything that’s red.

You can use these curves to make adjustments similar to those made using HSL qualification, but 
with one critical difference. Curve adjustments are mathematically smoother than the matte-limited 
adjustments of HSL qualifiers, so it can sometimes be easier to make specific alterations that blend 
smoothly with the rest of the image, without the potential for artifacts at the edges of qualified keys 
that can sometimes defeat a seamless result. 

On the other hand, it is often easier to define more distinct boundaries between separate elements 
using HSL qualification. Only time and experience will help you determine which tools are best for 
which situations.
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Right–Original image, Left–the image as altered by the Hue vs. Sat curve shown above

Unlike the Custom curves, which default to a diagonal position where lower left represents the black 
point and upper right represents the white point, Hue and Sat curves are flat. In the case of the Hue 
vs. Hue/Sat/Lum curves, the horizontal range of the curve from left to right represents the overall 
range of possible hues, from red through green through blue and then cycling back to red.

Because the range of hues cycle smoothly from the left to the right edge, changes that affect the 
curve near the left boundary of these curves loop smoothly around to the right boundary, and vice 
versa, such that the left and right sides of the curve always move together (as you can see in the above 
screenshot).

IMPORTANT:  When using Hue curves, the range of hue that you isolate with control points 
is always relative to the RGB input connected to that node. That means if you change the 
hue of a shirt from blue to red using Hue vs. Hue and you then want to raise the same 
shirt’s saturation with the Hue vs. Sat curve within the same node, you need to add control 
points to the same range of blue for both curves.

Image Sampling for Hue and Sat Curves
There’s an additional way to use Hue curves in DaVinci Resolve. Whenever one of the Hue vs. Hue, Hue 
vs. Sat, Hue vs. Lum, Lum vs. Sat, or Sat vs. Sat curve tabs are open, clicking or clicking and dragging 
over any range of pixels within the Viewer area samples the hues and/or image tonality of that 
region of the picture, and automatically places three control points on the currently open curve that 
correspond to the range of color and contrast you sampled. This also works if you use the cursor from 
the DaVinci control panel with the fourth trackball to sample a range of color.

Additional Controls in the Hue and Sat Curves
While the Hue vs. Hue, Hue vs. Sat, Hue vs. Lum, Lum vs. Sat, and Sat vs. Sat curves can be adjusted 
similarly to the Custom curves, they have additional controls running underneath the curve graph.

	— Enable Bezier button: Turning this button on forces a curve to use Bezier control handles, rather 
than the default DaVinci Resolve Curve Control points, to manipulate each control point on the 
curve. With Bezier handles enabled, click any control point to reveal its two Bezier handles. Drag 
either handle to alter the shape of the curve at that control point.
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	— Six-Vector Color Patches: The Hue curves each have six buttons for automatically adding control 
points to manipulate the red/yellow/green/cyan/blue/magenta ranges of hue. Clicking any of 
these buttons adds three control points; two to define the outer range of hue to be adjusted, and 
a middle control point that you use to make the adjustment.

	— Input and Output (Hue Rotate/Saturation/Lum) fields: These two number fields correspond 
to the horizontal and vertical adjustment values for the currently selected control point. Click any 
control point on a curve to view or alter these values. The label of the second field depends on the 
curve that’s selected.

The following sections describe each available curve in more detail. Each type of curve is accessed by 
selecting the appropriate icon in the upper right of the Curve Palette.

Custom Hue vs. Hue Hue vs. Sat Hue vs. Lum

Lum vs. Sat Sat vs. Sat Sat vs. Lum

Hue vs. Hue
The Hue vs. Hue curve lets you change any hue to any other hue. In the following example, the image 
on the left is the unadjusted original. The image on the right has had the orange jacket shifted to an 
olive green via a set of three control points.

Changing the hue of the woman’s jacket using the Hue vs. 
Hue curve; Left–original image, Right–altered image

One excellent use of the Hue vs. Hue curve is to quickly and subtly alter elements that require only 
minor adjustments. For example, a sky that appears a bit too cyan can be made into a richer shade of 
blue with a small adjustment. 

Hue vs. Hue is also useful for making more radical changes to elements that might be too noisy to key 
successfully using the HSL qualifier controls. For example, red autumnal foliage blowing in the wind 
might result in a chattery matte, but you can use the Hue vs. Hue curve to change reds to greens, 
without having to worry about aliased matte edges giving your correction away.
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Hue vs. Sat
The Hue vs. Sat curve lets you selectively alter the saturation of any hue within the image. This is a 
terrific tool for creative effect, allowing you to quickly and easily boost the saturation of elements you 
want to catch the viewer’s eye, while reducing the saturation of elements you’d prefer the audience 
not dwell upon.

This can be extremely useful for legalizing over-saturated overshoots or undershoots during 
a QC pass. For example, desaturating reds that are off the charts while leaving everything else alone.

Lowering the saturation of the woman’s jacket using the Hue 
vs. Sat curve; Left–original image, Right–altered image

The Hue vs. Sat curve can also be a powerful tool for increasing the color contrast of images that seem 
lackluster and flat. By boosting the saturation of colorful elements that are distinct from the dominant 
palette of a scene, you can add variety to an otherwise monochromatic image.

Hue vs. Lum
The Hue vs. Lum curve lets you increase or decrease the lightness of elements of specific colors.

Darkening the woman’s jacket using the Hue vs. Lum 
curve; Left–original image, Right–altered image

This is a tricky curve to use with highly compressed footage, as it can quickly reveal artifacts in the 
image if you aren’t careful. However, if you’re working with very high-quality footage, this can be a 
great tool to darken specific hues to add richness and depth, or to lighten colorful elements to which 
you want to draw attention.
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Lum vs. Sat
The Lum vs. Sat curve is similar to the Custom curves in that alterations to the saturation of an image 
are based on user-definable ranges of image tonality, rather than hue. In the following example, 
the Lum vs. Sat curve is being used to decrease selectively the saturation of everything falling 
into the highlights and shadows of the image, while increasing the saturation of everything within 
the midtones.

In the following example, a vividly saturated treatment results in shadows that seem artificially 
colorful. Using the Lum vs. Sat curve, it’s easy to gradually desaturate everything below a certain 
range, with a nice smooth falloff.

This is an outstanding curve to use for creative effect, for example, slightly boosting saturation within 
the midtones while reducing saturation in the shadows to increase the depth of the darkest portions 
of the image. It’s also a great curve to use to solve QC violations. For example, if you have illegal 
saturation in the highlights of an image, you can use the Lum vs. Sat curve cleanly and smoothly to 
lower the specific values that are causing problems.

Selective desaturation in the shadows and highlights using the Lum vs. Sat curve;  
Right–original image, Left–altered image

Sat vs. Sat
The Saturation vs. Saturation curve lets you selectively manipulate image saturation within specific 
regions defined by the image’s original image saturation. Control points added to the left of this 
curve affect areas of progressively lower saturation, effectively letting you increase or decrease the 
saturation of lower-saturated features. Control points added to the right affect areas of progressively 
higher saturation, letting you increase or decrease the most saturated features of an image.
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Like all curves, this operation is extremely useful for stylizing the image. You can create custom 
vibrance operations, where you selectively increase the saturation of low-saturated regions of the 
image in different ways to give the picture more “pop.” It’s also an excellent tool for taking care 
of over-saturated areas of the picture when adhering to conservative QC requirements. You can 
specifically desaturate only the most over-saturated parts of the picture, without affecting similar 
hues at lower levels of saturation.

In the following example, you can see that the portion of the image with the highest saturation has 
been desaturated, while the rest of the image has been left alone.

Desaturating only the highest saturated elements in the picture  
by lower control points at the right of the Sat vs. Sat curve

Sat vs. Lum Curve
The inverse of the Lum vs. Sat curve, Sat vs. Lum lets you quickly adjust the luminance of pixels that 
falls within a particular range of saturation. This is useful for cases where regions of the image you 
want to make lighter or darker happen to coincide with an identifiably consistent range of saturation.

To help guide your adjustment, the histogram drawn for this curve lets you see how many pixels there 
are at each level of saturation found within the image, with the leftmost part of the curve representing 
minimum saturation, and the rightmost part of the curve representing maximum saturation. Seeing 
where the levels of saturation lie in the current image help you to quickly make targeted luminance 
adjustments when you sample the region of the image you want to adjust to add points to this curve. 

2946Color  |  Chapter 132  Curves



The Sat vs. Lum curve

In the following example, the right side of this curve is lowered so that the most saturated parts of 
the image become darkened. You might want to make an adjustment like this to emulate one of the 
properties of film, where highly saturated colors block more light from passing through the emulsion 
than less saturated colors. Or, you may do this in an effort to desaturate bright colors in highlights 
that might otherwise clip past maximum white. Or, you might do this to quickly darken highly 
saturated skies.

(Top Left) The original image, (Top Right) The highly saturated blue sky and sea reflections are 
darkened to a more intense blue by lowering the right part of the Sat vs. Lum curve (Bottom).
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Chapter 133

Color Warper
The Color Warper is a powerful tool for making both highly specific 
adjustments to particular things in the frame, and widely general 
adjustments to create unique looks. 

The two modes of the Color Warper each make it easy to simultaneously modify two different color 
attributes, either saturation and hue, or lightness and hue. This gives the Color Warper an advantage 
over curves, which only let you adjust one color characteristic at a time. In this chapter, you’ll learn 
how to use both modes of the Color Warper to perform a wide variety of tasks.
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Introduction to the Color Warper
The Color Warper palette is a mesh-based warping tool that, instead of warping the spatial location 
of pixels, warps one set of colors into another. Better yet, unlike the HSL curves, the Color Warper 
lets you simultaneously adjust two color parameters at the same time, within user-selectable regions 
of specific hues. These adjustments, made using a grid of draggable control points, automatically 
have a smooth falloff from the colors you’re warping to other colors that are locked into place. The 
smoothness of this falloff depends on the distance between the warp points that are being adjusted 
and other warp points that are locked in place to prevent change. 

The Color Warper, located in the center palette area

There are two ways you can use this tool. You can drag the control points in the grid to make highly 
specific image adjustments. More intuitively, you can click to sample the image, which selects the 
closest grid point that affects that color, and then drag to make an adjustment with that control point.

Clicking and dragging to sample skin tone in the Viewer to adjust that 
color’s control point on the Hue-Saturation warping grid

You can use this tool to make extremely specific adjustments to colors in an image, similar to what 
you might do with a Qualifier key or with the HSL curves. However, by warping the points using a grid, 
you can manipulate two color characteristics at the same time, adjusting both hue and saturation, 
or chroma and luma. In the following example, specific adjustments are being made to refine the 
woman’s shirt, to adjust her skin tone, and to manipulate the greens of the foliage in the shot. All three 
of these naturalistic adjustments are smooth and artifact-free by virtue of the Color Warper’s method 
of cleanly remapping color.
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(Top) The original image, (Bottom) Manipulating the hue and saturation 
of the grass using the Chroma-Luma controls

You can also use this tool to create wide-ranging stylistic looks for the overall image, bending the color 
in creative ways that other controls don’t. In the following image, the less saturated and neutral colors 
of the image are all warped towards a bluish-cyan, while the more saturated oranges are warped 
towards a saturated orange-red, to quickly create a stylistic treatment of the image.

(Top) The original image, (Bottom) Stylizing the overall image using the Hue-Saturation controls
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The Color Warper Interface
You can either use the Color Warper as it appears docked into the middle palette area, or you can click 
the Expand button to open the Color Warper into a floating window that you can make as large as you 
like, giving you more detailed control of dense grids of control points. For convenience, the examples 
in this chapter show the Color Warper side-by-side with the Viewer, in a floating window. While the 
Color Warper is open in its own window, the Color Warper palette button in the toolbar turns into a 
“re-docking” button, clicking it puts the palette back in the palette area below.

(Left) Clicking the Expand button opens the Color Warper into a floating window, (Right) 
Clicking the Re-docking button in the palette toolbar puts the palette back.

There are two overall regions of the Color Warper palette. At the left, the grid area has the actual 
warping grid with points you manipulate to make adjustments, while controls underneath let you 
choose the resolution of the grid and the color space in which it works. At the right, the control area 
provides all the tools, range controls, and feathering controls that are available for manipulating the 
warping grid in a variety of highly specific ways.

Using the Grid Controls to Manipulate Color
This palette has two modes; each lets you manipulate the colors of the image in different ways, 
and each has a different style of grid used for warping the different color channels that are 
affected. Learning how to manipulate the color warping points of each of these grids is central to 
understanding how this palette works.

(Left) The radial grid in Hue-Saturation mode, (Right) The two rectangular grids in Chroma-Luma mode

Dragging to Warp Colors
Despite the different shapes, each of these grids are manipulated in similar ways. Dragging a control 
point alters whatever color corresponds to that point, while the colors that surround this dragged 
point are also adjusted proportionally according to their location between the point being dragged 
and surrounding points that either (a) aren’t affected, or (b) are locked into place. Locked points 
prevent the colors at those points from being changed. By locking some parts of a grid and dragging 
other parts, you can create sophisticated hue-specific adjustments.
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The orange control point has 
been selected and dragged 
to make an adjustment. 
Control points with black 
outlines are locked in place 
and help prevent control 
points on the opposite side 
from being moved. All other 
control points between the 
selected and locked control 
points are stretched or 
squished depending on the 
selected point’s adjustment. 

The image above shows the three states of control points in the grid:

	— Orange: Selected points appear orange. You can select multiple points by Command-clicking 
multiple points, by dragging a bounding box over multiple points, or by using the draw selection 
tool to click and draw over any points you want to select. Once you’ve selected and moved a 
control point, it becomes locked to keep that adjustment in place.

Selected points appear 
orange; in this example 
four points are selected to 
move them all together.

	— Outlined: White control points with a black outline are locked. Locked points do not move 
automatically when nearby points are dragged, so locked points are important for preventing 
specific colors you don’t want altered from being changed, as well as for saving changes to points 
that you’ve adjusted. All adjusted points become locked. The outer corners of the Chroma-Luma 
grid are locked, as is the outer ring and center point of the Hue-Saturation web.

Locked points with black 
outlines keeping other 
colors in the image 
from being adjusted by 
the selected point
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	— White: White control points are neither selected nor locked, and will be stretched or squished 
when adjacent control points are moved.

Unlocked control points 
between a selected point 
and locked points (in this 
case the corners of the 
grid) will squish and stretch 
to warp an entire range 
of color as you drag.

While control points work much the same in either the Hue-Saturation or Choma-Luma modes, 
there are some important differences. The radial “spokes” of the Hue-Saturation wheel don’t 
influence neighboring spokes, so any adjustment you make to a control point on one spoke only 
affects the colors that fall between it and the two neighboring spokes that surround it. This means 
it’s not necessary to lock control points on neighboring spokes of this wheel-shaped grid to 
prevent them from changing.

Adjustments made to control 
points on one “spoke” of 
the Hue-Saturation wheel 
grid don’t affect those on 
neighboring spokes, which 
act as if they’re locked, 
even though they’re not.

Both the Hue-Saturation and Chroma-Luma warper grids lock the outer boundary of the grid. You can 
still drag these points to adjust them, but they can’t be unlocked and they won’t move automatically 
when you adjust other control points. The Hue-Saturation grid has an additional point locked right in 
the center, which keeps the neutral colors (black through gray and white) neutral.

TIP:  Dragging the locked center point of the Hue-Saturation grid lets you alter the color 
of the white point, while proportionally warping all other colors in the image to smoothly 
accommodate this change. This can be the starting point of a lot of different looks.
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Previewing Which Colors Are 
Warped By Each Control Point
If you press and hold the Option key while you click on a control point in the warp grid, you get a 
preview in the Viewer of which colors that control point will affect. Affected pixels appear in color 
against black, which represents all pixels that will remain unaffected by that control point.

Holding the Option key down while clicking a Color Warper control 
point shows a preview of affected pixels against black.

Sampling to Warp Colors
While it’s important to learn how control points in the grid are manipulated, the most intuitive way of 
working with this control is to use the pointer to click within the Viewer to sample a color you want to 
adjust, hold the pointer button down, and then drag to adjust the color. 

When moving the pointer in the Viewer, you’ll see a crosshairs moving around the warping grid that 
shows you the exact color on the vectorscope graph, while a yellow box indicates the control point 
that’s closest to the color you’re sampling that will be selected if you click. In the following example, 
positioning the eyedropper over the sky shows that clicking will select a control point close to the 
center of the grid.

Moving the pointer in the Viewer shows a preview in the warping grid 
of which control point you’ll select were you to click.

Clicking and dragging selects and then moves the control point corresponding to that color in the 
Viewer. As you drag the pointer, you’ll see the selected control point move in the same direction as 
the mouse while the colors of the image update in real time to show the adjustment you’re making. 
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Meanwhile, an arrow in the grid shows you the delta of the current adjustment. Moving a selected 
control point to another hue in the grid warps the original color to the new color.

Clicking and dragging moves the control point corresponding to that 
color in the grid to adjust the color and locks it into place.

You can also lock control points by sampling the image. Hold the Command and Shift keys down, 
and then click on the color or colors you want to lock in the warp grid to prevent them from being 
changed. This makes it easy to work directly in the Viewer to lock colors you don’t want to change, 
before adjusting other colors that you do want to change.

In the following example, Command-Shift-clicking on the woman’s shoulder locks the yellowish 
highlights falling on her uniform in place. Then, clicking and dragging a highlight on her face lets us 
push the highlights towards teal without losing the warmer highlights on her shoulder, all by sampling 
directly in the Viewer.

 

(Top) Command-Shift-clicking to lock the closest control point to a color on the 
warping grid you don’t want to change, (Bottom) Warping a neighboring color while 
the control point you just locked keeps that part of the image from changing

2955Color  |  Chapter 133  Color Warper



Resetting Grid Points
If, at any point, you adjust a point that you want to reset, simply right-click on that point to de-lock 
and reset it.

Grid Resolution Affects The Specificity 
and Quality of Adjustments
You can change the resolution of the grids in either Hue-Saturation or Chroma-Luma modes, using 
the controls at the bottom of the Color Warper palette, underneath the grid itself. Separate drop-
down menus let you choose the resolution of control points for hue and saturation, or for chroma and 
luma separately, although by default they’re linked together.

The two resolution controls found 
underneath the grid controls

By default, the Hue-Saturation grid has a resolution of 6x6, which is the lowest resolution available. 
The Chroma-Luma grid defaults to 6x6, but can be set lower, to 4x4. Low resolution warping grids 
make it easy to create broad color adjustments affecting large ranges of analogous color with 
smooth results. Additionally, lower quality media that’s 8-bit, with 4:2:0 chroma subsampling, and/
or highly compressed benefits from lower resolution warping grids to avoid artifacts and keep color 
adjustments smooth.

(Left) The Hue-Saturation grid set to a resolution of 6x6,  
(Right) The Hue-Saturation grid set to a resolution of 24x16

On the other hand, higher resolution grids let you make more specific adjustments to tighter ranges 
of color. However, this approach is more useful in projects using high quality media (10- or 12-bit, 4:2:2 
or 4:4:4 chroma subsampling, and minimally compressed) to avoid unwanted artifacts. If you’re using 
high-quality media, you’ll find you can use the Color Warper to make incredibly specific adjustments.
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You can set the default Hue and Saturation grid resolutions in the Color Warper’s Option menu by 
choosing Default Hue Resolution or Default Saturation Resolution and selecting your preferred 
resolution from the drop-down menu.

The Chroma-Luma grid set to a resolution of 6x6

The Chroma-Luma grid set to a resolution of 24x24

NOTE:  If you make adjustments with the grid at one resolution, it’s possible to change the 
grid to a higher or lower resolution, and your adjustment will be interpolated to fit the new 
grid resolution, although the resulting adjustment may change a bit.

You Can Warp Color in Different Color Spaces
A drop-down menu at the bottom right of the warping grid lets you choose which color space to use 
for manipulating the colors of the image. Different color spaces project the colors of the image into 
the two-dimensional warping grid in different ways, and some may make it easier to manipulate a 
particular image in the way you want by spreading out different ranges of color more widely.
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The color space found underneath the grid controls

The available color spaces are:

	— HSV 	— HSL 	— HSY 	— HSP

Hue – Saturation Controls
As the name implies, the Hue-Saturation mode lets you alter hue and saturation simultaneously. 
For most people, this is likely the most intuitive mode in which to work as the range of hues and 
saturation in the image is represented radially, just like the Vectorscope; in fact a Vectorscope graph of 
the image appears underneath the “wheel” grid of control points used to manipulate color. 

By default, dragging any point of this grid changes the colors immediately surrounding that point that 
are between the point being manipulated and adjacent “spokes” of the radial grid that either aren’t 
influenced by that point, or are locked into place. In fact, you can pull these radial control points well 
past the boundary of adjacent spokes of the grid to warp those colors to entirely different hues.

The selected control point being adjusted doesn’t 
affect points on adjacent columns of control points that 
stretch from the outer ring to the center of this control, 
even when the dragged point is moved all the way past.

When manipulating control points to alter color, adjustments are similar to pushing color around a 
color wheel. Moving a control point radially around the circumference of the grid changes the hue of 
the colors corresponding to that control point. Moving a control point closer to the center desaturates 
those colors, while moving a control point closer to the edge of the grid increases the saturation of 
those colors.

The following sections describe how the different tools available in this mode work to let you 
manipulate these radial control points in different ways.
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Tools
Each of the available tools let you manipulate control points on the warping grid in different ways 
when you click on them.

	— Selection Tool: The default tool mode. Selecting this tool lets you select control points either 
individually (by clicking on a single point or command-clicking multiple points) or collectively 
by dragging a bounding box over multiple points, and you can right-click on control points to 
de-select, unlock, and reset them. You can also Shift-click with this tool to lock points into place 
without moving them. This is the most useful tool to use when manipulating the image by clicking 
and dragging in the Viewer to sample a color and adjust it at the same time.

	— Draw Selection: Selecting this tool lets you make a selection of control points by clicking and 
dragging to draw over all the points you want to select. This is good for making large, but specific, 
selections of points.

	— Pin/De-Pin: Selecting this tool lets you pin multiple control points by either clicking on them or by 
clicking and dragging to draw over all the points you want to pin/de-pin.

	— Pull Points: Selecting this tool lets you make adjustments by clicking anywhere on the warp grid, 
even between points, to pull all neighboring control points towards where you clicked. This can be 
used to reduce color contrast within a specific range of colors.

	— Push Points: Selecting this tool lets you make adjustments by clicking anywhere on the warp 
grid, even between points, to push all neighboring control points within a particular proximity 
away from where you clicked. This can be used to increase color contrast within a specific 
range of colors.

Modifiers
Each of the Modifier buttons let you manipulate selections and selected control points on the warping 
grid in different ways immediately upon clicking each button.

	— Increase Falloff/Smooth Selection: If you’ve selected one or more control points, clicking this 
button expands the selection to include all adjacent control points surrounding the selection.

	— Decrease Falloff/Smooth Selection: If you’ve selected a group of control points, clicking this 
button shrinks the selection by deselecting the outermost ring of selected control points, leaving 
the inner control points selected.

	— Invert Selection: Clicking this button selects all unselected control points, and de-selects all 
selected control points. This is useful when you want to make separate color adjustments to both 
specifically selected halves of the warping grid.

	— Convert Selection to Pin: Clicking this button pins all currently selected control points.

	— Select/Pin Column: If you have one or more control points selected, clicking this button expands 
the selection to include all points on every column that have at least one selected point.

	— Select/Pin Ring: If you have one or more control points selected, clicking this button expands 
the selection to include all points on every ring around the center that have at least one 
selected point.

	— Select/Pin All, Deselect/Pin All: Clicking this button toggles the selected state of the entire 
warping grid on or off.

	— Reset Selection/Pins: If you have one or more control points selected, clicking this button resets 
their position to the original default position in the warping grid, without de-selecting them.
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Range
The Range control is a fast method of selecting multiple control points corresponding to a specific 
range of colors.

	— Range: A gradient shows the range of hues currently being presented in the warping grid. 
Dragging the left and right handles of the Range control selection box lets you automatically 
select all control points corresponding to the hues that appear within the selection box. This is a 
fast way of selecting all points within a range of colors for uniform manipulation.

Auto Lock Controls
The Auto Lock controls enables DaVinci Resolve to automatically lock a border of control points 
surrounding any control point you select and adjust, which makes highly-specific color adjustments 
easier to accomplish.

	— Auto Lock: Enables and disables this behavior.

	— X Points Border: Lets you set how many points away from the control point you’re adjusting the 
border of locked control points that restricts your adjustments is. How large an area this ends 
up being depends on how many points you choose, and on the resolution of the warping grid. 
At higher grid resolutions, the same points distance isolates a smaller region of color.

Smoothing Controls
The smoothing controls let you “ease off” an adjustment you’ve made by progressively moving one or 
more selected control points towards their original default position in the warping grid.

	— Smooth Chroma: Each click of this button rotates the angle of selected control points around the 
circumference of the circular warping grid towards their original position, bringing the hue of the 
adjusted colors closer and closer to the original hues of the image. Saturation is unaffected.

	— Reset Chroma: Resets the angle of all selected control points to the original hues of those control 
points. Saturation adjustments are unaffected.

	— Smooth Saturation: Each click of this button moves the position of a control point closer to its 
original position relative the center of the circular warping grid, thus bringing the saturation at 
that point closer to the original image saturation of the node’s input. Hue is unaffected.

	— Reset Saturation: Resets the distance from the center of all selected control points to the original 
image saturation at those control points.

	— Reset Luma: Resets luma to the original image values.
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Chroma – Luma Controls
The Chroma-Luma mode lets you alter the hue and lightness of colors in the image simultaneously. 
This may not feel like a particularly intuitive way of working, as the grid controls are overlaid on colors 
projected as different sides of an RGB cube. However, this enables some powerful adjustments once 
you get the hang of how multiple adjustments interact in this mode, as well as the power of locking 
control points to limit your adjustments to specific areas of the two grids.

Whether you’re sampling the image or manipulating the control points of this grid directly, dragging 
any point of this grid changes the color of the image corresponding to that point. Vertical adjustments 
change lightness, where up makes that part of the image lighter, and down makes that part of the 
image darker. Horizontal adjustments change hue, depending on which range of hues are shown in 
the two Chroma-Luma warping controls, and which of these you’re adjusting.

By default, only the outer four corners of this control are locked, so any adjustment you make to 
any control point pushes and pulls all the other colors throughout the image, depending on your 
adjustment. Working this way, multiple adjustments to multiple colors gradually pins different 
colors into place, with each adjustment warping the colors falling in between to maintain a smooth 
transformation from one adjustment to the next. This can be a good way to make an overall stylistic 
adjustment to the image.

The original image

The result of making multiple interacting color adjustments across the entire Chroma Luma grid

Another approach to using this mode is to make more targeted corrections by manually locking 
different colors in the image that you don’t want to adjust. You can do this by using the Selection tool 
and Shift-clicking any value in the Viewer, or by Shift-clicking any control point on the grid control. 
By locking colors you don’t want to change, you can focus on manipulating a more specific range of 
colors without altering the entire image.
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Alternately, this is where the Auto Lock controls really shine. When you turn these on, you can choose 
the type of region you want to affect (vertical column, horizontal row, or a square region), then choose 
how large a region of color you want to manipulate (one or two points away from the point that’s 
selected). Keep in mind that the current resolution of the warping grid also has an effect on how large 
the resulting region of color will be. Lower resolution grids will let you manipulate larger regions of 
color, while higher resolution grids will let you adjust a more narrow range of color.

The Auto Lock controls let you make highly targeted 
adjustments to specific sections of the warping grid.

Once these controls are enabled, simply clicking once on the image or warping grid selects a control 
point and automatically locks off the region of the grid you want to focus your adjustment on. In the 
following example, a medium-resolution grid is used in conjunction with the Auto Lock controls set to 
lock a 2-point rectangular region. So, clicking on the skin of the woman’s face and dragging adjusts a 
section of available reds within the locked-off region of the grid. 

Making a targeted color adjustment to a locked-off region of the Chroma Luma grid

The following sections describe how the different tools available in this mode work to let you 
manipulate these radial control points in different ways.

Axis Angle
When you’re in Chroma-Luma mode, an additional control appears underneath the warping grids, a 
slider named Axis Angle. Dragging this slider to the left or right changes the range of hues in each of 
the two warping grids that’s presented, letting you manipulate different ranges of color.

Tools
Each of the available tools let you manipulate control points on the warping grid in different ways 
when you click on them.

The Tools buttons
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	— Grid 1/Grid 2 tabs: Since the Chroma-Luma controls expose two grids representing two different 
ranges of hue and luma, these two tabs let you choose which grid will be manipulated when you 
sample the image in the Viewer, as well as which grid the Tools controls affect.

	— Selection Tool: The default tool mode. Selecting this tool lets you select control points either 
individually (by clicking on a single point or command-clicking multiple points) or collectively by 
dragging a bounding box over multiple points. You can also Shift-click with this tool to lock points 
into place without moving them, and you can right-click on control points to de-select, unlock, 
and reset them. This is the most useful tool to use when manipulating the image by clicking and 
dragging in the Viewer to sample a color and adjust it at the same time.

	— Draw Selection: Selecting this tool lets you make a selection of control points by clicking and 
dragging to draw over all the points you want to select. This is good for making large, but specific, 
selections of points.

	— Pin/De-Pin: Selecting this tool lets you pin multiple control points by either clicking on them or by 
clicking and dragging to draw over all the points you want to pin/de-pin.

	— Pull Points: Selecting this tool lets you make adjustments by clicking anywhere on the warp grid, 
even between points, to pull all neighboring control points towards where you clicked. This can be 
used to reduce color contrast within a specific range of colors.

	— Push Points: Selecting this tool lets you make adjustments by clicking anywhere on the warp grid, 
even between points, to push all neighboring control points within a particular proximity away from 
where you clicked. This can be used to increase color contrast within a specific range of colors.

Modifiers
Each of the Modifier buttons let you manipulate selections and selected control points on the warping 
grid in different ways immediately upon clicking each button.

The Modifier buttons

	— Increase Falloff/Smooth Selection: If you’ve selected one or more control points, clicking this 
button expands the selection to include all adjacent control points surrounding the selection.

	— Decrease Falloff/Smooth Selection: If you’ve selected a group of control points, clicking this 
button shrinks the selection by deselecting the outermost ring of selected control points, leaving 
the inner control points selected.

	— Invert Selection: Clicking this button selects all unselected control points, and de-selects all 
selected control points. This is useful when you want to make separate color adjustments to both 
specifically selected halves of the warping grid.

	— Convert Selection to Pin: Clicking this button pins all currently selected control points.

	— Select/Pin Column: If you have one or more control points selected, clicking this button expands 
the selection to include all points on every column that have at least one selected point.
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	— Select/Pin Row: If you have one or more control points selected, clicking this button expands the 
selection to include all points on every row that have at least one selected point.

	— Select/Pin All, Deselect/Pin All: Clicking this button toggles the selected state of the entire 
warping grid on or off.

	— Reset Selection/Pins: If you have one or more control points selected, clicking this button resets 
their position to the original default position in the warping grid, without de-selecting them.

Range
The Range control is a fast method of selecting multiple control points corresponding to a specific 
range of colors.

The Range control

	— Range: A gradient shows the range of hues currently being presented in the warping grid. 
Dragging the left and right handles of the Range control selection box, or dragging within 
the range control to set both boundaries, lets you automatically select all control points 
corresponding to the hues that appear within the selection box. Once you’ve set a range, you can 
move the range to the left and right by dragging the center of the selection. This is a fast way of 
selecting all control points within a range of colors for uniform manipulation.

Auto Lock Controls
The Auto Lock controls enables DaVinci Resolve to automatically lock a border of control points 
surrounding any control point you select and adjust, which makes highly specific color adjustments 
easier to accomplish. These are particularly useful in the Chroma-Luma warping grid.

The Auto Lock controls

	— Auto Lock: Enables and disables this behavior.

	— X Points Border: Lets you set how many points away from the control point you’re adjusting the 
border of locked control points that restricts your adjustments is. How large an area this ends 
up being depends on how many points you choose, and on the resolution of the warping grid. 
At higher grid resolutions, the same points distance isolates a smaller region of color.

	— Lock Column: Lets you choose to restrict your adjustment to affect all control points within a 
particular column of the rectangular Chroma-Luma graph. The width of this column is defined by 
the border width controls. This is useful when you want to primarily adjust the lightness of a range 
of colors, while making a small adjustment to hues.
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	— Lock Row: Lets you choose to restrict your adjustment to affect all control points within a 
particular row of the rectangular Chroma-Luma graph. The height of this row is defined by the 
border width controls above. This is useful when you want to primarily adjust the hue of a range of 
colors, while making a small adjustment to lightness.

	— Lock Region: Lets you choose to restrict your adjustment to affect all control points within 
a rectangular region surrounding the selected point. The is useful when you want to adjust 
a targeted region of color that corresponds to a well-defined feature of the image, such as 
a specifically colored hat, shirt, foliage, or skin tone. Smaller regions will make more specific 
adjustments than larger regions.

Smoothing Controls
If you’ve found that you’ve gone a bit too far with an adjustment and need to back off a little bit, the 
Smooth controls let you do so gradually, or start over if necessary.

The Smoothing controls

	— Smooth Chroma: Each click of this button moves selected control points left or right, back 
towards their original position, bringing the hue of the adjusted colors closer and closer to the 
original hues of the image. Luma is unaffected.

	— Reset Chroma: Resets the position of all selected control points to the original hues of those 
control points. Luma adjustments are unaffected.

	— Smooth Luma: Each click of this button moves selected control points up or down, back towards 
their original position, bringing the luma of the adjusted colors closer and closer to the original 
luma of the image. Chroma is unaffected.

	— Reset Luma: Resets the position of all selected control points to the original luma of those control 
points. Chroma adjustments are unaffected.
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Chapter 134

Secondary Qualifiers
Secondary correction describes isolating a specific part of the 
image, or a specific subject, using a key. 

Keys in DaVinci Resolve are grayscale images that define which areas of the picture you want to alter 
(in white) and which parts of the picture you want to leave alone (in black). 

Keys can be generated either using the controls in the Qualifier palette, by using a Power Window, or 
by importing an external matte, For more information on how to use external mattes, see Chapter 143, 
“Combining Keys and Using Mattes.” This chapter focuses on how you can use qualifiers to key a range 
of color values (similarly to doing a green screen key) in order to create a matte with which to do this 
kind of isolated adjustment.
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Secondary Qualifiers
This section covers the use of the Qualifier palette, which lets you pull a 3D, HSL, RGB, or Luma key, 
with which to isolate the correction you need. The Qualifier controls are fast and flexible when you 
need to isolate an irregularly shaped subject with a distinct range of color or lightness. Since you’re 
generating a key by sampling the image, there’s no need for tracking or keyframing, so in the right 
situation qualifiers can be your fastest solution. In the following example, the client likes the slightly 
cool treatment overall, but wishes that the skin tones were a little more vibrant. This is exactly the sort 
of situation where qualifiers can help out. Adding a second node, and using the 3D or HSL Qualifier to 
isolate the face makes it relatively simple to add color exactly where you want it.

Adding a second node and using HSL 
Qualification to isolate the skin tones 

The image with a simple primary correction 	 The final adjusted image 

Just about every control in the Color page can be limited using of the Qualifier modes available in 
DaVinci Resolve. This makes the Qualifier palette a jack-of-all-trades tool with 101 uses. A few practical 
examples include keying a red element that’s too intense for broadcast, in order to darken it or 
desaturate it; keying a range of green foliage, so you can shift its hue to a more attractive color; keying 
an actor’s skin tone in a commercial, to apply some selective softening to it; or keying a range of sky, in 
which to add blue.

The Qualifier palette is color-space-aware when you’re using Resolve Color Management (RCM) or 
ACES. This enables Qualifiers to create high-quality keys as you would expect, no matter what the 
color space of the original media is, or what Timeline Color Space you’re using, for both SDR and HDR 
mastering. This makes Qualifier isolations easier, and a more consistent experience no matter what 
your workflow happens to be.

Adding a Secondary Operation to the Node Editor
Any node can be switched between functioning as a primary correction, where the adjustments you 
make affect the entire image, and a secondary correction, where you’re adjusting a specific element in 
the scene. The only difference is that nodes being used for secondary corrections are limited using a 
qualifier, Power Windows, or an external matte.
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If you’re planning to add a secondary operation to the current grade, you’ll need to first add another 
node in the Node Editor. When pulling a key to qualify part of the image, it’s important to understand 
that you’ll be sampling the YRGB values being fed to that node from any previous nodes in the 
tree. That means that the state of the image being fed to a node you’re qualifying affects the key 
you’re pulling.

For example, if the image coming out of Node 1 is well saturated and has a neutral color balance 
with a wide range of colors, but the image coming out of Node 2 applies a low saturation, 
monochromatically orange color wash, you may find it more difficult to pull a detailed key from Node 2 
than you would from Node 1. 

Choosing your battles–the image coming out 
of Node 1 will be easier to key than the highly 
stylized image coming out of Node 2

This is important because you have the flexibility of determining from what image you want to try 
pulling a qualified key. By connecting the node that’s outputting the best YRGB image for the key 
you’re trying to create to the node you’re qualifying, you can control what you’re keying. 

For more information about choosing which node to use for setting up a qualifier, see Chapter 143, 
“Combining Keys and Using Mattes.”

The Qualifier Interfaces
The DaVinci Resolve Qualifier palette interface is straightforward. To the left, graphical controls above 
numeric parameters let you manually adjust what ranges of each color component contributes to the 
key you’re creating. To the right, Selection Range tools below let you define a key by sampling pixels of 
the image using the pointer, while below a set of Matte Finesse parameters let you alter the shape of 
the key that’s been pulled.

Qualifier palette with HSL controls selected
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The default qualification mode is the HSL Qualifier, which uses three color components, hue, 
saturation, and luma, to define a key. However, you can also use the RGB or LUM (Luma) qualification 
modes to pull keys using other combinations of color components. The LUM qualifier mode, in 
particular, lets you make targeted adjustments to specific ranges of image lightness. This is a 
technique employed by many colorists to alter color temperature within a specific range of image 
highlights or shadows.

Alternately, you can use the 3D qualifier to quickly and easily pull well-refined keys by drawing lines to 
sample colors from the image that correspond to volumes of color within a three‑dimensional gamut. 
While the underlying technology is sophisticated, all you have to do is to draw blue lines to sample 
colors you want to isolate, or red lines to sample colors you want to subtract from the isolation you’re 
creating, all of which automatically generate a high-quality key. Each line you draw adds a sample to 
the selection list; you can turn each sample off and on to evaluate its contribution to the resulting key, 
or delete samples that don’t make a positive contribution.

The 3D qualifier

No matter which qualifier mode you use, the Matte Finesse controls make it easy to refine 
the resulting key to be even cleaner and more usable. In some instances, you can even take a 
marginal key that would otherwise be unusable, and squeeze it into something useful using the 
Clean Black, Clean White, and Blur Radius controls.

Which Qualifier Do I Use?
The Qualifier palette’s four modes offer you the flexibility to use the best keyer for the job when it 
comes to isolating a range of color or brightness values. In some cases, keys that are difficult to pull 
using some modes are easier to pull using others. Here’s a brief summary:

HSL: In many instances, the HSL keyer is not as immediately accurate as the 3D keyer, 
and will include a broader portion of the image for any given sample. On the other 
hand, if the 3D keyer is not giving you satisfactory results for a particular shot, the HSL 
keyer can sometimes do a better job. Because of its interface, the HSL keyer makes it 
easier to “fine-tune” the range and softness of each individual color component that’s 
sampled, in order to improve the result. The HSL keyer also gives you the option of 
disabling color components that you don’t want to contribute to the final key, so that 
you can pull a saturation-only key, or a hue-only key, for instances where that may solve 
the issue at hand.
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RGB: The RGB keyer shares many of the limitations and advantages of the HSL keyer, 
but since you’re sampling and adjusting red, green, and blue color components, the 
specificity with which you can fine-tune the resulting key works much differently. 

LUM: The LUM keyer works specifically to isolate parts of the image based on image 
tonality, lightness, or darkness. This is the perfect tool when you’re trying to isolate 
highlights or shadows in the image, which let you solve a multitude of different creative 
and technical issues. The LUM keyer is identical to using the HSL keyer with the Hue and 
Saturation qualifier controls turned off.

3D: The 3D keyer is a good one to start with if you’re trying to isolate a range of color 
such as a blue shirt, a cyan sky, a performer’s skin tone, or the orange leaves of a tree 
in autumn. Its interface of drawing lines over the part of the image you want to isolate, 
coupled with its high quality and extreme specificity, make it a fast and accurate tool 
to use in a variety of circumstances. However, the 3D keyer always samples every 
color component of the image; it’s not useful when you want to isolate specific color 
components, such as luma only, or hue and saturation without luma. The 3D keyer’s 
greatest strength, the speed with which you can sample areas of the picture to include 
(or exclude) from the final key, is also occasionally a weakness with images where your 
initial samples aren’t giving you satisfactory results, because there aren’t many ways to 
fine tune the key as it’s being generated (although you can manipulate the result). On 
the other hand, for most images you would want to qualify, two or three samples is all 
you need, in conjunction with using the Matte Finesse controls to adjust the resulting 
key. If you need to do some compositing in the Color page, the 3D keyer also does an 
excellent job doing blue and green screen keying to create transparency, and has a 
built-in Despill control as well.

The following two sections provide an overview of how to use the 3D and HSL keyer modes in 
DaVinci Resolve.

Basic Qualification Using 
the 3D Qualifier
The 3D Qualifier mode offers a fast, simple way of pulling a key to isolate a range of color in the image, 
by drawing lines over the parts of the image you want to key. Each line you draw over the image adds 
to or subtracts from the cloud of values you’re carving out of a three-dimensional representation of all 
available colors; you don’t see this representation, but this “under the hood” functionality is what gives 
the 3D keyer its name.

The 3D keyer is a general-purpose keyer, letting you isolate any color you like. However, the 3D keyer is 
not good at pulling luma-only keys. If you’re looking to isolate a range of luma values in the image, you 
should use the LUM mode.
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To use the 3D mode to isolate a subject in the Viewer:

1	 Open the Qualifier palette, choose the 3D icon in the upper right and click the eyedropper.

2	 Click and drag across the part of the image you want to isolate to draw a line. Lines that add to the 
key are colored blue.

Drawing a line to create a key using the 3D qualifier

3	 To see the key you’re creating as you work, click the Highlight button in the Viewer Options toolbar 
at the top of the Viewer. As you draw the line, the viewer will update to show your current key in 
real time.

Viewing the key using the Highlight button

4	 If necessary, draw additional lines to add more of the image to the key you’re creating. Ordinarily, 
it’s a good idea to not to draw more then two or three lines to sample the part of the image 
you’re trying to isolate. A few long strokes are better than several short ones. Ideally, you want 
the key you’re pulling to have a somewhat soft edge, which makes it easier to use the Matte 
Finesse controls to fine-tune your result later on. If you draw too many lines to sample the 
image, the result can be a key with hard, jagged edges that can sometimes be more difficult to 
adjust later on.
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A hard-edged key created with three samples

5	 Alternately, if there are parts of the image that are included in the key that you want to omit, 
hold the Option key down and draw a line over these areas. You can see that Option-drawn lines 
are red, and these subtract areas from the key you’re creating. Again, try not to overdo drawing 
subtractive red lines, as you can end up with an overly hard-edged key that’s difficult to adjust 
using other controls in the next few steps. 7Additionally, you can still use power windows in 
conjunction with the 3D qualifier to exclude specific parts of the image.

Blue lines add to the key and a red line subtracts the 
grass from the key, as seen with the highlight turned off

6	 If you find yourself wondering whether a particular sample in the list at left is doing any good, you 
can click the color patch at the left of any entry in the list to toggle that sample off and on. If you 
decide you don’t need a particular sample, click the trash can button at the right to delete it.

Controls for toggling samples off and 
on, and deleting them from the list
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7	 When you’re satisfied that the key is good enough to start fine-tuning, stop drawing lines. It’s 
all right if there’s a bit of noise, speckling, or if there are small holes in the key you’re creating, 
because you can take care of these using the Matte Finesse controls.

A sampled key that’s ready for further refinement

Nearly every key you pull will benefit from some further “post-key” refinement. What this means is 
that, once you’ve created the best key you can procedurally through sampling the image, you can 
now adjust the resulting key itself, which is just a gray-scale image, to improve the isolated result. 
This is what the Matte Finesse controls are for.

Matte Finesse controls
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8	 The three most common methods of key refinement using the Matte Finesse controls are to 
increase Clean Black to fill in “holes” in the parts of the image you’re omitting (the background), 
increase Clean White to close holes in the part of the image you’re isolating (the foreground), and 
then use Blur Radius and In/Out Ratio controls to blur the edge of the key and push it in and out. 
Using these controls, you can vastly improve nearly any key without the need to endlessly readjust 
the Qualifier controls.

More information about using the Matte Finesse controls appears later in this chapter.

9	 When you’re finished, click the Highlight control to turn the highlight off, and make whatever 
adjustment you need. In this example, the orange of the helicopter will be adjusted using the Hue 
control to make it blue instead.

Adjusting the orange color of the helicopter to be blue instead

Basic Qualification 
Using the HSL Qualifier
The HSL qualifier is one of the most flexible tools in DaVinci Resolve. Using any combination of 
sampled hue, saturation, and luma, you can isolate different ranges of color and contrast for specific 
adjustment. HSL is a general-purpose keyer, meaning you can key any color you like; it’s not restricted 
to blue or green.

The most straightforward way to use any qualifier is to sample the image in the Viewer. A set of four 
controls let you sample pixels within the image in different ways. When you sample one or more 
pixels, the Hue, Saturation, and Luma values are analyzed, and set different ranges in each of the Hue, 
Saturation, and Luma qualifier controls. There are a number of different eyedropper controls available 
to control how you sample color in the image.
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	— Sample Eyedropper: The first control you use whenever sampling the image. It defines the initial range 
of the qualification; you must use this tool before any of the others. Clicking once with this tool selects 
a single pixel value, while clicking and dragging selects a range of image values that add together.

Color Picker 
button

	— Add/Subtract Color Range: These two controls let you add areas of the image to, or subtract 
them from, the currently selected inner range of values that define the core of the key. As with the 
eyedropper, you can click on single pixels, or drag over a range of color.

Add and Subtract 
color buttons

	— Add/Subtract Softness: These two controls let you redefine the softness that transitions from 
the inner range of the key, falling off towards the outer edge of the key. Just like the other controls, 
you can click on single pixels, or drag over a range of color.

Add and Subtract 
qualifier softness

NOTE:  When you select one of the sampling controls, it remains selected until you 
select another sampling control. If you select another clip in the Timeline, then click 
in the Viewer to sample a key and nothing happens, make sure that you select the 
Eyedropper control in the Qualifier palette.

If you’re working with the DaVinci Resolve onscreen interface, the easiest way to qualify a 
subject is to use the pointer in conjunction with the sampling controls.

Example image to qualify
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To use the HSL Qualifier mode to isolate a subject in the Viewer:

1	 Open the Qualifier palette, choose HSL from the mode drop-down, and click the eyedropper.

2	 Either click a pixel of the part of the image you want to isolate, or click and drag across a range of 
pixels within that subject.

Picking to qualify the ocean

3	 To see the key you’re creating as you work, click the Highlight button in the Viewer Options toolbar 
at the top of the Viewer. 

By default, the area of the image you’re isolating appears in color, while the area of the image 
being excluded appears solid gray. 

Viewer image with highlight turned on, isolated region 
appears in color, omitted region appears gray

Even though the highlight obscures the rest of the image, this doesn’t prevent you from using the 
sampling tools to select pixels you can’t see.

4	 To subtract from the inner range of the key you’re creating, click the minus Color Range control, 
and click or drag across the portion of the keyed image that you’d like to exclude.

5	 To add softness to the outer range of the key you’re creating, click the plus Softness control and 
then click or drag across the portion of the image you’d like to include as a soft edge.

Once you’ve finished using the range and softness sampling controls to refine the key you’re 
using to isolate the subject, nearly every key you pull will benefit from some further “post-key” 
refinement. What this means is that, once you’ve created the best key you can procedurally 
through sampling the image, you can now adjust the resulting key itself, which is just a grayscale 
image, to improve the isolated result. This is what the Matte Finesse controls are for.
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Matte Finesse controls

6	 The three most common methods of key refinement using the Matte Finesse controls are to 
increase Clean Black to fill in “holes” in the parts of the image you’re omitting (the background), 
increase Clean White to close holes in the part of the image you’re isolating (the foreground), and 
then use Blur Radius and In/Out Ratio controls to blur the edge of the key and push it in and out. 
Using these controls, you can vastly improve nearly any key without the need to endlessly readjust 
the Qualifier controls.

More information about using the Matte Finesse controls appears later in this chapter.

7	 When you’re finished, click the Highlight control to turn the highlight off, and make whatever 
adjustment you need. In this example, the saturation has been raised and the color balance 
changed to make the adjustment obvious.

Altered color balance of the ocean and sky
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HSL Qualifier Presets
There is a set of HSL Qualifier presets, or Six Vector presets, that 
you can use to isolate automatically a predefined wedge of color 
(green, blue, red, magenta, yellow, or cyan) or chroma intensity 
(chroma light, chroma dark, or both). These presets are available 
either from the Color > Presets menu, or using the DaVinci Resolve 
Advanced control panel. 

Selecting one of these presets automatically sets the HSL Qualifier 
to the corresponding range or color or lightness. Afterwards you 
can continue modifying the HSL Qualifier to suit your purpose. The Color > Presets menu

Using Highlight to See 
What You’re Isolating
The Highlight control at the top of the Viewer (revealed by turning on Viewer Options in the Viewer’s 
Option menu) lets you overlay a representation of the key you’re creating over the current image in 
the Viewer. Overlays are also mirrored to your video output, so they’ll show up on an external display 
as well, in the event that you’re hiding the onscreen Viewer.

There are two types of highlights with which you can evaluate a qualification you’re creating. Each is 
useful for different tasks.

	— Flat-Gray: The default highlight that DaVinci Resolve uses shows the selected portion of the 
image with the original colors, and the unselected portion of the image with a flat gray. It is useful 
for seeing the subject you’re isolating even while you’re adjusting the Qualifier controls, which lets 
you also see the color or contrast adjustments you’re applying at the same time.

Oranges qualified and highlighted
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	— High-Contrast: Pressing Option-Shift-H, you can show what’s called a “high-contrast” highlight, 
which should be familiar to you if you’ve used other color correction applications and plugins; 
it’s a more typical display wherein the selected portion of the image is white, and the unselected 
portion of the image is black. The high-contrast highlight is useful in situations where you need to 
eliminate holes in a key, or evaluate how “chattery” a key is since irregularities are easier to spot 
when divorced from the original image.

High-Contrast B&W highlighting

To enable or disable a highlight, do one of the following:

	— In the Viewer Options toolbar at the top of the Viewer, click the Highlight control, and choose the 
type of highlight you want from the buttons that appear at the right.

	— Choose an option from the Highlight submenu in the Viewer’s option menu; a regular 
Highlight is Shift-H.

To enable or disable a high-contrast highlight, do one of the following:

	— Choose Highlight > Highlight BW (Option-Shift-H) from the Viewer’s option menu.

To make high-contrast black and white the default highlight:

1	 Open the Preferences > User > Color window.

2	 Check “Mattes display high contrast black and white.”

3	 Click Save.

The next time you click the Highlight control in the Qualifier palette, the high-contrast highlight 
will display.

Using Highlight to Solo Nodes
There’s one other use of the Highlight control, and that’s to solo individual nodes in the Viewer and 
video out, rather than outputting the sum of the entire node tree. For example, if you’re trying to 
adjust a stack of nodes attached to a Parallel or Layer Mixer node, it’s difficult to see what you’re doing 
while adjusting one of the stack of nodes, because only the final result is being output. 
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However, if you turn on Highlight while you’re selecting a node with no key, then only the currently 
selected node is output, making it easy to view just one node as you adjust it. Just make sure you turn 
Highlight off before moving on, or you may confuse yourself.

Showing Picker RGB Values
While you’re dragging the pointer over the Viewer and looking for a feature to sample, you can enable 
a tooltip that shows you the RGB Value of the pixel under the pointer by right-clicking the Viewer and 
choosing Show Picker RGB Value to toggle this feature on and off. When you turn this feature on, the 
Show RGB Picker Values In submenu in the Viewer’s option menu has options for displaying either 
8- or 10-bit tristimulus values.

The Color Picker tooltip 
that appears when you turn 
on show RGB Picker Values 

Qualifier Parameters
Each of the Qualifier modes, except for the 3D qualifier, has parameters that correspond to the 
relevant color components for that mode, with which you can identify a range and softness, similar to 
using the sample tools. These parameters can be edited precisely with virtual sliders using the pointer, 
or using the knobs of a supported grading control panel. However, mouse and tablet users can take 
advantage of each qualifier’s draggable white overlays, for more direct adjustment. 

	— Drag the left and right edges of any qualifier control overlay to adjust the Low and High values (or 
the Width value of the Hue control). 

	— Drag the center of any qualifier control to change the center or to simultaneously change the Low 
and High parameters together. 

	— Option-drag the left and right edges of any qualifier overlay to adjust softness. 

These draggable controls work for the HSL, RGB, and LUMA qualifier controls (the 3D qualifier 
works differently).

Draggable qualifier controls
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HSL Qualification Controls
The HSL Qualifier is by far the most versatile mode of the Qualifier palette. It’s also the qualifier that’s 
easiest to understand, and the easiest to adjust by hand if you don’t feel the need to sample the 
image. By selecting range and softness for each of three different color components, hue, saturation, 
and luma, you can isolate a wide variety of colorful subjects, or ranges of image lightness and 
saturation.

The HSL Qualifier controls in close up

One of the HSL Qualifier’s key strengths, and one of its most underutilized features, is that you can 
enable or disable each of the three HSL components using the Hue, Sat, and Lum buttons, using 
toggle controls found at the left of each qualifier range control’s name. This lets you ignore specific 
color components, while focusing on others that are more important. 

For example, if you’re trying to isolate the saturated parts of an image, regardless of the hue or 
brightness, you can turn off the Hue and Lum qualifiers so that only Sat is used to sample the image.

Qualification with saturation only to isolate the most saturated portion of the picture
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The HSL parameters include:

	— Hue Center: Defines the center of the range of Hue being isolated.

	— Hue Width: Defines the width of the range of hue being isolated. Widening or narrowing this 
parameter widens and narrows the range of hue about the current Hue Center.

	— Hue Soft: Widens or narrows the falloff at both sides of the currently selected range of hue.

	— Hue Symmetry: Lets you selectively alter the angle of Hue Soft falloff at either the right or left 
side. Lowering this parameter makes the softness to the right of the hue range grow steeper. 
Raising this parameter makes the softness to the left of the hue range grow steeper.

	— Sat Low/High: Two parameters let you define the upper and lower range of saturation 
being isolated.

	— Sat Low Soft/High Soft: Two parameters let you define the upper and lower softness falling off 
outside the current range of saturation.

	— Lum Low/High: Two parameters let you define the upper and lower range of luma being isolated.

	— Lum Low Soft/High Soft: Two parameters let you define the upper and lower softness falling off 
outside the current range of luma.

RGB Qualification Controls
The RGB Qualifier mode lets you isolate range and softness in the Red, Green, and Blue channels of an 
image. While this is not necessarily an intuitive way of manually creating a qualification from scratch, it 
can provide a different way of isolating potentially trickier ranges of the RGB color space. 

If you start by sampling the image, then you can widen and narrow each color channel’s isolated 
range of values. In some cases, you may find it’s faster to isolate a specific range of continuous color 
by adjusting these controls.

RGB qualification controls

The RGB parameters include:

	— Red Low/High: Two parameters let you define the upper and lower range of the Red channel 
being isolated.

	— Red Low Soft/High Soft: Two parameters let you define the upper and lower softness falling off 
outside the current range of red.

	— Blue Low/High: Two parameters let you define the upper and lower range of the Blue channel 
being isolated.
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	— Blue Low Soft/High Soft: Two parameters let you define the upper and lower softness falling off 
outside the current range of blue.

	— Green Low/High: Two parameters let you define the upper and lower range of the Green channel 
being isolated.

	— Green Low Soft/High Soft: Two parameters let you define the upper and lower softness falling 
off outside the current range of green.

Luma Qualification Controls
The Luma Qualifier mode simply pulls a key from the Luma channel all by itself. It’s identical to the HSL 
qualifier with H and S turned off. This single-component keyer is more useful than you might think; it’s 
a common technique to isolate a range of highlights, midtones, or shadows throughout the image to 
alter the color temperature selectively. 

The Luma Keyer mode automatically disables the Hue and Saturation controls

Also, keep in mind that the luma component is the sharpest keyable component when you’re working 
with heavily compressed video. Keys that are noisy or chunky with HSL qualification may be sharper if 
you just use the Luma Qualifier, although you won’t be able to be chromatically specific.

The Luma Qualifier has four parameters:

	— Lum Low/High: Two parameters let you define the upper and lower range of the luma 
component being isolated.

	— Lum Low Soft/High Soft: Two parameters let you define the upper and lower softness falling off 
outside the current range of luma.

3D Qualifier Controls
As discussed earlier in this chapter, the 3D Qualifier works much differently than the other qualifiers in 
DaVinci Resolve. In this mode, drawing lines over parts of the image you want to isolate adds samples 
to the Sample list, some of which add to the key (when you drag with the pointer) and some of which 
subtract from the key (when you Option-drag with the pointer). While this functionality is very simple 
to use, there are other controls that are available.
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The 3D Qualifier mode

The 3D Stroke Pickers:

Picker: Chooses the initial color to qualify. Longer strokes will tend to give you a 
better key.

Picker -: Removes a color region from the qualifier; also available by holding down the 
Option key.

Picker +: Choses an additional color region to add to the initial qualifier.

Invert: Inverts the current key; qualified areas are then unqualified and vice versa.

Show Paths: A checkbox that lets you turn the visibility of the lines you’re drawing to 
sample the image on and off. Turning lines off does not affect the key in any way.

Auto-B/W Highlight: With this checkbox enabled, the viewer automatically switches to 
Highlight B/W mode while drawing a line, to better show you the resulting key in real time. 
When the button is released the viewer will switch back to its original viewing mode.

Colorspace: A drop-down menu that lets you choose whether you’re sampling colors in 
YUV colorspace, or HSL, HSP, or LAB colorspaces. YUV is the default, but if you find you’re 
not getting satisfactory results, you can reset the Qualifier palette and switch to different 
ones to see if that works any better.

Strokes list: A list shows each line you drew as a sampled entry. A color patch at the left 
shows you the average color you sampled; clicking the color patch lets you temporarily 
turn any color sample off to evaluate its contribution to the overall key. A plus or minus 
icon shows you whether that patch is adding to or subtracting from the key. The average 
red, green, and blue color values are shown next, and a trash can icon at the right lets you 
delete any sample from the list.
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The 3D Qualifier Modes:

Soft: Provides a softer edge to the key that is more forgiving of Chroma and Luma 
adjustments. The more gentle drop-off is suitable for situations like subtle light changes 
across a face. Use the Shadow / Midtone / Highlight Matte Finesse Controls in conjunction 
with this mode to fine tune the result.

Flat: The default mode. Each color selected is 100% keyed, and adjustments are made for 
small color variations. This is the ideal mode for chroma keying a green or blue screen. 
Additionally, turning up the Pre-Filter setting in the Matte Finesse controls can make for a 
smoother, flatter key.

Tight: Only keys the exact color picked, and does not apply any softening based on color 
ranges. You chose that exact color, and only that exact color. Single pixel sharpness levels 
are expected. This can be used for difficult keying jobs, requiring adjusting the filter and 
softness manually in the Matte Finesse Controls.

Luma: Functions similar to the Tight setting but ignores all chroma data. This mode is 
used for black and white footage.

Despill: If you’re using the 3D qualifier to pull a blue or green screen key to create 
transparency, this slider lets you adjust an automatic color correction that eliminates blue 
or green spill from the image, while retaining the image’s original color.

The 3D Qualifier Chroma and Luma Adjustments 
showing the colors selected in the Strokes List.

The Chroma and Luma adjustment section is dominated by the Color Space box and the Brightness 
Range. The Color Space box is laid out roughly in the same manner as the Color Wheels, with primary 
colors laid out around its edge. The exact colors and layout is determined by the Color Space that 
you choose in the 3D Qualifier. The Brightness Range is represented as a bar underneath the Color 
Space, with left being black and right being white. Inside the Color Space and Brightness Range lie the 
individual colors that you chose with the pickers in the Strokes List. The tools around the periphery 
adjust the colors within the box in various ways, allowing you to visualize changes to the key.
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The 3D Qualifier Chroma & Luma Adjustments:

Chroma Tolerance: Click and drag left and right to expand or contract the range of colors 
selected by the key.

Chroma Softness: Click and drag left and right to change the sensitivity to similar colors 
selected by the key. This determines whether the key is a hard cutoff or a soft selection of 
similar colors.

Adaptive Chroma Softness: Activating this icon allows the keyer to operate consistently 
in both highly saturated and desaturated regions of the image at the same time. The 
majority of the time you will want to leave this on. The exception is If you are having 
difficulty in manually adjusting chroma softness in Soft or Flat mode, then turning 
Adaptive Chroma Softness off will give you more range to work with. Adaptive Chroma 
Softness is automatically disabled in Tight and Luma modes, as it is contrary to the 
functionality of these modes.

X: Moves your selected color region within the color space, changing its chroma based on 
its horizontal position.

Y: Moves your selected color region within the color space, changing its chroma based on 
its vertical position.

Angle: Moves your selected color region within the color space, changing its chroma 
based on its rotation around the central origin point.

Low: Expands or contracts the dark areas of the key in the brightness range.

High: Expands or contracts the bright areas of the key in the brightness range.

Low Soft: Controls how well defined the low end of the brightness range is. 
This determines whether the key is a hard cutoff or a soft selection of similar 
brightness levels.

High Soft: Controls how well defined the high end of the brightness range is. 
This determines whether the key is a hard cutoff or a soft selection of similar 
brightness levels.

2986Color  |  Chapter 134  Secondary Qualifiers



Matte Finesse Controls
After you’ve used the sample controls and qualifier parameters to create the most useful key for 
your purposes, you may find that it has problems that cannot be overcome easily by the available 
adjustments. Issues such as chattery edges, holes, or noisy bits can sometimes be easily fixed 
using the Matte Finesse controls. These controls filter the output of the Qualifier controls and are 
adjustments that are made to the matte itself, so they may work well in some instances, and poorly in 
others, depending on what you’re trying to do.

The Matte Finesse controls 

Pre-FIlter
This slider attempts to clean up the image before colors are sampled. This adjustment can be useful 
when you have footage containing MPEG blocking artifacts.

Clean Black
Clean Black is a specialized operation that eliminates noise (seen as white speckling when viewing 
a high-contrast highlight) in the black area of a key that omits the regions of the image you don’t 
want to isolate, and shrinks the key by making the dark parts of a key darker the higher you raise this 
parameter, pushing dark gray areas of the key toward black. The practical result is that raising Clean 
Black lets you “fill holes” in the background portion of a key and erode translucent edges.

Before/after raising Clean Black, viewing the high contrast matte
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Black Clip
Raising Black Clip applies a “lift” adjustment such that translucent areas of the matte (gray areas when 
viewing a high-contrast highlight) are pushed towards black. The range is 0 to 100, with 0 being the 
default setting.

Before/after raising Black Clip

Clean White
Clean White is another specialized operation that eliminates noise (seen as black speckling when 
viewing a high-contrast highlight) in the white portion of a key that include areas of the image 
you’re isolating, and expands the key by making light parts of a key lighter the higher you raise this 
parameter, pushing light gray areas of the key toward white. The practical result is that raising Clean 
White lets you “fill holes” in the foreground portion of a key and grow translucent edges.

Before/after raising Clean White, viewing the high contrast matte

White Clip
Lowering White Clip applies a “gain” adjustment such that translucent areas of the matte (gray areas 
when viewing a high-contrast highlight) are pushed towards white. The range is 0 to 100, with 100 
being the default setting.

Before/after lowering White Clip

Blur Radius
In small amounts, blurring a key does well to take the edge off problem edges. However, blurring a key 
can also feather the edges of a key past the border of the subject you’re keying, with the result being a 
visible “halo” around your subject depending on the adjustment you’re making. The range is 0 to 2000, 
with 0 being the default. With such a large maximum blur radius, combined with the capabilities that 

2988Color  |  Chapter 134  Secondary Qualifiers



the In/Out Ratio provides in customizing the direction of spread, you can turn some pretty precarious 
mattes into surprisingly smooth and useful results.

TIP:  If haloing is a problem, you can try adjusting the In/Out Ratio parameter, or you 
may want to consider using the Qualifier Softness parameters to feather the edges of the 
key, instead.

Using the Blur parameters to soften the edges of a key

In/Out Ratio
Controls whether the “Blur Radius” is applied equally to the inside and outside of the edge of the 
matte (zero), applied only within the matte (negative values), or applied only outside the matte 
(positive values). Using In/Out Ratio can help eliminate fringing when using the Blur Radius parameter.

(Left) In/Out Ratio lowered so blurring ends at the edge of the matte and feathers inward, 
(Right) In/Out Ratio raised so that blurring starts at the edge of the matte and feathers outward

However, you can also use In/Out Ratio even in situations where no Blur Radius is applied at all. 
Raising In/Out Ratio will fill in small black holes in the matte, while lowering In/Out Ratio below 0 will 
eliminate speckling by pushing small white bits of the matte toward black.

(Left) In/Out Ratio controls lowered to expand holes in the matte, (Right) In/Out Ratio 
controls raised to fill in small black holes in the matte

Morph Operation
Lets you choose how you want to modify the alpha channel/key. You can choose Shrink or Grow to 
dilate or erode the edges of the matte with great accuracy. Or, you can choose Opening or Closing to 
plug or expand holes to clean up a ragged matte.
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(Left) A matte with small holes in the face, (Right) Mode set to Shrink, 
Morph Radius set to 3; used to close holes in a matte

Morph Radius
Combined with Morph Operation, this slider adjusts how much to shrink, grow, open, or close the 
edge’s key.

Denoise
Denoise provides a distinct way to post-process extracted keys to selectively reduce the noise in a key, 
getting rid of stray areas of qualification and softly filling holes in a matte.

Before/after raising Denoise, viewing the high contrast matte

Shadow
Adjusts key strength based on the darker parts of the original image.

Midtone
Adjusts key strength based on the midtones of the original image.

Highlight
Adjusts key strength based on the brighter parts of the original image.

Post-Filter
Performs a final clean-up of the key, using the original image for reference, useful for bringing back 
some fine detail in sharp edges or hair.
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The Many Ways to Invert a Key
Sometimes, you’ll need to isolate a subject or range of values in an image, and then make a change 
to everything else. One way to do this is to add an Outside node after the node in which you’ve 
created the key. This lets you make one set of adjustments to what you’ve keyed, and another set of 
adjustments to everything outside the key.

If you just need to make a simple adjustment, you can invert the key from within the Qualifier palette. 
However, there are three other ways to invert a key.

	— The Qualifier Invert button: Clicking this control simply inverts the key being generated by all of 
the controls within the Qualifier palette.

	— Key Palette Qualifier Invert: The Qualifier Invert control within the Key palette provides another 
control with which you can invert the key that’s generated by the Qualifier palette.

	— Key Palette Output Invert: The Output Invert control within the Key palette is notable because 
it inverts the sum of all keys applied within that node. For example, if you’re using a Qualifier 
in conjunction with a Window, the two invert controls mentioned previously will only invert the 
Qualifier key; the Window key remains unaffected. However, using the Output Invert control 
inverts the overall combination of the Qualifier key and the Window, all together.

Combining Qualifiers and Windows
This is covered in more detail in a subsequent section, but if you create a key using one of the 
Qualifier modes, and you then add a Window, the final key that’s output by that node is limited to 
the intersection of the Qualifier key and the Window. This makes it easy to use a Window to “garbage 
matte” out bits of a key that you don’t want, that can’t be eliminated by further adjustment of the 
Qualifier controls.

The woman’s skin tone is too close to other elements in the scene.
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A Circular Power Window is used to further isolate the woman being isolated.

Manipulating Keys Using 
Additional Nodes
If you need to make more adjustments to a qualified key than the Matte Finesse controls will allow, you 
can use the Node Editor to feed the key output of one node to the RGB input of another, at which point 
you can use all of the second node’s color adjustment controls to manipulate the grayscale image that 
constitutes that key, to improve it.

Connecting a key output to an RGB input, and then connecting the 
RGB output back to the next node’s KEY input again 

You can also use the Key Mixer node to combine multiple keys in several different ways, adding keys 
together, or subtracting them from one another, in order to create exactly the key you need. 
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Adding multiple keys together using a Key Mixer

For more information about these techniques, see Chapter 143, “Combining Keys and Using Mattes.”
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Chapter 135

Secondary Windows
Secondary correction describes isolating a specific part of the 
image, or a specific subject, using a key. 

Keys in DaVinci Resolve are grayscale images that define which areas of the picture you want to alter 
(in white) and which parts of the picture you want to leave alone (in black). 

Keys are generated either using the controls in the Qualifier palette, by using a Power Window, or by 
importing an external matte. For more information on how to use external mattes, see Chapter 143, 
“Combining Keys and Using Mattes.” This chapter shows you how to use Power Windows to create 
shapes with which you can isolate parts of the image in different ways in order to do these kinds of 
targeted corrections.
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Power Windows
Power Windows are another way of making secondary correction, being essentially shapes you can 
use to isolate regions of the image. Different controls let you use oval, rectangular, polygonal, or 
custom curved shapes. Because you can isolate regions of the image by drawing, Power Windows 
produce exceptionally clean results, with edges that can be precisely positioned and feathered to 
achieve a variety of effects.

Before/after Curve Power Window isolates the sky area for a targeted correction.

Power Windows (also referred to as simply “windows”) are excellent when what you need to adjust 
can be encompassed within a clearly defined geometrical area. For example, the oval of a person’s 
face, the front of a car, or a wide expanse of sky are all good candidates for windowed adjustments. 
A drawback of windows can be that they must be animated to follow whatever subject they’re 
isolating. Fortunately, this is where DaVinci Resolve’s powerful tracker comes in, making it easy to track 
Power Windows quickly and accurately to follow along with the subject being isolated.
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Circular Power Window to focus attention to the skin

DaVinci Resolve makes it easy to combine multiple Power Windows in different ways, to intersect 
with one another and create even more sophisticated shapes. For example, multiple windows can be 
added together, or one window can be used to cut out part of another window, which saves you from 
the need to make complicated keyframing operations to animate that window’s shape.

Multiple windows combined to isolate and mask the image.

This section covers the use of Power Windows, how to create and modify them, as well as how to 
combine multiple windows, and combine windows and qualifiers to create highly specific isolations.

Adding Nodes with Windows
As with qualifiers, you must first add a node to a grade’s node tree before you begin windowing a 
correction. This is because all of the windows within a particular node work together to limit that 
node’s grade. As a reminder, any node can be changed from a primary operation that affects the 
entire image, to a more targeted secondary operation, simply by turning on a window, using a 
qualifier, or enabling an external matte.

Serial nodes showing the window on Node 2
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If you don’t create a new node before creating a window, you’ll discover you’ve inappropriately 
changed a primary correction into a secondary correction. If you create a new serial node, you’ll then 
need to use the controls found within the Window palette to turn on a window to customize for your 
purposes. However, there are also a set of commands you can use to add serial nodes with a window 
already turned on, saving you a few clicks or button presses in the process.

To add a new node with a window already turned on:

	— Choose Color > Nodes > Add Serial Node + CPW (Option-C)  
to create a new serial node with a circular window.

	— Choose Color > Nodes > Add Serial Node + LPW (Option-Q)  
to create a new serial node with a linear window.

	— Choose Color > Nodes > Add Serial Node + PPW (Option-G)  
to create a new serial node with a polygonal window.

	— Choose Color > Nodes > Add Serial Node + PCW (Option-B)  
to create a new serial node with a Curve window.

When you add a node with a Power Window, the Window palette automatically opens up, 
ready for editing.

The Window palette

The Window palette is divided into three sets of controls: the Window list, the Presets, and the 
Transform and Softness controls.

The Window Palette Interface
Once you’ve created a node with which to apply a Power Window correction, you need to open the 
Window palette if it hasn’t been opened already.

To open the Window palette:

	— Click the Window palette button.

The majority of the Window palette is occupied by the Window list, within which you can create as 
many windows as you need for the task at hand. There are five types of windows you can create, each 
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of which has a different geometry. You can use these windows individually, or you can combine them 
to create even more complex shapes and interactions. The Window palette has four groups of controls 
that let you use these windows in different ways.

The Window palette with the Window list

	— Window list: A row of buttons at the top of this list lets you add new windows, which you can then 
customize as necessary. Each window in the list exposes an On/Off button that shows the shape 
type, a Layer Name field (blank until you add some text) that you can use to identify what each 
window is for, an Invert button, and a Mask button that governs how that window interacts with 
the other windows that are currently enabled (adding to other windows by default, or subtracting 
from other windows in Mask mode).

	— Transform parameters: Controls the overall size, aspect ratio, position, and rotation of the 
currently selected window. 

	— Softness parameters: Controls the edge softness of the currently selected window. Different 
window shapes have different softness options.

	— Option drop-down menu: The Option drop-down menu has commands for creating and 
modifying custom window presets for easy recall later, resetting windows, deleting windows, 
saving and managing window presets, and copying and pasting track data.

Using buttons along the top of the Window palette, there are five types of windows you can create:

	— Linear: A four-point shape that can be edited into any kind of rectangle or trapezoid you might 
need. In addition to the center and corner controls, you can also drag any of the four sides to 
change the shape.

	— Circular: An oval that can be shaped, sized, and feathered to solve an amazing number of 
problems.

	— Polygonal: A four-point shape that can be expanded with additional control points to create 
complex sharp-cornered polygonal shapes.

	— Curve: A Bezier drawing tool that you can use to create any kind of shape, curved, polygonal, or 
mixed, that you require.

	— Gradient: A simple two-handled control for dividing the screen into two halves, with options for 
the center, angle, and feathering of the shape. Good for fast sky adjustments.
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Managing Windows
To manipulate a window, first you need to create the type of window you want to use, or if you’ve got a 
group of windows created already, you need to select the window you want to work on.

Methods of creating and selecting windows:

	— To create a new window: Click the Shape icon button or click the Create Window button (at the 
top of the Window list) that corresponds to the window you want to create.

	— To select a window using the onscreen controls: Click anywhere within a window to select it in 
the Viewer.

	— To select a window from the Window list: Click the Shape icon button corresponding to the 
window you want to select. 

To delete a window you no longer want: 

	— Select a window, then click the Delete button.

To reset a window:

	— To reset one window to its default shape: Select a window, then choose Reset Selected Window 
from the Option drop-down.

Showing and Hiding Onscreen Window Controls
When you open the Window palette, the Viewer goes into Power Window mode. Enabling a window 
makes that window’s onscreen controls appear within the Viewer, and are mirrored to video out so 
you can see the window controls on your external display. If you like, you can change how and where 
the onscreen controls appear.

To choose whether onscreen controls are mirrored to video out, or disabled, 
do one of the following:

Choose an option from the Window Outline submenu in the Viewer’s option menu. There are 
three options:

	— Off: Hides the window outline on both the external display and the Viewer.

	— On: The default, shows the window outline on both the external display and the Viewer.

	— Only UI: Hides the window outline on your external display, but leaves it in the Viewer.

Press Option-H to toggle among all three of the above modes.

This command is a three-way toggle. The first use of this command hides the window outline 
on your external display, but leaves it in the Viewer. The second use of this command hides the 
window outline on both the external display and Viewer. The third use of this command shows the 
window outline on both the external display and Viewer.

TIP:  If you leave the onscreen controls visible in the Viewer, you may find that as you work 
you want to temporarily hide or show the onscreen controls in the Viewer so you can get an 
uncluttered look at the image you’re adjusting. You can quickly toggle any set of onscreen 
controls off and on without selecting Off in the menu by pressing Shift-` (tilde).
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Using the High-Visibility Power 
Window Outline Option
Ordinarily, Power Window outlines are white (for the center shape) and gray (for the softness 
shapes). However, sometimes this color scheme can be difficult to see, so the Color panel of the 
User Preferences has an option in the General Settings section called “High visibility Power Window 
outlines.” Turning this on sets Power Window outlines to be drawn as green (for the center shape) and 
yellow (for the softness shapes), to make these windows easier to see in certain circumstances.

(Left) Default window outlines, (Right) High Visibility window 
outlines enabled in the Color panel of the User Preferences

Window Transform Controls
Windows have transform parameters that are similar to those found in the Sizing palette. 
These parameters let you alter the window, affecting all of its control points together. 

Window transform controls

	— Size: Scales the entire window up or down. 50.00 is the default size.

	— Aspect: Alters the aspect ratio of the window. 50.00 is the default value, larger values make the 
window wider, and smaller values make the window taller.

	— Pan: Repositions the window along the X axis. 50.00 is the default position, larger values move the 
window to the right, smaller values move the window to the left.

	— Tilt: Repositions the window along the Y axis. 50.00 is the default position, larger values move the 
window up, smaller values move the window down.

	— Rotate: The default value is 0. Increasing this parameter rotates the shape clockwise, decreasing 
this parameter rotates the shape counterclockwise. 
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	— Opacity: Lets you vary the transparency of an individual window’s contribution to a node’s key.

	— Convergence: When “Apply stereoscopic convergence to windows and effects” is enabled in 
the General Options of the Project Settings, this additional Transform parameter appears that 
lets you create properly aligned convergence for a window placed onto a stereoscopic 3D clip. 
For more information about working with Stereoscopic 3D projects, see Chapter 15, “Stereoscopic 
Workflows.”

The transform parameters also correspond to onscreen controls found in the Viewer, which can 
be manipulated directly using the pointer.

Manipulating the window position on the Viewer

While many of the onscreen controls correspond to parameters within the Window palette, some 
onscreen controls, such as the control points that govern reshaping linear, polygonal, and Curve 
windows, are only adjustable via the pointer.

Onscreen controls for window transforms:

	— To select any window: Click on one of an arrangement of many windows to select it, making that 
window’s controls active.

	— To reposition any window: Drag anywhere within the window’s onscreen control. Window 
position corresponds to the Window palette’s Pan and Tilt parameters. For a gradient window, 
drag the center control point.

	— To resize a circular window while locking its aspect ratio: Drag one of the four blue corner 
points out to enlarge, or inwards to shrink. This corresponds to the Window palette’s Size 
parameter.

	— To squish or stretch a circular window, altering its aspect ratio: Drag one of the blue top, 
bottom, left, or right control points. These adjustments correspond to the Window palette’s 
Aspect parameter.

	— To rotate a window: Drag the top inner white rotate handle, in the middle of the window. 
For a gradient, drag the bottom arrow handle.

	— To alter window softness: Drag any one of the magenta softness handles. Different window 
shapes have different sets of handles, which correspond to the Softness parameters.

	— To reshape a linear window: Drag any of the white corner handles to corner pin the window, 
or drag one of the white top, bottom, or side handles to move an entire side segment of the 
window around.

3001Color  |  Chapter 135  Secondary Windows



	— To reshape a polygonal window: Turning on a polygonal window reveals a simple white 
rectangle with four corner control points. Click anywhere on the surface of the rectangle to add 
additional control points with which to reshape the polygon, and drag any control point to alter its 
shape. Polygonal windows are limited to a maximum of 128 control points.

	— To change the size and aspect of a curve: Shift-drag a bounding box around the control 
points you want to transform, and then adjust the corners of the box to resize the points while 
maintaining the aspect ratio of the shape, or adjust the top, bottom, left, or right points to squish 
or stretch the shape.

	— To remove control points from polygonal or Curve windows: Middle-click the control point you 
want to remove.

NOTE:  Removing a control point from a polygonal window that’s already been animated 
using the Keyframe Editor results in that point abruptly popping on and off at the 
keyframes creating the animation.

Window Softness
Each type of window has different Softness parameters, depending on how adjustable that window is.

	— Circular: A single parameter, Soft 1, lets you adjust the uniform softness of the oval’s edge.

	— Linear: Four parameters, Soft 1–4, let you adjust the softness of each of the four sides of the 
linear window independently. Magenta softness control points on the top, bottom, left, and right 
let you adjust the softness of each side of the linear shape independently.

	— Polygon: Two parameters, Inside Softness and Outside Softness, let you adjust the overall 
softness of a polygonal window. There are no onscreen softness control points.

	— Curve: Two parameters, Inside Softness and Outside Softness, let you adjust the overall softness 
of a curve. Using the onscreen controls, you can adjust the magenta inside and outside softness 
control points independently, creating any softness shape you need. 

	— Gradient: A single parameter, Soft 1, lets you adjust the uniform softness of the 
gradient window’s edge.

Drawing Curves
The Curve window is the only window that doesn’t display any onscreen controls when it’s first turned 
on. Instead, you must click within the Viewer to add control points, drawing your own custom shape to 
isolate whatever region you want.

Curve window to isolate a car
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TIP:  Turning on the Viewer’s full-screen mode can make it easier to draw detailed shapes. 
You can also zoom into and out of the Viewer while you’re drawing, using either the scroll 
wheel of a mouse or by pressing Command-Plus or Command-Minus.

To draw a curve:

1	 Turn on the Curve window style control.

2	 Click anywhere in the Viewer to start adding control points and drawing the shape you need. 

3	 Click and drag to add and shape Bezier curves, or just click and release to add a hard angle.

4	 To finish drawing and close the shape, click the first control point you created to create a corner, 
or click and drag on the first control point you created to create a Bezier curve.

Once you’ve drawn a curve, there are many ways of manipulating it.

Simple methods of modifying a curve:

	— To add points: Click anywhere on a curve to add control points.

	— To reshape a curve: Drag any control point to a new location. You can drag control points even 
while you’re drawing a new curve, selecting previously drawn points to move them, to adjust their 
spline handles, or to delete previously added points, without the need to finish the window first.

	— To move a curve: Drag anywhere within or just outside a curve to move it.

	— To symmetrically alter a Bezier curve: Drag any Bezier handle. The opposite handle 
automatically moves in the other direction.

	— To asymmetrically alter a Bezier curve: Option-drag any Bezier handle. The opposite handle 
stays in place while you drag the current handle. Once you’ve created an asymmetric pair of Bezier 
handles, they move together as one if you simply drag a handle. You need to Option-drag to 
change the angle.

	— To change a curve into a corner: Option-double-click any Bezier curve control point to change it 
to a sharp-angled corner point.

	— To change a corner into a curve: Option-click any corner point and drag to pull out a Bezier 
handle, changing it to a curve.

	— To remove points: Middle-click the control point you want to remove.

NOTE:  Removing a control point from a polygonal window that’s already been animated 
using the Keyframe Editor results in that point abruptly popping on and off at the 
keyframes creating the animation.

You can also Shift-drag a bounding box to select multiple control points on a curve to move, delete, or 
transform them all at once.
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You can Shift-drag a bounding box over multiple 
control points to manipulate them all at once.

To select multiple control points on a curve:

1	 Hold the Shift key down and drag a bounding box around the control points you want to 
manipulate or delete. All included control points will become highlighted.

2	 Do one of the following:

	— To move the control points: Drag anywhere within the bounding box.

	— To transform the control points: Drag one of the outer corners to resize all control points 
symmetrically, drag the top, bottom, or side handles to squish or stretch the control points 
relative to one another, or move the pointer to one of the corners until the rotate cursor 
appears, and then drag to rotate the control points.

	— To delete the control points: Press the Backspace key.

3	 When you’re finished, press the Escape key to deselect the control points.

Converting Linear, Circular, and Polygon Windows 
into Bezier Curves
If you start out isolating a subject using one of the simple Linear, Circular, or Polygon shape windows 
and you realize that you need a more complex shape to accomplish the task at hand, you can easily 
convert them to a more complex Bezier curve by choosing Convert to Bezier from the Window palette 
Option menu.

Before and after converting a circular window to a Bezier curve and 
adjusting the result, before adding softness to the edge
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Once you’ve converted a simple shape to a Bezier window, you can add control points and manipulate 
the shape in any way you need to make it better conform to the subject, just as you would with any curve.

Resetting the Window Palette
The entire Window palette can be reset using the Option menu’s Reset command.

Combining Power Windows 
with the Mask Control
Adding multiple windows to a single node is an easy way to create composite keys. When combining 
windows, the Mask control defines whether one window adds to another window, or subtracts from 
that window.

In the following example, Circular and Curve windows have both been created, and each window’s 
Mask control is also turned on (by default), resulting in both masks being added together so that the 
sunset look correction affects both the sky and the woman’s face.

The two images show the combination of the key mattes.

By turning the Mask control of the circular window off, the circular window is subtracted from 
the curve.

Turning off the Mask control of the circular window

Now, the woman’s face is being protected from the aggressive sky treatment.

3005Color  |  Chapter 135  Secondary Windows



The two images show the result of subtracting the circular window

Since windows can be individually tracked and keyframed, you can quickly set up complex interactions 
of windows to solve common problems you’ll encounter. For example, when you’re tracking a window 
to follow a moving subject that moves behind something in the frame, you can use a second window 
with Mask turned off to cover the object in front. Now, when the tracked window intersects the 
subtractive window, the correction will disappear along with the subject. 

You can also use the Mask control to create more complex shapes than you can with a single window.

Mattes and mask used together to make complex shapes

Furthermore, once you reach the limits of what shapes you can create using the four available windows, 
you can combine multiple nodes containing multiple shapes and qualifiers using the Key Mixer. 

Copying and Pasting Windows
If there’s a particular window you’ve created that you want to either duplicate within the current node, 
or apply to another node, you can copy and paste an individual window’s shape from one item in the 
Window list to another.

Methods of copying and pasting windows:

	— To copy a window: Click any enabled window in the Window list, then click the Window palette 
option menu and choose Copy Window.

	— To duplicate a window: After copying a window, create another window of the same type that 
you copied, and then click the Window palette option menu and choose Paste Window.

	— To paste a window to another node: Double-click or otherwise select another node, open the 
Window palette, choose the same type of window that you copied in the Window list, and then 
click the Window palette option menu and choose Paste Window.

	— To paste a window to the same node: Click any enabled window in the Window list, then click 
the Window palette option menu and choose Copy Window, then click Paste Append Window in 
the Window Option menu.
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Saving Window Presets
If you find there’s a particular window shape or combination of windows that you use frequently, you 
can save one or more windows as a preset for easy recall whenever needed. For example, if you’re 
working on a documentary within which you find you need to do a lot of face brightening, you can 
create preset face ovals for close-up, medium, and wide shots, to save you from having to customize 
a stock circular window for every single new shot. You can also save groups of windows together as a 
single preset, in order to reuse complicated multi-window shapes.

Window presets are available from a group of Presets controls in the option menu in the upper right-
hand corner of the Window palette.

Controls for saving, applying, and 
deleting window presets

Methods of working with Power Window presets:

	— To save a window preset: Once you’ve created one or more windows you want to save, click the 
Save as New Preset option in the Window palette’s option menu. Type a name into the resulting 
dialog, and click OK. That preset is now available in the Preset section of the option menu.

	— To recall a window preset: Click to open the Window palette’s option menu, and choose a preset 
from the list. Loaded window presets overwrite whatever other windows were set up in that node.

	— To update an already saved preset: Recall a preset, change the resulting window(s), then click to 
open the Window palette’s option menu. Select Update Preset, then select the preset name. This 
will overwrite the selected preset with the altered window arrangement.

	— To delete a window preset: Click to open the Window palette’s option menu, and choose Delete 
Preset, then choose a preset from the list. Make sure you chose the correct preset name; there is 
no warning before the deletion, and you cannot undo the deletion once it’s done.

Once recalled, windows created by presets can be modified and tracked just like any other window.

Using Windows and 
Qualifiers Together
Another use of windows is to act as a “garbage matte” when used together with a qualifier. By default, 
when you use a window and qualifier together, a key is only output where both the window and 
qualifier intersect. This makes it easy to exclude unwanted parts of a key that are too difficult to 
eliminate by further refinement of the qualifier controls.
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For example, the following qualification is intended to isolate the woman’s face, but some of the 
similarly colored wood and sky in the background is also included.

Instead of driving yourself crazy trying to eliminate the unwanted parts of the key by modifying 
the current qualification, which is doing a great job of isolating the skin tones, you could instead 
use a window to isolate her face, excluding everything outside the window, and simplifying your 
job considerably.

A qualified image with highlight on

If she moves, then you can simply track the window to follow. Simple tracking is covered in 
Chapter 136, “Motion Tracking Windows.”

Now with additional Power Window isolation

Furthermore, you can use the window’s Invert control to do the reverse, excluding all qualified 
portions of the key inside the window, and including all qualified portions of the key outside 
the window.

If you need to build more complex qualifier/window combinations than this, you can add more 
windows, or you can use multiple qualifiers and windows with the Key Mixer node, which is 
discussed in Chapter 142, “Combining Keys and Using Mattes.”
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Chapter 136

Magic Mask
The Magic Mask palette uses the DaVinci Neural Engine, guided 
by the user via a stroke-based interface, to automatically create 
detailed masks with which to isolate objects or humans, either 
whole or in part, to which you want to make secondary adjustments 
in DaVinci Resolve. 

This chapter describes how to guide these powerful features using the stroke and tracking controls 
found within this palette.
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Magic Mask (Studio Version Only)
The Magic Mask palette uses the DaVinci Neural Engine to automagically create a mask to isolate one 
or more people or object in the frame, guided by user-applied paint strokes to identify the subject for 
isolation. Masks can be generated for either an entire object, person, or for specific features of that 
person (their face, hair, arms, shoes, etc.). The following images show these two kinds of masks with 
Highlight enabled in the Viewer. A red onionskin overlay lets you see what Magic Mask is isolating.

(Left) Using Magic Mask to isolate an entire person, (Right) Using Magic Mask to isolate someone’s face 

Once the Magic Mask palette has generated a mask, Matte Finesse controls let you adjust the mask’s 
size and feathering. This lets you deal with difficult edges that might tip your hand depending on the 
kind of adjustment you’re trying to make.

While the masks generated by Magic Mask can often be good enough to use directly for making high 
quality isolated adjustments, it won’t always give perfect results. Keep in mind that Magic Mask is as 
much for the fast creation of detailed garbage masks as it is for doing direct isolation. 

In these cases, the Matte Finesse controls let you make the resulting mask softer and looser as 
necessary to clear the edge of a difficult subject you’re isolating with the help of another mask 
generation technique, such as a Qualifier key or window. When you use the Magic Mask palette 
within the same node in which you’re also creating a key in the Secondary palette, or a window in the 
Window palette, the key or window and Magic Mask are combined to output a boolean intersection. 
This means the isolation is limited to areas where both kinds of masks overlap one another.

(Left) Using Magic Mask to create a mask, (Right) Combining the Magic Mask with 
a circular window, the resulting mask is an intersection of the two

Objects can also be isolated by Magic Mask, allowing you to create complicated masks of complex 
shapes that may be difficult to isolate with other tools. For example, using the Magic Mask in Object 
mode to modify only the wood grain section of this guitar.
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(Left) Multiple strokes in Object mode isolating the wood grain of the guitar, while 
ignoring the musician’s arm, (Right) The finished shot, with a warmer wood grain

If you’re isolating specific features of a person, you can also mix and match what you’re isolating 
to create exactly the type of mask you require. For example, you might isolate the face, along 
with exposed skin on the torso, arms, and legs, to create a mask for creating an overall skin tone 
adjustment that doesn’t include the subject’s hair or clothes.

(Left) Using Magic Mask to isolate a face, (Right) Using Magic Mask to isolate all exposed skin

As described earlier, this whole process is guided by strokes you draw to identify the subject. In a 
typical workflow, you’ll draw short positive strokes (colored blue) over the person or feature you want 
to isolate. Then, if necessary, you can also paint short subtractive strokes (colored red) over parts of 
the image that are not the person or feature you’re isolating, to correct any problems you see in the 
generated mask.

Blue strokes identify a person or feature 
to isolate, while red strokes identify things 
that shouldn’t be included in the mask.
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Ideally, both positive and subtractive guidance strokes should be relatively short, and centered on 
the part of the person or object you’re trying to add to the mask. Stroke position is usually more 
important than stroke length, and in fact if you don’t like the result you’re getting in the mask with a 
particular stroke you’ve drawn, you can drag it to another position without redrawing it; strokes are 
live and can be selected using the pointer to move or delete them. 

Selecting a stroke with the pointer; 
selected strokes become highlighted.

Very long paint strokes aren’t usually that useful, and can be counterproductive later on when you’re 
trying to track strokes to follow motion in the clip. This is particularly true if a stroke needs to follow 
something that’s changing shape as it moves, like an arm. Furthermore, while you can make as many 
strokes as you like, fewer strokes work better than many strokes, and as a general rule you shouldn’t 
use more than five strokes to isolate a particular person or feature (nor should you need to).

As you work, each stroke shows up in the Stroke list, which lets you select, enable/disable, delete, and 
otherwise manage the different strokes you create to guide automatic mask generation.

(Left) Multiple strokes in Features mode isolating exposed skin, (Right) 
The Stroke list keeps track of all strokes you’ve made.

But what about camera and/or subject motion, you ask? After you’ve painted one or more strokes 
to guide the analysis, you can motion track these strokes to follow the subject throughout that shot 
using the stroke tracking controls within this palette. If you’ve made multiple strokes, they’re all 
tracked at once, and each stroke automatically follows along with whatever image details immediately 
surround that stroke, so there’s no setup necessary. You simply draw one or more strokes, then click 
the track forward or backward button. When you track a stroke, the tracking bar for that stroke in the 
Stroke list shows you which frames have been tracked (tracked frames are blue).
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Controls let you track all mask analysis strokes forward and backward through the shot.

Once you’ve added the strokes that are necessary to isolate the subject, and you’ve motion tracked 
them to follow along with the motion of the shot, a mask is automatically generated live for each frame 
of the shot. This is important to know because any change you make, adding or removing strokes or 
moving them manually, will alter the resulting mask on the fly.

What Magic Mask Is Good For, 
and What It’s Not
Keep in mind that the Magic Mask tool does not specialize in soft translucent mask edges, such as 
those created by the HSL, Luma, or 3D Keyers (when they’re used carefully). On the other hand, it 
excels at creating form-fitting masks that isolate human features in situations where a typical keyer 
does poorly. For example, Magic Mask can isolate exposed skin in shots where that person is standing 
in front of a background with wood, stone, or soil that inhabits the same ranges of color as that 
person. It can isolate beige clothes against a beige background. It can even isolate a person within a 
black and white clip. 

Once you’ve drawn one or more strokes to isolate a mask, a variety of controls let you adjust the 
resulting mask to better fit the subject, if necessary. Depending on the adjustment you’re making 
to the subject at hand, you may find that the keys generated using Magic Mask are sufficient to 
convincingly isolate the person you’re grading, particularly if you’re working in Better mode.

However, real world projects pose plenty of unexpected challenges. Keep in mind that, depending 
on what you’re trying to do, the resulting automated mask isn’t always going to be perfect enough to 
replace precise rotoscoping for intensive secondary color adjustments. However, it’s been designed to 
easily create tight-fitting garbage masks to use in conjunction with secondary keys or windows, with 
which to exclude the background around a difficult-to-isolate subject.

If you’re using Magic Mask to create a garbage mask, keep in mind that the Faster mode has been 
optimized to create looser masks more quickly for situations where you’ll be using it in conjunction 
with a keyer or window to isolate a specific area for special grading.
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TIP:  The Magic Mask palette can even isolate people in photos and paintings. However, 
figurative representations must have a minimal level of shadow rendering and anatomical 
detail for a figure or feature to be recognized. For this reason, cartoony or abstract 
representations won’t isolate very well.

The Magic Mask Interface
The Magic Mask palette is divided into three sets of controls: the Toolbar, the Stroke list, and the Mask 
Finesse panel. When you first open the Magic Mask palette, it’s empty, and you’re told to draw a stroke 
in the Viewer to create a mask.

The controls of the Magic Mask palette in Object mode

Magic Mask Toolbar
A toolbar at the top contains most of the interactive controls of the Magic Mask palette.

	— Object Mode: Selecting this icon puts the Magic Mask tool into Object mode for isolating subjects 
that are not people.

	— Person Mode: Selecting this icon puts the Magic Mask tool into Person mode for isolating people 
and parts of people. A tab control at the left lets you choose the type of mask you want created. 
There are two choices:

	— Person: For creating a mask to isolate as much of a person is visible, given the 
framing of the shot.

	— Features: For creating a mask isolating just someone’s face, or hair, or arms, for example. In 
Features mode, you can also combine multiple specific features into a single mask.

	— Tracking Controls: The following controls let you track all available strokes to follow camera or 
subject motion in the frame. From left to right, these include: 

	— Go To Reference Frame: Moves the playhead to the frame on which you initially drew the strokes.

	— Go To First Frame of Tracked Area: Moves the playhead to the first tracked frame of a range 
of tracked frames, in preparation for tracking backwards if there are untracked frames at the 
beginning of the clip.
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	— Track One Frame Backwards: Tracks one frame backwards and stops. Useful if you’re 
tracking frame by frame to watch the progress of a particularly complicated bit of motion. 
If something goes wrong, you can back up to the last frame where the stroke was able to 
properly track the subject, and drag the stroke to a better location using the pointer to make 
it follow the subject properly. If necessary, you can go a frame at a time, dragging the stroke 
to a better position every time it fails to follow the feature you’re using it to isolate.

	— Track All Frames Backwards: Continuously tracks from the current frame all the way to the 
beginning of the clip.

	— Stop Tracking: Stops tracking, in cases where there’s a problem with the track and you want 
to make a change.

	— Track Forwards and Backwards: Tracks from the current frame all the way to the end of the 
clip, then returns to the original tracking point and tracks backwards to the beginning of the clip.

	— Track All Frames Forwards: Continuously tracks from the current frame all the way to the 
end of the clip.

	— Track One Frame Forwards: Tracks one frame forward and stops. Useful if you’re tracking 
frame by frame to watch the progress of a particularly complicated bit of motion. If necessary, 
you can go a frame at a time, dragging the stroke to a better position every time it fails to 
follow the feature you’re using it to isolate.

	— Go To Last Frame of Tracked Area: Moves the playhead to the last tracked frame of a range 
of tracked frames in preparation for tracking forwards if there are untracked frames at the 
end of the clip.

	— Stroke tools: Two tools at the right let you choose whether to draw strokes to identify the feature 
you want to isolate or identify things that aren’t the feature in order to eliminate unwanted 
excursions in the resulting mask. The plus eyedropper adds an area to the mask; the minus 
eyedropper removes an area from the mask.

	— Invert Mask: A button lets you invert the resulting mask in cases where you want to use the 
feature analysis of this palette to isolate everything except the feature or features being analyzed.

	— Mask Overlay: Turns on an onion-skinned overlay with which to see what parts of the image are 
being masked alongside which aren’t, so you can continue to refine the result by adding, moving, 
or deleting strokes. The isolated part of the mask is tinted translucent red.

Stroke List
Once you start drawing strokes to identify features for mask generation, they appear in this Stroke list. 

	— Stroke list header: The header, at the left of the Stroke list, has controls for selecting, 
enabling/disabling, and naming each stroke (if you need that level of organization). Right-clicking 
any stroke in its header reveals controls to Reset Tracking Data and change the mask type 
(feature or not feature).

	— In Object mode, this is just a flat list of strokes, each of which help to either define the object 
you want to isolate, or the background.

	— In Person mode, this is just a flat list of strokes, each of which help to either define the person 
you want to isolate, or the background. 

	— In Features mode, an additional drop-down menu lets you choose which specific feature you 
want to identify with a guidance stroke. All strokes are sorted hierarchically by the feature 
they correspond to, so for example each Face stroke appears underneath a Face title bar. 
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The title bar for each feature has a toggle control that lets you turn that feature off and on. 
When off, you disable that feature’s contribution to the overall mask being generated.

	— Stroke timeline area: A Timeline ruler shows the duration of the current clip you’re creating a 
mask for. Each stroke in this list has a track that displays how many frames of each stroke have 
been tracked. As you track each stroke, these tracks fill up with colored bars to show which frames 
have tracking data. 

Tracks of strokes that identify a person or object are blue, while tracks for strokes identifying 
things that aren’t the feature are red. Using this timeline, you can keep track of which strokes need 
to be tracked, and manipulate the tracking data as necessary to obtain a useful result.

Mask Adjustment Controls and Matte Finesse
There are two sets of controls for refining the mask that’s output by the Magic Mask palette. The first 
set of controls, at top, let you adjust how the mask is generated based on the analysis data, which lets 
you refine the mask result based on characteristics of the image. These include:

	— Quality: Two options let you choose a tradeoff between quality and performance. Faster lets you 
generate a lower quality mask more quickly, that’s suitable for garbage matting. Better generates 
a higher quality mask with more detail, that’s more processor-intensive.

	— Smart Refine (Person Mode): This control lets you expand or contract the resulting mask 
based on the analysis of the image, such that expanding the mask doesn’t expand it deeply into 
surrounding parts of the image that aren’t connected to that person. This operation does not 
introduce softness. Instead, it enlarges or shrinks the overall mask generated by this palette. 0.5 is 
unity, 0 is the maximum amount of expansion, while 1 is the maximum amount of contraction.

	— Refine Range (Object Mode): This control lets you adjust the sensitivity of the resulting mask 
based on the analysis of the image. This lets you fine tune the mask to encompass more or less of 
the selected object. 30 is unity, 100 is the maximum amount of sensitivity, while 1 is the minimum 
amount of sensitivity.

A second set of mask manipulation controls are for manipulating the mask after it’s been generated. 
Most of these are the same Matte Finesse controls that are available in the Qualifier palette, which are 
useful for trying to fix issues with problem masks, or soften the edges when you need to have a more 
feathered result. For more information about the Matte Finesse controls, see Chapter 134, “Secondary 
Qualifiers.”. There is one additional control, however, that’s unique to the Magic Mask palette.

	— Consistency: After you’ve tracked each stroke to follow the subject over the duration of the clip, 
this setting lets you choose how much temporal smoothing is necessary to ameliorate jitter in the 
edges of the resulting mask in areas of low confidence, such as frizzy hair or translucent clothing. 
Higher settings apply more smoothing to the edges of the mask but are more processor intensive 
and may affect how closely the mask follows motion in the image. Lower settings will be faster 
and more accurate but may allow more edge jitter in the resulting mask, which can be distracting 
in the final adjustment you’re making. This parameter defaults to 0, so your first application of 
Magic Mask will always begin with the most accurate (and potentially most active) application of 
this feature’s analysis.
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IMPORTANT:  Consistency requires a stroke to have a duration of at least a few frames in 
order to function correctly. This requires you to track each stroke to follow the motion of 
the camera and subject in order to extend the duration of each stroke. Because Consistency 
is trying to eliminate one or two frame “noise” in the shape of the mask, strokes of short 
duration may end up having their effect eliminated.

Choosing What to Isolate
This section elaborates on the different choices that are available for isolation and offers tips for what 
each choice is good for.

Object Mode
Object mode is the easiest choice to make. Essentially, use this mode for any subject that is not a 
person. Subjects like cars, pets, and food are all good candidates for Object mode. The notable 
exception to this rule are items of clothing like shirts, hats etc. that are being worn by a human. Worn 
clothing is much better isolated in Person mode instead.

Drawing positive strokes in Object mode will select areas of similar contrast and color, allowing you to 
link complex shapes together. Generally you will need more strokes to actively define an object than a 
person, due to the greater variety of the shapes involved.

Drawing negative strokes in Object mode removes areas from the object that you don’t want to 
isolate. This can be something simple like removing the wheels of a car from a mask, or more 
complicated like removing specific books from a mask of a bookshelf.

Person Mode
When you choose Person, every stroke you draw over someone helps to isolate that person’s entire 
body, or however much of that person is visible onscreen. This includes all clothes that person is 
wearing, including their shirt, pants, shorts, dress or skirt, bathing suit, knickers, jumpsuits, hat, 
shoes, even armor or space suit (yes, we’ve tested both), whatever. Most clothing should be correctly 
identified as part of the isolation mask you’re creating. However, excessively flowing garments may 
need an extra stroke or two to identify them in complex visual compositions.

Drawing negative strokes, when in Person mode, will identify everything that’s not the person you’re 
isolating; this omits both the background and/or other people from the mask being generated. 
Drawing negative strokes isn’t mandatory; you only need to draw a negative stroke if you see a 
problem such as part of the background being included in the isolation mask.

Features Mode
When you choose Features, a drop-down menu appears at the top of the Stroke list. You must first 
choose the feature you want to isolate from this menu, and then draw strokes over the selected 
feature (face, hair, etc.) you want to isolate. Each feature’s collection of strokes can be turned on or off 
to add that feature to the overall mask being created.
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	— Face: Isolates just the face and ears, including eyes and glasses. This omits hair and the neck 
(which is considered part of the torso). Facial hair, particularly bigger beards, will usually be 
omitted from an initial stroke made on exposed skin of the face, so you can work on just the skin if 
you want. However, an additional stroke on the beard will include it in the face isolation.

	— Hair: Isolates just the hair, stopping at the bangs and ears, and omitting as much of the face as 
possible. Curly, frizzy, or wispy hair will produce oversized masks encompassing as much of the 
hair detail as possible. This tool does not create fine transparency. Fine and irregular hair detail 
can cause jittery edges, but this can be ameliorated using the Consistency control.

	— Torso (Exposed Skin): Isolates exposed skin above the waist and below the face, excluding the 
arms. This is the selection you want to enable if you want to isolate the neck, neckline, and any 
part of the chest that’s exposed when wearing v-necks, plunge necks, tank tops, crop tops, or 
bikini tops.

	— Clothing (Top): Any clothing above the waist. Exposed skin is omitted.

	— Clothing (Bottom): Any clothing below the waist. Exposed skin is omitted.

	— Arms (Exposed Skin): The exposed parts of arms or hands. Shirt and dress sleeves are omitted, 
as are sun sleeves.

	— Shoes: Most styles of shoes will be isolated.

	— Legs (Exposed Skin): Isolates exposed skin below the torso, excluding socks and leggings.

	— Hat: Most styles of hats will be isolated, although thin accessories such as streaming ribbons or 
feathers might not be included.

Remember, no matter what feature you’ve selected to isolate, you can always draw negative strokes to 
omit other parts of the person or their clothing that are erroneously being included in the mask.

IMPORTANT:  When you’re drawing strokes in Features mode, accidentally drawing a stroke 
over a feature other than the one that’s selected in the drop-down menu at the top of the 
Stroke list will result in a completely incorrect mask. If you see this happen, delete the 
stroke you just made, double-check which feature is currently selected, and either redo the 
stroke or choose the correct feature you want to isolate.

Identifying More Than One Person
In both Person and Feature mode, you can add strokes to identify more than one person, or more 
than one person’s features. There’s nothing special you need to do, simply draw strokes over each 
person you want to isolate, or over the same feature of each person you want to include (for example, 
drawing stroke over three people’s faces in Face mode).
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You can draw strokes over multiple people to isolate them together in the same mask.

Using Matte Finesse Controls
There are plenty of situations where a seemingly problematic mask can be improved using the Smart 
Refine and Matte Finesse controls at the right of the Magic Mask palette. If the mask is only a few 
pixels off, and the color adjustment you want to make is reasonably subtle, you can probably use Blur 
Radius and In/Out Ratio to create a soft edge that falls off just at the outer edge of the subject (so as 
not to create a halo effect) with which to make your adjustment.

(Left) The hard edges of the initial mask aren’t quite close enough to the edges of the 
woman’s arm to make a subtle adjustment, (Right) Using the Blur Radius and In/Out Ratio 
controls to create soft edges that don’t extend past the subject to make a useful mask

3019Color  |  Chapter 136  Magic Mask



Using Magic Mask as a Garbage Matte
In situations where the outer edge of a person is not being detected closely enough for Magic Mask 
to give a useful result for a more extreme color adjustment, you’re probably better off expanding 
the result into a closely-fitting garbage matte to use for isolating the person or features using other 
techniques, such as a keyer in the Qualifier palette. Even for this purpose, you’ll find using Magic 
Mask is typically faster than rotoscoping a relatively close garbage matte over a moving figure 
using windows.

(Left) The initial mask isn’t quite close enough to the edges to make an extreme 
adjustment, (Right) Using the Mode/Shape/Radius/Iterations/Blur Radius controls 
to expand the matte to be a garbage matte for use with other keys

Dealing With Hair
Wispy or frizzy hair, individual strands of hair being thrown back, and tips of dreadlocks or heavily 
moussed hair that comes to points will often require special handling with this tool. Keep in mind 
that the Magic Mask tool does not specialize in soft translucent mask edges like a keyer does. When 
it comes to hair styles that are loose and free, in many situations you may be able to finesse an 
acceptable result using the Matte Finesse controls to expand a softened version of the matte to 
encompass the entire hairstyle. 

If this interferes too much with the edges of other features of the subject you’re isolating, you can 
create a dedicated hair mask in Features mode by drawing Hair strokes. You can then use the Matte 
Finesse controls at the right of the palette to create softened edges that work well with the outer 
boundary of the hair style you’re isolating.

Creating a soft-edged hair mask

3020Color  |  Chapter 136  Magic Mask



At this point, you can try doing different color adjustments using two different correction nodes, one 
for the subject’s hair, and another using Magic Mask to isolate everything but the hair. 

Alternately, if you want a single matte with which to isolate the entire subject, you can then use 
additional instances of the Magic Matte tool (one per node), using one node to isolate just the face and 
body without the hair, and a third node to isolate the entire subject but with a very soft edge. Then, 
you can use a Key Mixer node to combine all these masks together with the original hair mask you 
created, with which to feed a complete key to another node used to make the correction.

(Left) Nodes 2, 3, and 4 are creating three different masks that are combined 
using a key mixer and connected to the Key input of Node 5 to make an 
adjustment, (Right) The final result of this three-mask approach.

While hair with soft edges can be a challenge, Magic Mask excels at many elaborate hair styles 
with detailed shapes and hair accessories, including jewelry and ribbons. For example, the stylized 
hairstyles found in European and Chinese period movies and shows give the DaVinci Neural Engine no 
trouble at all, particularly as these styles are usually tightly bound with no wispy hair.

Asymmetrical hairstyles may require extra strokes to identify hair that’s significantly longer on one 
side of the face. This may also be true for unorthodox hair styles, such as hair that’s been sculpted into 
distinct sculptural shapes. Lastly, tight braids that expose skin on the scalp are also challenging for 
the kind of hard masks that Magic Mask produces, so you’re better off using Magic Mask as a garbage 
matte and using a keyer to create a detailed soft mask to use in these instances.

About Hats
Magic Mask works with an incredibly wide variety of hats from all time periods. On hats, tassels or 
details like feathers can be a problem (in testing, the feather on Errol Flynn’s cap in Robin Hood 
couldn’t consistently be included, even though the cap itself was no problem). Additionally, veils 
that are part of hats may or may not be easily identified, but an additional stroke usually solves 
the problem.

Dealing With Accessories
Things that people are holding, such as handkerchiefs or umbrellas, are best selected in Object mode. 
Jewelry and watches pose a special problem, as they’re typically so thin and small that they can be 
difficult to omit, but you may not want to include them depending on the adjustment you’re trying 
to make. Your results will vary with the thickness of the items and the framing of your subject, but in 
general your results will probably be better if you simply add a stroke or two to include these items in 
the isolation, since omitting fine detail like a necklace can be problematic.
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Adding Strokes to Guide 
Mask Creation
Here are some tips for how to draw strokes to analyze the image. To identify people, try starting with a 
single short positive stroke (blue), centered on the face or body. 

Drawing the first stroke to identify an entire person

Depending on the result, more strokes may be needed to differentiate an arm or frizzy hair from the 
background. If you’re adding a stroke to an arm or hair, don’t put it right at the edge; the goal is not to 
trace the subject, but to use strokes within the body of the subject to clarify what features belong to 
the subject, and which do not. 

Adding a stroke to the arm to include it as well

As you do this, resist the urge to use too many strokes. One stroke might well be all you need, or you 
might need two or three, but using more than five strokes for any subject or feature may cause more 
problems than it solves.
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Adding negative strokes to the reflection to remove

To identify faces, try starting with a single short stroke in the middle of the face, along the nose, or 
from eyes to the lips. Depending on the result, you may need additional strokes to identify the chin, a 
beard, or to distinguish the forehead from wispy hair.

Drawing strokes to identify a face; notice that additional strokes are needed to include the beard.

It’s a good idea to start with a single stroke, then track the stroke through the duration of the clip 
(described later in this section). Over the entire clip, you’ll see which parts of the mask may exhibit 
problems. This will guide where you put additional strokes, in order to more clearly identify the person 
versus the background, in order to clean up the resulting mask. As you add additional strokes, track 
those as well and see how things go.

If you notice parts of the background that are erroneously added to the mask, you can add a negative 
stroke (red) to clarify that those parts of the image should not be isolated. Short strokes, longer 
strokes, and zig zags are good for backgrounds. Since strokes just help the analysis update the mask, 
you can try different types of strokes to see what works best, and delete any stroke that doesn’t give 
good results. As with positive strokes, don’t use more strokes than are absolutely necessary to get the 
result you want.

3023Color  |  Chapter 136  Magic Mask



(Left) The microphone incorrectly identified as part of the woman being 
interviewed, (Right) Drawing negative strokes to identify the microphone as 
background, using a zig-zag pattern to tag the entire microphone

Similarly, if you’re isolating features such as a face, and you find other features, such as hair, getting in 
the way, you can draw a negative stroke on the hair to identify it as not part of the face.

If there’s a “hole” in the resulting mask that’s actually part of the background and not the subject, you 
can try drawing a stroke connecting that hole to the rest of the background.

Drawing strokes to connect the background with itself, to remove 
part of the mask that’s not part of the person

If there’s an “island” in the mask that’s actually part of the subject and not the background, you can try 
drawing a stroke across the island that connects one solid part of the mask to itself.

Drawing strokes to fill an island in the subject being isolated
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Of course, extracting a mask using strokes is only the first part of creating a useful mask. The Quality, 
Consistency, and Smart Refine controls let you refine the stroke analysis of the image to create the 
best tradeoff between performance and quality for the type of mask you need. These controls work 
hand in hand with the strokes you draw to extract a mask. A set of Mask Finesse controls then let you 
adjust the resulting mask to manipulate and soften it, to better suit whatever adjustment you’re trying 
to make. All of these controls are described earlier in this section.

Managing Strokes in the Stroke List
When you draw a stroke, it appears in the Stroke list. By default, all strokes last for the duration of the 
clip to which they’re applied, so if you draw a stroke to identify a figure that’s not moving, there’s no 
requirement to motion track the stroke. Strokes in Person mode appear in one long list, while strokes 
in Features mode appear hierarchically, with the strokes for each feature separated by the title of each 
feature. Once a stroke appears in this list, it has the following controls.

	— Enable/disable feature: In Features mode, once you draw at least one stroke to identify that 
feature, the title of that feature appears, underneath which is organized all the strokes for that 
feature. A toggle next to the feature name lets you turn that feature’s contribution to the overall 
mask on and off.

	— Enable/disable stroke: Each individual stroke in this list has a blue dot that lets you turn that 
stroke’s contribution to the overall mask on or off.

	— Stroke Timeline Area with Stroke Tracks: The stroke track for each stroke lets you keep track of 
and manipulate the animation of strokes to follow camera and subject motion. Blue or red frames 
in this track let you see at a glance how much of each stroke has been motion tracked; blue frames 
for positive strokes, red frames for negative strokes. You can also use these tracks to identify 
frames where you’d like to mute that stroke’s contribution to the final mask and to keep track of 
which frames have been muted. You can draw a bounding box within the stroke track around 
however many frames of however many strokes for which you want to delete motion tracking.

Stroke Duration
When you first draw a stroke, that stroke has a duration of one frame, located at the timecode position 
of the playhead when you drew it. If you move the playhead to the left or right, you’ll see the stroke 
disappear. If you want one or more strokes to continue analyzing the subject for the duration of that 
shot, you need to use the Motion Tracking controls to track the stroke to follow along with the motion 
of whatever it’s drawn on top of. As a stroke is tracked, its duration increases to cover the entire range 
of tracked frames. If at any point a stroke outlasts its usefulness, such as when a person walks off 
frame, you can stop tracking that stroke when it’s no longer necessary and it will stop contributing to 
the analysis.

This is useful, because often you’ll want to place strokes to deal with analysis issues that only last for 
a few frames, to fix a hole in the mask that only appears briefly. Just be aware, you can’t simply draw 
a stroke and move on to the next shot; you must track at least one stroke to last for the duration of a 
subject’s time on screen for that subject to be continuously masked.
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Tracking Strokes to 
Follow Subject Motion 
You can think of each stroke you’ve drawn as a persistent eyedropper that samples the image that 
overlaps it. The mask that results from all strokes’ collective analysis of the image is generated live 
over each frame of the clip. This means that if the camera or the subject moves, you need to motion 
track or otherwise adjust the position of each stroke to follow along with the motion, so the subject 
continues to be correctly identified. You also need to make sure that each stroke is able to analyze 
what it’s supposed to, and turn off strokes that can’t for whatever reason. 

TIP:  Magic Mask is a processor-intensive operation, so to accommodate users of less 
powerful workstations, there is a Use Fast Tracking option available in the Magic Mask 
palette’s Option menu, which speeds up the process of tracking at the expense of 
potentially less accurate tracking for fast or erratically moving subjects.

Methods of Moving Strokes to Follow Subject Motion
For these reasons and more, there are multiple methods of manipulating strokes to refine the 
final analysis.

	— Motion Tracking: A set of tracking controls at the top of the Magic Mask palette let you motion 
track one or more strokes to follow the camera and subject motion in a clip. Every frame that’s 
motion tracked effectively has a motion-tracked reference frame placed on it that moves the 
stroke to a new position.

	— Reference Frame: Any time you drag a stroke from its original position in the Timeline, you create 
a static reference frame at that frame that instantly moves the stroke from its previous position to 
the new position at that frame. Because these are similar to static keyframes, there’s no motion 
interpolation from one “keyframe” to the next in order to create animation. Instead, a reference 
frame in the Magic Mask palette is a simple frame-by-frame operation. Every time you move a 
stroke at a new frame, you change the stroke’s position at that frame from that point forward, 
without changing stroke position on any other frame that’s been previously tracked.

If this seems simplistic, keep in mind that the goal is not to create beautiful stroke animation with 
this tool. You only need to move each stroke to follow along with whichever subject or background 
feature it’s supposed to be sampling in each frame. The only important thing is that, in every 
frame, the stroke overlaps a suitable part of the feature you’re isolating to create the appropriate 
mask. If the stroke itself jumps around abruptly, that doesn’t matter so long as the mask that’s 
generated is good. This means that even if you’re stuck doing a limited amount of frame-by-frame 
animation to make a stroke follow along with a troublesome feature (such as a veil flapping in 
the wind), it’ll go pretty fast, because in each frame you’re just dragging the stroke to overlap 
the feature wherever it happens to have moved. This repositioning doesn’t have to be smooth, 
just accurate.
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	— Combining Tracking and Reference Frames: Since each frame that’s motion tracked is 
effectively keyframed, manually dragging a stroke on a frame that’s already been tracked 
overrides the tracking data at that frame with a reference frame that records the new position 
of the stroke at that frame. If there’s no more tracking data, either before or after that reference 
frame, then the stroke disappears until you do more tracking. If there’s tracking data immediately 
after a reference frame, then the stroke jumps to the position dictated by that tracking data.

	— Deleting Stroke Tracking at Specific Frames: To accommodate cases where a subject you’re 
isolating moves behind something and becomes hidden for a range of frames, you have the ability 
to delete stroke tracking for one or more frames. This lets you eliminate the stroke for however 
many frames the subject you’re tracking is obscured and cannot be sampled. This makes it easy 
to deal with features that come and go over the duration of a clip, since you can delete stroke 
tracking over however many ranges of frames the feature disappears. If you’ve muted frames by 
mistake, you can either undo or re-track the stroke over those frames.

To delete tracking frames, draw a bounding box on the stroke tracks over the range you want to 
delete, and then choose Clear Selected Track Data from the Magic Mask option menu.

Option Menu Commands for 
Removing Strokes and Tracking
The Option menu of the Magic Mask palette presents a number of commands for clearing either 
strokes or stroke tracking data.

	— Clear All Strokes: Deletes every stroke in the Stoke list, along with tracking.

	— Clear All Strokes of Current Frame: Deletes the tracking data at the current position of the 
playhead on all strokes in the list.

	— Clear All Strokes from In to Out: If you use the I and O keys to set In and Out points in the 
Stroke Timeline, this command deletes all tracking data on all strokes within that range.

	— Clear Selected Stroke from In to Out: If you select a stroke in the Stroke list, and then use the I 
and O keys to set In and Out points in the Stroke Timeline, this command deletes the tracking data 
of selected strokes within that range.

	— Clear Selected Track Data: If you drag a bounding box around tracking data for one or more 
strokes, this command deletes all tracking data within the box.

An Example Stroke Tracking Workflow
By combining motion tracking, manual reference frames, and stroke muting, you’ll be able to make 
short work of isolating most moving subjects. The following procedure illustrates how you might 
use these techniques together to make the strokes you’ve drawn follow along with the features 
you’re isolating.

To track one or more strokes to follow a subject:

1	 If necessary, move the playhead to the frame where you want to begin isolating the subject you 
want to mask. For example, if you’re isolating a person walking into the room through a door, you 
probably want to begin your work on a frame where the person is already in the room, and work 
your way backward and forward from that frame. If your subject is already fully visible at the first 
frame of the shot, you can start there.
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2	 Draw at least one stroke identifying the subject or feature you want to isolate. You cannot track a 
stroke to follow the features unless there’s at least one stroke.

3	 Choose whether you want to track all strokes or only selected strokes. By default, all existing 
strokes with at least one frame in the Stroke Timeline at the position of the playhead will be 
tracked. However, you can choose to track only selected strokes in the Stroke list by choosing 
Track Selected Stroke Only in the Magic Mask palette’s Option menu.

4	 Click the Track Forwards to End or Track Backwards to Beginning buttons if you want to motion 
track the strokes over the remaining duration of the clip.

By default, each stroke is tracked to follow whatever image detail immediately surrounds it; 
you don’t have to define a tracking region, this is done automatically. As tracking proceeds, the 
tracking bar for each stroke will fill up showing you which frames have been tracked, and which 
have yet to be tracked. Meanwhile, each stroke being tracked will transform to follow along with 
simple position and rotation changes in the subject. However, things that obscure the subject, as 
well as more extreme movements, may cause problems.

Strokes that are tracking a feature that moves off screen are automatically excluded from tracking 
at the frame where the feature is completely off screen, even if that feature returns onscreen in a 
later frame.

5	 (Optional) If a problem occurs during the track, such as the subject being occluded behind 
something else in the frame (for example, a person’s face moves behind a tree as they walk), 
click the Pause Track button. You can deal with problems in the track in the following ways:

a)	 If a stroke has completely moved off of the subject: For example, you’re tracking a 
stroke to follow a person and they turn around 180 degrees, so the stroke moves off onto 
the background. To fix this, pause the track, move the playhead to the first frame where the 
stroke hasn’t followed the subject properly, then use the pointer to drag the stroke onto 
another part of the subject that’s clearly visible. On each frame where you drag the stroke 
to a new position, a new reference frame will be automatically added. Continue this process 
until the subject’s motion is consistent enough to be trackable again, and you can then 
resume tracking.

b)	 If a stroke has moved onto something that’s partially obscuring the subject: Pause the 
track, drag a bounding box over the frames where the track is having a problem, and choose 
Delete Selected Tracking from the Magic Mask Option menu to clear the bad tracking data. 
Then, move the playhead to the first frame of the deleted tracking data, and use the pointer to 
drag the stroke onto any part of the subject that’s visible to either side of the occlusion. Move 
the playhead to each successive frame, and drag the stroke onto whichever part of the subject 
is visible from behind the occlusion, until the subject moves past the occlusion. At that point, 
you can use the Track Forwards to End or Track Backwards to Beginning buttons to continue 
tracking as usual.

c)	 If the subject becomes completely hidden: Clips where the subject appears and disappears 
over the duration of a clip can be resolved by deleting the stroke or strokes on that subject 
over all frames where the subject is obscured, so that strokes only sample the image when the 
subject is visible and thus able to be isolated. You can delete one or more strokes by dragging 
a bounding box over a range of frames, and then choosing Clear Selected Track Data from the 
Magic Mask Option menu.
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d)	 If a stroke is having trouble following the subject: If the subject you’re tracking is moving 
too fast, too irregularly, or is changing shape too greatly for the tracker to give a good result 
(for example, someone lifts their arm towards the camera), you can track through the problem 
area of the clip one frame by frame using the Track Forward 1 Frame or Track Backward 1 
Frame buttons, and then use the pointer to manually drag the stroke to follow along with the 
subject as you go. Once the problem motion stops and the motion of the subject becomes 
more regular, you can use the Track Forwards to End or Track Backwards to Beginning buttons 
to continue tracking as usual.

e)	 If the subject is moving off the frame: If you’ve drawn a stroke in the middle of someone’s 
face, and their face is moving off screen, you can manually reposition the stroke on the last 
few frames before the subject completely exits so that stroke continues to identify what parts 
of the face are still visible even though the part of the face it was originally following becomes 
hidden. Once the face completely exits the frame, you can mute the stroke for the rest 
of the shot.

6	 (Optional) If you only tracked the stroke’s movement over part of a shot, you can click the Jump 
to Start or Jump to End buttons to move the playhead to the first or last tracked frame, in 
preparation for tracking from that frame onward.
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Chapter 137

Motion Tracking 
Windows
While Power Windows can be manually keyframed to follow a 
moving subject you want to isolate, this chapter shows how you 
can use the powerful cloud and point-based motion tracking 
controls in DaVinci Resolve to make Power Windows follow 
along with the motion of subjects and the camera in the fastest, 
easiest way possible. 

Then, numerous techniques are presented for dealing with complicated tracking scenarios and 
common problems that arise for subjects that are difficult to track.
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Motion Tracking Windows
The Tracker palette has three modes, available from the Palette menu. 

	— In Window mode, the tracking controls let you match the motion of a window to that of a moving 
feature in the frame. 

	— In Stabilizer mode, the same underlying technology is used to smooth or stabilize the motion 
within the entire frame.

	— In FX mode a Point Tracker can be used to animate ResolveFX or OFX plugins with positioning 
controls. For more information about the FX and Stabilizer modes, see Chapter 150, “Sizing and 
Image Stabilization.”

DaVinci Resolve has an incredibly simple, yet powerful, 3D cloud tracker that allows you to track quickly 
and accurately any Power Window (Circular, Linear, Polygonal, Curve, or Gradient) to follow any moving 
feature. This avoids the need to use dynamic keyframes to manually animate a window’s position. 

In particular, you can use the tracker to match a window’s position, size, rotation, and its pitch and yaw 
in 3D space to either foreground or background elements that move within the frame.

A Power Window tracking a woman’s face

Simple Tracking Using the Tracker Menu
The simplest way to track a feature using a Power Window is to use the commands found in the 
Color > Tracker menu. These commands include:

	— Track Forward (Command-T): Tracks a window to a feature from the current position of the 
playhead forward, ending at the last frame of a clip.

	— Track Reverse (Option-T): Tracks a window to a feature from the current position of the playhead 
backward, ending at the first frame of a clip.

	— Track Stop (Command-Option-T): Interrupts any track. This is useful for letting you cancel a long 
track that goes wrong (the Stop button of a control panel stops tracking as well).

	— One Frame Forward (Option-Right Arrow): Tracks a window to a feature one frame forward 
from the current position.

	— One Frame Reverse (Option-Left Arrow): Tracks a window to a feature one frame backward 
from the current position.
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Most window tracks are easy to accomplish using these three commands.

To track any Power Window to match a moving feature within the frame:

1	 Move the playhead to the frame of the current shot where you want to begin (you don’t have to 
start tracking at the first frame of a shot).

2	 Turn on any window, and adjust it to surround the feature you want to track.

Typically, you’ll have done this anyway, for example, framing someone’s moving face with a 
Circular window to lighten their highlights.

3	 To initiate tracking, do one of the following:

	— Choose Color > Tracker > Track Forward (press Command-T). 

	— Choose Color > Tracker > Track Reverse (Option-T).

DaVinci Resolve automatically opens the Viewer page, places a series of tracking points within the 
window you’ve created, and performs the track from the current frame; forward to the last frame or 
backward to the first frame.

DaVinci Resolve analyzes a cloud of tracking points that follow the vectors of every trackable group 
of pixels within the window you’ve created, and the results are fast and accurate. After tracking, the 
window you’ve placed automatically moves, resizes, rotates, and skews to match the motion of the 
feature you’re tracking.

Once a clip has tracking data applied to one of its windows, a small tracking icon appears 
within that clip’s icon in the Thumbnail timeline.

Object tracking in progress. Tracking points are automatically 
placed over trackable features of the image

A tracking icon in the 
top left corner of the 
Thumbnail timeline shows 
that clip has been tracked

If the track you’ve performed is unsuitable, you can reposition the window to cover a different area 
of the subject you’re trying to track, and initiate tracking again. New tracking data overwrites any 
previous tracking data applied to that window.

Once you’re satisfied with your track, you can continue to resize, reposition, or reshape the window 
being tracked. Tracking data is separate from the window transform parameters (which can be 
keyframed), so changes you make to a window offset it from the originally tracked path.
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Tracking Windows Across Transitions
When you track a window that crosses a transition boundary (for example, a dissolve from one clip 
to another), DaVinci Resolve will automatically continue the track for the full extent of the video 
under the transition.

Tracking Windows When You’ll Be 
Exporting Media With Handles
When you track windows to match moving features in a clip, the windows are only transformed on 
frames with tracking data. In Round Trip workflows where you add handles to the graded clips you 
render for editorial flexibility in the footage you deliver, you need to make sure that you track all 
windows from the beginning to the end of these handles to make sure that, if an editor actually trims 
any of the clips you give them to use the handles, all windows are doing what they should. 

An easy way to do this is to choose View > Show Current Clips With Handles to display each clip 
you select in the Timeline with handles defined by the “Default handles length” setting in the Editing 
panel of the User Preferences. Make sure that the “Default handles length” is equal to the handles 
you export using the “Add X Frame handles” option in the Render Settings list of the Deliver page. 
With each clip’s handles made visible in this way, you can easily track windows along every frame 
you’ll be rendering.

Simple Ways of Working With Existing Tracking Data
If there’s a portion of a shot that you haven’t tracked (for example, you started tracking at a later 
frame, or you ended tracking before the end of the shot), then the window you’re tracking remains 
wherever it was at the first or last frame that was tracked. If you want to fill in these gaps, you can 
always move the playhead to the first or last frame that was tracked, and then use the Track Backward 
or Track Forward command to track the rest of the frames in that shot.

Tips for Better Tracking
In situations where a feature changes shape in such a way as to confuse the tracker, you can try 
tracking a smaller part of the feature by using a smaller window. Once you’ve achieved a successful 
track, you can resize the window as necessary, and it will have no effect on the track that’s already 
been made.

Also, if you’re tracking a feature that moves behind something onscreen and disappears for the rest 
of the shot, there’s an easy way to avoid having an awkward window sitting in the middle of the scene. 
You can use dynamic keyframes to animate the Key Output Gain parameter (in the Key tab of the Color 
page) to fade from the correction’s full strength of 1.0 down to 0, the value at which the correction 
disappears, along with the window itself.

Tracking One Frame at a Time
You can click the “track one frame forward” or “track one frame backward” buttons in the Tracker 
palette to track a moving feature one frame at a time, making it easier to make adjustments to follow a 
difficult track when you’ve set tracking to Frame mode (by clicking the Frame button). 
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In Frame mode, you can keyframe window transformations to more faithfully conform to troublesome 
motion as you’re moving one frame at a time through the track; manual changes to a window’s 
position will be keyframed to create frame-specific transformations, rather than used to offset the 
entire tracked motion path as in Clip mode. When you add multiple keyframes in the Tracker graph, 
animation will be automatically interpolated from keyframe to keyframe.

Copying and Pasting Tracking
There will be plenty of times you’ll apply multiple windows to a single moving subject, such as a car, 
when you can use a single motion track for all the windows. Commands in the Option menu let you 
copy and paste track data from one window to another within the same node, saving time when you 
want several windows tracking together as one.

To copy track data from one window to another:

1	 Open the Window palette, then select a window that has tracking applied to it (indicated 
by a tracking badge in the corner of the shape icon), and choose Copy Track Data from the 
Option pop-up. 

2	 Select another window, and choose Paste Track Data from the Option pop-up. Once you’ve copied 
track data from one window, you can paste it to as many other windows as you like.

You can also copy tracking from the FX mode of the Tracker palette and paste it to a window, in 
case you want to use the same tracking data for both an effect and a window.

To copy track data from an FX track to a window:

1	 Open the Tracker palette, choose the FX mode that contains the tracking data you want to copy, 
and choose Copy Track Data from the Option pop-up. 

2	 Open the Window palette, select a window, and choose Paste Track Data from the Option pop‑up. 
Once you’ve copied track data from one window, you can paste it to as many other windows 
as you like.

Tracker Palette Controls 
in More Detail
You can easily combine object tracking and keyframing to animate windows. For example, you’ll 
typically use object tracking to make a window follow the position and orientation of a moving feature, 
but you can add dynamic marks to the window track of the correction in the Color page with which to 
alter its size and shape to better conform to a feature’s changing form.

Controls in the Window Tracker Palette
Occasionally, you’ll run into a shot that doesn’t quite track well enough using the Tracker menu’s 
simple controls. In these cases, the Viewer page provides the complete set of object tracking controls 
that can be used to modify tracking operations in different situations.
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The Tracker palette

The object tracking controls are divided into seven groups.

Tracker Palette Modes
The Tracker palette’s Option drop-down menu lets you choose between Window mode (for matching 
a window to the motion of a feature in the frame), Stabilizer mode (for subduing unwanted camera 
motion; for more information on Stabilizer mode, see Chapter 150, “Sizing and Image Stabilization.” ), 
and FX mode (for tracking position to be used with Resolve FX or Open FX plugins).

Types of Tracking
A pop-up menu below the Tracker graph lets you choose whether to use the Cloud Tracker or the 
Point Tracker. There are two options:

The tracker type pop-up

	— The Cloud Tracker: Automatically analyzes all parts of the image for trackable points, and uses 
these to automatically figure out the motion in the shot that you want to use to move a Power 
Window or stabilize a shot. This tracker type is great for quickly tracking a window to match the 
movement of almost any feature, with a minimum of work.

	— The Point Tracker: Lets you create one or more tracker crosshairs that you can manually position 
in order to track specific features in the shot. The more crosshairs you create and position, the 
more accurate the track can be. The Point Tracker is incredibly useful in situations where you need 
to follow the motion of a very specific feature in the frame. It can also be useful in cases where you 
want to stabilize a shot that has many subjects moving in different directions, and it’s difficult to 
obtain a good result with the Cloud Tracker.
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Object Tracking
The object tracking controls provide the most basic tracking functions, some of which are mirrored 
within the Color > Tracker menu.

Choose which type of transform you want to track before tracking

A series of five checkboxes let you turn on and off which transforms you’d like motion tracking to 
apply automatically to the window. These checkboxes must be selected before you perform a track in 
order to restrict the transforms that are used. 

	— Pan and Tilt: Enables tracking of horizontal and vertical position, when you want to transform a 
window to follow the location of a tracked subject.

	— Zoom: Enables tracking of size, when you want to transform a window to resize to follow a 
tracked subject.

	— Rotate: Enables tracking of orientation, when you want to transform a window to rotate with a 
tracked subject.

	— Perspective 3D: Enables tracking of pitch and yaw in 3D space, when you want a window to skew 
to follow the orientation of a tracked subject within the scene. Good when you want the window to 
“stick” to a surface.

NOTE:  Once tracking or stabilization has been done, disabling these checkboxes does 
nothing to alter the result. To make changes, you need to enable or disable the necessary 
checkboxes first, and then reanalyze the clip.

After you’ve defined the transforms you want to use for the track, the analyze controls let you proceed 
with the analysis of the subject being tracked.

	— Track One Frame Reverse button: Motion tracks a single frame in reverse. Useful for slow 
tracking of difficult subjects that may require frequent correction.

	— Track Reverse button: Initiates tracking from the current frame backward, ending at the first 
frame of the clip. Good for tracking backward when your best starting point is somewhere within 
the middle of the shot.

	— Pause button: Stops tracking (if you’re fast enough to click this button before tracking is finished).

	— Track Forward button: Initiates tracking from the current frame forward, ending at the last 
frame of the clip. 

	— Track Forward and Back button: Initiates tracking from the current frame forward, then when 
finished, tracks backward from the original selected frame. This allows you a one button process 
when tracking from the middle of a shot.

	— Track One Frame Forward button: Motion tracks a single frame forward. Useful for slow 
tracking of difficult subjects that may require frequent correction.
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Clip/Frame Controls
Two buttons let you set how manual adjustments to the position of tracked windows affect the 
overall track.

Selecting clip or frame to apply adjustments

	— Clip: The default mode, in which changes you make to the position of a window are globally 
applied to the entire track. For example, if you track a feature, and then move the window, the 
window moves along a motion path that’s consistently offset from the original track for the 
duration of the clip. Use this mode if you’re happy with the track, but you want to modify the 
window’s overall shape and position relative to the motion path it’s following.

	— Frame: In this mode, changes you make to the position or shape of a window create a keyframe at 
the frame at the position of the playhead. Multiple keyframes are interpolated to create animation 
with which you can manually transform a window to solve a variety of problems. This mode is useful 
for rotoscoping the shape and position of windows to match a subject that’s tough to automatically 
track. Frame mode is also useful for making corrections to individual frames that were badly 
tracked, for animating windows to go all the way out of frame along with a subject, or for making 
manual, frame-by-frame adjustments to window position to cover untrackable≈sections.

The Tracker Graph
The Tracker graph provides a visual display of the tracking data that’s being analyzed. Each of the 
transform controls that can be tracked has an individual curve, which lets you evaluate each tracked 
parameter on its own, and each curve is color-coded to match the corresponding label of the tracking 
transforms listed above.

The Tracker graph showing a curve for each transform control

A vertical slider to the right of the Tracker graph lets you scale the height of the curve data within 
to make it easier to see it all within the graph. A horizontal slider at the bottom of the graph allows 
you to zoom in and out of the tracker curves, allowing you to see finer detail of the tracking paths. 
Above the Tracker graph, a Timeline ruler contains a playhead that’s locked to the playheads in the 
Viewer and Keyframe Editor.

You can draw a bounding box in the Tracker graph with which to select a portion of one or 
more curves to delete sections of low-quality tracking data using the Clear Selected Keyframes 
command found in the Tracker Options menu. To eliminate the current bounding box from the 
Tracker graph, click once anywhere within the graph.
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Interactive Mode Controls
The Interactive controls, at the bottom-left of the Tracker palette, let you make manual changes 
to the automatically generated tracking point cloud that DaVinci Resolve creates when you’re 
tracking with the Cloud Tracker, so you can try different ways of obtaining better tracking results in 
challenging situations.

Interactive mode controls

	— Interactive Mode checkbox: Turns the Interactive tracking mode on and off. When you enter 
Interactive mode, you can manually alter the point cloud that DaVinci Resolve uses to track the 
feature within the current window. You’ll then make your track while in Interactive mode.

	— Insert: Lets you add tracking points to whatever trackable features exist within a bounding box 
that you’ve drawn in the Viewer. Inserted tracking points are automatically placed based on 
trackable pixels in the image.

	— Set Point: Lets you use the cursor (using the DaVinci Resolve Advanced control panel), to manually 
place individual tracking points, one by one, with which to track a feature. If there is no trackable 
pixel group at the coordinates where you placed the cursor, a tracking point will be placed at the 
nearest trackable pixel group.

You must place at least two tracking points at different pixel groups to track rotation, and at least 
three to track zoom.

	— Delete: Eliminates all tracking points within a bounding box that you’ve drawn in the Viewer.

Point Tracker Controls
If you’re using the Point Tracker, then the Interactive Mode controls disappear, replaced by the two 
controls of the Point Tracker.

Point Tracker controls

	— Add Tracker: Click to create a new tracker that’s automatically positioned in the center of the 
frame. Once created, you can drag it using the pointer to line up with the feature you want to 
track. You can create as many trackers as you like. Multiple trackers are all tracked at once.

	— Delete Tracker: Select any tracker (selected trackers are red, deselected trackers are blue), and 
click this button to remove it.

Additional Commands in the Tracker Options Menu
There are some additional commands located in the Tracker Options pop-up menu.
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	— Reset Track Data on Active Window: Lets you delete the tracking data corresponding to the 
currently selected window.

	— Clear Selected Track Data: When you drag a bounding box over parts of one or more curves in 
the Tracker graph, this command lets you delete that part of the graph. This is useful when you 
want to eliminate sections of low-quality track data. Portions of curves that are cleared in this 
way have linear interpolation automatically applied to them, similar to if you used the Keyframes 
Interpolation controls.

	— Delete Keyframe: Deletes tracker graph keyframes at the current position of the playhead.

	— Clear All Tracking Points: Clears the tracking points in the Power Window at the frame you are on.

	— Show Track: Turn this checkbox on to show the motion path produced by the tracking you’ve done.

	— Copy Track Data: Lets you copy track data from the currently selected window. Windows can be 
selected directly in the Viewer while the Tracker palette is open.

	— Paste Track Data: Pastes copied track data to the currently selected window. Windows can be 
selected directly in the Viewer while the Tracker palette is open.

Cloud Tracker Workflows
The next few examples illustrate how to use the Tracker palette’s controls in practical situations. In 
many circumstances, objects passing in front of a tracked subject, known as “occlusions,” can cause 
problems. While the tracker in DaVinci Resolve is highly occlusion-resistant, the following sections 
show a variety of techniques you can use when an occlusion prevents you from getting a useful track.

Using Interactive Mode to Manually 
Choose Tracking Features
Interactive mode lets you manually remove or add tracking points to improve tracking performance in 
situations where the automatic image analysis in DaVinci Resolve provides unsatisfactory results.

For example, you can delete tracking points within a window that correspond to overlapping features 
you don’t want to track. Suppose a car that you’re tracking drives by a sign that partially obscures the 
car. Without intervention, the PowerCurve that’s isolating the car will deform improperly when the car 
moves along and then away from the sign.

Using Interactive mode, you can delete the tracking points that will overlap the sign you don’t want to 
track, improving the result.
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To eliminate specific, unwanted tracking points from a track:

1	 Open the Tracker palette.

2	 Turn on the Interactive Mode checkbox.

Selecting Interactive Mode 

3	 In the Viewer, drag a box around the tracking points you want to eliminate within the window.

Dragging a box around tracking 
points that need to be deleted 

4	 Click the Delete button.

Deleting tracking points 

The points within the selection area are deleted.

Remaining tracking points ready to be used

5	 While Interactive mode is still on, click Track Forward or Track Reverse to track the subject using 
the remaining tracking points.

6	 When you’re finished tracking, turn off the Interactive Mode checkbox.

DaVinci Resolve goes back to using automatically placed tracking points.
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In another interactive tracking example, you may sometimes run into situations where you want to eliminate 
all automatically placed tracking points altogether, placing your own in specific regions of the image.

To eliminate automatic tracking points, adding your own instead:

1	 Open the Tracker palette.

2	 Turn on the Interactive Mode checkbox.

Selecting Interactive mode

3	 In the Viewer, drag a box around all the tracking points in the window, and click the 
Delete button to eliminate all tracking points from the image.

Selection box surrounding all tracking points

4	 Click the Delete button to eliminate all tracking points from the image. 

Deleting tracking points 

5	 Drag a box around the specific area where you’d like to add new tracking points. In this case, you only 
want to track the top half of the woman’s face, since the bottom half is cut off by the fence posts.

Placing the selection box over the top of the window 

6	 Now, click the Insert Track Points button.
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The Insert button of Interactive mode automatically adds 
tracking points within the current bounding box.

New tracking points are automatically added to whichever features are appropriate for tracking 
within the box you’ve drawn.

Tracking with the remaining tracking points

NOTE:  If no appropriate tracking features can be found, no points will be added.

Dealing With Occlusions When Tracking
Sometimes you’ll find that you need to deal with a gap in the useful tracking data. For example, 
objects in the frame that pass in front of the feature you’re trying to track cause gaps in the tracking 
information for a clip.

In situations where a subject being tracked becomes totally occluded by another object in the 
frame, there’s an easy method of interpolating to cover holes in the available tracking data. In the 
following example, the woman walks behind another fence post, this time one that’s taller than she is. 
The window tracking her face will become completely lost at this point, but interpolation will help to 
salvage this shot.

Original clip
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Interpolating between two sets of tracking data to track past an occlusion:

1	 Move the playhead to the first trackable frame of the moving feature you’re correcting, 
and create a Power Window that surrounds it.

Adding the Power Window 

2	 Use Track Forward to track the feature as far as you can before it becomes obscured behind 
something else in the frame.

3	 When the Power Window stops tracking the feature reliably, stop the track.

The Power Window is obscured by the post 

4	 Open the Tracker palette.

5	 Click the Frame button to put the Tracker controls into frame-by-frame adjustment mode. This is 
an important step.

Selecting Frame mode 

6	 Move the playhead to the frame where the feature you’re tracking reappears from behind the 
occlusion, then drag the window so that it again overlaps the feature.

Moving the playhead and position the window 
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7	 Use Track Forward to continue tracking the feature until the end of the clip. Alternately, you 
could have started from the end of the clip and used Track Reverse to track the feature as far as 
possible, if that’s easier.

Now that you’ve identified the gap in reliable tracking data for this clip, it’s 
time to set up the interpolation. 

Notice the gap in the tracking data where 
the window was behind the post

8	 Drag a bounding box over the portion of the curves in the Tracker graph that fall between the 
good tracking data at the beginning and end of the shot.

9	 Click the Tracker palette option pop-up menu, and choose Clear Selected Track Data.

The portions of curves that you selected are deleted, and have linear interpolation automatically 
applied to them so that there’s no hole in the track data or the motion of the window, which now 
moves smoothly from the last outgoing frame of reliable tracking data to the first incoming frame 
of new reliable tracking data.

Point Tracker Workflows
As advanced as the Cloud Tracking that is the default in DaVinci Resolve is, there are times when it 
may be simpler to track using good old-fashioned crosshairs. The Point Tracker makes it easy to track 
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very specific features of a subject with motion you need to follow. Unlike the Cloud Tracker, which 
automatically looks for all trackable points within a region of the image that you identify using a 
window, the Point Tracker lets you create one or more crosshairs that you must manually position to 
overlap with whatever high-contrast features you want to track. This section covers the three main 
workflows you need to know to use the Point Tracker.

Tracking a Window Using the Point Tracker
The following procedure describes, in a general way, how to use the Point Tracker to track a moving 
subject and apply that motion to a Power Window.

1	 Move the playhead to the frame of the current shot where you want to begin (you don’t have to 
start tracking at the first frame of a shot, since you can always track backward).

2	 Turn on any window, and adjust it to surround the feature you want to track. Typically, you’ll have 
done this anyway, for example, framing someone’s moving face with a Circular window to lighten their 
highlights. You want to make sure that the window you want to apply the tracked motion to is selected 
before you begin tracking. In this example, we’ll be tracking a Circular window to follow the woman’s face.

Setting up to track a window over a woman’s face

3	 Open the Tracker palette, and choose Point Tracker from the bottom right pop-up. 

Choosing the Point Tracker

4	 Before you start tracking, choose what types of motion you want to track and apply to the window 
you’re working on. You can choose from among Pan, Tilt, Zoom, Rotate or Perspective 3D. Which 
methods of transformation can be applied depend on how many points you add to track.

Choosing what type of motion to analyze

5	 Click the Add Tracker Point icon. A new tracker crosshairs appears in the Viewer in the center of 
the frame.
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Clicking the Add Tracker Point icon

6	 Move the pointer directly over the tracker crosshairs, and when it turns into the move cursor, click 
and drag to move the crosshairs to line up on top of the feature you want to track. For the best 
results, this should be a high-contrast detail such as a corner, the end of a line, a small shape like 
a pebble, or a jagged detail. Unlike other point trackers, there is no inside or outside region to 
separately adjust, there’s only the one crosshairs that you need to align. In this example, this first 
crosshairs is placed at the inside of her stage left eyebrow (the corner of her eye would introduce 
too much jitter as the tracker will pick up her blinks).

Lining up the tracker crosshairs with 
the feature you need to track

7	 If you want to improve the accuracy of your track, you can create more tracker crosshairs and 
position them on top of other details within the subject you’re tracking. For the best results, make 
sure that all crosshairs are placed onto details that are in the same plane of motion. In other 
words, don’t put some crosshairs on a person’s face in the foreground, and other crosshairs on 
a tree that’s far in the background, since both these features will have very different vectors of 
motion. In this example, trackers are placed at her inside eyebrows and at the corner of her lips.

Setting up four trackers to follow the 
corners of her eyebrows and mouth

The final track, accomplished with four point 
trackers, with the track path turned on

8	 When you’re done placing crosshairs, click the Track Forward or Track Backward buttons to 
initiate tracking. The clip will be analyzed, and the Tracker graph will update with the tracking 
data, and the window you had selected automatically moves to match the motion of the feature 
you’re tracking.
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Removing Trackers
If you find that a particular tracker is causing problems, you can remove it by selecting it in the Viewer, 
and clicking the Delete Tracker icon, before retracking the subject.

Clicking the Delete Tracker icon

Using Frame Mode to Offset Track
A common issue when point tracking is how to deal with occlusions and times when the tracked 
feature moves off screen. In DaVinci Resolve, the solution is to use the Tracker palette’s Frame mode 
to move the tracker crosshairs onto another feature to track, while offsetting the resulting motion so 
that it continues to follow the original motion path.

1	 In this example, a point tracker crosshairs has been positioned at a corner of a window of a 
building that’s being separately adjusted using a Power Window. The window is being used 
because, as the woman turns to leave, she covers up most of the other trackable outer edges of 
the building, which would ruin the track.

Setting up to track a building moving off screen

2	 As the camera pans, the feature being tracked is about to go off frame, which is about to ruin the 
track. As this happens, click the Stop Track button.

Stopping the track on the last good frame of the 
track, before the tracker goes off screen

3	 Move the playhead back to the last good frame of tracking, and then click the Frame button in the 
Tracker palette to go into Frame mode.
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Turning on Frame mode, to prepare to offset the track

4	 In Frame mode, you can now drag the tracker to another feature of the building, this time the outer 
edge of the roof, that will be better to follow as the building goes out of frame to the left, since the 
Power Window will go out of frame before the rightmost corner of the building’s roof does.

Dragging the tracker to another feature that’s better to track

5	 Now, click the Track Forward button again, and the crosshairs will begin tracking the new feature, 
but the motion will be offset, so the movement of the Power Window continues to follow the 
original motion path.

Tracking an offset feature lets the 
window go all the way off screen

The tracker path before and after moving the tracker 
crosshairs in Frame mode is smooth and continuous

6	 If you turn on the track path (in the Tracker Option menu), and move the playhead to the frame 
where you moved the tracker, you can see that the motion before you moved the tracker and 
the motion after continues smoothly along the same path, with no sudden breaks. When you’re 
finished, click the Clip button to get out of Frame mode.
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Rotoscoping Window 
Shapes After Tracking
While the DaVinci Resolve trackers are pretty miraculous when it comes to making a window follow 
moving subjects, or elements within a moving scene, there will be plenty of times when the final track 
isn’t quite perfect. 

For example, if you’re trying to isolate someone’s face with a very specific window, and the person 
turns their head, then the resulting change of shape is almost certainly going to require you to make 
animated adjustments to the window in order to continue making such a specific isolation.

Before and after a window tracking a turning 
head, the window doesn’t quite follow the 
edge of the woman’s face as her head turns

Fortunately, the Tracker palette’s Frame mode makes it easy to animate shape changes you make 
to windows in order to better follow a moving subject, a task often referred to as rotoscoping. 
By following the motion of a moving subject, and making a series of automatically keyframed 
adjustments to the window at every point the subject changes speed or direction, you can make a 
window isolate a moving target with surprising precision.

Using Frame mode to rotoscope the 
window to better follow the edges of her 
face and the contours of the jaw
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Furthermore, you can also use Frame mode to repair imprecise tracks where the window is veering 
off course because of quickly or irregularly moving features. In these cases, you have the option of 
manually tracking the window in Frame mode to fit the trajectory of the feature, frame by frame.

Lastly, you don’t even have to have performed a track to use the Tracker graph in Frame mode 
to keyframe animated changes to a window. In fact, using the Tracker graph in Frame mode can 
sometimes be more convenient than using the Keyframe Editor in Auto Keyframe mode, depending 
on what you’re doing.

Rotoscoping Controls
The Clip/Frame buttons determine whether or not you’re rotoscoping a shape.

	— In Clip mode: Any changes you make to a window transform it over the entire duration of that 
clip. In other words, you can track a window to a moving feature, and in Clip mode any changes 
you make to the size, rotation, position, or shape of the window occur equally from the beginning 
to the end of that clip.

	— In Frame mode: Changes you make to a window automatically create a keyframe at the bottom of 
the ruler in the Tracker graph. Making two or more changes to a window in Frame mode results in 
automatically interpolated animation from one keyframed window transformation to the next.

You can freely move back and forth between Clip to Frame modes to make changes to a window. 
Even if you’ve keyframed a window to change shape, you can turn on Clip mode and make an overall 
change to the window, enlarging it for example, that results in the window being equally enlarged at 
every keyframe.

Keyframing in Frame Mode
Once you’ve added keyframes to the Tracker palette, there are a number of ways you can edit them.

Methods of working with keyframes in the Tracker graph:

	— To add a keyframe: Click the Add Keyframe icon at the upper right-hand corner of the Tracker 
graph. It looks similar to the Keyframe icons found in the Edit page Inspector. This is useful for 
adding a keyframe to a frame where the window fits the subject well, prior to moving forward 
a few frames and making an alteration to the window to follow the subject that will generate 
another keyframe.

	— To move the playhead from one keyframe to another: Click the Previous Keyframe and Next 
Keyframe icons at the upper right-hand corner of the Tracker graph. These controls look similar to 
those found in the Edit page Inspector.

	— To delete a keyframe: With the playhead on the same frame as the keyframe you want to delete, 
open the Tracker option menu, and choose Delete Keyframe.

The Previous Keyframe, New Keyframe, and 
Next Keyframe buttons in the Tracker graph
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A Rotoscoping Workflow
The following procedure demonstrates how to use a window to rotoscope an onscreen feature that 
you want to isolate. In the process, it shows how to set up a window for rotoscoping using the Tracker 
palette, and discusses some best practices for rotoscoping efficiently.

To rotoscope or manually track a window using automatic keyframing:

1	 Create a window to isolate the feature you’re wanting to adjust, and use the tracker to make 
it follow the motion of the subject. If the window doesn’t follow the contours of the subject as 
precisely as you require, then you can begin manually keyframing its shape on top of the tracking 
you’ve done to rotoscope the subject.

2	 With the Tracker palette open, click Frame to change the tracking mode.

Clicking the Frame button to begin keyframing your shape

The best way to use Frame mode for tracking is to either start at the last successfully tracked 
frame and work your way forward, or start at the first successfully tracked frame and work your 
way backward. This takes the best advantage of the automatic keyframing and interpolation 
between keyframes to animate the window you’re transforming smoothly.

3	 With the playhead at either the first or last frame where the window fits the subject you’re 
isolating, you can either click the Add Keyframe button at the upper right-hand corner of the 
Tracker graph, or wiggle any control point by a pixel or two, to add a keyframe at that frame. 

Clicking the Add Keyframe icon 
in the Tracker graph

Adding a keyframe at the last frame where the window follows the subject’s motion well means 
that any future animated changes you make interpolate from this frame forward, rather than from 
previous frames where there’s no need for alterations.

Adjusting the window in Frame mode adds a keyframe
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While you’re in Frame mode, the changes you make to the window automatically generate a 
keyframe in the Tracker palette, which appears at the bottom of the Tracker graph’s timeline.

Keyframes appear in the  
Tracker graph ruler

It’s frequently essential to add a keyframe at the last frame where a window conforms well to the 
subject you’re trying to isolate, in order to limit window animation from that frame to the next 
keyframed transformation, rather than accidentally animating from the beginning of the clip, or 
from the next or previous keyframe in the Tracker graph.

4	 Next, move the playhead to the next frame where the window requires adjustment to better fit 
the moving subject, and adjust the position of the window, the control points of the window, or 
both to isolate the subject as necessary.

Readjusting the window in Frame mode 
to follow the subject’s motion

This results in a second keyframe being placed in the ruler of the Tracker graph.

Two keyframes creating rotoscoped animation in 
addition to any motion tracking that’s applied

5	 With your first two keyframes placed, scrub the playhead back and forth between them to 
evaluate how well the window’s animation is automatically interpolating to fit the motion of the 
subject you’re isolating. If the window doesn’t follow the motion of your subject well enough, 
move the playhead to the frame where the window divergence is the most pronounced and make 
another adjustment to correct the shape.

This creates another keyframe.
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A frame between the two keyframes you’ve 
rotoscoped that needs further adjustment

After adjusting the  
in-between frame

6	 When you’re finished making adjustments between your first two keyframes, move the playhead 
farther along and add keyframes as necessary to make the window follow the motion of 
your subject. 

In general, look for the frames where your subject’s motion starts, stops, speeds up, slows down, 
or changes direction. As you work, it’s good to try and add the fewest number of keyframes 
you can to ensure smooth motion from one to another. Too many keyframed adjustments 
made too close together for a smoothly moving subject risks adding jerky motion if you’re not 
careful. On the other hand, if you have an erratically moving subject, you may have to add more 
keyframes, possibly frame by frame, to achieve the desired result.

TIP:  If you’re isolating a subject with a complex shape that moves quite a lot, you might 
consider using multiple simple overlapping shapes to track and rotoscope it, rather 
than a single complicated one, to make the task easier.

7	 When you’re finished rotoscoping the window, be sure to click the Clip button to switch back 
to Clip mode, so you can trim the window’s shape across every keyframe you’ve just created, 
if necessary. This will also prevent you from accidentally adding more keyframes if you select 
other shapes.

This technique requires a bit more work then simply using the Tracker, but it’ll let you quickly 
adjust the animation of a window to more tightly conform to a moving subject when you need 
an adjustment to be specific to that subject alone. You can also use this technique to reposition 
specific motion path points in the middle of an otherwise successful track to make them fit better, 
or to add keyframes to the beginning or end of a track when the subject moves offscreen but the 
window does not.

Viewing a Window’s Motion Path
You can turn on the motion path of the window you’re tracking by choosing Show Track from the 
Tracker Option menu.
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Chapter 138

Using the Gallery
The Gallery provides a way to save, browse, and use saved still 
frames from different clips in a program. Each project is saved with 
its own individual set of stills, and each still you save consists of a 
DPX image of the saved frame, and the grade metadata. You can 
use saved stills for reference when matching one clip to another, or 
you can use them to copy grades to other clips, or other timelines. 

There are two ways to work with the contents of the Gallery. The Color page has a small Gallery, to 
the left of the Viewer, that provides quick access to saved stills and grades as you work. The Gallery 
window, which can be opened via a button at the top right of the Gallery, provides a dedicated 
interface for organizing your grades, copying grades and memories between projects, and for 
accessing a dedicated collection of DaVinci Resolve looks.
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Using the Gallery
The Gallery in the Color page and the expanded Gallery window environment share many of the same 
commands for organizing stills. However, the commands for saving stills and customizing split-screen 
views are restricted to the Color page.

Color page Gallery

Saving Stills
One of the most common operations is to save a clip as a still (with that clip’s embedded grade) for 
future reference and use.

To save an individual still in the Color page, do one of the following:

	— Choose Color > Stills > Grab Still (Option-Command-G).

	— Right-click on the Viewer and choose Grab Still.

	— Press GRAB STILL on the Transport panel of any of the DaVinci Resolve control panels.

It’s also possible to save stills automatically for every clip in the entire Timeline. This can be useful 
if you’re planning to export a set of grades to hand off to another colorist, or if you need to apply a 
series of grades manually from one project to another when ColorTrace™ won’t work.

To save a still for every clip in the current timeline, right-click the Viewer, 
and choose one of the following:

	— Grab All Stills > From First Frame: The first frame of each clip is saved to the Gallery.

	— Grab All Stills > From Middle Frame: The middle frame of each clip is saved to the Gallery.

	— Grab Missing Stills > From First Frame: Only the first frame of clips with no stills in the Gallery 
are saved to the Gallery.

	— Grab Missing Stills > From Middle Frame: Only the middle frame of clips with no stills in the 
Gallery are saved to the Gallery.
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You can cancel the Grab All Stills operation at any time by clicking on the Cancel button in the 
“grabbing stills” dialog box. This is useful if you notice a clip needs to be altered after starting the tool, 
and you don’t want to wait for the operation to finish grabbing stills from the entire timeline before 
fixing it. Once you’ve made your correction, simply run Grab All Stills again.

By default, when you save one or more stills, they’re named “TrackNumber.ShotNumber.VersionNumber” 
with dots separating each number. If you like, you can choose an option from the General Options 
panel of the Project Settings to “Automatically label Gallery stills” in different ways. This is covered in 
more detail later in this chapter.

Selecting Stills
To select a range of stills, do one of the following:

	— Click one still, then Shift-click another to select a contiguous range of stills.

	— Command-click any stills you like to make a noncontiguous selection.

	— Right-click any still, and choose one of the following commands;

	— Select All: Selects every clip in the Gallery.

	— Select Current to Last: Selects every still from the one you’ve clicked through the 
last still in the Gallery.

	— Select First to Current: Selects every still from the one you’ve clicked through the 
first still in the Gallery.

Deleting Stills
If you need to remove one or more stills, this can only be done using the Gallery’s contextual menu.

To delete one or more stills, do one of the following:

1	 Select one or more stills in the Gallery.

2	 Right-click one of the selected stills and choose Delete Selected.

Each still is also saved with a variety of metadata that is used by DaVinci Resolve to manage 
the contents of the Gallery in different ways. This metadata can also be used for searching and 
sorting, and is viewable by opening the Still Properties window.

To display a still’s properties:

	— Right-click a still in the Gallery and choose Properties. 

A floating translucent window appears displaying the date the still was created, what clip it was grabbed 
from, when it was grabbed, and the source and record timecode values of the frame it came from.

Right-click on a still to choose Still Properties 
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Where are Stills Saved?
By default, all grades/stills you save are saved in the DPX format, and are placed in the directory 
path defined in the “Gallery stills location” field in the Working Folders section of the Master Settings 
panel of the Project Settings. This path defaults to a hidden “.gallery” directory that’s created at the 
location of the first Media Storage Volume you specify in the Media Storage panel of the System 
Preferences window.

Changing the PowerGrade Still Directory
Optionally, you can change the location where PowerGrade stills are saved by Opening the Gallery 
Option menu and choosing Change PowerGrades Path. You’ll be prompted via a “Select PowerGrades 
Folder” dialog to choose a directory where all PowerGrades will be saved.

Live Previews of Gallery Stills
The Live Preview option, found in the Gallery option menu, lets you preview how the current clip would 
look with a particular Gallery Still grade applied to the currently selected clip simply by moving the 
pointer over the still you want to preview.

Enabling and Disabling the Gallery Live Preview:

1	 Open the Gallery option menu and choose Live Preview. 

The Live Preview option for the Gallery 
browser lets you hover over a saved grade to 
preview it on the current clip in the Viewer

2	 Click a node in the Node Editor you want to preview applying the grade from a still to. The live 
preview will display how the current clip will appear with the grade of the still you select applied to 
the currently selected node of current grade, which will affect the result.

3	 Move the pointer over the still you want to preview. 

The Viewer image updates to show how that clip would look with that still’s grade applied to the 
currently selected node.

Hover Scrub in the Gallery
When Live Preview is enabled in the Gallery option menu, the Hover Scrub Preview submenu lets you 
choose how you want Live Preview to be shown by a thumbnail in the Gallery and in the Viewer when 
you hover the pointer over a still or LUT in the LUT Browser:
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	— You can choose to scrub both the thumbnail you’re hovering over and the Viewer, letting 
you preview the current still’s grade or a LUT over the duration of the current clip in both the 
thumbnail and Viewer. 

	— You can choose to scrub just the thumbnail, leaving the Viewer to show just the grade or LUT over 
the frame at the position of the playhead.

	— You can disable scrubbing altogether, in which case both the thumbnail and the Viewer will only 
show the grade or LUT over the frame at the position of the playhead.

The Hover Scrub Preview options when Live Preview is enabled

Playing Stills and Setting Up 
Image Wipes
There are many ways to play a still in the Color page, making it visible as an image wipe in the Viewer 
and on the external display connected to your video interface.

To play a still, displaying it as an image wipe or full screen, do one of the following:

	— Double-click a still in the Gallery.

	— Select a still in the Gallery, and click the Image Wipe button on the top Viewer toolbar.

	— Click a still in the Gallery, then right-click in the Viewer and choose Show Reference Wipe.

	— From the Color > Stills menu, choose Next Still (Option-Command-N) or Previous Still (Option-
Command-B) to select a still in the Gallery, and then choose Wipe On/Off (Command-W) to play it.

	— Press PREV STILL or NEXT STILL on the DaVinci Resolve Advanced Search Dial panel, or the 
DaVinci Resolve Advanced control panel to select a still, then press PLAY STILL. Press PLAY STILL 
again to dismiss the still.

Whenever you play a still, the Viewer mode’s drop-down menu changes to Split mode.

Once displayed, the wipe between the current clip and the still being referenced can be moved and 
reoriented in different ways. If you want a full-screen view so you can flip back and forth between the 
still and the current clip, simply adjust the split until the still fills the entire Viewer.

To adjust a wipe in the Viewer, do one of the following:

	— Drag the pointer within the Color page’s Viewer to move the wipe.

	— Push the T-bar lever up and down on the T-bar panel of the DaVinci Resolve 
Advanced control panel.
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To customize the type of image wipe that’s displayed in the Viewer, do one of the following: 

	— Click any of the controls at the top right of the Viewer toolbar to choose Horizontal, Vertical, Mix, 
Alpha, Box, and Difference types of wipe.

	— Choose Gallery, Timeline, or Offline from the Reference Wipe Mode submenu in the Viewer’s 
option menu.

	— Choose Horizontal, Vertical, Mix, Alpha, Difference, and Box from either the Wipe Style submenu 
in the Viewer’s option menu, or the style icons at the top of the Viewer.

	— Choose Invert Wipe (Option-W) from the Viewer’s option menu.

Timeline Wipes
A timeline wipe is when you use the Wipe Timeline Clip command in the Thumbnail timeline (it’s found 
in the contextual menu when you right-click a clip other than the current clip) to wipe the current clip 
against another clip in the Timeline, without needing to save a still first. When you turn a timeline wipe 
on, the clip in the timeline that’s being wiped is outlined in blue.

Gang Timeline Wipe With Current Clip
A “Gang timeline wipe with current clip” option, available from the Viewer option menu, lets you 
maintain the offset between the current clip and a timeline clip you’re wiping against when you move 
the current clip selection to other clips. With this option enabled, the offset between the timeline 
wiped clip and the current clip is maintained when you move the clip selection. When this option is 
disabled, the timeline wiped clip stays where it is regardless of what clip you select.

Change a Timeline Wipe Using the 
Timelines Album of the Gallery
While you’re using the Wipe Timeline Clip to show a wipe of the current clip against any other clip 
in the Timeline, you can open the Timelines album of the Gallery and click different clips to change 
which Timeline clip you’re wiping against (outlined in blue) without changing the current clip 
(outlined in orange). Make sure you have selected the same timeline in both the Timeline album, 
and the Color page.

Labeling and Searching 
for Stills and Sources
By default, all stills are identified by a three-number code. The first number is the video track the clip 
is on, the second number is the clip’s position number in the current Timeline, and the third number is 
the version number of the grade.

If you’ve saved many stills, it can help to label the important ones with whatever text you find helpful. 
Once labeled, you can search for stills by label using the Search field, at the upper right-hand corner of 
the Gallery.
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All stills are numbered Track.Shot.Version

Automatic Labeling
If you like, you can choose an option from the Color group in the General Options panel of the Project 
Settings to “Automatically label Gallery stills” in different ways. There are many options:

	— Clip Name: Saves the Clip Name, which defaults to the File Name unless you’ve customized it.

	— Clip Version Name: Automatically saves the name of the current version.

	— Source timecode (HH.MM.SS.FF): Saves the source timecode of the current frame.

	— Timeline timecode (HH.MM.SS.FF): Saves the timecode for the playhead’s 
position in the Timeline.

	— Timeline Name: Saves the name of the currently open Timeline.

	— Display LUT Name: Saves the name of the currently used Display LUT, if one is applied.

	— Custom label using tags: Choosing this option reveals a field you can use to either type custom 
text into, or in which you can use metadata variables to save automatically updated information 
relating to the currently selected clip and timeline. For more information about using metadata 
variables, see Chapter 16, “Using Variables and Keywords.”

For all options, there’s also a checkbox you can toggle:

	— Append still number on export: Turning this checkbox on lets you choose how to include the 
default still number when exporting stills with the “Use labels on export” option enabled, either as 
a prefix or suffix.

Manual Labeling
Sometimes the easiest thing to do is to just give a particular still a custom name that’s representative 
of what that still represents, such as “SeemedLikeAGoodIdea.” When naming stills manually, it’s best to 
avoid using the forward slash character in case you find yourself exporting these stills with file names. 
In fact, it’s a good idea to avoid using the forward slash character for just about any text that you add 
in DaVinci Resolve.

To manually label a still:

1	 Right-click a still in the Gallery and choose Change Label or double-click directly under the Still ID.

2	 Type a name into the Change Still Label dialog, and click OK.

The new label appears underneath the still number.
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You can also label stills 
for easier identification

Searching For Stills
Once labeled, you can search for stills you need in the Gallery.

To search for a still by label:

	— Click the Magnifying Glass button to open the Search field, click to place the cursor within, and 
then type the name or description you are searching for.

As soon as you start typing, DaVinci Resolve automatically begins to filter the results of the 
currently selected album in the Gallery to match what’s been typed. 

Match Reference Wipe Frame
You can right-click any Gallery still and choose Match Reference Wipe Frame to automatically move 
the playhead to the exact frame that corresponds to that still, and select that clip in the Color 
page Timeline.

Gallery Options
In the upper right corner of the Gallery palette there are several options that let you adjust the view 
and organization of your stills.

	— Still Size Slider: Dragging this slider to the left makes the still thumbnails smaller, dragging it to 
the right makes them larger.

	— Sort Stills: Choosing an option from this submenu changes the sort order of all clips in the 
Gallery. The options are: 

	— Still ID: Sorts all stills by their assigned ID number (track, clip number, grade version).

	— Label: Sorts all stills by their text label.

	— Record Timecode: Sorts all stills by their position in the program.

	— Source Timecode: Sorts all stills by the timecode of the source clip they came from.

	— Grab Date: Sorts all stills by the date they were originally grabbed.

	— Create Time: Sorts stills based on when you saved each still.

	— Thumbnail View: Pressing this icon puts the gallery in Thumbnail view; each still is represented 
by an image.

	— List View: Pressing this icon puts the gallery in List view; each still is represented by 
columns of text attributes.
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	— Search: Opens up a search dialog box, to find stills based on their text label.

	— Gallery View: Opens up the full Gallery Management window.

The Gallery options (L-R): Still Size Slider, Sort 
Stills, Thumbnail, List, Search, Expand, Options

When you right-click the gray area of the Gallery, behind the Still icons, you can open a contextual 
menu that provides a variety of additional options for controlling how many stills are saved, how 
they’re displayed, and how they’re arranged in the Gallery. There are the following options:

	— Switch Wipe Mode: Switches the Reference mode between showing a “Gallery” still, a “Timeline” 
clip, or an “Offline” reference movie.

	— Trace Timeline: When enabled, selecting a clip in the Timeline also automatically selects the first 
still that was saved from that clip to the Gallery.

	— One Still Per Scene: When enabled, restricts the Gallery to save only a single still for each clip in 
the Timeline. If multiple stills have already been saved before turning this option on, those stills 
will remain in the Gallery until you save another still from the same clip, at which time all other 
stills from that clip will disappear.

	— Apply Display LUT: If you have a Display LUT selected in the Lookup Tables panel of the Color 
Management panel of the Project Settings, it’s applied to the video output via a connected video 
interface, and also to the Viewer. Ordinarily, you don’t also want the Display LUT applied to stills 
you’re saving since it’s meant to be temporary. Accordingly, stills are saved with a LUT-free image. 
However, in instances where you may also want to save a reference to the currently used Display 
LUT, turning on “Apply Display LUT” saves the Display LUT along with the still, and applies that LUT 
when that still is used for split-screen reference. Keep in mind that the internally saved Display LUT 
is only used when playing that still in the Viewer; the DPX image that’s saved remains unaffected.

	— Apply Grades Using: This submenu contains three options for how to apply the keyframes that 
are automatically saved within each saved grade.

	— No Keyframes: No keyframes are copied. The state of the grade at the frame used to save 
the still is what is applied to the target clip or clips.

	— Keyframes Aligning Source Timecode: Keyframes are copied aligning the source timecode 
of the saved grade with the source timecode of the target clip. This is the ideal setting when 
you’re copying a grade back to the clip it came from originally, or to a duplicate of that clip 
elsewhere in the Timeline, and you want the keyframes to align with the same frames as 
before. If there is no source timecode overlap, keyframes will be pasted aligning with the start 
frame of the edit, the same as the third option (below).

	— Keyframes Aligning Start Frames: Keyframes are copied aligning the start frame of the 
clip that still was saved from with the start frame of the target clip. This is the ideal setting 
when you’re copying a grade with keyframes from one clip to a completely different clip, with 
different timecode.

	— Use labels on still export: Lets you use labels that you’ve added to stills in the file name of 
exported stills. 

	— Show All Stills: This command shows all available stills in the current album if any have been 
hidden, for example by searching or by using the Show Current Timeline Only command.
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	— Show Current Timeline Only: Choosing this option restricts the Gallery to only showing the 
stills that were saved from the currently selected Timeline. All other stills from other Timelines are 
hidden until you switch to that Timeline.

NOTE:  There are a variety of other commands available in this contextual menu that are 
covered elsewhere in this chapter.

Organizing Stills Using Albums
All stills you save are always placed into the currently open album of the Gallery, which defaults for 
new projects to “Stills 1.” However, you can create additional albums with which to organize your stills 
into whatever categories you require. Albums can be shown, created, and removed using the Gallery 
in either the Color page or Gallery windows.

Use albums to organize your stills

To show or hide the Albums list:

	— Click the Album button, at the top left of the Gallery.

If the Albums list was hidden, clicking the Album button will make the Albums list appear, to the left of 
the Gallery, containing all albums that are currently available in the project that’s open, as well as the 
PowerGrade album at the bottom. If the Albums list is already visible, then it becomes hidden, making 
more room for still thumbnails in the Gallery.

Once you’ve displayed the Albums list, there are a variety of ways you can quickly and easily work 
with albums.

Methods of working with albums:

	— To add a new album: Right-click the Albums list, and choose Add Still Album from the contextual 
menu. A new album is created, numbered incrementally.

	— To add a new PowerGrade album: Right-click the Albums list, and choose Add PowerGrade 
Album from the contextual menu. A new album is created, numbered incrementally.

	— To rename an album: Double-click any album in the list, and when it is selected, type a new name 
and press Return.
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	— To navigate albums: Click any album to make it the current album. Using the DaVinci Resolve 
Advanced control panel, you can use the PREV PAGE/NEXT PAGE buttons to move up and 
down the Album list.

	— To move clips from one album to another: Drag and drop a still from the Gallery to an album.

	— To remove an album: Right-click any album, choose Remove Current Album, and click Delete at 
the prompt. All clips inside that album will be deleted along with the album, so use this carefully.

PowerGrade Albums
PowerGrade albums are meant to be repositories for grades you want to reuse frequently, or for stills 
that you need to reference from multiple projects, such as when grading a series that shares common 
looks from episode to episode.

PowerGrades are associated with your user login

Unlike stills saved to the other albums in the list, which are ordinarily available only to the project 
in which they were saved, stills saved to a PowerGrade album are shared among all projects 
that have been stored within a particular project library. Each project library has its own unique 
PowerGrade album.

Creating a new project library creates a new PowerGrade album, which starts out as a clean slate. 
However, you can always use the Gallery window to copy PowerGrade stills from other projects and 
project libraries to the current one, and you can create as many PowerGrade albums as you need to 
organize your grades. For more information about project management and project libraries, see 
Chapter 3, “Managing Projects and Project Libraries.”

Functionally, PowerGrade albums are identical to any other album, and you can save, organize, and 
use stills in PowerGrade albums as you would with other albums. Since PowerGrade albums are 
special in that they’re maintained by DaVinci Resolve, the last PowerGrade album cannot be deleted.
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Browse all Grades from 
the Current Timeline
The Gallery has a Timelines album, available at the bottom of the Album list, that lets you browse all 
the grades in the current timeline, or in other timelines of the current project (using a drop-down 
menu that appears at the top of the Gallery browser area), making it easy to copy grades from earlier 
or later in your timeline, or from other timelines that share the same media. 

This is particularly useful for reality shows or documentaries where the same clips can appear multiple 
times in different parts of a program. Being able to simply show all existing grades in the Gallery frees 
you from having to save a still for every grade you think you might eventually reuse.

The Timelines grade browser in the Gallery automatically shows all grades in the current timeline

The Gallery Management Window
While you can do quite a lot of stills management using the Gallery as it appears in the Color page, 
the Gallery window provides additional functionality for copying stills among different projects and 
project libraries, for organizing your stills and memories, and for accessing the DaVinci Resolve looks 
that accompany the application.

To open the Gallery window:

	— Click the Gallery View button at the upper right-hand corner of the Gallery or select 
Workspace > Gallery.
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Gallery window

The Gallery opens into a floating window, divided into four areas:

	— Stills navigator: Lets you navigate the contents of other projects and project libraries that are 
available. Independent projects, as well as project library > user > project relationships, appear in 
this hierarchical list. Click the disclosure triangle next to any item on this list to reveal its contents. 
Click any project in the list to reveal its albums and stills in the Group Stills browser.

	— Group Stills browser: Displays the contents of the currently selected item in the Stills navigator. 
One or more selected stills can be copied to the current project by selecting an album in 
the Project Stills browser, and dragging and dropping the selected stills to the Project Stills 
browsing area.

	— Project Stills browser: Contains the same Album list and Project Stills browser that’s visible in the 
Color page Gallery.

	— Project Memories: Provides a larger view of the project memories that are visible in the 
Color page Gallery.

To resize different areas of the Gallery window:

	— Move the pointer to the border between any areas of the Gallery. When the pointer changes to 
the resize cursor, drag the border to resize the adjacent interface areas to whatever size you need. 
Dragging all the way to the edge of the screen hides that interface area completely.

What’s Available in the Stills Navigator
The Stills Navigator accesses a variety of content via a hierarchical list. Disclosure triangles to the 
left of each item in the Stills browser let you access the contents of each item, and many items have 
several nested levels of content within, each accessed by its own disclosure triangle.
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The Gallery Stills project library show all projects connected so you can import those stills

	— DaVinci Resolve looks: A collection of predefined grades, categorized by type, that provides 
excellent examples of different looks available in DaVinci Resolve. These grades are installed with 
DaVinci Resolve and cannot be altered.

	— Project Libraries: Each project library that’s available appears within this list. Each project library 
has a nested series of users, projects, and timelines within, as well as one nested PowerGrade 
item for each user, which provides access to the saved stills within.

	— Orphans: Stills are saved to a separate directory which is defined in the Master Settings panel of 
the Project Settings. Whenever you delete a project library, the stills that corresponded to that 
project library become orphaned. All orphaned stills that lack a connection to any current project 
library appear within the Orphan item in the Stills Navigator.

Browse and Import Timeline 
Grades From Other Projects
The Gallery window lets you see and import grades in the timelines of other projects, even if they 
weren’t saved as stills first. When you open the Gallery Window and use the hierarchical disclosure 
controls of the Stills panel to open up and select a specific Project Library > User > Project > Timeline, 
you’ll see at least three browsable albums to the right: the Stills galleries that were created, the 
Memories, and at the bottom an album called Timeline Media. The Timeline Media album lets you 
browse the currently used grades for every clip in that timeline, making it easy to copy the ones you 
need to the current project’s Stills album or Memories.

This is particularly useful if you’re working on a series where and you find that you want to re-use 
different grades, looks, adjustments, or fixes from previous episodes in the current one. Previously, 
you’d have to remember to save every clip as a still to be able to browse the grades in this way. Now 
you can simply browse the clips in the Timeline directly.
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Browsing the timeline grades for another project in the project library

Importing and Exporting Stills
It’s possible to import still images in different graphics formats into the Gallery, which can be 
particularly useful when a client provides reference images to which they’d like you to refer. It’s also 
possible to export stills from the Gallery, which is good for sending a series of reference stills for 
approval to a remote client. In both cases, you can choose whether to import or export images with 
an accompanying LUT.

For both import and export, DaVinci Resolve supports the following file formats: DPX, CIN, TIFF, JPEG, 
PNG, PPM, BMP, and XPM.

To import one or more still images:

1	 Right-click anywhere on the gray background of the Gallery.

2	 Choose one of the following commands:

	— Import: Imports image files, along with a matching DRX file, if one is present in 
the selected directory.

	— Import With Output LUT: Imports an image and DRX file, along with a matching LUT file, 
if one is present in the selected directory.

3	 When the Import Stills dialog appears, choose the type of files you want to import from the 
“Files of type” drop-down menu, then navigate to the files you want to import, select them, 
and click Import. 

To export one or more still images:

1	 If you want to export Gallery stills with labels that have been added to them, right-click anywhere 
in the background of the Gallery and choose “Use labels on still export” in the contextual menu so 
it becomes checked.

2	 Select one or more stills in the Gallery.
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3	 Right-click one of the selected stills, and choose one of the following commands:

	— Export: Two files are saved for each still you selected. An image file in the format of your 
choice, and a DRX (DaVinci Resolve eXchange) file that contains the grading metadata that was 
saved with that Gallery still.

	— Export With Display LUT: If you have a Video Monitor Lookup Table specified for the current 
project in the Color Management panel of the Project Settings, this command will output the 
image as it is processed by the specified LUT. A DRX file is also output containing the grading 
metadata that was saved with that Gallery still.

4	 When the Export Stills dialog appears, choose a file format to export to from the “Files of type” 
drop-down menu, then choose a location, type a name into the Save As field, and click Save.

Each of the selected stills is exported with all accompanying files. Each file uses as its prefix the 
name you typed into the Export Stills dialog, followed by an underscore, the still ID number of the 
selected still, and the three-letter file extension.

Using and Organizing Memories
Stills and memories contain identical information, and can be split screened, copied, appended, 
exported, and can display their node graph just like any other still. However, stills that are assigned 
as a memory make them easier to access via keyboard shortcuts, and from dedicated buttons on the 
DaVinci control panel.

Memories are hidden by default, but you can reveal them by clicking the Memories button, to the right 
of the Gallery list button at the top-left of the Gallery.

Place grades you will use often in Memories for faster recall

The Memories thumbnail display makes it easy to keep track of which stills have been assigned to which 
memories in situations where you’re using multiple memories to copy grades throughout a program.

To copy stills and memories back and forth, do one of the following:

	— Drag a still onto a memory bank.

	— Drag a memory into the Gallery.

TIP:  In this way, memories can be used to copy stills from one album to another.
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To save the current clip’s grade to a memory for future use, do one of the following:

	— Choose Color > Memories > Save Memory A–H (Option-1 through 8).

	— Using the DaVinci Resolve Advanced control panel, press CRNT on the Search Dial panel, then 
press the letter of the memory bank you want to save to. Use the SHIFT UP and SHIFT DOWN 
buttons to save to another memory sharing the same button.

	— If you save a grade to a memory that already contains something, the previous memory 
is overwritten.

To apply a memory to the current clip in a timeline, do one of the following:

	— Right-click a memory and choose Apply Grade.

	— Choose Color > Memories > Load Memory A–H (Command-1–8).

	— Using the DaVinci control panel, press the letter of the memory bank you want to apply. Use the 
SHIFT UP and SHIFT DOWN buttons to apply a memory that shares the same button.

To clear a memory:

	— Right-click a memory, then choose Clear.
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Chapter 139

Grade Management
The Color page offers numerous ways of saving grades, copying grades, creating and altering groups 
of clips to share grades, rippling grades and adjustments, and managing multiple versions of grades.

All of these procedures enable you to work faster by leveraging work you’ve already done to apply to 
other clips that can benefit from the same adjustments, or by applying changes across multiple clips 
all at once.
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Using Versions to Manage Grades
Working quickly requires a mastery of the numerous grade management features built into 
DaVinci Resolve. These features are designed to help you copy and ripple grades to individual clips, 
among manually defined groups of clips via the Node Editor’s Clip mode, or among automatically 
linked clips that share the same source clip in the Media Pool (when using Remote versions). Multiple 
versions of grades are supported for every clip, as are various options for previewing, overwriting, and 
appending these versions.

Choosing to Copy Grades Manually 
or Automatically Using Versions
Each grade you apply to a clip is a version. Each clip can have multiple versions, although only one 
version can be applied at a time. By default, the first grade applied to every clip in a timeline is a 
local version named “Version 1.” A clip’s version name and/or number appears underneath the clip 
thumbnail, to the right. You can also see the version name, along with a list of all the other versions 
that are currently available to that clip, by right-clicking a clip in the Timeline and looking for the 
version names that appear underneath the Local Versions submenu.

Selecting versions of grades from the Timeline thumbnails

NOTE:  Double-clicking the version name underneath a clip’s thumbnail in the Timeline 
cycles the version names, the clip names, and the codec used by each clip.

There are two different types of versions in DaVinci Resolve, each of which provides a different 
method of grade management and linking among the clips and timelines of a project.

	— Local versions: The default mode of grade management. Clips using local versions are unlinked, 
so each clip has its own grade which is not shared with any other clips in any other timelines. 
Changing the grade of a clip using a local version has no effect on any other clip in that project. 

	— Remote versions: An alternate mode of grade management that you can enable. All clips using 
remote versions that share the same source clip in the Media Pool are automatically linked, in all 
timelines, and share the same set of grades.

If you use local versions to grade all your clips, you don’t have to worry about one clip’s grade being 
accidentally copied to other clips that happen to come from the same file in the Media Pool, which can 
make it easier to work. On the other hand, you need to manually copy every grade that you want to 
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duplicate, even among clips that clearly come from the same take or angle. You can always create a 
group to share a grade among clips using local versions, but that’s an extra step.

Switching to use remote versions, instead, puts you into a mode where clips using remote versions 
that share the same media file are automatically linked together. This gives you a convenient shortcut 
for grading your program, since a grade that’s applied to one linked clip is automatically copied to 
every other clip it’s linked to, which can be convenient when grading a series of headshots appearing 
throughout a program that come from the same interview take. Another use of remote versions 
is when you’re importing a new edit of an already graded timeline. Using remote versions, you 
can set your project up so that new incoming timelines are automatically relinked to the previous 
timeline’s grades.

The only disadvantage to using remote versions is that when you find you need to make individual 
adjustments to clips that are linked, it’s an extra step to either create another version, or switch that 
clip to use a local version, in order to keep its adjustment separate. This will be discussed in more 
detail later in this chapter.

Mixing Versions
Each clip is capable of having multiple local and remote versions at the same time; you get to choose 
which to apply. Which type of versioning is best depends on the type of project you’re working on, 
the way in which the media was shot, and how you like to work. The following sections explain the 
differences in workflow.

Using Local Versions by Default
Since local versions are the default method of grading when you first create a new project (unless 
you’ve edited your settings presets), you don’t need to do anything to enable this mode at first. As the 
name implies, local versions are local to the Timeline in which they appear, so local versions are not 
rippled to linked clips, and they’re not shared among different timelines. This makes it easy to avoid 
accidentally having grades copied when you don’t want them to be, but you lose the conveniences that 
automatic linking can provide.

However, you can always switch the clips in a timeline to use remote versions if you change your mind, 
either individually, or all together.

Using Remote Versions to Enable Automatic Linking
Remote versions let all clips from the same source media file in the Media Pool share their grades 
automatically, either within a single timeline, or across multiple timelines in the same project. 
However, to enable the convenience of remote grades, you need to put DaVinci Resolve into this mode 
of working using the Settings window. 

To enable remote grades to be used:

	— Open the Project Settings, open the General Options panel, and turn off “Use local version for 
new clips in timeline” in the Color section.

Turning this option off only affects clips that are added to Timelines from that point onward. 
You can keep track of which clips use remote versions by the (R) that appears when you double-click 
the area underneath the thumbnail to hide the codec name in the Thumbnail timeline.
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Turning off “Use local version for new clips in timeline” to enable remote grades to be used by default

How Automatic Linking Works
When clips using remote versions have been added to a timeline, any other clips in any timeline that 
(a) use remote versions also, and (b) refer to the same file in the Media Pool are linked. Selecting a 
clip using a remote grade in the Color page that is automatically linked to one or more clips displays a 
small “linked” badge at the right of that clip’s timecode in the Thumbnail timeline.

The linking arrow shows this 
clip has the same source as the 
one selected on the Timeline

TIP:  The Timeline Filtering drop-down in the Color Page toolbar has an option named 
“Common Media Pool Clips” that only shows clips in the Timeline that are linked to the 
currently selected clip.

Adjustments that you apply to a remote version of one linked clip are automatically rippled to 
every other clip it’s linked to, which can save you an enormous amount of time when you’re getting 
started with a new program. For example, if every reverse angle from the same take in a particular 
angle of coverage is automatically linked using remote versions, then the grade you apply to one 
reverse angle clip will ripple to every other reverse angle clip throughout the Timeline.

Timeline with three automatically linked clips shown, and codec names hidden 
to reveal the (R) that shows these clips are using remote grades
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So long as remote versions are enabled, there are other ways that linked clip relationships are formed. 
If, after conforming an AAF, XML, or EDL, you used the Split Clips button in the Color page to split one 
conformed clip into many, each of the clips you split would be linked, since they too would share the 
same source media in the Media Pool.

Finally, automated linking also occurs for clips that appear in multiple timelines that also use remote 
versions. As a result, the grade you apply to one linked clip is automatically rippled to every other clip 
it’s linked to.

NOTE:  Media management or media consolidation operations that split large source media 
files into many individual media files will defeat automatic linking within the same timeline, 
since each clip will be conformed to its own individual media file. 

Starting with Remote Versions, 
Then Switching to Local Versions
It’s possible to combine the best aspects of remote and local versions into a single 
workflow, taking advantage of your ability to freely switch from one to the other. Since 
remote versions make it easy to copy grades among clips that are similar, you can switch 
to using remote versions first, and then grade your way through the Timeline until you 
get to the point where you need to start making much more specific changes to individual 
clips. Then, it’s easy to either switch each linked clip that needs individual adjustment to 
use a local version, or to use the Copy Remote Grades To Local command (described later) 
to copy the current remote version of each and every clip to a local version, at which point 
you can make all the specific tweaks you need to without worrying about changes being 
accidentally copied.

Creating a Master Timeline
DaVinci Resolve version 9 and earlier would automatically create a Master Timeline whenever you 
added clips to the Media Pool. This changed in versions 10 and later, which by default have no Master 
Timeline. However, if you want to create a Master Timeline in order to use it as you would have before, 
this is easy to do.

If you want a Master Timeline to have a single timeline that always contains all clips currently in the 
Media Pool, there’s a way you can create one. However, you need to do it immediately upon creating a 
new project, before adding any media to the Media Pool. Once you’ve added one or more clips to the 
Media Pool, the option you need to do so will be disabled.

To create a new Master Timeline:

1	 Create a new project, open the General Options panel of the Project Settings, and turn on the 
“Automatically match master timeline with media pool” checkbox in the Color section. If you also 
want all clips to use Remote versions as you grade by default as in previous versions of DaVinci 
Resolve, you can turn off the “Use local version for new clips in timeline” checkbox.

2	 Click Save.
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3	 Open the Edit page, and choose File > New Timeline (Command-N).

4	 When the New Timeline Properties window appears, turn the Empty Timeline checkbox off, and 
click Create New Timeline.

Now, in addition to the new Timeline, a Master Timeline appears in the Timeline list.

Once created, the Master Timeline contains every clip in the Media Pool of the current project. If you 
color correct the clips in the Master Timeline, you’ll find there’s only one set of versions available, 
found underneath the Local submenu of the Color Page timeline’s contextual menu. It’s important 
to understand that local versions within the Master Timeline are in fact the remote versions found in 
every other timeline of that project. 

In fact, it would be fair to say that the remote versions found in other timelines are actually the Master 
Timeline’s versions. When you grade a clip in the Master Timeline, those grades ripple out to every 
other instance of that clip, in every other timeline within that project, via remote versions.

Sharing of remote versions among the Master Timeline and newly conformed timelines is why you can 
grade a collection of clips that you import into DaVinci Resolve without any editorial structure, grade 
and output offline media, and then reimport a project file that relinks to the original clips along with 
their grades. It’s also why you can grade clips in one timeline, and then import additional re-edited 
timelines via AAF, XML, or EDL, which automatically inherit all remote versions of grades that were 
created in previous timelines.

Differentiating Clips with Individual Versions
If you’ve enabled DaVinci Resolve to add clips with remote versions, there are times when you may 
want to suspend automatic linking. As convenient as automatic grade rippling among linked remote 
versions is, there are many instances where you may need to stop it. For example, if the Media Pool 
contains a source media file with the entire content of an interview, then every clip that has been 
conformed to that source media will be linked, which is ordinarily good since you’d expect they’d all 
share the same grade. However, if the DP fiddled with the exposure of the camera in the middle of 
the interview, such that some clips are lighter and others are darker, you may find yourself needing to 
make different adjustments to clips from different parts of the interview.

One way of doing this, which can be useful in timelines where you only need to make a few of these 
kinds of changes, is to create a new remote version for every clip to which you need to make an 
individual adjustment. Since each version is its own grade, and differently named versions don’t link to 
one another, this is a simple solution.

To suspend linking by creating a new remote version:

1	 Move the playhead to the clip you need to alter individually.

2	 Do one of the following:

	— Choose Color > Grade Version > Add (Command-Y).

	— Right-click the thumbnail in the Timeline, and choose Remote Versions > Create New Version.

	— Using the DaVinci control panel, press ADD VERSION on the T-bar panel.

3	 Grade the new version that’s appeared.
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While this method works well, keep in mind that multiple linked clips using the same version number 
will always be linked with one another. In other words, suppose Clip 1, Clip 3, and Clip 5 are linked 
using the default Version 1, which has a strong blue grade applied.

Three clips automatically linked, sharing a blue grade

Then, you set Clip 3 to use Version 2 with a different grade, tinted red. Clip 3 is now unlinked from 
Clips 1 and 5.

Setting the second of the three clips to use another version with a different remote grade sets it apart

However, switching Clip 5 to also use the red-tinted Version 2 means that Clip 3 and Clip 5 are now 
linked together, but Clip 1 is no longer linked.

Setting the third of these clips to share the same remote version as the 
second clip now links those two together, omitting the first clip

Every new remote version you create, and every change you make, becomes available to all other clips 
in all other timelines that comes from the same source Media Pool clip as the shot you’re working on. 
However, any clip can use any version, and which version is used by a linked clip is not rippled. 

For example, Timeline 1 contains a clip named Max CU, which has three remote versions. Timeline 5 
also contains Max CU, which is currently set to use Version 2. If you open Timeline 1 and add one more 
remote version to Max CU, that new version will also be available to Max CU in Timeline 5, but it will 
still be set to use Version 2.

Switching Clips Between Local and Remote Versions
You can also suspend remote version grade linking by switching individual clips to use local versions. 
This makes it easy to create a situation where some clips are linked, and other clips are not. Keep 
in mind that each clip has both local and remote versions, so you can switch from one to the other 
without losing anything.
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To suspend linking by setting individual clips to use a local version:

	— Right-click a clip thumbnail, choose the submenu of the corresponding remote version you want 
to copy, and choose Copy to Local. The remote version is copied to a local version, which now 
appears as the current version that’s used.

You can also set every clip in the entire timeline to use local versions. If you switch an entire timeline 
to local versions, then no clip in that timeline will be linked to any other unless you create a group 
(covered later in this chapter). This is the default state, but it’s useful even when you’ve switched to 
using remote versions when you want to grade one timeline differently from the others in a project, 
for example when doing a trim pass for another video or stereo 3D format, or when grading another 
cut, such as a trailer, that uses the same media but requires a different look.

To suspend linking by switching from remote versions to local versions:

	— Right-click any clip thumbnail, and choose one of the following commands;

	— Use Local Grades: Switches all clips to their local versions. If there are already local versions 
defined for each clip, those will appear. If there are no local versions yet defined, each 
clip will be ungraded.

	— Copy Remote Grades to Local: Copies the currently assigned remote version of each clip to a 
local version.

Because Undo is used only for individual clip operations, the Use Local Grades and Copy Remote 
Grades To Local commands cannot be undone. However, switching a timeline from remote to local 
versions is not a one-way trip. You can select Use Remote Grades to switch every clip in a timeline back 
to the remote versions at any time.

To switch a timeline back to using remote versions:

	— Right-click any clip thumbnail, and choose Use Remote Grades.

Furthermore, you can also copy the local grades you made to be remote grades, for instances where 
you started grading with local grades, and you want to switch to remote grading using your local 
grades as a starting point. Be aware that when you do this in a timeline with many clips that share the 
same source media, the grade of the very last shared clip in the Timeline will be the only remote grade 
that’s used for those auto-linked clips.

To copy each clip’s local grade to a remote grade for every clip in the current timeline:

	— Right-click any clip thumbnail, and choose Copy Local Grades to Remote.

If you’re switching back and forth between local and remote versions, keep the following 
rules in mind:

	— If you select Use Remote Grades, change your remote grades, and then Copy Remote Grades 
To Local on that timeline again, you’ll overwrite all of your previously graded local versions. This is 
a good workflow if you don’t like what you’ve done with your local versions, and you want to start 
over by recopying the remote versions.

	— If you select Use Remote Grades, change your remote grades, and then select Use Local Grades, 
you’ll return to your previously graded local versions, as they were before you selected Use 
Remote Grades. This is a good workflow if you just want to switch back to your remote versions in 
order to copy the remote versions of specific clips to local versions.
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Working with Versions
Each clip can have as many local and remote versions as you like. There are commands for creating, 
renaming, and deleting the versions that are available to each clip when using the pointer, keyboard 
shortcuts, or the DaVinci control panel. When using the DaVinci control panel, the buttons affect 
whichever type of version (remote or local) is currently applied to the current clip.

Additionally, DaVinci Resolve 15 introduced the ability to batch create, rename, load, and delete 
versions for multiple clips that are selected at the same time.

To create a new local or remote version quickly for one or more selected clips, 
do one of the following:

	— Choose Color > Grade Version > Add (Command-Y).

	— Using the DaVinci control panel, press ADD VERSION on the T-bar panel.

A new version is created, identical to the type of version that was previously selected (remote or local), 
named “Version x” where x is the number of the versions that have been created. All keyframes and 
motion tracking are copied from the previously selected version to the new one.

To create a new version for one or more selected clips, with the option to set a name 
and whether to copy keyframes:

1	 Right-click one of the selected clip thumbnails, and choose one of the following:

	— Local Versions > Create New Version

	— Remote Versions > Create New Version

2	 Type a name for the version in the dialog that appears, and choose either “Copy all marks” or 
“Copy the first mark only,” depending on whether or not you want to copy all the keyframes into 
the new version. 

NOTE:  Motion tracking will be copied regardless of whether “Copy all marks” is 
selected or not.

3	 Optionally, you can choose one of the preset version names from the drop-down list. These 
names are defined in the Versions section of the General Options panel of the Project Settings.

4	 Click OK.

To delete a specific version for one or more selected clips:

	— Right-click one of the selected clip thumbnails, choose the submenu of the remote version you 
want to delete (it can’t be the currently selected version), and choose Delete.

To delete all versions for one or more selected clips:

	— Right-click one of the selected clip thumbnails, and choose one of the following commands from 
the contextual menu corresponding to the scope of the versions you want to delete;

	— Local Versions > Delete All Versions

	— Remote Versions > Delete All Versions

	— Delete All Versions

All versions are deleted as specified, except for the currently selected version, which is now the only 
one remaining.
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To load a particular remote or local version for one or more selected clips:

	— Right-click one of the selected clip thumbnails, choose the submenu of the corresponding remote 
version you want to copy, and choose Load.

To rename the version of one or more selected clips:

1	 Right-click one of the selected clip thumbnails, choose the submenu of the corresponding remote 
version you want to rename, and choose Rename.

2	 In the Version Name dialog, type a name into the text field. Optionally, you can choose one of the 
preset version names from the drop-down list. These names are defined in the Versions section of 
the General Options panel of the Project Settings.

Selecting a Version name from the dropdown list, the names 
on the list come from assignments made using the Versions 
section of the General Options panel of the Project Settings

3	 Click OK.

That name now appears underneath the clip thumbnail in the Timeline.

If you’re going to use predefined names for versions, you need to define these in the Versions group 
of the General Options panel of the Project Settings. Ten drop-down menus let you choose from 
preset version names, or enter your own. These names will appear in the drop-down menu of the 
Version Name dialog.

The Versions section of the Project Settings
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The Importance of “Version 1”
There are specific operations in DaVinci Resolve where “Version 1,” otherwise known as “the default 
version,” is the only version that’s used, regardless of how many other versions are available, or which 
version was previously selected. The default version can be named anything you want, but whatever 
its name, the default version is the first version in the list, and it’s important. Here are some examples:

	— Importing additional timelines that use the same clips: In this case, if you’re importing 
timelines and ”Use local version for new clips in timeline” is disabled in the Color section of the 
General Options panel of the Project Settings, then only the default version of each clip is relinked. 

	— Whenever you switch a timeline between local and remote versions: In this case, 
every clip in the Timeline will be switched to the default version, regardless of what you had 
selected previously.

Consequently, if you plan to reconform your clips to a newer version of the edit that you’re importing, 
or pursue other workflows that are off the beaten path, it’s a good idea to make sure, no matter 
how many versions you end up creating, that the most important grade is always copied back to the 
default version.

To copy any version quickly to the default version:

1	 Choose Color > Memories > Save Memory A (Option-1). You can use any memory you want, but 
Memory A is convenient for this example.

2	 Choose Color > Grade Version > Default (Command-U).

3	 Choose Color > Memories > Load Memory A (Command-1) to apply the saved memory to 
the default 

To copy any version quickly to the default version using the DaVinci control panel:

1	 Press CRNT and then press A (or any memory button you like). These controls are available on 
either the Transport or T-bar panel.

2	 Press DEFAULT VERSION on the T-bar panel.

3	 Press A (or whichever Memory button you used) to apply the saved memory.

To jump immediately to the default version, do one of the following:

	— Choose Color > Grade Version > Default (Command-U).

	— Press DEFAULT VERSION on the T-bar panel.

Deleting Unused Versions
In cases where you want to make absolutely sure there’s no alternative to the grade you want a clip to 
have, there’s an easy way to delete all versions except for the version that’s currently in use, thereby 
making it the default version.

To eliminate either local or remote versions except for the current version:

1	 Choose the local or remote version you want a clip to use.

2	 Right-click the thumbnail of the clip you want to eliminate extra versions from, and choose Delete 
Unused Versions from the contextual menu.
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If you selected a local version, all unused local versions will be deleted, but remote versions will be left 
alone. Similarly, if you selected a remote version, all unused remote versions will be deleted, but local 
versions will be left alone.

To eliminate all other local and remote versions except for the current version:

1	 Choose the version you want a clip to use.

2	 Right-click the thumbnail of the clip you want to eliminate extra versions from, and choose Delete 
All Versions from the contextual menu.

Regardless of whether you selected a local or remote version, all other local and remote versions 
not in use will be deleted.

Rendering Versions
When the time comes to render your clips in the Deliver page, each clip’s currently selected version 
will be rendered. If you need to render a different version for a given clip, you can either make sure it’s 
selected in the Color Page timeline before you open the Deliver page, or use the Versions submenu 
in the Color mode of the Deliver page Thumbnail timeline. This contextual menu also provides access 
to the Stereo 3D commands, the Edit PAR (Pixel Aspect Ratio) command, and a command for updating 
the Render Window Timeline thumbnails to reflect any changes you’ve made in case they haven’t 
updated automatically.

Additionally, the Commercial Workflow output option, located in the Deliver page, provides a method 
of rendering multiple versions for each clip when outputting your project in Source Order (as 
individual media files). There are two additional options in the Version submenus of each clip in the 
Thumbnail timeline contextual menu that let you control which versions are rendered when you use 
Commercial Workflow.

	— Render Disabled: Turning this option on excludes that version from being rendered when 
Commercial Workflow is enabled.

	— Enable Flat Pass: Turning this option on forces the selected version to render with the grade 
turned off, essentially outputting the original media.

For more information on rendering versions using the Commercial Workflow option, see Chapter 187, 
“Rendering Media.”

Copying Grades 
There are various methods you can use to copy grades from one clip to another. Which is appropriate 
to your need depends on your style of working with DaVinci Resolve.

Protecting Adjustments with the Copy Grade Options
Before going into the myriad of ways that grades can be copied from one clip to another, you should 
know of a series of options, available from the contextual menu of the Gallery (right-click anywhere 
in the gray area of the Gallery), that let you carefully specify grading, sizing, and stereo data to be 
preserved when overwriting grades in clips you’re copying to. There are three options:
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	— Copy Grade: Preserve number of nodes: Lets you choose 0–10 nodes to be protected when 
applying a grade. When set to 1, the first node of the copied grade is ignored, but all other nodes 
are copied. When set to 5, the first five nodes of a copied grade are ignored, as long as there are 
at least five nodes in the grade of the clip you’re copying to. This option is useful for colorists who 
routinely use the first few nodes for shot matching and scene balancing, with additional nodes 
applying individual or stylistic adjustments.

	— Copy Grade: Preserve Camera Raw Settings: When enabled, the camera raw Source settings 
of the current clip are preserved, letting you apply stylistic grades from unrelated clips without 
overwriting clip-specific source settings.

	— Copy Grade: Preserve Input Sizing: When enabled, Input Sizing adjustments are not overwritten 
by those of the copied grade.

	— Copy Grade: Preserve Convergence: When enabled, Convergence adjustments in the 
Stereo 3D palette are not overwritten by those of the copied grade.

	— Copy Grade: Preserve Floating Windows: When enabled, Floating Windows adjustments in the 
Stereo 3D palette are not overwritten by those of the copied grade.

	— Copy Grade: Preserve Auto Align: When enabled, Auto Alignment adjustments in the 
Stereo 3D palette are not overwritten by those of the copied grade.

	— Copy Grade: Preserve Dolby Vision™ Analysis Metadata: When enabled, Dolby Vision Analysis 
Metadata is not overwritten by that of the copied grade. Only available if you’re set up to do Dolby 
Vision grading. For more information, see Chapter 9, “Data Levels, Color Management, and ACES.”

	— Copy Grade: Preserve Dolby Vision™ Trim Metadata: When enabled, Dolby Vision Trim 
Metadata in the Dolby Vision palette is not overwritten by that of the copied grade. Only available 
if you’re set up to do Dolby Vision grading. For more information, see Chapter 9, “Data Levels, Color 
Management, and ACES.”

Copy and Paste From One Clip to Another
The simplest way to copy color adjustments from one clip and apply them to another clip is to use the 
same Edit > Copy and Paste commands shared with nearly every other application ever made. However, 
you can use this straightforward functionality in one of two ways, depending on the focus of the interface.

	— If you click on the clip in the Thumbnail Timeline, you copy and paste the entire grade from one 
clip to another. 

	— If you click inside the Node Editor, you copy and paste only the selected node to another selected node.

You can override this focus-based selection, and make the default behavior to only copy between 
nodes rather than entire grades regardless of the interface focus. Do this by checking the “Always 
perform copy and paste on selected nodes” box in the Color section of the User panel in Preferences.

Methods of copying and pasting grades and node adjustments.

	— To copy and paste an entire grade: Choose a clip with a grade you want to copy, and press 
Command-C. Then select the clip you want to copy the grade to in the Thumbnail Timeline, and 
choose Command-V to paste the entire grade.

	— To copy and paste a single node: Choose a clip with a node you want to copy, and press 
Command-C. Then select the clip you want to copy the node to in the Thumbnail Timeline, and 
then click anywhere inside the Node Editor. Then choose Command-V to paste the node that was 
selected when you copied to the currently selected node in the node tree.
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Copy and Paste Specific 
Parameters Using Paste Value
The Edit > Paste Value (Shift-Option-V) command lets you paste only the value of a specific parameter 
into the node of another clip.

To paste only a specific value:

1	 Select a Corrector node with a parameter you want to copy, and press Command-C to copy it. 
You’re really copying the entire grade, but that’s okay.

2	 Choose any other node in any grade, and open the palette that contains the parameter you want 
to paste into.

3	 Double-click the number field of the specific parameter you want to paste the copied value into.

4	 Choose Edit > Paste Value (Shift-Option-V) to paste that value.

NOTE:  Paste Value only works for parameters within palettes; it does not work for OFX or 
Resolve FX in the Inspector.

Applying Saved Grades From the Gallery
Every time you save a still into the Gallery or a memory, it contains both the Clip grade, and the 
Timeline grade, if one is applied. Which grade is applied from a still using the Apply Grade or Append 
Node Graph commands depends on which mode the Node Editor is in. This is selectable from the 
drop-down menu in the upper right-hand corner of the Node Editor.

 

Node Editor Clip and Track selector

If you’re in Clip mode, you’ll only copy the saved clip grade. If you’re in Timeline mode, you’ll only copy 
the saved timeline grade.

NOTE:  This mechanism also works for saving and applying grades for clips that are in 
Groups. The currently selected group grade in the Node Editor determines which grade is 
saved with a still, and the currently selected mode in the Node Editor determines where a 
saved grade will be applied.

Preparing to Copy or Apply Grades
For all other methods of copying or applying grades described in this chapter, there are some 
common methods of controlling how adjustments from the clip or still you’re copying from are applied 
to the clip you’re pasting or applying to.
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Choosing Which Aspect of a Grade to Apply with All/Color/Sizing
When applying grades using any of the techniques described in this section, you can use the All/Color/
Sizing setting that are available via the Mark > Keyframe Timeline Mode submenu, the drop-down 
menu that’s visible at the upper-right of the Keyframes Editor, or your DaVinci control panel. When 
copying a grade in conjunction with the settings in this menu, the following rules apply:

	— All: When All is selected, both the grade and the sizing are copied.

	— Color: Only the grade is copied, the target clip retains its original Input Sizing settings.

	— Sizing: Only the Input Sizing is copied, the target clip retains its original grade.

Choosing How to Copy Keyframes
When copying or applying grades that have keyframes, you can choose how these keyframes are 
copied via a setting in the Gallery contextual menu by right-clicking anywhere in the gray background 
area of the Gallery, and choosing one of these options from the Apply Grades Using submenu. There 
are three options:

	— No Keyframes: No keyframes are copied. The state of the grade at the frame used to save the still 
is what is applied to the target clip or clips.

	— Keyframes Aligning Source Timecode: Keyframes are copied aligning the source timecode of 
the saved grade with the source timecode of the target clip. This is the ideal setting when you’re 
copying a grade back to the clip it came from originally, or to a duplicate of that clip elsewhere in 
the Timeline, and you want the keyframes to align with the same frames as before. If there is no 
source timecode overlap, keyframes will be pasted aligning with the start frame of the edit, the 
same as the third option (below).

	— Keyframes Aligning Start Frame: Keyframes are copied aligning the start frame of the clip that 
still was saved from with the start frame of the target clip. This is the ideal setting when you’re 
copying a grade with keyframes from one clip to a completely different clip, with different timecode.

From that point on, keyframes, should they exist, will be copied or applied using the selected method 
whenever you copy a grade using any of the previously described methods.

Copying Grades Using the Pointer
An incredibly easy way of copying a grade from one clip to another, or from a still or memory in the 
Gallery to a clip, is by using the third button of your mouse, usually mapped as the “middle‑click” of the 
mouse scroll wheel. 

To copy a grade from a clip or still to one or more clips using the pointer:

1	 Select the clip thumbnail you want to copy the grade to in the Timeline; a single selected 
clip appears highlighted orange. If you want to copy a grade to several clips, you can either 
Command‑click multiple non-adjacent clips, or Shift-click a continuous range of clips; multiple 
selected clips appear highlighted red.

2	 Middle-click the clip thumbnail, Gallery still, or memory you want to copy the grade˛from.

The grade of the clip you middle-clicked is copied to the previously selected clip or clips.
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TIP:  If you’re using a trackpad, third-party software may allow you to define a “three‑finger-
click” that works the same as mouse button 3. If you’re a pen and tablet or trackball user, 
you may be able to define a stylus or other button to perform the same button-3 action.

If you don’t have access to a middle-click on the pointing device you’re using, there’s another way of 
doing this using a contextual menu command.

To copy a grade from a clip or still to one or more clips using the Apply Grade command:

1	 Select the clip thumbnail you want to copy the grade to in the Timeline; a single selected clip 
appears highlighted orange. If you want to copy a grade to several clips, you can either Command-
click multiple non-adjacent clips, or Shift-click a continuous range of clips; multiple selected clips 
appear highlighted red.

2	 Right-click the clip thumbnail, Gallery still, or memory you want to copy the grade from, and 
choose Apply Grade from the contextual menu.

The grade of the clip you middle-clicked is copied to the previously selected clip or clips.

Copy Forward Commands
Another simple way of copying grades is to use the equals (=) and minus (–) keys on the keyboard to 
copy grades forward from one or two clips behind the currently selected clip. This is a great way to 
copy grades in scenes with a shot-reverse-shot structure, where you’re cutting between two angles of 
coverage, each of which uses the same grade.

To copy grades forward:

	— To copy a grade from one clip back: Choose Color > Apply Grade From One Clip Prior, or 
press Equals (=).

	— To copy a grade from two clips back: Choose Color > Apply Grade From Two Clips Prior, or 
press Minus (–).

Copying Using Memories
Memories are virtually identical to stills, except that they’re labeled with a letter (A–Z) for easy access 
via keyboard shortcuts or DaVinci control panel buttons. A memory bank above the Gallery browser 
provides a visual reference of which saved grade is assigned to which letter. This makes it easy to keep 
track of multiple saved memories in instances where you’re copying them to several different clips 
throughout a scene or program. 

For example, you might save a memory for each angle of coverage in a complicated scene, making it 
easy to copy grades forward. In another example, you might save a memory for the grade applied to 
each interview subject’s headshot in a documentary, so you can copy that grade forward as you work 
through the documentary.

To save the current clip’s grade to a memory for future use, do one of the following:

	— Choose Color > Memories > Save Memory A–H (Option-1–8).

If you save a grade to a memory that already contains something, the previous memory is overwritten.
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To apply a memory to one or more clips in a timeline, do one of the following:

1	 Choose one or more clips in the Thumbnail timeline to copy to. This can be the current clip, or it 
can be a range of clips that you select by Command-Clicking or Shift-Clicking.

2	 Do one of the following to copy a grade to the selected clips:

	— Right-click a memory and choose Apply Grade.

	— Choose Color > Memories > Load Memory A–H (Command-1–8).

To clear a memory:

	— Right-click a memory, then choose Clear.

Copying Using Preview Memory
You can also preview the effect of a memory or saved grade on the current clip, with the option to 
either keep it if it works, or go back to the previous grade if it doesn’t. 

To Preview Memory:

1	 Move the playhead to a clip for which you want to preview a memory.

2	 Choose Color > Preview Memory (Option-Shift-P).

3	 Do one of the following: 

	— Right-click any saved still in the Gallery and choose Apply Grade.

	— Choose Memories > Load > Memory A–H (Command-1–8).

The selected grade or memory is now being previewed.

4	 Now, do one of the following to either accept or reject the memory:

	— If you like the effect, then you can leave it be and move on to another clip.

	— If you don’t like the effect, then choosing Color > Preview Memory (Option-Shift-P) again 
reverts the clip to the original grade.

Copying from Stills in the Gallery
As mentioned previously, each still you store in the Gallery contains the grading information as well as 
the image of the frame it was saved from. This saved grade can be applied to any clip in the Timeline. 

IMPORTANT:  Copied grades overwrite any previously existing grades on the clip 
or clips you copy to.

To apply a grade from a still to one or more selected clips in a timeline:

1	 Choose one or more clips in the Thumbnail timeline to copy to. This can be the current clip, or it 
can be a range of clips that you select by Command-clicking or Shift-clicking.

2	 Do one of the following to copy a grade to the selected clips:

	— Drag the still from the Gallery into the Viewer.

	— Right-click a still in the Gallery and choose Apply Grade.

	— Middle-click a still in the Gallery.

	— Double-click a still to wipe it in the Viewer against the current clip in the Timeline, then 
right‑click the Viewer and choose one of the options from the Apply Grade submenu.
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Append Node Graph
You can also append a saved grade to any clip in a timeline. This adds the entire node graph of the 
saved still to the end of the node tree of the current clip. In other words, the current clip’s grade isn’t 
overwritten, the applied grade is added to the end of it.

By planning ahead, you can save fragmentary grades that create specific effects or adjustments using 
only a few nodes. You can then use these fragmentary grades as a toolkit that you can add to other 
grades in order to mix and match different adjustments and effects. 

For example, you could create a three-node glow effect, save it, and then apply that effect at the end 
of a completely different clip’s grade.

Appending grades places them after the original nodes

To append a saved grade or memory as individual nodes, do one of the following:

	— Drag a still or memory from the Gallery onto a connection line in the Node Editor; when the 
plus icon appears, drop it and its nodes will be appended within the node tree starting at 
that connection.

	— Right-click a still or memory in the Gallery, and choose Append Node Graph.

Ordinarily, when you append the node graph from a memory or still to another node graph, you 
end up adding a whole shedload of new nodes. This may be exactly what you need, but in situations 
where you want to keep things a bit tidier, you also have the option of appending node graphs as 
compound nodes.

To append a saved grade or memory as a compound node:

	— Command-drag a still or memory from the Gallery onto a connection line in the Node Editor; 
when the plus icon appears, drop it and its nodes will be appended to the node tree as a single 
compound node.
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NOTE:  When you append the nodes from a gallery still to a grade, how keyframes are 
applied depends on the “Apply Grades Using” setting of the Gallery. For more information, 
see Chapter 138, “Using the Gallery.”

Aligning Keyframes to a Specific 
Frame While Copying Grades
If you need to copy a grade with keyframes so that the start keyframe of the copied grade aligns with 
a specific frame of the Timeline, you can do so using the following procedure:

To copy a grade and align its keyframes to a specific frame of the Timeline:

1	 Save a grade with keyframes as a Gallery still by right-clicking the Viewer and choosing Grab Still.

2	 Choose the clip you want to copy the saved grade to in the Thumbnail timeline.

3	 Double-click the Gallery still to wipe it against the current clip in the Viewer.

4	 Move the playhead to the frame of this clip you want the first keyframe of the saved grade to be 
aligned with.

5	 Right-click the Viewer and choose Apply Grade > Align Keyframes to Current Frame.

Copying Individual 
Nodes and Settings
Copying grades from clip to clip copies everything except for keyframes and motion tracking. 
However, there is one way you can copy the motion tracking from one clip to another, and that’s by 
copying and pasting individual node settings. This can save time when you’re assembling complicated 
node trees by recycling specific nodes or node settings from previous grades.

Copying and Pasting All Settings 
From One Node to Another
The simplest thing you can do is to copy all of a node’s settings, and paste them into another node. 
This makes it easy to duplicate things like windows, qualifier settings, keyframing, or motion tracking 
that you want to reuse in another node as the basis for another operation. This is also a quick way to 
manually ripple a change you make in a node to that same node in another clip’s grade.

To copy a node’s settings from one clip to another, do one of the following:

	— Option-drag one node onto another. When you drop it, the settings of the node you dragged 
overwrite those of the node you dropped onto.

	— Select a node with settings you want to copy and choose Edit > Copy (Command-C). Then, select 
a node you want to paste these settings to either in the current grade or in the grade of another 
clip, or create a new node, and choose Edit > Paste (Command-V) to paste the settings you copied. 
These pasted node settings overwrite any other settings that node previously used.
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Paste Attributes on the Color Page
You can copy the settings of one node and 
paste a subset of those settings to another 
selected node by choosing Edit > Paste 
Attributes (Option-V). A Paste Attributes 
window appears that shows you which node 
you’re copying from, and which node you’re 
pasting to, and provides controls for choosing 
whether you want to paste keyframes and 
how to align them (Start Frames or Source 
Timecode), as well as a series of checkboxes for 
choosing which palettes, windows, and OFX/
ResolveFX you want to apply. You can only 
paste all parameters from a specified palette; 
there’s no current provision for pasting specific 
parameters from within a given palette, with 
the exception of pasting specific windows and 
their accompanying trackers.

The Paste Attributes window on the Color page

Copying from the Node Graph of 
Other Clips or Gallery Stills
When constructing new grades, you may sometimes find it convenient to copy existing nodes or node 
settings from the grade of another clip or gallery still. This can be easily accomplished by exposing the 
node tree of any still that’s saved in the Gallery, or any clip in the Thumbnail timeline, and using the 
controls found in the floating node graph to copy individual nodes or node adjustments to the current 
clip’s grade shown in the Node Editor. 

Copying Clip Settings Using Display Node Graph
In Clip mode, the floating Node Graph window has four sets of controls you can use to choose how to 
copy nodes and adjustments:

	— Clip Node Graph: By default, the Clip node graph is displayed at the left. You can drag any node 
from the floating node graph to the current grade shown in the Node Editor, and drop it onto an 
existing node to overwrite that node’s settings or onto a connection line to insert it as a new node.

	— Timeline Node Graph: (Only available if there is a Timeline grade) You can switch to the Timeline 
grade, if there is one, by either clicking the second button in the Node Graph title bar, or by 
choosing Timeline from the drop-down menu at the upper right-hand corner of the floating 
Node Graph window.

	— Apply Color/PTZR/Source/All buttons: With the Clip panel selected, four buttons let you 
selectively copy the entire grade, the sizing, the source settings, or all settings at once to 
the current clip.
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Dragging a node from another clip’s node graph to the currently selected clip’s grade in the Node Editor

Copying Node Settings Using Display Node Graph
In Node mode, the floating Node Graph window displays all of the available Color Attributes found 
within each node, instead of the Apply Color/PTZR/Source/All buttons:

	— Node Settings: Use the checkboxes to choose which node adjustments get copied and which 
do not. After you’ve checked the settings you want to selectively copy, dragging a node from the 
floating node graph onto nodes in the Node Editor copies or appends the selected attributes into 
the target node, leaving all other attributes alone. For Windows and OpenFX, you have the option 
of also copying any motion tracking that’s available.

The Node panel open with the Color Corrector and Blur attributes selected for copying

Ability to Open Compound Nodes in “Display Node Graph”
When you right-click a Gallery still or a thumbnail and choose Display Node Graph for a grade that 
uses compound nodes, you can right-click any compound node and choose “Show compound node,” 
or Command-double-click a compound node to open it and see its individual nodes.
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Opening a compound node in a floating Node Graph window

How to Copy Nodes Using Display Node Graph
The following procedures describe how to open the floating node graph in different situations.

To copy individual nodes or settings from any still in the Gallery:

1	 Click the thumbnail in the Timeline of the clip you want to copy nodes to. Its node graph will 
appear in the Node Editor. 

2	 Right-click a still in the Gallery you want to copy nodes from, and choose Display Node Graph. 
A floating Node Graph window appears displaying that still’s node tree.

3	 (Optional) While the Gallery Node Graph window is open, you can select any other still, and this 
window will update to show the currently selected still’s node graph, ready for you to copy from.

4	 In the floating Node Graph window, choose Clip if you want to copy overall clip attributes, or 
choose Node to copy individual node attributes.

5	 Do one of the following to copy nodes or settings to the Node Editor.

	— In Clip mode, drag any node from the floating node graph to the current grade shown in the 
Node Editor, and drop it onto an existing node to overwrite that node’s settings. If you open 
the Node panel and choose specific attributes, only those attributes will be copied to the 
node you drag onto.

	— In Clip mode, drag any node from the floating node graph to the current grade shown in the 
Node Editor, and drop it onto a connection line to insert it as a new node. If you open the 
Node panel and choose specific attributes, only those attributes will be copied to the new 
node that’s created.

	— In Clip mode, click Apply Color to copy the entire grade from the floating node graph to 
overwrite the current grade in the Node Editor.
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	— In Clip mode, click Apply PTZR to copy the sizing from the floating node graph to overwrite 
that of the current clip.

	— In Clip mode, click Apply Source to copy the source settings from the floating node graph to 
overwrite those of the current clip.

	— In Clip mode, click Apply All to copy every setting from the floating node graph to the 
current clip.

	— In Node mode, select which attributes you want to copy, and then drag any node from the 
floating node graph to the current grade shown in the Node Editor, and drop it onto an 
existing node to overwrite the settings of that node that you selected.

	— In Node mode, select which attributes you want to copy, and then drag any node from 
the floating node graph to the current grade shown in the Node Editor, and drop it onto a 
connection line to insert it as a new node with only the settings that you selected.

6	 While the floating Node Graph window is open, you can also select any clip in the Thumbnail 
timeline to change the grade that’s displayed in the Node Editor, ready for you to copy to.

7	 Click Close when you’re finished.

To copy individual nodes or settings from any clip in the Timeline:

1	 Click the thumbnail in the Timeline of the clip you want to copy nodes to. Its node graph will 
appear in the Node Editor.

2	 Right-click the thumbnail of another clip you want to copy nodes from, and choose Display 
Node Graph.

NOTE:  The Display Node Graph command only appears in the contextual menu of a clip 
in the Thumbnail timeline that is not currently selected.

3	 (Optional) In the floating Node Graph window, choose Clip if you want to copy overall clip 
attributes, or choose Node to copy individual node attributes.

4	 Do one of the following to copy nodes or settings to the Node Editor.

	— In Clip mode, drag any node from the floating node graph to the current grade shown in the 
Node Editor, and drop it onto an existing node to overwrite that node’s settings. If you open 
the Node panel and choose specific attributes, only those attributes will be copied to the 
node you drag onto.

	— In Clip mode, drag any node from the floating node graph to the current grade shown in the 
Node Editor, and drop it onto a connection line to insert it as a new node. If you open the 
Node panel and choose specific attributes, only those attributes will be copied to the new 
node that’s created.

	— In Clip mode, click Apply Color to copy the entire grade from the floating node graph to 
overwrite the current grade in the Node Editor.

	— In Clip mode, click Apply PTZR to copy the sizing from the floating node graph to overwrite 
that of the current clip.

	— In Clip mode, click Apply Source to copy the source settings from the floating node graph to 
overwrite those of the current clip.

3093Color  |  Chapter 139  Grade Management



	— In Clip mode, click Apply All to copy every setting from the floating node graph to 
the current clip.

	— In Node mode, select which attributes you want to copy, and then drag any node from the 
floating node graph to the current grade shown in the Node Editor, and drop it onto an 
existing node to overwrite the settings of that node that you selected.

	— In Node mode, select which attributes you want to copy, and then drag any node from 
the floating node graph to the current grade shown in the Node Editor, and drop it onto a 
connection line to insert it as a new node with only the settings that you selected.

5	 (Optional) While the floating Node Graph window is open, you can also select any clip in the 
Thumbnail timeline to change the grade that’s displayed in the Node Editor, ready for you to copy to.

6	 Click Close when you’re finished.

Rippling Adjustments 
Among Multiple Clips
If you’ve graded a sequence of clips and find yourself needing to make a quick change to several clips 
all at once, you can use the Color > Ripple Node Changes to Selected Clips/Current Group commands 
to quickly copy changes made to one clip to several others. However, these commands require that 
you follow certain rules in order to get the results you want.

Node rippling uses the number of each node to determine what changes should ripple to which 
nodes. In other words, changes made to Node 3 will ripple to Node 3 of every other selected clip, or to 
Node 3 of every other clip in the current group (depending on which command you use). 

Rippling changes from one clip to several others requires that all clips share the same number of 
nodes, at least for the nodes you’re rippling. If you try to ripple a change to one or more clips that 
don’t have a node with the same number as the one you’re rippling, then no change will be rippled to 
those clips.

To ripple a change in one node to several selected clips:

1	 Select the clip you want to use to make the change so that it’s the current clip, outlined in orange.

2	 Now, Command-click or Shift-click to select the range of clips you want to ripple your change to, so 
that they’re all selected red.

The orange outlined clip is the current clip you’re modifying, and the 
clips highlighted in red are the ones you’re rippling this change to

You don’t have to select the clips you’re going to ripple your change to prior to making the change, 
but it may be easier to keep track of what you’re doing if you set everything up in advance. The clip 
you’re changing should be outlined in orange, and the clips you’re rippling the change to should 
be highlighted in red.
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3	 Select a node to modify. Ideally, every selected clip should have a node sharing the same number 
as the one you’re modifying. If some clips don’t, then those clips won’t inherit the change you’re 
going to be rippling.

4	 Make whatever changes you need to, adjusting any of the palette controls in the Color page you 
need to, except for Camera Raw, Sizing, and Data Burn, which aren’t node‑specific.

5	 When you’re happy with the change you’ve made, choose Color > Ripple Node Changes to 
Selected Clips.

The change you’ve made should ripple to every other selected clip with a node of the same 
number, and in a few moments the thumbnails of those clips should update to show the change.

If you’ve created a group, it’s even easier to ripple node adjustments to the other clips in the group.

To ripple a change in one node to the current group:

1	 Select the clip you want to use to make the change so that it’s the current clip, outlined in orange. 
It must be part of a group for this to work.

2	 Select a node to modify. Ideally, every selected clip should have a node sharing the same number 
as the one you’re modifying. If some clips don’t, then those clips won’t inherit the change you’re 
going to be rippling.

3	 Make whatever changes you need to, adjusting any of the palette controls in the Color page you 
need to, except for Camera Raw, Sizing, and Data Burn, which aren’t node‑specific.

4	 When you’re happy with the change you’ve made, choose Color > Ripple Node Changes to 
Current Group.

The change you’ve made should ripple to every other clip in the current group that has a node 
of the same number, and in a few moments the thumbnails of those clips should update to show 
the change.

Appending a Node to Multiple Clips
If you’ve made an adjustment to a node in one clip that you’d like to apply to several other clips, you 
can quickly do that using the Color > Append Node to Selected Clips command. You can do this as a 
prelude to using one of the Ripple Node Change commands, as it’s a quick way to make sure several 
previously ungraded clips have the same nodes, but you can also do this as a quick way to apply the 
same node change to several clips, regardless of whether they have matching node trees.

To append a node to other selected clips:

1	 Select the clip you want to use to make the change so that it’s the current clip, outlined in orange. 

2	 Select the node you want to append to other clips.

3	 Now, Command-click or Shift-click to select the range of clips you want to ripple your change to, so 
that they’re all selected red.

The clip you’re copying from should be outlined in orange, and the clips you’re rippling the change 
to should be highlighted in red.

4	 Choose Color > Append Node to Selected Clips.

The selected node should be appended to the end of the node tree of each selected clip, and in a 
few moments the thumbnails of those clips should update to show the change.
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Using Shared Nodes
Shared nodes are meant to be a way to extend the benefits of automatically rippled changes among 
different clips to colorists that prefer a flatter node structure than Group Grading allows. By turning 
individual Corrector nodes into Shared nodes, and copying these to multiple clips, you enable linked 
adjustments right from within the clip grade. This means that the clip grade can freely mix both clip-
specific nodes and Shared nodes, all within the same node tree. This makes Shared nodes fast to use 
as there’s no need to create groups or switch to a group node tree (covered in the next section) to 
reap the benefits of linked adjustments among multiple clips.

A grade with an Unshared (at left) and Shared node (at center), a 
badge indicates the Shared node, which is also locked

What Are Shared Nodes Good For?
Shared nodes are similar to group grades, except that they don’t require grouping and can be added 
to any normal grade. Changes made to a Shared node are automatically rippled to all other instances 
of that node in the grades of other clips. Furthermore, you can add as many Shared nodes to a grade 
as you like, and you can arrange them in any order to control the order of the operations they apply. 
And, of course, you can intersperse them with ordinary Corrector nodes 

Shared nodes are extremely flexible. For example, you can use Shared nodes to:

	— Add a Color Space Transform Resolve FX or a LUT to the beginning of every clip 
from a particular source

	— Add a base correction to every talking head shot of a particular interviewee

	— Add a shot matching adjustment to each clip from a particular angle of coverage within a scene

	— Add a stylistic adjustment to every clip in a specific scene

	— Make your base adjustments when grading with remote versions, so those adjustments remain 
linked when you copy your remote versions to local versions for fine tuning

In fact, you can mix and match Shared nodes among differently overlapping sets of clips to accomplish 
any or all of the above at once. For example, you can add one Shared node to make an adjustment 
to every clip from a particular camera, add a second Shared node to each of those clips that are in a 
particular scene, and then add a third Shared node to whichever of those clips happen to be a closeup 
of the lead actress, before adding one or two regular Corrector nodes that aren’t shared to make clip-
specific tweaks.

IMPORTANT:  At the time of this writing, there is a limitation when using Shared nodes. 
Grades using shared nodes cannot be used in collaborative workflows. It is hoped that this 
limitation is temporary.
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Creating Shared Nodes
Creating a Shared node is easy, assuming you’ve created a node that has an adjustment you’d like to 
share among multiple clips.

To create a Shared node:

	— Right-click any Corrector node and choose Save as Shared node.

Locking Shared Nodes
Once you turn a node into a Shared node, that node is automatically locked, preventing you from 
accidentally making adjustments to it that would affect all other grades using that same Shared node. 

To toggle the locked status of a Shared node, do one of the following:

	— Right-click any Shared node and choose Lock Node from the contextual menu.

	— Open the Keyframe Editor, and click the Lock icon in the track header of that node’s keyframe track.

Copying Shared Nodes
Because Shared nodes are essentially Corrector nodes within clip grades, they’re easy to work with. 
Once you’ve created one or more Shared nodes, there are a variety of ways you can copy them to the 
grades of other clips in your program to take advantage of the linked adjustments they let you make.

Ways of copying Shared nodes among multiple clips:

	— Add a Shared node to another clip’s grade using the Node Editor contextual menu: Once you 
save a node as a Shared node, it becomes available from the bottom of the Add Node submenu 
of the Node Editor contextual menu, making it easy to add any Shared node to any clip. If you 
customize the label of the Shared node, that custom label appears in the contextual menu, making 
it easier to find what you’re looking for.

	— Add Shared nodes to a basic grade you’ll be copying to other clips: If you create one or more 
Shared nodes when you initially build a grade, copying that grade to other clips naturally copies 
the Shared nodes as well.

	— Save a Shared node as a Gallery still and apply it to other clips: If you save a grade with a 
Shared node in it to the Gallery, then every time you copy that Gallery still to another clip, you copy 
its Shared node.

	— Create a Shared node and append it to a selection of additional clips: If you’ve already graded 
several clips in a scene, you can add a Shared node to the end of one of the clips grades and 
make sure it’s selected, then select all of the other clips in the scene and choose Append Node 
to Selected Clips.

	— Use Shared nodes to preserve linked adjustments when copying remote grades 
to local grades: If you use Shared nodes to make your base adjustments when you grade using 
Remote Versions to automatically copy those grades to other clips that come from the same 
source media, those adjustments will remain linked when you copy your remote versions to local 
versions for fine tuning.
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You can also choose options in the Gallery that dictate what happens when you copy a grade that has 
shared nodes within it.

Converting Shared Nodes Back to Corrector Nodes
Sometimes you need to stop a node from being shared. For example, if you want to copy a grade from 
another scene to use as the starting point for a new grade, chances are you don’t want any shared 
nodes to continue being shared as you customize that grade for the new scene. In this instance, you 
can convert the Shared node back to a regular Corrector node, make any adjustments you need to 
customize it for the new scene, and then turn that node into a brand new Shared node that’s specific 
to the new scene.

To convert a Shared node back to a Corrector node:

	— Right-click any Shared node, and choose Convert to Corrector from the contextual menu.

Deleting Shared Nodes
If you’ve created a Shared node that’s being used in multiple clips, and you decide you want to 
eliminate the linked relationship among these nodes so they all work independently, you can 
“delete” a specific Shared node. This leaves the now unlinked nodes intact within each node tree in 
which they appear, but clears their effect. Additionally, that Shared node is removed from the Add 
Node submenu.

To Delete a Shared node:

	— Right-click any Shared node, and choose a node to delete from the Delete Shared Node submenu.

Using Adjustment Clips
You can also apply a single grade to multiple clips in the Timeline using Adjustment clips that have 
been superimposed over numerous other clips in the Timeline. They can be used to apply a single 
grade to all clips in a scene, or to add further color adjustments or trims to a section of clips via a 
second grade that’s applied on top of the individual clip grades that are already applied.

Adjustment clips are a great way to add adjustments to multiple clips that you may be making frequent 
changes to. If you make changes to a grade in an Adjustment clip, that change is automatically applied 
to all clips underneath it in the Timeline. Additionally, grades applied via adjustment layers can be 
turned off by disabling the adjustment layers, either one at a time, or by disabling an entire track with 
adjustment layers in it.
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An Adjustment clip (shown selected in the Mini Timeline)  
used to apply a cooler grade to four other clips in a scene

Adjustment clips can be edited into the Timeline on the Edit page, and are available from the 
Effects bin of the toolbox in the Effects Library. When an Adjustment clip is superimposed above one 
or more clips in the Timeline, all effects that are applied to the Adjustment clip are also applied to all 
clips underneath it. 

Adjustment clips can be used to apply the following types of effects:

	— ResolveFX and OpenFX plugins

	— Inspector parameters, including Composite, Transform, Cropping, and Dynamic Zoom

	— Fusion page effects

	— Color page grading and sizing

Effects clips are a fast and easily revised way to apply one or more grades and effects to a 
range of clips.

TIP:  Multiple adjustment layers can be grouped together so that you can apply Group and 
Clip grades to adjustment layers, linking multiple adjustment layers together in situations 
where you want to apply the exact same trim or stylistic adjustment to multiple scenes in 
non-contiguous areas of the Timeline.

3099Color  |  Chapter 139  Grade Management



Using Groups
Grouping is one of DaVinci Resolve’s most powerful features for organizing grades amongst multiple 
clips. Groups are manually created collections of clips with automatic linking relationships that make 
it easy for you to control the rippling of grades among sets of clips that you define. When clips have 
been grouped together, selecting one member of the group reveals a group “linked” badge at the top-
right of each clip’s thumbnail belonging to the group.

The green link icon indicates 
this clip is in a group

You can create as many groups within a single project as you need. You can add or remove shots from 
the current group, and the current group is defined by the last shot you’ve selected (if it belongs to a 
group, that’s the new current group).

As introduced in DaVinci Resolve 11, the grading of grouped clips is easier than it has ever been. Once 
grouped, you can choose from one of four Node Editor modes to grade the current clip. Which mode 
you choose determines whether that grade will automatically ripple to every other member of that 
group, or whether the grade will only affect that one clip. In this way, you can combine multiple node 
trees, some which will ripple, and one which won’t, to create the final look of each clip in that group.

For example, you might group together every clip from the same angle of coverage in a scene. You 
might also group together every clip from a particular section of B-roll that will be graded with the 
same treatment. This way, whenever you make a change or otherwise update one member of the 
group using one of the rippled Node Editor modes, every clip in the group will be changed together.

This section discusses how to create and manage groups, how best to use them, and what issues you 
need to be aware of to use groups to best advantage.

Creating and Managing Groups
The following procedures describe how to create, load, modify, and delete groups.

To create a new group:

1	 Select one or more clip thumbnails in the Timeline. You can select a contiguous range of clips 
by clicking one and then Shift-clicking another, or you can make a noncontiguous selection by 
Command-clicking individual clip thumbnails anywhere in the Timeline.

2	 Right-click one of the selected clip thumbnails, and choose Add Into New Group.

3	 Type a name into the field of the Group Name dialog, and click OK.

The new group is created, and the clips you had selected now appear with the “linked” group 
badge above the thumbnails.
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To load a different group, do one of the following:

	— Move the playhead to another clip that’s a member of that group.

	— Right-click any clip belonging to any group, and choose Group > “Name of group” > Load.

The selected group now becomes the current group. Using the Add Into 
Current Group command will add a clip to the newly loaded group.

To add one or more clips to an existing group:

1	 Load the group you want to add clips to.

2	 Select one or more clip thumbnails in the Timeline. You can select a contiguous range of clips 
by clicking one and then Shift-clicking another, or you can make a noncontiguous selection by 
Command-clicking individual clip thumbnails anywhere in the Timeline.

3	 Right-click one of the selected clip thumbnails, and choose 
Group > “Name of group” > Assign to Group.

The selected clips now appear with the “linked” group badge above the thumbnails.

To remove one or more clips from an existing group:

1	 Select one or more clip thumbnails in the Timeline that you want to remove from a group. You 
can select a contiguous range of clips by clicking one and then Shift-clicking another, or you can 
make a discontiguous selection by Command-clicking individual clip thumbnails anywhere in 
the Timeline.

2	 Right-click one of the selected clip thumbnails, and choose Remove From Group.

To rename a group:

1	 Right-click any clip belonging to any group, and choose Group > “Name of group” > Rename.

2	 Type a new name into the field of the Group Name dialog, and click OK.

The group is renamed. The new name appears as a new submenu of the Timeline 
contextual menu.

To delete a group:

	— Right-click a clip belonging the group you want to delete, and choose 
Group > “Name of group” > Delete.

	— This clears the group, while preserving the last applied grade within each clip.

Using Group Modes to Control 
Which Grades Ripple and Which Don’t
When you create a group and then select any clip that is a member of that group, additional Node 
Editor modes become available that let you apply multiple levels of grades to the clips in that group. 

Available options in the Node 
Editor modes drop-down
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For clips that aren’t grouped, two dots at the top of the Node Editor let you switch between Clip and 
Timeline modes via a single click. If you’re working on a clip that’s part of a group, four dots will be 
displayed to allow fast access to the Pre-Clip and Post-Clip Group modes as well.

Four dots at the top of the Node Editor let 
you choose which mode you’re working on

Node trees you create using the Group Pre-Clip and Group Post-Clip modes automatically ripple 
changes to every member of a group. Node trees created with the Clip mode are specific to each clip. 
Node trees created with the Timeline grade affect the entire Timeline, all at once. Combining node 
trees made using these different modes makes it easy combine clip-specific changes with group-wide 
changes that make grading faster.

	— Group Pre-Clip: Node trees assembled in this mode affect every clip in the group simultaneously. 
Pre-Clip adjustments are useful for creating an overall grade that you want to use as a starting 
point for the scene, such as when you need to normalize a group of log-encoded clips in a specific 
way, or when you want to create a base grade that generally improves every clip in a scene. 

	— Clip: The Clip grade corresponds to the local or remote version associated with that clip. Node 
trees assembled in the Clip mode only affect the specific clip that’s selected. All Local and Remote 
versions you create are in Clip mode. Clip adjustments are useful for matching clips to one another 
in a scene, doing clip-specific secondary adjustments, or making any other sort of adjustment that 
you only want applied to the current clip, rather than to the group as a whole. Clip adjustments are 
applied after Pre-Clip adjustments.

	— Group Post-Clip: Node trees assembled in this mode also affect every clip in the group 
simultaneously, but these adjustments are applied after the Clip adjustments. Post-Clip 
adjustments can be useful for applying a creative look to an overall scene, so that later revisions to 
a scene’s look can be accomplished with a single set of adjustments that automatically affect the 
entire group.

	— Timeline: Node trees assembled in this mode affect every single clip in the entire Timeline. 
Timeline adjustments are useful when you have a single change that you want to apply to every 
single clip at once.

The image processing of each Node Editor mode is sequential, making it easy to keep track of the 
order of operations affecting a particular clip. 

An Example of Grading a Group of Clips
This section shows an example of how you might approach grading a group of clips using the different 
Node Editor modes that are available. Keep in mind that this is only one of many possible approaches 
you could take to the use of groups, and was chosen because it exercises everything you can do to a 
single grade.
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To get started, select a series of clips that you want to group, and right-click one of them and choose 
Create New Group to group them together, entering a name and clicking OK when prompted. 
One convenient advantage of simply creating groups from a selection is that you’re not limited to 
selecting a continuous range of clips in the Timeline. Another advantage is that you can use the View 
> Timeline Thumbnail Mode > Source (C-mode) command, or Timeline filtering, to isolate the range of 
clips you want to use for creating a group.

There are different ways you might choose to group clips together:

	— All clips within a particular scene

	— All clips recorded from a specific camera

	— All headshots of a particular person

	— All clips from a particular angle of coverage

	— All exteriors of a particular location

The list could go on and on, but you get the idea. You can group any selection of clips together that 
have reason to share a common grade. In this example, a series of shots from an exterior scene are 
selected and made into a group.

Clips made into a group

Once you’ve created a group, choose Group Pre-Clip from the Node Editor mode drop-down. This is 
the first grade that’s applied, as the underlying grade that affects the entire group. Using this node 
tree, adding a LUT to normalize the clips, a Color Wheel adjustment, and some Curve adjustments to 
tune the color provide a primary grade that now affects every single clip in the group.

A primary adjustment applied to the Group Pre-Clip mode

With this accomplished, you can see there’s some variation among the clips in the scene that needs 
to be corrected in order for every clip to match. Choose Clip from the Node Editor mode drop-down. 
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Grades that you make in Clip mode only affect the clip to which they’re applied, so now you can work 
clip by clip using the Image Wipe and Split-Screen controls to compare clips and make whatever 
adjustments are necessary to make each one match the main look for the scene.

Scene balancing adjustments made using the Clip mode

Once all the clips are balanced with one another, you can choose Post-Clip Group from the Node 
Editor mode drop-down. This lets you add one more grade on top of the Pre-Clip and Clip grades that 
you’ve already applied, that you can use for any number of things. In this example, a single stylistic 
adjustment is applied that now affects all of the clips at once. If a client wants to see something 
different, you can easily make the necessary changes to one clip, and all other clips in that group will 
immediately be altered as well.

A stylistic adjustment applied to the Group Post-Clip mode

At this point, the scene is graded via a well organized set of corrections. If the client later wants a 
change affecting the underlying primary grade that everything is built on, you can adjust the Pre-Clip 
grade. If you spot an inconsistency with your shot matching at any point, you can make a fast tweak 
to the relevant Clip grade. And if the client wants a stylistic change, you can make any necessary 
adjustments to the Post-Clip grade to change the overall look of the whole scene. In each case, 
groups give you total control over which adjustments will ripple across the whole group, and which 
adjustments will be clip-specific.
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Using Undo in Groups
Each Node Editor mode has a separate undo stack, meaning that separate multiple-level undo is 
saved for Group Pre-Clip, Clip, and Group Post-Clip.

Saving Stills and Grades in Groups
When you save a still for a clip that’s part of a group, the result is that the still reflects the look of the 
combined Pre-Clip, Clip, and Post-Clip node trees, but the grade that’s saved within depends on the 
Node Editor mode you had selected when saving the still. For example, if the Node Editor is set to 
Group Pre-Clip, then you’ll only save the Pre-Clip grade; the Clip, Group Post-Clip, and Track grades will 
be ignored. Copying a saved grade to a clip in a group results in that grade being copied to the node 
tree of whichever Node Editor mode is currently open.

Collapse Group Grades
If you want to take a clip out of a group, but you want its grade to continue incorporating all 
adjustments made in the Pre-Group and Post-Group Node Editor modes, you can use the Collapse 
Group Grades command to copy all nodes in the Pre-Group and Post-Group grades to the Clip grade. 
When you do this, Pre-Group nodes are added before any pre-existing nodes in the Clip grade, and all 
Post-Group nodes are added after, in order to maintain the correct order of operations.

(Top) The Clip node tree, (Bottom) After using the Collapse Group Grades command 
to flatten the Pre-Group and Post-Group nodes into the Clip node tree
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To flatten all group grades into a single Clip mode node tree:

	— Right-click a clip’s thumbnail in the Thumbnail timeline, and choose Collapse Group Grades from 
the contextual menu.

Using Collapse Group Grades on a clip always removes that clip from whatever group it was previously 
a member of. This can also be an easy way of creating a single flat node tree in preparation for saving 
a grade to the Gallery for applying to other clips that aren’t themselves in groups.

Groups and Versions
Local or Remote versions you create relate only to the Clip grade. Group Pre-Clip and Group Post-Clip 
grades cannot be versioned.

Exporting Grades and LUTs
If you find it necessary to exchange grades with other workstations, there are two ways you can 
do so directly: by exporting grades, or LUTs. This section discusses the export of Grades; for more 
information about exporting LUTs, see Chapter 147, “Using LUTs.”

To export a grade:

1	 Save the grade you want to export as a still in the Gallery.

2	 Right-click the saved still in the Gallery, and choose Export.

3	 Select the image format you want to save the still as. Choices include: DPX, Cineon, TIFF, JPEG, 
PNG, PPM, BMP, and XPM.

4	 Choose a location for the resulting still image and saved grade files, type a name into the 
Save As field, and click Save.

Two files are saved. The image file contains the still image of the frame that was stored. A DRX 
(DaVinci Resolve eXchange) file contains all the grading information.

To Import a grade:

1	 Right-click anywhere in the gray area of the Gallery, and choose Import.

2	 Click the Options button to select the specific file type you want to import, or select “All Files” 
for multiple formats.

3	 Choose the image file that was exported from your DaVinci Resolve workstation, or someone 
else’s. The accompanying DRX file must be in the same location. If you lose the original image file, 
you can still import the DRX file by itself. It will preserve the node structure of the still, but you will 
not be able to wipe against it.

The still you imported appears in the Gallery, containing the grading information you wanted 
to import.
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Chapter 140

Node Editing Basics
This chapter covers the basics of using the Node Editor in 
DaVinci Resolve to manage all of the adjustments you decide to 
apply to a clip, as well as the fundamental procedures for editing 
and organizing nodes within a tree that are the basis for creating 
more sophisticated effects.
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Node Editor Basics
By default, every clip has one node in the Node Editor that contains the first corrections you make. 
However, you also have the option of creating multiple nodes, where each node contains one or more 
corrections that affect the image.

The Node Editor showing a reasonably full-featured grade

The specific arrangement of nodes you create lets you exert precise control over the order of 
operations performed by your grade, which provides many advantages. This section covers different 
ways of creating, editing, and arranging node trees to harness the full power of DaVinci Resolve.

Thumbnail-Optional Nodes
The Node Editor option menu provides a Show Thumbnails option that lets you disable or enable the 
thumbnails attached to each Corrector node. 

Disabling thumbnails in the Node Editor option menu makes nodes shorter
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How Many Nodes Do I Need to Use?
In this chapter and the ones that follow, you’ll learn many different techniques for 
combining adjustments and nodes in different ways to achieve highly specific effects. 
Consequently, new DaVinci Resolve users often wonder, how far do I go? There is no right 
answer, but suffice it to say that some of the world’s leading colorists achieve stunning 
results in as few as three or four nodes, while others routinely build carefully organized 
hierarchies of ten to twenty nodes, or more. The number of nodes you use is often 
dependent on the quality of media you’ve been given to work with, as well-lit footage 
usually requires less work than material shot run-and-gun with available light, that typically 
needs many more adjustments to achieve an acceptable result. Furthermore, the number 
of nodes you may use can also depend on what kind of program you’re working on, with 
commercial spots affording the colorist enough time in the schedule to build truly massive 
grades that adjust every little detail, and narrative features and television shows requiring 
you to work faster and do more within fewer adjustments in order to stay on track. The real 
answer? Each grade requires as many nodes as are necessary. No more, no less.

The Node Editor Interface
As you work within the Node Editor, you may find the need to zoom into or out of it to get a better look 
at the node tree, and to pan around the working area to deal with large collections of nodes.

To expand the size of the Node Editor’s working area:

	— Drag the border between the Node Editor and the Viewer to the left or right to make it 
wider or narrower.

	— Right-click anywhere within the Node Editor (except on a node) and choose Toggle Display 
Mode, which hides the Viewer and moves the Node Editor to the right of the Gallery, enlarging it 
considerably. Right-click and choose Toggle Display Node again to return to the default layout.

To arrange the node tree to fit your current working area:

	— Right-click anywhere in the Node Editor (except on a node) and chose Cleanup Node Graph from 
the contextual menu. This will rearrange your node tree to fit in whatever size working area you 
have at the time.

To zoom and pan within the Node Editor, do one of the following: 

	— Use the Node Editor’s zoom slider to shrink or enlarge the nodes in the Node Editor.

	— Click the Pan tool (the hand icon) at the upper left-hand corner of the Node Editor, and drag 
anywhere within the gray area of the Node Editor to pan around.

	— Press the H key to toggle between selection and pan modes in the Node Editor.

	— Middle-click and drag anywhere within the Node Editor to pan around.

	— Right-click and choose Zoom In or Zoom Out.

	— Right-click and choose Zoom to Window to fit the node tree to the current size of the node graph.

	— Right-click and choose Original Size to return the node graph to the default size.
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The Node Editor’s 
Pan (Hand) tool

The Components of a Node Tree
Ambitious grades may require trees of multiple nodes to create the necessary effect. This section 
covers the mechanics of putting nodes together into the structures that are described in more detail 
later in this chapter.

Every node you add is a “Corrector” node, which is capable of either primary or secondary correction, 
depending on whether or not you enable the Qualifier/Window/Matte controls. Even “Serial” and 
“Parallel” nodes are simply Corrector nodes that are added in series or in parallel to the previous node 
in the node tree; the names are a consequence of how they’re added.

Each Corrector node has two inputs and two outputs, which lets you separately manage the RGB 
image-processing channel, and the Key channel that defines areas of isolation for image processing 
operations, or transparency for compositing. RGB connections are light green, located at the top left 
and right of each node. Key connections are blue, located at the bottom left and right of each node. 
Inputs into the node are triangles, and outputs are squares. These inputs and outputs let you control 
the flow of image and isolation channels coming into and going out of each node in the tree.

A single node, the RGB (green) and 
key (blue) triangular inputs and 
square outputs are clearly visible

Nodes are attached to one another via “connections,” seen as lines that connect one node to 
another. Image data flows from left to right, starting with the Source input all the way at the left of 
the Node Editor, through each node in the tree, and ending at the Node Tree output at the right of 
the Node Editor.

A simple serial arrangement of corrections

3110Color  |  Chapter 140  Node Editing Basics



Here’s an explanation of the different components of a basic node tree where all nodes are connected 
in serial, one after the other, and how they work together:

	— Source Input: The green source node to the far left is the clip’s image data as processed by the 
Sizing and Source decode settings, ungraded. The Source input feeds RGB data to the grade, 
and is connected to the RGB input of the first node in your tree. If necessary, you can connect 
the Source input to more than one Corrector node, creating multiple simultaneous streams of 
image processing emerging from the original source state of the image that you can eventually 
recombine in different ways using the Parallel or Layer Mixer nodes.

	— Nodes: Each node in the node graph represents a collection of image processing operations that 
can be enabled or disabled separately from any other node in the graph. By separating operations 
into multiple nodes, you’re able to precisely control the order of all image processing operations 
in DaVinci Resolve to create many different corrections and effects. The green RGB inputs and 
outputs are used to connect these nodes together. Each node’s thumbnail image shows how the 
clip looks at that particular stage of the grade, giving you a visual indication of what each node is 
doing, and small badges below each node show you which specific operations are being applied 
by that node.

	— RGB Inputs and Outputs: The green inputs and outputs at the upper right and left of each node 
are used to connect the RGB image that’s output from one node to the RGB input of the next 
node. For a Corrector node to have an effect, you must connect both its RGB input and its RGB 
output to neighboring nodes in the tree. Furthermore, every single node in the Node Editor must 
be connected for a grade to be enabled; having any disconnected node in the node tree disables 
that grade until it’s fully connected.

	— Key Inputs and Outputs: The blue inputs and outputs at the bottom right and left of each 
node are used to route the key channel generated by a node’s Qualifier or Window controls, or 
imported via a Matte clip that you previously associated with a clip in the Media page. When you 
connect the key output of one node to the key input of another, you basically copy the first node’s 
key to the second node. You can also combine the key outputs of multiple nodes in various ways 
using the Key Mixer node.

	— Node Tree Output: The RGB output of the last node in a tree must be connected to the green 
Node Tree output node, which “completes the circuit” of image processing, and passes that 
correction on to the next stage in the DaVinci Resolve image processing pipeline. If the output is 
not connected, the node tree is disabled and has no effect on the clip. You can only connect one 
RGB output at a time to the Node Tree output.

	— Second Source Input (for RED HDRx): You can access the alternate highlight exposure of 
RED HDRx media by exposing this optional second Source input. For more information, see 
“Mulit‑Channel RED HDRx Support” in Chapter 143, “Channel Splitting and Image Compositing.”

	— Second Source Input (from Fusion page): You can also create additional sources to route in 
masks or mattes created in the Fusion page for use as keys in the Color page.

	— Alpha Output: It’s possible to create regions of transparency for compositing directly in 
DaVinci Resolve by connecting a key output to an optional Alpha output. For more information,  
see Chapter 143, “Combining Keys and Using Mattes.”
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Node Badges and Labels
Nodes appear with various labels and badges to help you identify what each node is contributing to 
the overall grade. How long a label and how many badges appear depends on the size of each node, 
as set by the Node Editor’s Zoom slider.

Nodes showing the kinds of labeling and badges that are available for 
identifying what operations each node is performing

	— Node number: Nodes are numbered in the order in which they appear in the node graph, making 
it possible for you to select specific nodes by number via the DaVinci control panel.

	— Adjustment badges: As you apply various operations within a node, small badges appear 
underneath the thumbnail that indicate which palettes have been used to adjust that node. How 
many badges are visible depends on how far in or out you’re zoomed into the Node Editor, and 
whether or not there are Color Space or HDR labels already taking some of this room. At larger 
node sizes, more badges can appear within the width of the node. Each palette in the Color 
page has a unique badge. If you apply more operations than a node has area to display, a single 
“downward arrow” badge appears.

	— Animation badge: Nodes with animated parameters display a keyframe badge.

Labeling Nodes
Nodes can be labeled to identify a particular node’s function in your grade. This can make it easier to 
revise a grade months later. Node labels are also saved when you save a still, so labels can also make it 
easier to decipher a saved grade down the road. At each node’s default size in the Node Editor, nodes 
can appear with up to 12 characters of text, although larger nodes can accommodate more text.

To label a node:

1	 Right-click a node and choose Change Label.

2	 Type the label text you want and press Return.

The label you entered appears above the node in the Node Editor. 

To edit a node’s label:

	— Once a node has a label, you can change the label at any time by double-clicking it.
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Selecting Nodes
The node that’s currently selected in the Node Editor is highlighted in orange, and is referred to as the 
current node. When you adjust any of the parameters or settings in the Color page, you’re adjusting 
parameters within the current node. You can only select one node at a time.

To select a node, making it the current node, do one of the following:

	— Click any node in the node graph.

	— Choose Color > Nodes > Previous Node (Option-Shift-Semicolon) or Color > Nodes > Next Node 
(Option-Shift-Apostrophe). When you do this, the last node loops around to the first one, 
and vice versa.

The selected node appears highlighted in orange. You also have the ability to select multiple nodes, 
in preparation for doing things like moving them or creating compound nodes (covered later in 
this chapter).

To select multiple nodes:

	— Command-click each of the nodes you want to simultaneously select.

	— With the Node Editor Selection tool chosen (at the upper left-hand corner of the Node Editor) 
simply drag to select multiple nodes using a bounding box.

The Node Editor’s 
Selection tool

When you select multiple nodes, each one appears highlighted in white, with the exception of the 
current node, which remains orange.

Selecting three nodes by dragging a bounding box

When you select another clip in the Timeline, the default behavior is that the last node that was 
selected when you worked on that clip is the one that’s selected when you move to that clip 
again. However, a setting in the option menu of the Node Editor and the Color panel of the User 
Preferences, called “Switching clips,” lets you change this behavior. For more information on this 
option, see Chapter 4, “System and User Preferences.”
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Disabling Nodes
In the process of creating a node tree, it’s often useful to turn one or more selected nodes off to 
disable their effect on your grade. It’s also useful to turn the entire node tree off and on in order to 
see “before and after” views of the current clip. Disabled nodes are not processed during rendering, 
and they remain disabled when you save that grade along with a still in the Gallery and then apply that 
grade to another shot.

Disabling Individual Nodes
Disabling a single node is useful for temporarily disabling adjustments that you don’t think you 
want to use but don’t want to discard (however you should remember that it’s alarmingly easy to 
inadvertently turn these nodes back on again). It’s also good for giving your client a before and after 
preview of the last adjustment.

To toggle individual nodes off and on, do one of the following:

	— Click the number of any node in the node graph to disable that node by itself. 

	— Select a single node, and choose Color > Nodes > Enable/Disable Selected Nodes (Command-D).

Disabling Multiple Nodes All At Once
If you select more than one node in the node tree, using any of the methods of turning nodes off and 
on described above (including Command-D) will toggle Enable/Disable Selected Nodes. Please note 
that the current node outlined in orange is always considered to be part of the selection.

This makes it easy to do before/after comparisons of any combination of nodes doing complicated 
adjustments by selecting them, while leaving un-selected nodes doing base adjustments that you 
want to leave enabled alone.

Disabling All Nodes
In addition to the Bypass All Grades command, disabling all nodes of a grade at once is another easy 
way of disabling a grade to provide a before and after of the original state of the clip (or the color 
managed state of the clip if Resolve Color Management (RCM) is enabled). More importantly, it’s a 
good way to disable all nodes of a grade in preparation for walking your client through each operation 
in that grade node by node, as you turn each node on in turn while narrating how it’s improving 
the image.

To turn every node off and on at once, do one of the following: 

	— Choose Color > Nodes > Enable/Disable All Nodes (Option-D) to toggle all nodes off and on. 

IMPORTANT:  When you turn every node off and then on again, every node is re-enabled, 
even nodes that had previously been individually disabled.
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Turning Grades and/or 
Fusion Effects Off
The Bypass Color Grades and Fusion Effects button/drop-down commands in the Viewer’s title bar 
are also available via View > Bypass Color and Fusion menu commands. Turning off Fusion effects in 
the Color page is an easy way to improve playback performance on low power systems when you just 
need to make a quick set of grading adjustments. Toggling grades off and on is also a convenient way 
to quickly get a before and after look at a shot where the before goes all the way back to the source.

If you choose Toggle Bypass or click the Viewer control, you’ll turn off whatever is checked in the 
optional menu, which lets you choose whether or not you want to bypass both Color and Fusion, or 
just one or the other.

(Left) Menu commands for bypassing Color and Fusion, (Right) Edit page Timeline Viewer controls

Resetting Nodes
If you’re dissatisfied with your current operations and want to start over, there are three ways you can 
reset nodes in the Node Editor. These are available as items in the Color menu.

	— Reset Selected Node Grade: Resets the currently selected node, eliminating all keyframes, to the 
default parameter settings.

	— Reset Grades and Keep Nodes: Resets every node in the current node tree, without affecting the 
node tree’s structure; all nodes remain where they were. However, each node has been reset to 
the default parameter settings.

	— Reset All grades and Nodes: Deletes every node and keyframe, and restores a single node set to 
the default parameter settings.

You can also reset nodes using the mouse, which can be a quick thing to do if you’re already working 
in the Node Editor to accomplish other things.

Methods of resetting nodes with the mouse:

	— To reset a selected node: Right-click that node and choose Reset Node Grade from the 
contextual menu.

	— To reset all grades and nodes: Right-click anywhere in the background of the Node Editor, and 
choose Reset All Grades and Nodes from the contextual menu.
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Methods of resetting nodes with the keyboard:

	— To reset a selected node: Press (Shift-home).

	— To reset all grades and nodes: Press (Command-home).

	— To reset all grades and keep nodes: Press (Shift-Command-home).

Previewing and 
Restoring Node Trees
There are two other methods of quickly dealing with unwanted changes you’ve made to node trees, 
without needing to use undo.

	— Preview Memory: Lets you preview the effect of any saved grade on the current clip. To preview, 
choose Color > Preview Memory (Option-Shift-P), and then right-click any saved still in the 
Gallery (or Memory) and choose Add Correction. In fact, you can use Add Correction to try out 
as many stills as you like. If you like any still’s effect, then you can leave it be. If you don’t like any 
of the stills you previewed, then choosing Color > Preview Memory again reverts the clip to the 
original grade.

	— Original Memory: This command lets you quickly revert a clip’s grade to its original state when 
you first selected that clip. It is accessed by choosing Color > Original Memory (Option-Shift-O). 
This is useful for getting immediately back to a clip’s original grade if you’ve made a series of 
changes that you then regret. Selecting another clip in the Timeline and then reselecting the clip 
you made changes to resets what is considered to be the current grade.

Caching Specific Nodes to 
Improve Performance
You can flag specific nodes to be cached, along with all nodes appearing upstream in that node tree. 
By caching nodes using processor-intensive effects, you free up real time capability for the remaining 
downstream nodes in a grade. Choosing Playback > Render Cache > User only caches nodes that 
you’ve flagged for caching.

When you choose Playback > Render Cache > Smart mode, DaVinci Resolve automatically caches any 
nodes that use Motion Blur, Noise Reduction, or OFX plugins, without you needing to do anything.

To flag a node and all corrections made in upstream nodes for caching:

	— Right-click any node and choose Node Cache > On from the contextual menu.
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Editing Node Trees
There is no limit to the number of nodes you can create and connect to one another, and you can make 
as many or as few parameter adjustments as you like within each node. The following procedures 
describe the ways you can add nodes to the node graph as you build each grade’s node tree.

Adding Nodes
The simplest thing you can do to add to the complexity of a node tree is to add additional nodes, in 
order to add more adjustments to the current grade. You can add nodes so that they’re automatically 
attached to nodes that are already in the node tree, for immediate adjustment, or you can add 
unattached nodes to empty areas of the node tree in preparation for assembling a particularly 
complicated and specific node tree to accomplish a difficult task.

Methods of adding nodes to the tree using a mouse, tablet, or trackpad:

	— To add any kind of node to the node graph using the mouse: Right-click any node in the 
node tree, and choose the type of node you want to add from the Add Node submenu of the 
contextual menu.

	— To add a disconnected node to the node graph: Right-click anywhere within the node graph’s 
background, then choose Add Node > Corrector from the contextual menu. Disconnected nodes 
have no effect on a node tree until they’re connected.

Methods of adding nodes to a currently selected node in the tree using the keyboard:

	— To add a serial node after the currently selected node: Press Option-S key, choose Color > 
Nodes > Add Serial from the menu.

	— To append a serial node to the very end of the node tree: Press Option-K, choose Color > 
Nodes > Append Node from the menu.

	— To add a serial node before the currently selected node: Press Shift-S, or choose Color > 
Nodes > Add Before Current.

	— To add nodes in parallel to the currently selected node: Press Option-P, choose Color > 
Nodes > Add Parallel from the menu.

	— To layer nodes with the currently selected node: Press Option-L, choose Color > Nodes > 
Add Layer from the menu.

	— To add an outside node to the currently selected node: Press Option-O, choose Color > 
Nodes > Add Outside Node from the menu.

Adding Nodes with Windows Turned On
There are also dedicated commands for adding serial nodes with Circular/Linear/Polygon/Curve 
windows automatically turned on, for convenience. 
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To add a node to the tree with a Window automatically enabled:

Choose an item from the Nodes menu that corresponds to the following:

	— Node + CPW: Circular Power window (Option-C)

	— Node + LPW: Linear Power window (Option-Q)

	— Node + PPW: Polygonal Power window (Option-G)

	— Node + PCW: PowerCurve window (Option-B)

Whenever you add a node to a tree, it’s numbered consecutively to come after the next most recent 
node you’d added, regardless of the order in which it appears in the node tree. For example, if you’ve 
already added three nodes, and then you decide to add another node in between Nodes 1 and 2, the 
new node will be Node 4, and the order of the nodes will be 1, 4, 2, and 3.

Deleting Nodes
If there’s a node that you no longer need, you can choose to remove it completely from the node tree 
to remove its effect permanently.

To delete a node, do one of the following:

	— Select a node, then press the Forward-Delete key.

	— Right-click a node, and choose Delete Node.

After you’ve deleted a node, the node to the left and right of the node you deleted are automatically 
connected so that the node tree is unbroken. Also, all the nodes in a tree are renumbered after 
the deletion of any node, so there’s no discontinuity in node order. For example, if you have three 
consecutively numbered nodes in a tree and you delete the second one, the node that was formerly 
number 3 is renumbered to be 2.

Connecting and Disconnecting Nodes
For a node tree to work, every node in the Node Editor must be connected into a working node tree, 
from the Source input, through each node in the tree, to the Node Tree output. Any disconnected 
node will result in that clip’s grade being disabled. However, you may find the need to disconnect 
some parts of a node tree in order to reconnect them in different ways.

To connect two disconnected nodes:

	— Click and drag a connection from the RGB or key output of one node to the corresponding 
RGB or key input of another, and when the line highlights, release the mouse button.

To change the connection from one node to another:

	— Move the pointer over the second half of any connection line between two nodes until it highlights 
blue, then click and drag it to reconnect it to another input, on that node or another.

To disconnect two nodes, do one of the following:

	— Position the pointer over the right-hand side of a node connection so it highlights, 
and click it to delete it.

	— Click a link to select it (selected links turn orange), and then press the 
Delete or Forward-Delete key.

	— Right-click a link and choose Delete Link.
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To overwrite a node’s previous connection:

	— You can drag a connection to a node input or output that’s already connected, which will overwrite 
the previous connection with the new one you’re dragging. When you do this, the connection 
that’s about to be overwritten appears highlighted in orange.

	— You can connect any node’s RGB or Key output to as many inputs as you want, but you can 
only have one connection going to a node’s input. The exception to this is a node with multiple 
inputs, designed to combine the output of multiple nodes. These include the Parallel, Mixer, 
and Key Mixer nodes.

Extracting a Node
Sometimes you need to remove a node from its current position in the node tree, such that the nodes 
to the left and right of it automatically reconnect to one another, saving you from having to reconnect 
them manually. This is called extracting a node.

To extract a node, do one of the following:

	— Select a node, and choose Color > Nodes > Extract Current Node.

	— Select a node, and press E.

Keep in mind that disconnected nodes in the node tree suspend grading altogether, so you’ll want 
to either reconnect that node to another part of the node tree, or delete it; you cannot leave it 
disconnected in the Node Editor.

Inserting a Node
If there’s a disconnected node in the Node Editor, there’s a simple way you can insert it into the node 
tree between any two other nodes. This also works for nodes that you’re dragging into a node tree 
from another source, for example, from the exposed node tree of a still in the Gallery.

To insert a disconnected node between two other nodes:

	— Drag a disconnected node, or a node from another node tree, onto the connection between any 
two other nodes in a node tree; when a plus icon appears over the node you’re dragging, drop it 
to insert the node.

Rearranging Node Order
The order in which nodes are connected in your tree affects the result of a grade. For example, if you 
boost the highlights in the first node, and then you try to isolate a portion of the picture in a second 
node that you now realize has been clipped, you may to need to change your order of operations to 
optimize your corrections.

To swap the contents of two nodes:

	— Command-drag any node and drop it onto another node to swap the operations within each 
node. The nodes won’t appear to have moved, but you should be able to tell from the node 
badges underneath that the operations have been reversed.
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To move a node to any other position in the node tree:

1	 Double-click any node in the node tree and press E to extract it, removing it from the tree so that 
it becomes unattached.

2	 Drag the now-unattached node to the connection line between any two other nodes in the tree, 
and when a small plus icon appears, drop it to automatically connect that node at that position in 
the node tree.

Copying and Pasting All Settings 
From One Node to Another
The simplest thing you can do is to copy all of a node’s settings and paste them into another node. 
This makes it easy to duplicate things like windows, qualifier settings, keyframing, or motion tracking 
that you want to reuse in another node as the basis for another operation. This is also a quick way to 
manually ripple a change you make in a node to that same node in another clip’s grade.

To copy a node’s settings from one clip to another, do one of the following:

	— Option-drag one node onto another. When you drop it, the settings of the node you dragged 
overwrite those of the node you dropped onto.

	— Select a node with settings you want to copy and choose Edit > Copy (Command-C). Then, select 
a node you want to paste these settings to either in the current grade or in the grade of another 
clip, or create a new node, and choose Edit > Paste (Command-V) to paste the settings you copied. 
These pasted node settings overwrite any other settings that node previously used.

NOTE:  There are additional methods of copying nodes and individual node settings. 
For more information, see Chapter 139, “Grade Management.”

Keeping Node Trees Organized
It’s a good idea to keep the arrangement of your nodes in the node graph clean and neat. It’ll make it 
easier to read your tree if you need to revisit a grade later on, and it will also make it easier for other 
colorists working on the same project to figure out what you’re doing. The following procedures 
describe how to rearrange the nodes in your tree, and the node tree working area, to help you keep 
on top of your grades.

To move nodes within the Node Editor:

	— Drag any node to a new position.

	— Command-click or drag a bounding box around multiple nodes that you want to move, and drag 
them all to a new position.

Of course, it’s easy to get carried away. If you’ve been working furiously on a complex grade and you 
find yourself staring at a riot of disorganized nodes, it’s easy to quickly reorganize your node graph 
using a pair of commands in the Node Editor contextual menu.
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To clean up the node graph, right-click the Node Editor and choose:

	— Cleanup Node Graph: Moves all nodes in the node graph so they appear in an evenly spaced 
grid. Connection lines are routed around nodes to minimize clutter.

Before/after using “Cleanup Node Graph”
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Using Compound Nodes
Another node structure you can use to keep complex node trees organized is the compound 
node. You can Command-click to select any number of nodes in the node tree (selected nodes are 
highlighted white), and then use the “Create Compound Node” command to nest all selected nodes 
inside of a single node.

Before/after creating a compound node

The resulting compound node that’s created has as many inputs and outputs as are necessary to 
accommodate the connection lines that attached the nodes you selected to the rest of the node tree. 

You can use compound nodes to organize complicated node trees by nesting sets of nodes that work 
together to do a specific thing within a single node. You can also turn a set of nodes that you’re using 
to create a specific effect into a compound node in preparation for saving to the Gallery. Creating a 
library of effects in this way makes it easy to reuse them via the Append Grade command, without the 
undue burden of adding lots more nodes to your grade later on.

Methods for creating and working with compound nodes:

	— To create a compound node: Command-click each node you want to nest inside of a compound 
node to select them with a white highlight, or drag a bounding box around a group of nodes. 
Then, right-click one of the selected nodes, and choose Create Compound Node from the 
contextual menu.

	— To edit a compound node: Either hold the Command key down while double-clicking the 
compound node you want to open, or right-click any compound node and choose Show 
Compound Node from the contextual menu. The contents of that node appear in the Node Editor, 
taking the place of the overall node tree. 
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	— To exit a compound node you’re editing: To return to the top level node tree, double-click 
the leftmost item in the path control at the bottom of the Node Editor, or click the name of 
the compound node. You can also right-click in the compound Node Editor and choose “Exit 
Compound Node” from the contextual menu. 

	— To label a compound node: Right-click a compound node, choose Change Label from the 
contextual menu, and type a new label for that node. Press the Return key when you’re finished.

	— To decompose a compound node: Right-click the compound node you want to decompose, 
and choose “Decompose Compound Node” from the contextual menu. The compound node 
disappears, replaced by the original nodes within. Please note, if you had applied an adjustment to 
the compound node itself, that adjustment is lost when you decompose it back into its constituent 
nodes. If you want to preserve the compound node adjustment itself, you can copy it, then 
decompose the node, and then create a new node and paste the adjustment you’d copied.

Adding Inputs and Outputs to Compound Nodes
When you open the contents of a compound node using the Show Compound Node command, you 
can make whatever adjustments you like to the node tree within, but you also have the option of right-
clicking within the Node Editor and choosing Add Source to add an input to the compound node, or 
Add Output to add an output. Adding more inputs and outputs lets you set up the node to connect to 
the rest of your node tree in more complicated ways. Disconnected inputs and outputs have no effect 
on your grade.

Furthermore, you can also use the Add Alpha Source and Add Alpha Output contextual menu 
commands to add KEY inputs and outputs to a compound node, making it easy to route key or alpha 
channel data to other connections in the enclosing node tree.

Nesting Compound Nodes
Compound nodes can also be nested within other compound nodes, if necessary.

Grading Compound Nodes
After you’ve created a compound node, you can select it to make one or more adjustments using the 
compound node itself, which effectively adds those adjustments after all other adjustments that take 
place via the nodes that are inside of the compound node. This gives you the opportunity to “trim” the 
effect that compound node is having on your grade, or to limit it using a qualifier or window.

To adjust the individual nodes nested within a compound node, you need to first open the compound 
node. Then, you can select and adjust any node as you ordinarily would.
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Identifying Nodes
As you make various adjustments to nodes, small badges appear underneath that indicate what each 
node is actually doing. Since nodes are capable of holding multiple adjustments, any given node may 
have multiple badges; how many badges a node can show depends on the zoom level of the Node 
Editor. Larger nodes will show more badges, whereas smaller nodes will show fewer badges, hiding 
whichever badges don’t fit.

Another nice organizational feature of the Node Editor is an automatic tooltip that appears whenever 
you hover the pointer over a particular node, that shows you a concise list of all the operations applied 
to that particular node.

(Left) Badges underneath each node indicate which adjustments it contains. 
(Right) Using a node’s contextual menu to put that node into HDR mode

Putting Nodes into HDR Mode
When using various grading controls in the Color page to grade wide-latitude images for HDR output, 
you may find it useful to enable the HDR mode of the node you’re working on by right-clicking that 
node in the Node Editor and choosing HDR Mode from the contextual menu. 

This setting adapts that node’s controls to work within an expanded HDR range. Practically speaking, 
this makes it easier to work with wide-latitude signals using controls that operate by letting you make 
adjustments at different tonal ranges such as Lift/Gamma/Gain, Custom Curves, Soft Clip, and so on.

Clip vs. Timeline Grading
Ordinarily, the Node Editor has two modes. The default Clip mode lets you create individual 
grades for each clip or group in the Timeline. However, the Timeline grade mode lets you apply a 
single grade simultaneously to every clip in the Timeline, as seen in the Thumbnail timeline in the 
following screenshot. 
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A paragon of sophisticated grading, the author applies a red edge vignette to 
every clip in the project simultaneously using the Timeline grade

There are a variety of reasons you might want to do this. For example, if you’re working on a 
commercial spot, you might elect to use Clip grades to do general correcting and scene-to-scene 
balancing, and then use the Timeline grade to apply a single stylistic grade to the entire spot 
simultaneously. That way, any changes the client wants made to the style of the grade can be 
instantly applied to the whole spot.

Another example would be using the Timeline grade to apply corrections meant to address 
QC issues running throughout a program, desaturating highlights or selectively darkening a 
specific shade of red wherever it appears.

To switch between Clip and Timeline grading modes:

	— Choose the mode from the drop-down menu at the top right of the Node Editor.

Selecting Track mode in the Node Editor

	— Click the dot in the Node Editor toolbar that corresponds to the Clip or Timeline mode

Two dots show whether you’re in Clip or Timeline 
mode; these can be clicked to switch

NOTE:  When you reset the Timeline grade using the Color > Reset All Grades and Nodes 
command, the Output Sizing parameters are reset as well.

Two dots at the top of the Node Editor let you switch between Clip and Timeline modes via a single 
click. If you’re working on a clip that’s part of a group, four dots will be displayed to allow fast access 
to the Pre-Clip and Post-Clip Group modes as well. For more information about group grading, see 
Chapter 139, “Grade Management.”

Timeline Grades and Saved Stills
When you save a Gallery still, the Clip and Timeline grades are both saved. However, when you apply a 
grade from that still, you only apply either the Clip grade, or the Timeline grade, depending on which 
mode the Node Editor is in. For more information on saving and applying grades, see Chapter 139, 
“Grade Management.”
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Chapter 141

Image Processing 
Order of Operations
The addition of the HDR palette and Color Warper in 
DaVinci Resolve 17 necessitated an updated diagram of the 
order of all image processing operations in DaVinci Resolve, 
from input through output. 

A truly detailed breakdown now requires two charts as detailed in this chapter; the first chart details 
the overall order of operations taking place on every page, while the second zooms into the specific 
order of operations occurring within each node of the Pre-Clip, Clip, Post-Clip, and Timeline grades 
that you create on the Color page. Understanding the order of operations presented here will make 
it easier for you to control the power of the full DaVinci Resolve toolset.

Contents
Overall Image Processing�   3127

Image Processing Within Grades�   3128
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Overall Image Processing
In the following chart, each image processing operation in DaVinci Resolve is shown in the order in 
which it’s processed. Operations are color-coded to indicate the page on which those controls appear, 
because in many cases page order does not determine image processing order. Why? Either to make 
sure each operation is processed as cleanly as possible, or to give the user the maximum control over 
the image. For both of these reasons, image processing order is carefully considered, and in some 
cases the best result requires operations on different pages to alternate with one another.

Most of the time, this order of operations is irrelevant to the user who’s only interested in the end 
result. However, if you’re trying to achieve something very specific, or if you’re wondering why you 
see a particular result when you use the features of the Cut, Edit, Fusion, and Color pages together 
all at once, this chart should help make things clear. Finishing artists in particular should find this 
chart illuminating.

The overall order of image processing operations in DaVinci Resolve, from input through output
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Image Processing Within Grades
For Pre-Clip, Clip, Post-Clip, and Timeline grades on the Color page, most Color page operations are 
available within each Corrector node you add to the Node Editor. Within each node, these operations 
take place in the following specific order.

The order of image processing operations that takes place within each Corrector node in the Color page

Thanks to the modular operation of the Node Editor, if a pair of image processing operations you need 
to use isn’t in the ideal order for what you’re trying to do, you can apply each operation using two 
different nodes in order to force those operations into the order you want. Similarly, when using Layer, 
Parallel, or Key mixer nodes, the order of operations can be seen in the visible arrangement of nodes 
in your node graph.

That said, most colorists tend to spread different operations across multiple nodes, whether they 
need to or not, for organizational purposes or to “sandbox” certain volatile decisions that might need 
to be independently revised later. However, nothing’s keeping you from using multiple operations 
within a single node if you prefer a simpler node structure for your grading. Thanks to the flexibility of 
the Color page, it’s your choice.
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Chapter 142

Serial, Parallel, 
and Layer Nodes
This chapter covers the four fundamental node structures you can 
use to combine Color page adjustments in even more detailed 
ways. These methods let you control your order of operations and 
re-combine multiple versions of the graded image in much more 
specific ways.
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Serial, Parallel, and 
Layer Node Tree Structures
There are several ways you can organize nodes in a tree. Each method lets you control a group of 
image processing operations in different ways to achieve specific results. This section covers how to 
use Serial nodes, Parallel nodes, and Layer nodes, as well as how to use LUTs, work with HDR media 
that lets you combine two different exposures using two different Source inputs, and apply additional 
project-wide adjustments using the Timeline grade.

Serial Node Structures
The simplest, and most common node structure is a serial cascade of nodes, where a linear series of 
nodes is connected, one after another. 

Serial nodes, where the output of one node 
feeds an altered image to the next

Much of the time, this method of constructing a tree of multiple operations is all you need to do. It’s 
a simple and intuitive way of organizing your adjustments, similar in principle to the stacks of layers 
used in other grading and compositing applications to apply multiple operations to a clip.

Controlling What Feeds a Node’s RGB Input
When you create a grade using serially arranged nodes, each node’s output is used as the next 
node’s input, so the order in which the nodes are arranged determines the order of image 
processing operations. 

In the following screenshot, the node tree shows a series of three operations that are applied to 
a log-exposed, low-contrast clip. The first node expands clip contrast and increases saturation. 
The second node isolates the sky to intensify its color. The third desaturates and warms the image. 
At right, you can see the result of this node tree.

Node 2 pulls a clean key from the image data fed it by Node 1
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If, instead, we reversed the order of Nodes 2 and 3, the result will be a less effective key.

By comparison, Node 3 pulls a less then optimal 
key from the image data fed it by Node 2

Because the secondary operation is sampling the desaturated image, rather than the source, the HSL 
Qualifier’s key has less image data to work with, and thus you may get an inferior result.

Parallel Node Structures
Another way to organize your corrections is to use a Parallel node structure, which lets you apply 
two or more overlapping adjustments at a single stage of a node tree. You can use the Parallel 
node structure for organizational reasons when there is a group of secondary corrections that you 
want to apply all at once. You can also use this structure for the unique way it blends overlapping 
image adjustments.

The Parallel Mixer node that makes this possible has multiple RGB inputs and a single RGB output. This 
lets the Parallel Mixer mix together multiple Corrector nodes, outputting a single image as a result.

When you add a Parallel node to an existing node, DaVinci Resolve automatically adds one Corrector 
node below the current node, and adds a Parallel Mixer node to its output.

Adding a Parallel node to Node 2 
automatically adds the Parallel Mixer

TIP:  If you want to create a series of Parallel nodes that connect to the output of the 
currently selected node, create a Serial node before you create your first Parallel node.

If you’re manually connecting another node to a Parallel Mixer node, you can drag from the output of 
the node to the Parallel Mixer node, and it will automatically add an input for you.
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To create an additional, unconnected input on a Parallel Mixer node:

	— Right-click a Parallel Mixer node and choose Add One Input.

Ordinarily, the RGB input of every Corrector node that’s connected to a Parallel node is connected to 
the output of the same node. This results in a stack of nodes that take the same state of the image as 
their input. This makes it easy to apply multiple secondary operations without worrying about whether 
or not a change to one will affect the keys of the others.

Further Parallel nodes can be added as you 
wish with each using a common source

If you add another node in parallel, the Parallel Mixer automatically adds another input. You can have 
as many nodes in parallel as you need. 

The adjustments made by all nodes that are connected to a Parallel Mixer are combined equally, 
regardless of which nodes are highest. In the following example, a separate overlapping window is 
applied by each of three nodes in parallel.

The Parallel Mixer blends all input nodes together

As you can see in the image at right, the three tints created by the overlapping windows are all mixed 
together equally; the colors blend with one another as if they are optically mixed. Most of the time, 
this is exactly what you want when you’re blending overlapping naturalistic color adjustments.
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Converting Parallel Mixers to Layer Mixers
On the other hand, if you need your overlapping color adjustments to have priority over one another, 
or if you want to combine multiple adjustments using composite modes, then you may want to use the 
Layer Mixer node instead. If you’ve created a Parallel Mixer structure and you want to convert it to a 
Layer Mixer, you can.

To change a Parallel Mixer node into a Layer Mixer node:

	— Right-click a Parallel Mixer node and choose Morph Into Layer Mixer Node.

Layer Mixer Node Structures
The Layer Mixer is structurally quite similar to the layout used by the Parallel Mixer. However, there 
are two key differences. First, the Layer Mixer node combines multiple adjustments with priority 
given to the image adjustment in the lowest overlapping node input. Second, you have the option 
of combining all of the Corrector nodes that are connected to a Layer Mixer using one of several 
different composite modes, to create a wide variety of visual effects.

Because of their similarities, layering nodes with the Layer Mixer works in much the same way as 
creating a Parallel node structure.

Layer Mixer Prioritization
In the following example, the same node structure from the Parallel Mixer example is shown, this time 
with the three overlapping color adjustments mixed together using the Layer Mixer.

The Layer Mixer prioritizes nodes connected to lower inputs such 
that each node’s output completely obscures whatever is behind it

Now, instead of the three adjusted color tints being blended, you can see that the blue tint, which is 
connected to the lowest input of the Layer Mixer, is dominant and covers the overlapping regions of 
the two other adjustments. Meanwhile, the green tint, which is connected to the middle input of the 
Layer Mixer, covers the overlapping portion of the orange tint, which is connected to the highest input 
of the Layer Mixer.
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Rearranging which connections are attached to which Layer Mixer inputs changes each node’s 
priority, and like the Parallel Mixer, you can add more inputs manually, or by dragging the output of a 
node to the Layer Mixer.

The Layer Mixer’s prioritization is most useful when you have an overlapping adjustment that you 
need to override any other adjustments happening on that stack. In the following example, two nodes 
are connected to the Layer Mixer node. Node 2 is applying a high-contrast, cool look to the entire 
clip. Node 3 isolates the skin tone, which is unflattering with the background stylization, and applies a 
different, more naturalistic adjustment.

Using the layer mixer, grades on Node 3 will have a greater 
priority over Node 2, so the final grade combines the high 
contrast from Node 2 with the adjusted skin tone from Node 4

Because of the Layer Mixer’s prioritization, the adjustment made to the woman’s skin tone completely 
covers the adjustment made to the node that comes above it, providing the best of both worlds with 
one simple adjustment.

TIP:  If you want to “solo” overlapping nodes that are connected to the Layer Mixer to 
see their individual adjustment, turn on Highlight (Shift-H, or the HILITE button on the 
DaVinci Resolve Mini Panel, or at the bottom of the T-bar panel of the DaVinci control 
panel). This lets you view just that node’s effect, regardless of what other node adjustments 
are overlapping.
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Using Composite Modes With the Layer Mixer
You have the option of combining the adjustments made by all nodes connected to a Layer Mixer 
node using the same Composite modes that are available when compositing clips in the Timeline. 
This lets you combine different overlapping image adjustments using compositing math to achieve 
creative effects or utilitarian fixes.

The following simple example shows two overlapping Corrector nodes connected to a Layer Mixer 
node that’s set to the Add composite mode. Node 3 has no adjustment, but Node 5 has an extremely 
high-contrast curve adjustment applied, along with a blur, that effectively isolates the highlights of the 
image and feathers them out.

Combining two nodes using the Layer Mixer 
set to Add to create a glowing effect

By adding both treatments together, a hot glow has been created, blowing out the highlights 
of the image. Many, many other effects are possible using the different composite modes that are 
available. For more information on composite modes, see Chapter 50, “Compositing and Transforms in 
the Timeline.”
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Adjusting Layer Node Strength 
Using Key Output Gain
Whether you’re combining overlapping corrections, or mixing different adjustments using Composite 
modes, you’ll run into situations where you want to reduce the influence of one overlapping 
adjustment relative to the other nodes that are connected to the Layer Mixer node. This can be 
accomplished using each overlapping node’s Key Output Gain parameter, located in the Key palette.

Using the Output Gain parameter in the Key palette

Key Output Gain defaults to 1.00, but lowering this value reduces the strength of that node’s 
contribution to the Layer Mixer. Using the previous example, selecting Node 4 (the high‑contrast 
image used to create the glow), opening the Key palette, and reducing the Key Output Gain parameter 
to 0.50 reduces the intensity of the Glow effect by half.

You can use Key Output Gain to mix the proportion of any number of overlapping adjustments in 
order to create the perfect combination for your purposes.

TIP:  You can also use the Key Output Gain parameter to mix the proportion of adjustments 
being combined using the Parallel Mixer node.

Converting Layer Mixers to Parallel Mixers
You can easily convert a Layer Mixer to a Parallel Mixer should you discover that you need to mix your 
overlapping corrections evenly rather than combine them with priority. Keep in mind that you’ll lose 
the ability to use Composite modes.

To change a Layer Mixer node into a Parallel Mixer node:

	— Right-click a Parallel Mixer node and choose Morph Into Parallel Node.
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Chapter 143

Combining Keys 
and Using Mattes
A key is the actual image channel that’s generated by 
different secondary operations to isolate specific portions of 
images to work on. 

This chapter covers different ways you can manipulate and combine keys from multiple nodes, or 
propagate keys among nodes. It also shows different ways you can use mattes that are imported from 
other applications, as well as how to use the Key palette to further manipulate keys in different ways.
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Introduction to Manipulating 
and Combining Keys
Each node’s key input and key output makes it possible to route key channel data from one node to 
another so you can apply isolated corrections. Furthermore, the Key Mixer lets you combine a variety 
of keys from different nodes to create more detailed keys with which to tackle complex operations. 
This section covers all the ways you can recombine key data, as well as how keys can be used in 
conjunction with the Alpha output to create regions of transparency in a clip for compositing right 
within DaVinci Resolve.

Outside Nodes
Whenever you use a Power Window or HSL Qualifier to limit a correction within one node, a special 
node structure lets you automatically create a second node, called an Outside node, to apply 
additional adjustments to the inverse of the region you isolated in the previous node. Outside nodes 
are really just Corrector nodes with the Key Palette’s Key Input Invert control enabled, which makes it 
easy to apply separate corrections to an isolated subject and to its surroundings. 

The Key Input Invert button, in the Key palette, 
that inverts any key fed to that node’s Key Input

In the following example, the sky has been isolated using a Power Window, and an Outside node 
has been added to make an additional correction to everything else within the shot.

The Outside node automatically 
has its key input inverted.

To add an Outside node to a node, creating a secondary correction:

1	 Select a node that has been limited using a Power Window or HSL Qualifier.

2	 Do one of the following:

	— Choose Nodes > Add Outside (Option-O).

	— Right-click a node choose Add Outside Node.

A new node is created immediately after the selected node, with the RGB and key outputs of the first 
node automatically connected to those of the new node. 
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When selecting the new node and opening the Key palette, you can see that the Key Input’s Invert 
control is on by default, which is what inverts the key from the previous node.

The Key Input Invert control is on 
by default for each node.

If, instead of using the Outside node to invert the incoming key, you want to copy the existing key 
in order to perform another operation to the same isolated region, you can disable the key input’s 
Invert control.

Feeding Keys From 
One Node to Another
One of the most powerful aspects of the Node Editor is the ability to create keys based on a specific 
part of the node tree, and feed the result into a completely different correction somewhere else in the 
node tree. This is one of the reasons for the separate key input and output on every Corrector node.

The key that’s created whenever you use the HSL Qualifier, create one or more windows, or use an 
external matte can be output from one node’s key output and fed to the key input of any other node 
in a tree. There are many reasons to do this, but the following example shows a common problem you 
can solve with this technique.

Using a key from one node to make an adjustment with a different node:

1	 Use Node 1 to apply a basic primary correction, increasing contrast and balancing the color to 
achieve a pleasing ambient color temperature. 

2	 Add a Serial node (Node 2), followed by a Layer Mixer node which also adds Node 4 (as seen in the 
following screenshots). Then, completely desaturate Node 4 and add contrast to make it super-
high contrast black and white, desaturate Node 2 just a bit, and right-click the Layer Mixer node to 
choose the Overlay blend mode with which to combine these two layers.

A group of nodes to create a stylized image
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The result is a highly stylized image, but the skin tone on the actor’s face and hands in the 
resulting image are too monochromatic, and you want to give them some differentiation. Simply 
adding another node after the Layer Mixer and keying the skin tone may not work well because 
the low level of saturation will make a key difficult to pull. 

The resulting stylized image may 
be difficult to key accurately.

3	 Add another node after the Layer Mixer (Node 5 in the screenshot), and then right-click in the gray 
background area of the Node Editor, and choose Add Node > Corrector to create an unattached 
node, (Node 6).

4	 Connect the RGB output of Node 1 to the RGB input of Node 6, and then connect the key output 
of Node 6 to the key input of Node 5. Now you’re ready to pull a high-quality key from the very first 
correction in Node 1, skipping all the complication coming afterwards.

5	 Use the HSL Qualifier in Node 6 to pull a good strong skin tone key based on the primary image. 
Given the way the node tree is now set up, that key is fed to Node 5, and will limit whatever 
adjustments you make there. 

Using Node 6 to pull a key from the image output 
by Node 1, and feeding that key to Node 5

6	 Now, you can make your adjustment to Node 6’s grade, to lower the contrast, brighten, and 
increase the saturation of the actor’s skin tone.As a result of this operation, the background 
remains desaturated and contrasty, while the actor’s skin tone has the brighter quality we need 
for the shot.
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(Left) An entire clip with a high-contrast grade, (Right) The skin tone 
graded differently from the high-contrast grade using a key

This example could have been handled in a variety of different ways, but the point is that you can add 
nodes that connect to the state of the image at any part of a node tree, and use them to generate keys 
to feed to any other node, regardless of what’s happening to the picture in between.

Connecting Key Outputs to 
RGB Inputs, and Vice Versa
There’s another way you can manipulate a key from one node using another in the Node Editor, and 
that’s to connect the key output from one node to the RGB input of another node. When you do this, 
you can use any of the controls of the second node to manipulate the key, and you can then use the 
result by connecting the RGB output of the second node to the key input of a third node.

Connecting a key output to an RGB input to adjust a key with a second node’s controls

In the node tree shown above, Node 2 pulls a key, Node 4 manipulates the key, and Node 3 uses 
the key to make a color adjustment.

Keep in mind that a key is just a grayscale image. Setting up this kind of node structure lets you 
use any of the second node’s controls, such as the Custom Curves, Noise Reduction or Motion Blur 
controls, Sharpen, Midtone Contrast, Lift/Gamma/Gain, Contrast, or Log controls, to manipulate 
the key in ways you couldn’t do using only the Matte Finesse controls.
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While this technique may not be necessary for conventional color isolations, it can come in very 
handy when making tricky isolations with hard to key subjects, or when using one of the Qualifier 
modes to pull a key to create transparency for compositing using the Node Editor’s Alpha output. 
In this instance, you can connect the RGB output of a node used for key manipulation directly to 
the Alpha output. In the example, Node 1 pulls a key, and the RGB is connected to Node 3 which 
is used to color correct the foreground image. The key from Node 1 is connected to the RGB of 
Node 2, which manipulates the key to clean it up prior to connecting it to the Alpha output block at 
the bottom right of the Node Editor.

Connecting a key output to an RGB input to adjust a key used 
to create transparency via the Alpha output

Furthermore, this capability also lets you create keys in other ways besides using the Qualifier 
palette controls. In the following example, the Contrast and Custom Curve controls in Node 
3 create a high-contrast matte of the windows which is blurred. The RGB output of Node 3 is 
then connected to the KEY input of Node 2, where the resulting key can be used for a variety of 
adjustments; in this case, to tint the product within the image green. Alternately, this technique 
could be also be used to create transparency via the Alpha output.

Using a high-contrast color correction as a key

You can manually connect RGB inputs and outputs to Key inputs and outputs by dragging links 
between them. Alternatively, you can drag and hover a node over an RGB or Key link to insert it. 
Interconnecting key and RGB inputs and outputs is a powerful capability that lets you create many 
kinds of workarounds for uncommon situations.
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Using External Mattes
The External Matte node has evolved over the years. What was once purely a means for importing 
matte channels for defining opacity and limiting adjustments has expanded to become a way to 
import the RGB channels of a media file to be used for overlaying grain, texture, and stylized distress 
onto an image, and even as a way to use the channels of a clip itself as a matte.

Matte clips can be added to your project in one of two ways:

	— You can add mattes using the Media page, either by attaching them to a clip so a particular matte 
is only available to a particular clip as part of a Clip grade, or you can add timeline mattes that 
stand alone in the Media Pool, which are then available to any Track grade. 

	— You can also add a matte to a clip using the Media Pool in the Color page, by dragging a clip from 
the Media Pool to the Node Editor. When you do so, that clip is turned into an external matte in 
the current grade, which you can use as a matte for secondary adjustments, or as a compositing 
layer (in conjunction with the Layer mixer) for mixing textures or images with your grade. That clip 
is also automatically attached to the Media Pool clip that corresponds to the clip you’re grading, as 
a clip matte, to help you keep track of which clips are using other clips as mattes.

For more information about adding matte clips in the Media page, see “Adding and Removing External 
Mattes” in Chapter 18, “Adding and Organizing Media with the Media Pool.”

Whether attached or unattached, mattes operate within a grade using EXT MATTE (external matte) 
nodes. EXT MATTE nodes have the following outputs:

An external matte connected to the first node of a grade

	— EXT MATTE Outputs: Four blue square key outputs let you output the channels contained within 
the EXT MATTE node, but which channels are available affects what is output. If the EXT MATTE 
node’s source clip has RGBA channels, then these are available as Alpha, Red, Green, and Blue 
key outputs that you can attach to any other node’s key input. On the other hand, if the EXT 
MATTE node’s source clip only has RGB channels, then the key outputs that are made available 
are Y (luma), Red, Green, and Blue, and a “Use Lum for Alpha Output” setting in the Node Editor 
contextual menu lets you use the Y channel as a matte.

An interesting aspect of these four outputs is that each one is dedicated to individual A, R, 
G, and B color channels. Ordinarily, External Matte clips are written with matte data written 
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simultaneously to all three RGB channels. However, you could also render separate pure primary-
colored mattes to each color channel (a so-called “disco” matte), so that the Red channel has one 
matte, the Green channel another, and the Blue channels still another, thereby exporting three 
separate mattes within a single media file, for convenience. If you add another matte to the Alpha 
channel, you can even export four mattes within a single file. You can then use each one of these 
mattes individually by connecting the correct output of the EXT MATTE node. (Note: For backward 
compatibility, projects from versions of DaVinci Resolve previous to 12.5 continue to output RGBY 
from the square outputs, not YRGB.)

	— RGB Output: A square green RGB output lets you connect the RGB image data of a matte clip to 
any other clip’s RGB input. This is especially useful when you’re combining a matte clip with the 
current clip using a Layer Mixer node, to create a textured composite of some kind.

External Mattes to Limit Adjustments
Going back to the External Matte node’s original use, mattes are typically grayscale media files that 
represent image opacity, and are meant to be used either as alpha channels for creating opacity 
within a corresponding RGB clip, or as a matte for limiting effects. 

An example of a matte channel would be the key created by a green screen keyer. If you output just 
the key, that would be an external matte. If you receive an external matte along with an effects clip, 
you can attach the matte to its corresponding RGB clip in the Media page. Then, you can access that 
matte via an External Matte node in the Node Editor, so you can use the key it outputs to limit different 
kinds of corrections you want to apply. 

In the following example, the keyed matte of a green screen composite clip is used to apply different 
corrections to the inside and outside of a keyed composite, in order to make the subject match the 
background more convincingly.

A matte attached to clip 
Makeup_Green.mov, as seen 
in the Media Pool

To use a clip matte to limit an adjustment within a Clip grade:

1	 Right-click any node, and choose the attached matte you want to use from the Add Matte 
submenu of the contextual menu.

By default, the EXT MATTE node that appears has its first output connected to the Connect one of 
the EXT MATTE node’s triangular key outputs to the key input of a node you want it to limit.

2	 Select the node to which the EXT MATTE node is attached, and add an Outside node to make it 
possible to add adjustments on either side of the matte.
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Node Editor displaying the influence of the external 
matte on multiple nodes when the keys are linked 

3	 If necessary, select Node 1, and use the Key palette controls to modify the incoming key, inverting 
or blurring it as necessary to create the isolation you need. 

NOTE:  Don’t select the EXT MATTE node, because it exposes different controls in the 
Key palette for transforming, flipping, looping, and freezing the matte.

At this point, you can add adjustments to the inside and the outside of this composited shot to 
improve the composite.

(Before/After) An external matte is used to apply separate grades to the 
foreground and background of a previously composited clip

Ideally, external mattes are exported so that they match the size and duration of the RGB clip 
they’re supposed to accompany. If they don’t match or if you’re using some other grayscale clip as 
an external matte to create some sort of effect, then there are parameters in the Key palette that 
you can use to retime or transform a matte so it works better in your grade.

To slip the sync of a matte relative to the clip it’s attached to:

1	 Select the Ext Matte node you want to slip.

2	 Open the Key palette, and turn off the Lock Matte checkbox.

3	 Raise or lower the Offset parameter until the matte is perfectly aligned with the clip it’s 
supposed to match.

3145Color  |  Chapter 143  Combining Keys and Using Mattes



To transform a matte:

1	 Select the Ext Matte you want to transform.

2	 Open the Key palette, and turn off the Lock Matte checkbox.

3	 Use the Pan, Tilt, Zoom, Rotate, Width, Height, HFlip, or VFlip parameters to adjust the matte so it 
has the correct geometry.

It’s worth mentioning that you can attach as many external mattes to a single clip in DaVinci Resolve 
as you like. For example, if a CGI shot has been delivered with a set of isolation mattes for each of 
three characters in the scene, you can import all three mattes and use them to isolate adjustments 
that you want to make in the Node Editor.

Extracting External Mattes from OpenEXR Layers
OpenEXR media is capable of containing multiple layers and multiple alpha channels, which can also 
be accessed from EXT MATTE nodes. As a result, DaVinci Resolve uses a slightly different but related 
procedure for accessing these mattes.

To extract OpenEXR layers as external matte nodes:

1	 Right-click any node, and choose the .exr clip name from the Add Matte submenu of the 
contextual menu.

By default, the EXT MATTE node that appears has its first output connected to the Connect one of 
the EXT MATTE node’s triangular key outputs to the key input of a node you want it to limit.

2	 Double-click the EXT MATTE node to select it, then right-click it and choose which layer you want 
to use from the Select Matte submenu. 

Right-clicking an OpenEXR file’s EXT MATTE node to choose which layer to use

OpenEXR files with multiple RGBA layers (or passes) embedded within them (RGBA + RGBA + RGBA 
and so on) or OpenEXR files with multiple alpha channels (RGBA + A + A) expose multiple entries in this 
submenu. Whichever one you choose is the layer that will be used as a matte by that EXT MATTE node.
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Once you’ve extracted an OpenEXR layer, you can use it as you would any other EXT MATTE node 
described in this section, to limit adjustments (as seen above), or to add texture or transparency (as 
seen in the following sections).

Using External Mattes to Add Texture
You can also use external mattes as creative tools, to add grain and texture. For example, you might 
use a more abstract animated matte, or a grayscale film scan of dirt and dust, to apply correction 
for effect.

Light leak and dirt and dust images From Warren Eagles’ Scratch FX 
collection (FXPHD), designed to add texture to your grades

Once attached to a clip, external mattes can be exposed in the Node Editor, and their key output can 
be used just like any other key in a node tree. 

To use a clip matte to create texture for a Clip or Timeline grade:

1	 When applying a matte as part of a Clip or Timeline grade, right-click any node and choose the 
attached or timeline matte you want to use from the Add Matte submenu of the contextual menu. 
Unattached mattes appear in the Add Matte > Timeline Mattes submenu.  

2	 Disconnect the EXT MATTE node’s key output connection to the Key input of the node it’s 
connected to by default.

3	 Add a Layer Mixer to the end of the node tree.

4	 Disconnect the bottom Corrector node’s RGB input, and then connect it to the EXT MATTE node’s 
square RGB output.

A node tree set up to feed an EXT MATTE node’s RGB output to the input of a node 
connected to a Layer Mixer, in order to blend it with the grade using composite modes
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5	 Right-click the Layer Mixer node, and choose Overlay from the Composite Mode submenu to 
blend the Ext Matte node most effectively with the grade.

6	 If necessary, you can use the grading controls of the Corrector node to which you’ve attached the 
EXT MATTE node to change the characteristics of the texture clip, desaturating it for instance. You 
can also select the EXT MATTE node itself, open the Key palette, and use the Transform, Offset, 
Loop, or Freeze controls described later to change how the matte appears.

The resulting texture effect, blended with the 
grade using the Overlay composite mode 

TIP:  If you want the texture you create to be unaffected by blur or sharpening 
operations within the grade, be sure to add it to the very end of the node tree.

Using External Mattes to Create Transparency
You can also use an EXT MATTE node to create transparency in a clip, for compositing with clips 
underneath it on the Timeline.

To use a clip matte to create transparency in a clip:

1	 Right-click any node, and choose the attached matte you want to use from the Add Matte 
submenu of the contextual menu. 

Adding an EXT MATTE node to a Clip grade applies the effect to only that clip, whereas adding an 
EXT MATTE node to a Track grade applies the effect to the entire Timeline.

2	 Right-click any empty area of the Node Editor, and choose Add Alpha Output to reveal the Node 
Tree output on the right that lets you assign a key to be used to define clip transparency.

3	 Connect one of the EXT MATTE node’s triangular key outputs to the Alpha output at the right of 
the Node Editor.

The node setup for using an external matte to composite two layer
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The areas of the matte defined by the key are now rendered transparent.

The final composite created using the external matte node 

Key Palette Controls for the External Matte Node
When you select an EXT MATTE node, the Key palette displays different parameters only for mattes. 
Be aware that you must turn off the Lock Matte checkbox before you can make adjustments to 
transform the matte.

The Key Palette showing a texture layer added as an EXT MATTE node

	— Transform: Standard Pan, Tilt, Zoom, Rotate, Width, and Height parameters let you transform a 
matte to fit the image better.

	— Flip Image: Two buttons let you flip the matte clip horizontally or vertically.

	— Offset: Adjust this parameter to offset the start point of a matte clip.

	— Freeze: Turning on this checkbox freezes the matte clip on a single frame. Adjust the Offset 
parameter to choose which frame to freeze on.

	— Loop: Turning on this checkbox enables matte clips to loop endlessly, which lets shorter matte 
clips cover longer durations.

	— Lock Matte: When turned on, locks the sizing of a matte to whatever changes are made to the 
Input Sizing of that clip, so the matte transforms to follow the clip.

You can also use external mattes as creative tools. For example, you might use a more abstract 
animated matte, or a grayscale film scan of dirt and dust, to apply correction for effect.
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Using Mattes From the Fusion Page
If you’re grading a composite that’s been created in the Fusion page, you can feed mattes created in 
different parts of a Fusion composition to the Color page to use in the grade as well. For example, if 
you’re grading a composite of a foreground actor who’s green screen keyed against a background 
layer, you might want to use the matte generated for the key to protect the foreground subject from 
an operation in your grade that you only want to affect the background. Happily, this is easy to set up.

In the following Fusion composition, two DeltaKeyer nodes (one to create an overall matte, and one 
to create a solid matte protecting the core) and one BSpline node (to create a garbage matte) work 
together to create a finely-tuned matte. This matte is used by the Merge1 node to preserve the 
subject’s hair and composite them in front of a gently blurred (using the LensBlur node) planet, with 
the final result connected to the MediaOut1 node, which feeds this image to the Edit page and Color 
page for continued adjustment.

A green screen composition in the Fusion page, outputting the RGB in 
MediaOut1, and the foreground matte in MediaOut2

Because the Merge1 node outputs the entire composition as a single image, a second MediaOut node 
(highlighted) is added to output the matte, just in case the colorist might want to use it later.
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TIP:  In this composition, the foreground and background images are different sizes, 
so outputting the alpha channel of the DeltaKeyer1 node would result in a matte sized 
to match the foreground image, but that doesn’t fit the composition, which is cropping 
the top and bottom of the foreground image based on the frame size of the widescreen 
background image. To get around this, the foreground and background images are 
composited a second time using the Merge2 node, which has the Operator parameter set 
to “In” to output just the foreground image and matte, as resized by the Merge operation. 
The resulting MediaOut2 node thus outputs a foreground matte that’s properly sized to fit 
the composition.

On the Color page, the grade in node 1 is applied to the overall final result, which is a single image. 
After grading, it’s decided that the woman appears a bit warm relative to the cool blue of the 
planet behind.

The composition as it appears in the Color page Node Viewer

Right-clicking the background of the Node Editor and choosing Add Source adds a second source at 
the left of the Node Editor.

Adding a source to bring in the MediaOut2 node’s 
matte output from the Fusion page composition

This second source corresponds to the second MediaOut node you added to the Fusion page 
composition, which outputs the Matte as a key in the Color page, usable just like any other key. If you 
hover your pointer over each source, a tooltip appears letting you know which output corresponds to 
which node. 

3151Color  |  Chapter 143  Combining Keys and Using Mattes



Hovering the pointer over a source 
identifies it in a tooltip

Generally, sources are arranged from top to bottom from the first MediaOut node appearing in a 
Fusion composition to the last. At this point, you can connect the second Source to the Key input of a 
second corrector node, using that key to selectively grade just the woman in the foreground (grade 
exaggerated for effect), without affecting the background. The Viewer is shown with Splitscreen set 
to Highlight Modes, so you can see the result as well as the key from the Fusion page that’s being 
used by Node 2.

Connecting the second source to a second Corrector node’s KEY input to use 
the matte to limit a correction made to the foreground character

Using the Key Mixer
The Key Mixer node lets you mix keys output from multiple Corrector nodes, combining them in 
different ways to create a single key output. This makes it possible to build much more intricate keys 
than you can with a single qualifier or set of four windows. In particular, the Key Mixer node is the only 
way to combine multiple keys made using qualifiers and windows, adding, subtracting, or intersecting 
them to create a highly specific result.

Adding Two Keys Together
In the following example, you’ll learn how to set up a Key Mixer to combine the keys output by two 
Corrector nodes in a node tree. Then you’ll learn how to change the way the input keys are combined 
using the Key palette.

To combine two or more keys using the Key Mixer:

1	 Right-click anywhere on the gray area of the Node Editor, and choose Add Node > Key Mixer.

2	 Create two Corrector nodes, then attach their RGB inputs to the RGB output from an appropriate 
node in the main part of the tree, and attach their key outputs to the key inputs of the Key Mixer.
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3	 Next, attach the key output of the Key Mixer node to the key input of the node you want to use to 
make the correction. Remember, the objective is to use the key that’s output by the Key Mixer to 
limit the adjustment being made using another node, in this case Node 3.

Setting up the node tree you’ll need to combine two keys together

Keep in mind, especially since this is a significant reordering of nodes in the Node Editor, that 
every node needs to be connected properly for the overall grade to work.

4	 Now that the node structure is fully connected, use windows, qualifiers, or both to create keys in 
each of the nodes that you connected to the Key Mixer. In this example, Node 2 is isolating the 
main skin tone, and Node 5 is isolating the blue of his jeans and hood.

By default, all keys connected to the Key Mixer are added together, as you can see in the 
Key Mixer’s thumbnail.

Combining multiple keys with the Key Mixer

If you wanted, you can use the controls in the Key palette to change this, in order to isolate the 
intersection of two keys, or to subtract one key from another. This is covered in the next section.

5	 Continuing with the previous setup where both keys are added together by default, selecting 
Node 3 and dropping the saturation to be very faint stylizes the entire background, while leaving 
the various hues of the man we’ve isolated alone.
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Final grade, the talent in color with a B&W background

Subtracting One Key from Another
The way multiple keys are combined within the Key Mixer depends on a pair of Key Input buttons you 
can toggle using the Key palette. In the following example, a partial green tint is washed throughout 
the midtones of the image using a qualifier, but you want to exclude the man’s skin tone from this 
operation. Using the Key Mixer, you can subtract one key from another to accomplish this with ease.

A selective blue tint added to the midtones 
of the image includes the red sign.

To change the Key Input settings for a node connected to a Key Mixer:

1	 In this example, Node 2 is isolating part of the midtones of the image, and feeding its key through 
the Key Mixer to Node 4, which is using it to apply a partial blue tint. However, in preparation for 
subtracting the skin tone from this operation, Node 3 is isolating the man’s skin tone.

A node setup in preparation of subtracting the Bar sign from 
the midtone isolation being used to add a partial blue tint
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2	 To reveal the controls you’ll use to change how the key from Node 3 interacts with the key from 
Node 2, double-click the Key Mixer node to select it.

3	 Open the Key palette; a list of all input links that are connected to the Key Mixer appears at 
the right.

The input list of the Key Mixer node

4	 Within each list entry is the input name (Input Link 1, Input Link 2, etc.), a Matte control, 
a Mask control, a gain parameter, and an offset parameter.

	— To subtract Node 3’s key from that of Node 2: Turn on both the Key Input Matte button and 
the Key Input Invert button for Input Link 2.

Turning on Matte and Invert for Input Link 2 to 
Output Node 3 subtracted from Node 2

	— To subtract Node 2’s key from that of Node 3: Turn on both the Key Input Matte button and 
the Key Input Invert button for Input Link 1.

Turning on Matte and Invert for Input Link 1 
to Output Node 2 subtracted from Node 3
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	— To limit the output to the intersection of both keys: Turn on the Key Input Matte button 
for either Input Link 1 or Input Link 2.

Turning on Matte for Input Link 1 to 
output the intersection of two mattes

	— To invert the resulting matte you’ve created: Turn on the Output Link Invert button.

When you’re finished, if you choose to subtract Node 3’s key from that of Node 2, the result 
should resemble the following screenshot.

The result of subtracting a key of the man’s face 
from a key of the overall midtones of the image, 
and using that to add a selective green tint

Adding Inputs to Key Mixer Nodes
New Key Mixer nodes have two key inputs by default. If necessary, additional inputs can be added in 
order to combine even more keys with one another.

To add inputs to the Key Mixer:

	— Drag the Key Output from a corrector node to the Key Mixer.

	— Right-click a Key Mixer node, and choose Add One Input.
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When combining three or more keys, the interaction of keys using the Key palette controls becomes 
even more complex, but the rules outlined above still apply.

Using the Key Palette
For example, the Key Input Invert control is always enabled when you add an Outside node, which is 
why the Outside node applies adjustments to the inverse area of the previous node. If you turn this 
control off, that node’s key will exactly mirror the original key being fed to it from the previous node.

The controls that are available in the Key palette vary depending on what kind of node you have selected:

	— Corrector Nodes: Have three sets of parameters. Key Input parameters let you make adjustments 
to keys being fed through a node’s Key Input connection. The Key Output parameters let 
you make adjustments to the key data being output by a node’s Key Output connection, and 
includes the incredibly powerful Offset Gain parameter that governs the strength of that node’s 
contribution to the overall grade. Finally, the Qualifier parameters let you make adjustments to the 
internal key created with the HSL Qualifier or Window controls. This functionality is covered more 
extensively in the next section.

	— Ext Mattes: Have two sets of parameters. Transform parameters let you make geometric 
transformations to a matte so it fits the clip it’s being applied to better. An Offset control lets you 
slip the sync between an external matte and the clip to which it’s applied. This functionality is 
covered in the section on external mattes.

	— Key Mixer Nodes: Have two sets of parameters that are dependent on which of the 
connections attached to a Key Mixer’s key inputs is selected. Input parameters let you adjust 
how much of a contribution a key makes to the total key mix, and whether the contribution is 
additive or subtractive.

The Output parameters let you adjust the inversion and strength of the key that’s output by the Key 
Mixer. This functionality is described more extensively in the Key Mixer section.

Layer Mixer and Parallel Mixer nodes have no adjustable controls in the Key palette.

Using the Key Palette to Affect Corrector Nodes
When you open the Key palette for a selected Corrector node, you can adjust the following parameters:

Key palette showing controls when a node is selected
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Key Input Controls

	— Input invert: Inverts the key being fed into the key input. Off by default.

	— Input matte: Lets you switch the key input between Matte and Mask modes. In Matte mode 
(on by default) the key input combines via intersection with keys generated internally using the 
Qualifier or Windows palette. In Mask mode, the key input is added to the internal key instead.

	— Gain: Controls the strength of the key connected to the key input.

	— Offset: Controls the contrast of the key connected to the key input.

	— Blur Radius: Blurs the key connected to the key input

	— Blur H/V Ratio: Alters the horizontal/vertical ratio of the blur that’s being applied to the key input.

Key Output Controls

	— Qualifier invert: Inverts the overall key.

	— Gain: Using the key output, this parameter governs the strength of that node’s contribution to the 
overall grade. Setting Gain to 0 results in that node having no effect at all, while the default setting 
of 1.00 applies the full strength of any adjustments made with that node. The maximum setting of 
2.00 increases the intensity of any part of the key output that’s less than 100 percent white. You 
can also use this parameter to keyframe the key output to fade that node’s contribution in or out 
with one set of keyframes.

	— Offset: Lets you adjust the contrast of the Output key. This has no effect if the entire key is 100 
percent white (a solid key).

Qualifier Controls

	— Qualifier invert: Inverts the key created by that node’s Qualifier palette.

	— Qualifier matte: Lets you switch the interaction of the keys generated by the Qualifier and 
Window palettes between Matte and Mask modes. In Matte mode (the default), the Qualifier and 
Windows palettes combine via intersection. In Mask mode, they’re added together instead.

	— Gain: Lets you raise or lower the strength of the key generated by the Qualifier palette.

	— Offset: Lets you adjust the contrast of the key generated by the Qualifier palette.

Using the Key Palette to Adjust Key Mixer Controls
When you open the Key palette for a selected Key Mixer node, you can adjust the following controls:

Key palette showing controls when a Key Mixer is selected
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	— Input list: A list of every input that’s connected to the Key Mixer. Each entry on the list has the 
following controls:

	— Input name: The name of each node connection attached to that key mixer, such as Input 
Link 1, Input Link 2, and so on.

	— Input invert: Inverts the key being fed into this particular input. Off by default.

	— Input mask: Lets you switch the key input between Matte and Mask modes. In Matte mode 
(on) the key input combines via intersection with other inputs connected to the Key mixer. In 
Mask mode (off by default), the key input is added to the other key inputs connected to the 
Key mixer.

	— Gain parameter: Decreases or increases the intensity of that input matte’s contribution to 
the resulting output matte.

	— Offset parameter: Adjusts the contrast of that input matte’s contribution to the resulting 
output matte.

	— Output invert: Inverts the overall result of the various Input Link interactions.

	— Gain: This parameter increases or reduces the strength of the resulting output key. Setting Gain 
to 0 results in all inputs being set to black, while the default setting of 1.00 outputs the combined 
mattes at full strength. The maximum setting of 2.00 increases the intensity of any part of the 
key output that’s less than 100 percent white, which can have the practical effect of “growing” 
soft edges. You can also use this parameter to keyframe the key output to fade that node’s 
contribution in or out with one set of keyframes.

	— Offset: Lets you adjust the contrast of the Output key.

The Many Uses of Key Output Gain
Several of the techniques discussed in here and in “Secondary Qualifiers,” can be further customized 
using the Key Output Gain parameter, which makes it easy to control the strength of a node’s effect on 
your grade with a single adjustment. In the following example, two simple Serial nodes are applied to 
a clip, with the first one expanding image contrast, and the second one using a variety of controls to 
add some extreme warmth to the highlights.

A tint applied only to the highlights of the image

If you decided that you want to reduce the amount of warmth added by the second node without 
readjusting the controls you used to create the effect, you could open the Key palette and lower 
the Key Output Gain parameter to fade the effect with a single adjustment.
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Four versions of this grade shown using the Versions option of the Split Screen 
controls, with Output Gain set to 1, .75, .5, and.25 for comparison

This principle also works for controlling the strength of individual nodes that are being combined in 
parallel, that are combined using the Layer node, or for simply fading out the effect of any node in the 
node tree you want to “turn down” a bit.
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Chapter 144

Channel Splitting  
and Image 
Compositing
This chapter begins by showing node structures you can use to 
isolate, split apart, convert, and recombine the image channels of 
clip in different ways. This includes ways of using the additional 
image channels that are provided in some types of media. 

The second part of the chapter shows ways that you can do image compositing right in the 
Color page, with techniques for using external mattes for compositing, and using qualifier keys to do 
green- and blue-screen compositing against other layers in the Timeline.
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Isolating, Splitting, and 
Converting Color Channels
DaVinci Resolve provides two different methods of making channel-specific adjustments, 
depending on whether you need to apply an adjustment to just one channel within a single node, 
or apply separate adjustments to all three channels across several nodes.

Enabling, Disabling, and 
Converting Node Channels
Within the contextual menu of each node in the Node Editor is a series of four options:

Expanded choices for choosing a color space and gamma for 
image processing within a node, and for disabling channels

While the ability to change the color space in which a particular node’s operations work from the 
RGB default has been available for many versions, the list of available color spaces was greatly 
expanded in DaVinci Resolve 15 (all the previous options such as Lab (CIE), HSL, and YUV are still 
there). Additionally, you have the option of choosing the gamma that node works with as well, with a 
similarly long list of options. 

Choosing a node-specific color space and gamma does not directly alter the image, as with the Color 
Space Transform ResolveFX plugin. Instead, changing a node’s color space and gamma alters what 
type of image channels the red, green, and blue controls affect, and how the adjustments you make 
within that node are applied. For example, this lets you make a temperature adjustment with a node’s 
gamma set to Linear, which in some instances may be mathematically advantageous.

Additionally, three checked Enable Channel 1–3 options let you turn individual channels off or on, 
limiting which channel that node’s adjustments will actually affect.

In the following example, you’ll see how to use these features to selectively sharpen just the Y’ (luma) 
of an image without affecting the chroma, which can be a more subtle effect than simply sharpening 
the entire image.
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To use channel disabling and color space conversion to sharpen luma only:

1	 Add a node with which to apply the sharpening you want to the current clip.

2	 Right-click the new node, and choose YUV from the Color Space submenu of the contextual menu.

3	 Apply sharpening by doing one of the following:

	— Using that node’s contextual menu, uncheck Enable Channel 2 and Enable Channel 3, which 
correspond to the U (Cb) and V (Cr) channels, leaving only Channel 1 (Y) enabled. Then, open 
the Blur palette, and drag the ganged Radius sliders down to sharpen the Y channel.

	— You can also just open the Blur palette, ungang the Radius sliders, and drag the red slider 
down to sharpen the Y channel, since any control with three gangable sliders will automatically 
assign those sliders to whichever channels are used by the currently selected Color Space.

(Before) The original image, (After) Sharpening applied to only the Y’ channel of the image 

As you can see, while the Blur palette ordinarily provides separate R, G, and B controls that can be 
unganged from one another, the Color Space submenu lets you apply sharpening to the channel 
definitions of other colorspaces, providing many other corrective and creative possibilities with the 
same controls.

Splitting Channels with the 
Splitter/Combiner Nodes
Another method of applying corrections to individual color channels is using the Splitter/Combiner 
nodes, which break the Red, Green, and Blue channels apart into separate node tree branches, each 
capable of accepting multiple serial and parallel nodes of image adjustment. There are two ways you 
can create a Splitter/Combiner node structure.

Methods of adding Splitter/Combiner nodes:

	— To add a premade Splitter/Combiner node structure: Choose Color > Nodes > Add Splitter/
Combiner Nodes (Option-Y). A Splitter and Combiner node appear already connected to three 
Corrector nodes, one for each color channel.

	— To manually construct a Splitter/Combiner node structure: Right-click in any empty area of 
the Node Editor, and choose from the Add Node submenu to create a Splitter node, a Combiner 
node, and three Corrector nodes, wiring them together as necessary to create the desired effect.
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The Splitter Combiner node structure

The Splitter node takes an incoming image and provides individual outputs for each color channel 
(top/red, middle/green, bottom/blue). When you connect each of these outputs to a Corrector 
node, that color channel automatically connects to all three internal channels of that node, so that 
the default three nodes in a Splitter/Combiner structure are internally processing red/red/red, 
green/green/green, blue/blue/blue. The Combiner then pulls the Red, Green, and Blue channels 
out of each node connected to its three inputs, and reassembles them into a single RGB image 
again. Of course, what happens in between the Splitter and Combiner is entirely up to you.

One of the simplest ways of showing the possibilities of this node structure is to combine it with 
Node Sizing in the Sizing palette. Using Node Sizing, you can correct for misaligned channels in older 
archived video, or create channel misalignments for creative looks. In the following example, a simple 
Node Sizing adjustment to a split Blue channel will create an interesting “prism vignette” effect.

To use Node Sizing on individually split channels:

1	 Choose Nodes > Add Splitter/Combiner Node (or press Option-Y) to add a premade Splitter/
Combiner node structure to the Node Editor.

2	 Select the middle of the three Corrector nodes appearing in between the Splitter and Combiner 
nodes (Node 5 in the following screenshot).

3	 Open the Sizing palette, choose Node Sizing from the Mode drop-down, and then raise the zoom 
parameter by a small amount; this example uses 1.014. 

Zooming just one color channel 
using the Splitter/Combiner nodes
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As you can see in the screenshot, just the Green channel has been zoomed in on across the entire 
image. This is only possible using Node Sizing. This is cool, but not quite what you need.

4	 Open the Window palette, add a Circular window, turn on its Invert control, and transform it to 
be a very soft, horizontally aligned vignette. This limits the individual scaling done to the Green 
channel to just the outer edge of the image, similar to a lens with excessive chromatic aberration.

The resulting channel split effect 

You could easily keep going, applying varying amounts of zoom with different window shapes to each 
of the other color channels, and perhaps adding some blur to enhance the effect, but this example 
should show the creative potential available when using this technique.

Multi-Channel RED HDRx Support
The RED EPIC, SCARLET, DRAGON, and WEAPON cameras are all capable of shooting in an HDR mode 
that effectively “brackets” two different exposures of each frame. The resulting image data stores two 
channels of image data: the regular exposure, and a “highlight exposure” that’s underexposed by a 
user-selectable margin (+3, +4, +5, or +6 ƒ-stops difference).

By default, the Input bar in the node graph feeds the regular exposure to your grade’s node tree. 
To take advantage of the additional “highlight” exposure, you can add an additional Source input to 
the node graph that feeds a second stream of image data that you can mix with the regular exposure 
in different ways.

NOTE:  You can also take advantage of the highlight exposure of RED HDRx media by 
enabling and adjusting the Magic Motion controls in the Camera Raw palette.

To set up a node tree combining the normal and highlight HDR versions:

1	 Using the first default node (Node 1), grade the image to see if you even need to use the alternate 
exposure that’s available. We’ll assume for this example that you do. In this example, the sky of 
the default exposure is pretty blown out, but there may be detail that can be retrieved using the 
highlight exposure.
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Using HDRx images 
with the Layer Mixer

2	 Create a Layer Mixer node by choosing Nodes > Add Layer (Option-L).

Two nodes are created, a Layer Mixer node that’s added after Node 1, and a third node (Node 3) 
that’s connected to a second RGB input of the Layer Mixer node in parallel to Node 1.

The Source currently 
supplies two input, 
but you can add a 
second source, which 
is the short exposure 
in the HDR image

3	 Right-click anywhere within the node graph (except on a node) and choose Add Source from the 
contextual menu.

A second Source input appears underneath the first, which outputs the highlight exposure of the 
image as a separate image stream.

A node tree that uses 
a Layer Mixer node 
to mix two Corrector 
nodes, each connected 
to separate outputs 
for the regular and 
highlight exposures

4	 Delete the connection between the top Source input and Node 3, and then connect the bottom 
Source input to the RGB input of Node 3.

Immediately, the image in the node thumbnail and Viewer updates to show the darker, 
underexposed version of the HDR image. This is because, by default, the Layer Mixer is mixing 
100% of Node 3 over Node 1.

3166Color  |  Chapter 144  Channel Splitting and Image Compositing



5	 Select Node 3 and use one of the following two procedures to create a useful combination of the 
two exposures:

To create a mix of the two exposures, open the Key tab, and drag the Key Output Gain slider to 
lower the contribution of Node 3 to the overall image. Using dynamics (keyframing), this is a good 
way to animate a dissolve from the regular exposure to the highlight exposure if you’re going from 
a dark environment to a bright environment in the same take and you want to create a smooth 
transition between both exposures.

Dissolving between the regular 
and highlight exposures of RED 
HDRx media using the Key Output 
Gain slider of a Corrector node 
connected to a Layer Mixer node

TIP:  You can also use the Blend Type and Blend Bias parameters in the Camera Raw 
palette to blend the two exposures without building a dedicated node tree.

To use the highlight exposure to selectively put detail back into the image (for example, to retrieve 
blown-out windows), use a Power Window, HSL Qualification, or a combination of the two to 
isolate the region you want to retrieve in Node 3. (Be careful if you’re using HSL Qualification to 
combine both exposures, as keyed edges can be tricky to blend.)

Isolating a region of the 
image to replace using 
the highlight exposure 
image of a RED HDRx clip 

Final node display 
with isolations
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A Note About RED HDRx Media and Performance
Since RED HDRx media records two complete streams of image data, DaVinci Resolve must 
simultaneously decode two separate tracks whenever you add a second Source input. 
(If you don’t add the second Source input, only the first stream is decoded.)

Because of this, whether you’re relying on your computer’s CPU or GPU to decode RED 
media, you’ll get half the performance when using the highlight stream of an HDR clip. 

To improve performance, you can enable the Smart Cache by choosing Playback > Render 
Cache > Smart. This automatically caches all raw source clips to the current codec set in 
the Render Cache Format parameter of the Master Settings panel of the Project Settings. 
Alternatively, you can enable the User Cache, and cache all HDRx clips manually by right-
clicking them and choosing Render Cache Fusion Output > On. DaVinci Resolve renders 
all cached clips while you’re paused, so the next time you play a cached clip, it will play at 
full speed.

If you regularly use RED HDRx media, multiple high-end GPU cards are recommended for 
optimal decoding performance.

Introduction to Compositing 
Using the Alpha Output
While DaVinci Resolve can use the alpha channel of imported media for compositing, the Alpha 
Output in the Node Editor is an optional output that you can turn on to create clip transparency using 
operations inside DaVinci Resolve to create composites against other clips on lower video tracks. 
There are many ways of using the Alpha Output, but this section will focus on three examples. 

Using a Qualifier Key to 
Create Transparency
In this first example, the Alpha Output will be used to composite a green screen clip with a 
background plate. 
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A green screen clip, ready for compositing

In preparation for this composite, the background plate is on track V1 of the Timeline, and the 
green screen clip has been superimposed on track V2.

A superimposed green screen clip on track V2 of the Timeline, above 
a background plate on track V1, ready for compositing

To create a chroma-key composite in the Color page:

1	 Right-click anywhere within the gray area of the Node Editor and choose Add Alpha Output to add 
the Alpha Output at the right of the node graph.

An Alpha Output appears underneath the Node Tree output at the right of the Node Editor.

The image Node Tree output 
with Alpha Output below

2	 You’ll want to use Node 1 to color correct the image to optimize it for keying. In this example, the 
foreground plate is log-encoded, so a LUT is added to Node 1 to normalize it. 

3	 Add a Serial node after Node 1 and connect its key output to the Alpha Output. This is a fast 
way to build this composite if you’re confident that the corrections you’ve made in Node 1 won’t 
adversely affect the key (or if you know they’ll improve it by expanding the contrast of a flat-
contrast source clip).

Alternately, you could create a second processing branch by adding a disconnected node 
(Node 2), connecting the Source node to its RGB input, and then connecting its key output to the 
Alpha Output you just added. Creating a second image processing branch from which to pull your 

3169Color  |  Chapter 144  Channel Splitting and Image Compositing



key lets you key directly from the source (assuming the source is fit to key without adjustment), 
avoiding any problems that grading the first node could introduce to the key.

Node 1 grades the clip, expanding contrast to improve both the image, and 
its ability to be keyed. Node 2 uses Qualifier controls to pull the key.

4	 Use the Qualifier controls of Node 2 to key out the green background, and then turn on the Invert 
checkbox to create the proper composite. In this example, we’re using the 3D Qualifier mode to 
pull a high-quality key.

An HSL Qualification to key the green feeding 
the Alpha Output to create transparency

5	 If there’s green spill in the composite (or blue in cases where you’re keying a bluescreen) you can 
turn on the Despill checkbox to eliminate it.
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6	 You can also use a Power Window to garbage matte out any elements you don’t want intruding 
into the shot, using the Tracker palette if necessary to make the window follow the motion of the 
foreground subject.

A PowerCurve used to garbage matte 
out unkeyable lighting fixtures

7	 If necessary, you can add another node to the output of Node 2 to make whatever corrections 
are necessary to the background plate clip to make the composite blend more seamlessly. For 
example, with this additional node selected, you could right-click the background clip and choose 
“Shot Match to This Clip” to use the automatic shot matching in DaVinci Resolve to adjust the 
foreground to match the background.

Adding more color adjustments to a node added after the qualifier

With all this set up, you end up with a nice green screen composite that’s visible in both the Color 
and Edit pages.

The result, with a window garbage matte cropping 
out the equipment, ready for further refinement 
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Using a Matte to 
Create Transparency
If you’ve been provided with a separate Matte clip for defining clip transparency, you can use that 
Matte clip within the node tree of a superimposed clip to create a composite using the Alpha Output.

To create a composite using an external matte:

1	 To associate an external matte with a clip, open the Media page, select the clip you want to add 
a matte to in the Media Pool, navigate to the matte file using the Library browser, and then 
right‑click the matte file and choose Add as Matte. For more information on importing mattes,  
see Chapter 143, “Combining Keys and Using Mattes.”

2	 Open the Color page and select the foreground clip in the Thumbnail timeline, then right-click 
Node 1 in the Node Editor and choose the matte you added from the Add Matte submenu.

An EXT MATTE node appears underneath Node 1, with the first of its four key outputs connected 
to Node 1’s key input. (Working with external mattes is covered in more detail in a prior section of 
this chapter.)

3	 Now, right-click anywhere within the node graph (other than on a node) and choose Add Alpha 
Output from the contextual menu.

An Alpha output appears underneath the Node Tree output.

4	 Drag a connection line from the second key output of the EXT MATTE node to the Alpha output.

Using an external matte in the grade and to the Alpha output

You should now see a successful composite, with the external matte creating a region of 
transparency in the foreground clip through which the background clip shows through.

Before and after the final composite, created by connecting an 
EXT MATTE node to the Alpha output in the node graph
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Setting the Composite Mode 
in a Corrector Node
If you are compositing in the Color page using the Alpha output, you can set a specific composite 
mode for any corrector node. Right-click the node and select Composite Mode from the contextual 
menu. You can then change the type of composite for the node to any of DaVinci Resolve’s built-in 
composite modes.

Choosing a Composite mode for the Corrector node
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Using OFX Alpha Channels (Legacy)
Now that all effects use standard color corrector nodes, the OFX Alpha is always available without 
having to manually set a menu option. There is no need for the user to do anything else to access an 
OFX Alpha moving forward from DaVinci Resolve 18.5.

However, for legacy project use there is still an OFX Alpha menu with two options.

	— Enable: On by default. When this is unchecked, even if the effect generates Alpha, the Alpha is 
ignored. Why one would go to the bother of generating an effect with an Alpha channel, only to 
discard it completely is a matter of conjecture, but the option is there if you’re doing something 
exceedingly strange and complicated. Really just leave this on.

	— Use For Mixing: On by default. When unchecked, no mixing of the Alpha happens on the node 
at all.  Power Windows and Keys stop working, and the node behaves like a legacy FX node. Any 
Alpha generated is still output, it just doesn’t limit where the effect acts.

The Use OFX Alpha option has been replaced with the OFX 
Alpha menu. You most likely want to keep both Enable and 
Use for Mixing checked unless you have a really good reason.
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Chapter 145

Keyframing in 
the Color Page
The Color page has a dedicated Keyframe Editor, found at the right 
of the palette area, that you can use to animate grading changes 
from one frame to another. Because grading is a fundamentally 
different task than editing, the Color page Keyframe Editor operates 
somewhat differently from the Curve Editor in the Edit page.
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Introduction to Keyframing
Whether it’s referred to as keyframing, dynamics, or marks, DaVinci Resolve provides an interface for 
automatically interpolating color adjustment parameters in various ways from one setting to another. 
For example, if you have a clip with varying exposure settings, you can animate a series of contrast 
adjustments using Dynamic keyframes to make the changes in exposure less distracting. 

The Keyframe Editor with dynamic keyframes animating the parameters of Node 2

In another example, suppose you’re grading a documentary, and an archival clip that’s edited in the 
middle of the Timeline actually consists of six different shots from a program in the eighties. If you’re 
in a hurry, you can insert Static keyframes (marks) at the cut points of each of these shots, creating 
instant one-frame transitions between different adjustments made to that clip’s grade, which allows 
you to create unique adjustments for each shot within the clip.

Round static keyframes added to all parameters, enabling individual 
adjustment of shots merged together within a single clip

In both cases, you use the Keyframe Editor to create a series of keyframes with which to change 
parameters from one value to another. In this section, you’ll learn how to work with the Keyframe 
Editor to set up these kinds of animated changes.

The Keyframe Editor Interface
The Keyframe Editor has all the controls necessary to create and modify keyframes for the currently 
selected clip. If necessary, you can even make it wider in a single screen layout by clicking its expand 
button (at the top right of the Keyframe Editor). If you have two computer displays, you can use the 
Color page’s Dual Screen layout which places the Keyframe Editor on a second screen and uses the 
entire width of the monitor, for even more room.
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The Node Editor shown in wide mode, pushing all other palettes to the left

The Keyframe Editor consists of the following components:

	— Timeline Ruler: Mirrors the record timecode of the currently selected clip; dragging within the 
Timeline Ruler moves the playhead, and a timecode display to the left shows the current frame.

	— Keyframe track header: Each node in the current grade has a corresponding keyframe 
track, Sizing has its own keyframe track, and the track header contains controls you can use to 
manage the keyframing. 

The Keyframe track header

	— Enable/Disable button: A round white button lets you enable or disable that track’s 
corresponding node. 

	— Lock button: Lets you prevent any changes from being made to that track’s corresponding node. 
Nodes that have been locked show a lock icon. You can also lock or unlock nodes by right-clicking 
a node in the Node Editor and choosing Lock Node from the contextual menu.

Nodes 1 and 2 have been locked in the Keyframe Editor of the Color page.

	— Auto-Keyframe button: Turn this button on to automatically create a Dynamic keyframe every 
time you adjust any parameter within that node.

	— Track disclosure triangle: Exposes individually keyframable groups of parameters underneath 
the main keyframe track.
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	— Keyframe tracks: To the right of the track header, the keyframe tracks are where you create and 
edit the keyframes that animate parameter changes. A topmost “master keyframe track” shows 
every keyframe applied on every keyframe track in the Keyframe Editor, even keyframes applied to 
a keyframing track hidden inside a track with a closed disclosure triangle.

	— Keyframes: Each keyframe appears as a small diamond for a Dynamic keyframe or as a circle for 
a Static keyframe. Dynamic keyframes are associated with dissolves while Static keyframes (marks) 
act instantly. Grades are linked to the preceding keyframe, which may be a default one on the first 
frame of the master clip. Keyframes can be selected by clicking on them, or moved by dragging 
them to another position in the keyframe track.

	— FX track: Resolve FX or OFX plugins that have been added to a grade as a standalone node have 
a separate track for creating animated effects. Every parameter of that track is keyframed via a 
single consolidated keyframe track. If you apply multiple plugins as multiple nodes, each has a 
separate FX track.

	— Sizing track: The Pan, Tilt, Zoom, Rotate, and Convergence (in Stereo 3D projects) parameter have 
an entirely separate track for creating animated pan and scan adjustments.

	— Track selection drop-down: A colored bar shows the currently selected scope of keyframing: all 
tracks at once, just the current correction node, or the Sizing settings, as defined by the Keyframe 
Timeline mode discussed in the next section.

Ordinarily, the Keyframe Editor takes up the rightmost bottom third of the Color page. However, you 
can make it wider to have more room to work if you have a scene requiring complex keyframing.

To expand and collapse the Keyframe Editor:

	— Click the Expand/Collapse button at the top right corner of the Keyframe Editor. The Keyframe 
Editor widens or narrows accordingly.

To zoom into and out of the keyframe tracks:

	— Use the Zoom slider to zoom into or out of the Keyframe Editor.

	— Right-click any keyframe track and choose Maximum Zoom to zoom all the way in.

	— Right-click any keyframe track and choose Reset Zoom to fit the entire clip into the available width 
of the Keyframe Editor.

All/Color/Sizing
Perhaps the most important control for keyframing, the Keyframe Timeline mode, lets you switch 
the scope of what tracks get keyframed when you use the Start Dynamic or Add Static Keyframe 
commands, either from the keyboard or via the buttons of your control panel. This command 
alternates among three modes:

	— All: The default mode. Adds keyframes to every track in the Keyframe Editor, keyframing every 
parameter in every node all at once, including the Sizing settings. In this mode, an orange bar 
appears highlighting the topmost “master keyframe track.”

	— Color: Only adds keyframes to the node currently selected in the Node Editor. In this mode, a 
green bar appears highlighting the keyframe track corresponding to the node currently selected.
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	— Sizing: Only adds keyframes to the Sizing track, which is useful when you’re keyframing “pan 
and scan” style transforms. In this mode, a blue bar appears highlighting the Sizing track.

	— EXT MATTE: Only appears if there’s an external matte node in the node tree. Lets you keyframe 
external matte-specific parameters in the Key palette.

Even though All is the default setting, it may be to your advantage to switch to the Color or Sizing 
keyframing modes to avoid creating a lot of unnecessary keyframes. Even though keyframing 
everything all at once is a fast way to work, the extra keyframes may slow you down when you later 
need to make adjustments to nodes that didn’t need to be keyframed in the first place.

To change the keyframing mode, do one of the following:

	— Choose an option from the Keyframe mode drop-down at the top right of the Keyframe Editor.

	— Choose an option from the Mark > Keyframe Timeline mode submenu.

TIP:  This control has one other function. Choosing a mode also affects what is copied when 
you use the various grade management tools in DaVinci Resolve. For example, if you choose 
Color, then you can copy a clip’s color grade without copying its sizing. If you choose Sizing, 
then you can copy the sizing without copying the color grade. For more information, see 
“Copying Grades” in Chapter 138, “Grade Management.”

Keyframing Methods
There are two different types of keyframes used by DaVinci Resolve to create automated changes. 
Each type of keyframe interpolates parameters differently.

Dynamic Keyframes (Dynamics)
Dynamic keyframes are the most conventional type of keyframe you’ll use, and are the type of 
keyframe used for creating animated changes from one state to another. For example, if you need 
a grade to become brighter over time to compensate for a change in lighting conditions, you’ll use 
Dynamic keyframes.

Nearly every parameter and control in the Color page can be keyframed, but it’s important to 
understand that the Interface controls do not animate to match whatever dynamically keyframed 
changes are taking place. Instead, visible Interface controls that correspond to keyframed changes will 
jump from their initial position at one keyframe to their final position when the playhead reaches the 
next keyframe. 

This can be most confusing with Curves, which can be interpolated using Dynamic keyframes just like 
any other control or parameter. Just keep in mind that the actual settings are animating, even though 
the controls are not.
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To animate a node using Dynamic keyframes:

1	 Move the playhead in the Keyframe Editor’s Timeline ruler to the frame where you want to 
begin a change.

2	 Do one of the following to place a Dynamic keyframe at that frame:

	— Choose Mark > Add Keyframe (Command-[).

	— Turn on the Auto Keyframe button for the track you want to animate in the Keyframe Editor.

Dynamic keyframes are diamond-shaped.

3	 If necessary, adjust your clip at this first position of your animated change. If you’re using 
Auto Keyframe, then you have to make an adjustment for a keyframe to be created.

4	 Now, move the playhead to the frame that is at the second position of the animated change 
you’re making, and create another Dynamic keyframe if you’re creating keyframes manually, or 
make another adjustment if Auto Keyframe is on.

5	 After you’ve created this second keyframe, make whatever adjustments are necessary to the clip 
to create the final look you need.

At this point, playing from the first keyframe to the second keyframe should show a smoothly 
animated change from the first adjustment to the second. When you’re finished, make sure you 
turn Auto Keyframe off if it was enabled.

Static Keyframes (Marks)
Static keyframes, or marks, are keyframes that are used to create abrupt, one frame changes from 
one state to another. They’re typically used to mark edit points separating one shot from another 
when multiple shots appear within a single clip. However, Static keyframes are also useful in any 
situation where you need a sudden change from one setting to another, such as when creating a 
lightning effect.

Static keyframes are round.

To automate a node using Static keyframes:

1	 Find the frame at which you want the abrupt change to take place, and place a keyframe at that 
frame by doing one of the following:

	— Choose Mark > Make Static Keyframe (Command-]).

	— Static keyframes (marks) are round.

2	 Move the playhead to any frame before the keyframe to make changes to the entire segment 
of the clip leading up to the keyframe, or move the playhead to any frame after the keyframe to 
make changes to the entire segment of the clip appearing after the keyframe. The playhead does 
not need to be on top of the keyframe, but if it is, you’ll be adjusting the second portion of the clip.
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NOTE:  If you’re using Static keyframes to automate grading changes between multiple 
shots appearing within a single clip, keep in mind that you can’t add nodes from one 
keyframe to the next as you would if you had split the clip in the Edit page.

Mixing and Converting 
Dynamic and Static Keyframes
Typically, if you’re creating multiple animated changes within a clip, you’ll want to use all Dynamic 
keyframes. Similarly, if you’re creating a series of abrupt changes, you’ll use all Static keyframes. 
However, you can mix Dynamic and Static keyframes together, so long as you keep in mind the 
following rules:

	— If you add a Dynamic keyframe to the right of a Static keyframe: There will be no 
interpolation from the Static keyframe to the Dynamic keyframe. However, if you add a Static 
keyframe to the right of a Dynamic keyframe, there will be interpolation.

No dynamic interpolation following the static keyframe

If you accidentally create the wrong kind of keyframe, it’s easy to convert it into the type of 
keyframe you need.

To change one kind of keyframe into another:

1	 Click the keyframe you want to convert to select it.

2	 Right-click the selected keyframe, and choose either Change to Dynamic Keyframe or Change to 
Static Keyframe.

Try Creating Keyframed Changes in a Separate Node
One tip to keep in mind is that you don’t have to create keyframed changes within the same 
nodes you’re using to create other adjustments. If you want to create some automated 
changes without altering the nodes you’ve already adjusted, you can simply create a new 
node in which to make your keyframed changes. That way, if you don’t like the result, or you 
somehow find yourself hopelessly tangled up in a needlessly complicated set of keyframes, 
it’s easy to reset either just the keyframes or the entire node without affecting the rest of 
your grade.
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Keyframed Nodes Have a Badge
Nodes with keyframed parameters display a keyframe badge in the Node Editor, to make them easy 
to find. Note that keyframe badges won’t appear when you simply add a keyframe but only once 
there’s an actual keyframed adjustment being made.

Keyframed nodes display a 
badge in the Node Editor.

Using Specific Keyframing Tracks
If you’re simply using the Color mode of the All/Color/Sizing command to do keyframing, then you’ll 
be adding keyframes to every parameter of the currently selected node whenever you apply a single 
keyframe. However, often that’s overkill in situations where you only need to keyframe a single setting 
or group of settings.

For example, you may find that you need to keyframe a color adjustment in order to change the color 
temperature and brightness when the camera pans across a window, but you don’t want to keyframe 
the Windows palette controls because you want to adjust them independently. This can be done by 
opening a Corrector track to expose the keyframing tracks within.

Individual keyframing tracks within a Color Corrector node

Keyframing tracks let you keyframe different sets of similarly functioning parameters separately from 
one another. For example, there’s one keyframing track for all the color adjustment parameters, and 
another keyframing track governing the parameters found within the Qualifier palette.

To reveal a node’s keyframing tracks:

	— Click the disclosure triangle next to the number of the node you’re keyframing.
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To keyframe an individual keyframing track manually:

1	 Make whatever adjustments you need to the currently selected node, and click its disclosure 
triangle to reveal its keyframing tracks.

2	 Move the playhead in the Keyframe Editor to where you want to add the first keyframe, then right-
click within the keyframing track you want to animate, and choose Add Static Keyframe or Add 
Dynamic Keyframe (this example shows a Dynamic keyframe).

A keyframe appears at the position of the playhead in that keyframing track.

3	 Move the playhead in the Keyframe Editor to where you want to add the next keyframe, then 
right-click within the keyframing track and again choose either Add Static Keyframe or Add 
Dynamic Keyframe (this example shows a Dynamic keyframe).

Keyframing just the Circular Power Window using its individual keyframe track

Now, you can make whatever changes you need to the controls governed by the keyframing track 
you keyframed, in order to create the necessary animated effect.

TIP:  You can also animate individual keyframing tracks using automatic keyframing, 
explained in more detail later in this chapter.

Corrector Keyframing Tracks
All of the parameters governing the adjustment of color and contrast controls, as well as various effects, 
Power Windows, and other adjustments are sorted into various sub-tracks within the Corrector track.

	— Linear Win: Controls parameters corresponding to the Linear window.

	— Circ Win: Controls parameters corresponding to the Circular window.

	— Polygon Win: Controls parameters corresponding to the Polygon window.

	— PowerCurve: Controls parameters corresponding to the PowerCurve window.

	— Gradient Win: Controls parameters corresponding to the Gradient window.

	— Color Corrector: Controls all parameters found in the Camera Raw, Color Wheels, 
Primary Controls, RGB Mixer, and Curves palettes.

	— Qualifier: Controls all parameters in the Qualifier palette.

	— Defocus: Controls all parameters in the Blur and Key palettes.

	— NR: Controls the Spatial and Temporal Noise Reduction and Motion Blur parameters 
found in the Motion Effects palette. 

	— Open FX: Controls all parameters of whichever OFX plugin is applied to the current node.

	— Node Format: Controls all parameters of the node sizing mode of the Sizing palette for 
the current node.
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ResolveFX Keyframe Tracks
The Color Page Keyframe Editor supports viewing and editing keyframes for ResolveFX and OpenFX 
plugins in the Color page in one of two ways:

	— Plugins that have been added to a Corrector node appear within the hierarchical list of keyframe 
tracks that appear within that node’s top-level keyframe track. 

The keyframe track of a Resolve FX plugin added to a Corrector node

	— Plugins that have been added as standalone nodes appear within a new FX track of the Keyframe 
Editor. Each plugin that’s added as a separate node has a separate FX track.

The keyframe track of a Resolve FX plugin added as a standalone node

The Sizing Keyframing Tracks
The Sizing keyframing tracks govern sizing transforms and stereoscopic adjustments separately from 
the color controls.

	— Input Sizing: Controls the Input Sizing parameters found within the Sizing palette. 

	— Convergence: Controls the Convergence parameter in the Stereo 3D palette.

	— Float Window: Controls the Left, Right, Top, and Bottom Position/Rotate/Softness Floating 
Windows parameters.

	— Auto Align: Controls the Pitch and Yaw parameters in the Stereo 3D palette.

TIP:  Output Sizing can only be keyframed when you choose Timeline mode in the 
Node Editor.
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The Ext Matte Node’s Freeform Isolation Track
If your node tree has an External Matte, the EXT MATTE node exposes a Freeform Isolation track in the 
Keyframe Editor. This is useful for time offsets or Sizing repositioning of the Ext Matte image.

Automatic Keyframing
Every track in the Keyframe Editor has an Auto-Keyframing button that can be turned on or off. When 
auto-keyframing is enabled for a particular track, every change made to a parameter or control 
associated with that keyframe track automatically generates a keyframe. There are two ways you 
can use this:

	— Used with a keyframing track, auto-keyframing makes it simple to set up animated changes to 
specific adjustments within a node. This is a lot easier than manually placing keyframes one by one.

	— On the other hand, turning on auto-keyframing for the Corrector track correspondingly enables 
auto-keyframing for every keyframing track belonging to that node. In this case, keyframes 
will automatically be placed on whatever keyframing track corresponds to the parameters or 
controls you adjust.

Auto-keyframing selected for 
Circular window on Node 1

When auto-keyframing is disabled, changes you make alter existing keyframes. How this alteration 
works depends on the location of the playhead, and the type of keyframes in the Keyframe Editor. For 
more information, see the next section.

Modifying Keyframes
Once you’ve started adding keyframes to animate changes to a grade, there are a variety of methods 
available to navigate and edit these keyframes to further customize these effects. This section covers 
the different ways you can navigate among, alter, and remove keyframes.

Navigating Among Keyframes
For many operations, it’s necessary to move the playhead directly on top of the keyframe you want to 
modify. While you can always use the transport controls or pointer to move the playhead, there are 
also commands for jumping to a specific keyframe.
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To move the playhead among a series of keyframes:

	— Choose Playback > Next > Keyframe (the right bracket key) or Playback > Previous > Keyframe (the 
left bracket key).

Moving Keyframes
If you need to change the timing of a series of keyframes, you can move the position of any keyframe, 
along with whatever values that keyframe contains.

To move a single keyframe using the onscreen interface:

	— Use the pointer to drag any keyframe to another location.

	— Drag keyframes in a top-level Corrector or Sizing track to simultaneously move all other keyframes 
on the same frame within that corrector.

To move multiple keyframes at the same time:

1	 If necessary, open the keyframe track with the keyframes you want to move.

2	 Drag a bounding box around the keyframes you want to move. Selected keyframes appear 
highlighted in red.

3	 Drag any of the selected keyframes to move them to the left or right.

Changing Keyframe Values
Unlike many other applications, DaVinci Resolve lets you alter keyframe values when the playhead isn’t 
directly on an existing keyframe. How this works depends on the location of the playhead relative to 
the keyframes that are in the Keyframe Editor, and what kind of keyframes you’re editing.

	— If the playhead is to the left or on the first Dynamic keyframe: The Dynamic keyframe at or to 
the right of the playhead updates with the new adjusted values.

	— If the playhead is to the left or on the last Dynamic keyframe: The Dynamic keyframe at or to 
the left of the playhead updates with the new adjusted values.

	— If the playhead is between two Dynamic keyframes: The Dynamic keyframe to the left 
of the playhead updates with the new adjusted values, but the Dynamic keyframe to the 
right is unaffected.

	— If the playhead is between two Static keyframes (marks): Adjustments made between two 
Static keyframes always affect the keyframe to the left of the playhead. The entire segment of the 
clip between that keyframe and the next is affected equally.

Changing Dynamic Attributes
By default, the transition from one Dynamic keyframe to the next is linear. However, if you need to 
alter the acceleration of value interpolation from one Dynamic keyframe to the next, then you can 
change that keyframe’s dynamic attributes.

To change a keyframe’s dynamic attributes:

1	 Click to select a keyframe in the Keyframe Editor.

2	 Right-click the selected keyframe, and choose Change Dynamic Attributes.
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3	 When the Dynamic Attributes window appears, do one or both of the following:

	— Choose a new outgoing acceleration curve using the Start slider, affecting the interpolation 
occurring to the right of that keyframe.

	— Choose a new incoming acceleration curve using the End slider, affecting the interpolation 
occurring to the left of that keyframe.

As you choose different acceleration curves, the display to the right shows the resulting 
curve graph.

Changing the dissolve profile

4	 When you’re happy with the curve, click OK.

By using different Start and End values, you can make animated adjustments “ease in” or “ease out” of 
a particular keyframe, to create a more gradual or abrupt transition.

TIP:  The default dynamic profile start and end of each new keyframe can be set via the 
Dynamics Profile values in the General Options panel of the Project Settings.

Deleting Keyframes
You have the option to delete individual keyframes, or to delete all the keyframes within a particular 
grade at once.

To delete individual keyframes, do one of the following:

	— Move the playhead on top of the keyframe you want to delete, then choose Mark > Delete 
Keyframe (Option-]). Every keyframe at the position of the playhead is deleted.

	— Using the pointer, click a keyframe in the Keyframe Editor to select it, then right-click that 
keyframe and choose Delete Selected Keyframe. Only the selected keyframe is deleted.

3187Color  |  Chapter 145  Keyframing in the Color Page



To delete every keyframe for the current clip:

	— Choose Mark > Delete All Keyframes.

Copying Keyframes
It’s possible to copy a set of keyframes from one node to another, either within the current grade, or in 
another clip entirely. It’s also possible to copy an entire grade with keyframes from one clip to another.

To copy a set of keyframes from one node to another:

1	 Select a node to copy keyframes from, and choose Edit > Copy (Command-C).

2	 Do one of the following:

	— To copy all keyframes, select another node to paste keyframes and other adjustments to, and 
choose Edit > Paste (Command-V).

	— If you want to just copy only the keyframe information from a specific keyframe track, choose 
Edit > Paste Attributes (Option-V), then click the “Copy Keyframes and Align Using” checkbox, 
and select the appropriate parameters to copy.

TIP:  This procedure also works for tracking data that you want to copy from one node 
to another, either in the current clip, or another clip altogether.

To copy an entire grade with keyframes from one clip to another:

1	 Click the thumbnail of the clip you want to copy to in the Thumbnail timeline.

2	 Right-click the thumbnail of the clip you want to copy from, and choose Apply Grade from the 
contextual menu.

NOTE:  When copying a grade with keyframes from one clip to another, the keyframes 
will automatically be placed at matching frames that correspond to the source timecode 
of the originating clip. This makes it easy to copy a grade with keyframes to the same 
clip elsewhere in the Timeline, but it may not provide the desired results if you’re 
applying a grade with keyframes from one clip to a completely different one.

Keyframes and Saved Stills
If you save a still from a clip using keyframes within the grade, by default keyframes are not saved. 
However, the still and grade that are saved reflect whatever parameter values are contained by the 
next keyframe to the left of the position of the playhead. For example, if a clip has a dynamically 
keyframed transition from a saturation of 50 to a saturation of 0, and you place the playhead right 
in the middle of both keyframes when you save a still, the grade and still that are saved have a 
saturation of 50.
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However, if you right-click the background of the Gallery, choose one of the options within the “Apply 
Grades Using” submenu, and choose the appropriate “Keyframes Aligning…” options, then grades 
saved within a still are saved with the keyframes, which reference the source timecode, or start frame 
of the original clips. This means that if you apply a saved grade with keyframes to a clip, the keyframes 
will automatically be placed at matching frames that correspond to the source timecode or start frame 
of the original clip. This makes it easy to copy a grade with keyframes to the same clip elsewhere in the 
Timeline, but it may not provide the desired results if you’re applying a grade with keyframes from one 
clip to a completely different one.

Adding EDL Marks
Just as clip grades are separate from the timeline grade that can be applied to the entire Timeline, so 
clip keyframes are separate from timeline keyframes. Keyframes you apply to the timeline grade work 
exactly the same as clip keyframes. However, there is one extra option you have when keyframing the 
timeline grade.

If you find yourself wanting to adjust a timeline grade individually to take into account variations from 
one clip to the next, you can use the Add EDL Marks on Tracks command to add a Static keyframe 
(mark) to the Keyframe Editor at the position of every edit point in the entire Timeline.

To add EDL marks:

1	 Choose Timeline from the Node Editor’s mode drop-down menu.

2	 If you want to keyframe a grade, then create whatever grade you need to apply to the entire 
Timeline. If you want to keyframe Sizing settings, you don’t need to do anything else.

3	 Right-click the Corrector track or the Sizing track in the Keyframe Editor, and choose Add EDL 
Marks on Tracks.

Marks appear at the frame of every edit point in the Timeline. You may want to widen the 
Keyframe Editor to make it easier to work with all these keyframes.

After you’ve added EDL marks, you can delete them if you decide you don’t want them any more.

To delete EDL marks:

	— Right-click the Corrector track in the Keyframe Editor, and choose Delete EDL Marks on Tracks.

If you’ve added your own keyframes in addition to the EDL marks, then the Delete EDL Marks on 
Tracks command only eliminates the EDL marks. Your custom marks are left alone.
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Chapter 146

Copying and 
Importing Grades 
Using ColorTrace
ColorTrace is a key feature of DaVinci Resolve, which lets you 
copy grades quickly and easily from the clips of one timeline to 
those within another, based on the source timecode of each clip 
(or using clip names when in Automatic mode). 

You can even use ColorTrace to copy grades between timelines within the same project, 
and ColorTrace one stereo timeline to another.

Contents
Copying Grades Using ColorTrace�   3191

Using ColorTrace in Automatic Mode�   3192

Using ColorTrace in Manual Mode�   3195

Importing CDL Data Using ColorTrace�   3198

Using CDL Adjustments�   3199

Calculating CDL Functions�   3199

3190Color  |  Chapter 146  Copying and Importing GradesUsing ColorTrace



Copying Grades Using ColorTrace
ColorTrace copies whichever version of a clip’s grade was applied in the Source timeline you’re copying 
from, either local or remote, depending on which grades each clip in the Source timeline is set to 
use. Furthermore, ColorTrace copies Group Pre-Clip and Group Post-Clip grades, as well as Fusion 
compositions. These improvements make this an extremely reliable tool for copying grades from one 
timeline to another in a wide variety of situations.

To use ColorTrace:

1	 Open the Edit page and select the Timeline you want to use ColorTrace with from the Media Pool, 
then open it and choose Timelines > ColorTrace > ColorTrace From Timeline.

Choosing ColorTrace for a selected Timeline

The ColorTrace Setup window appears, which shows every project library, user, project, and 
timeline within a single hierarchical list.

2	 Using the Project List browser, select the specific Timeline you want to copy grades from.

You’ll need to click the disclosure triangle to the left of the project library, user name, and project 
that contains that Timeline in order to select it.

ColorTrace project and Timeline selection window
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3	 (Optional) If you’re using ColorTrace with a project that has numerous VFX clips in a workflow 
where all VFX clips have specific reel names that identify them, you can enter these names 
(with asterisks (*) used as wildcards that indicate text in each reel name that can vary) in the 
“Effects Shot Definitions” field. 

This speeds automatic ColorTrace operations by enabling DaVinci Resolve to use fuzzy 
string matching when a clip’s reel number qualifies it as a VFX shot so that the best match is 
displayed first on the list. You can enter multiple VFX reel names with wildcards, one per line, 
for simultaneous string matching. You can use whatever reel name text makes sense for your 
workflow, some examples of VFX reel names are as follows:

*_COMP_*

VFX*

EFFECTS*

4	 Click Continue.

The ColorTrace window appears with two tabs that let you choose how to work.

5	 Choose which mode to work in by clicking the Automatic or Manual tab:

	— In Automatic mode, ColorTrace automatically searches for matching clips between the 
selected Timeline and the current Timeline. Each clip is color coded depending on the 
correspondence that’s been identified.

	— In Manual mode, you copy grades yourself, using the Copy and Paste procedures, or by 
dragging and dropping using your mouse.

The ColorTrace window is complex; details about the operation of each mode are covered 
separately in the following sections.

6	 When you’re finished using ColorTrace, click Close.

Using ColorTrace in Automatic Mode
In Automatic mode, ColorTrace automatically finds the correspondences between clips in the selected 
Timeline that you want to copy grades from (the Source timeline), and those in the current Timeline 
that you want to copy grades to (the Target timeline).

Selecting the Automatic or Manual ColorTrace 

Each clip in the Target Timeline Thumbnail timeline is outlined with a color that indicates its status.

	— Red: No match was found at all. Generally true for clips in the current Timeline that weren’t used 
in the Timeline you’re ColorTrace matching to.

	— Blue: Due to overlapping timecode and reel names, multiple correspondences have been found 
(similar to a reel conflict), and you must select the correct one for each clip. This often happens 
with VFX and motion graphics clips that you’ve imported with timecode starting at 00:00:00:00.

	— Green: A match has been found. 
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ColorTrace Thumbnail outlines indicate matching, 
overlapping, and non matching clips.

In Automatic mode the correspondence between each clip in the Source timeline and each clip in 
the Target timeline should be automatically made. However, overlapping timecode and reel names 
can cause problems. The other controls in the ColorTrace window help you deal with the subset of 
clips that can’t be automatically matched, or are matched in error. These controls are:

The ColorTrace window shown in Automatic mode

	— Matching Source Clips list: Shows a scrollable collection of thumbnails that might correspond to 
the selected clip in the Target timeline.

	— Target Timeline: Shows each clip in the Timeline you want to copy grades to, color coded 
according to how good a match it is.

	— Clip Info pane: Displays two columns of properties for the source clip and the target clips that 
you’ve selected. These properties include the reel, source timecode, record timecode, clip name, 
project names, and timeline names of each clip, for easy comparison.

	— Attributes and options checkboxes: A series of checkboxes lets you specify which clip attributes 
are copied as part of the ColorTrace operation.

	— Color: Enables the copying of grades.

	— Preserve Num Nodes: When copying grades, lets you prevent the first X nodes of the target 
clip grades from being overwritten by the first X nodes of the source clip grades.

	— Input Sizing: Enables the copying of Input Sizing attributes.

	— Convergence: Enables the copying of Convergence for Stereo 3D projects.

	— Floating Windows: Enables the copying of Floating Windows for Stereo 3D projects.

	— Auto Align: Enables the copying of Auto Align settings for Stereo 3D projects.

	— All Versions: Copies all versions, rather than just the current version, from the source to the 
target clips. The currently selected version of each source clip is always correctly copied.

	— Version Camera Raw Settings: Enables the copying of versioned Raw settings, rather than 
just the current Raw setting.

	— Track Marks: Enables the copying of keyframes.
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	— Flags and Markers: Enables copying of all flags and markers.

	— Hide Matching Clips: Hides all clips which have been successfully matched, and only show 
the clips with multiple or no matches. This lets you focus on the subset of problem clips within 
a potentially long timeline.

	— Ignore Reel Names: If you believe the reel names are in error, you can turn this checkbox on 
to ignore them, matching all source and target clips by timecode alone.

	— Copy Grades: Copies the matched source grades to each green and purple target clip.

	— Copy Grades & Exit: Once you’ve finished making all the grade matches you can, click this 
button to copy the matched source grades to each green and purple target clip, and close the 
ColorTrace window.

Here’s how to use these controls to sort out which source clips to copy from for each blue and red 
target clip in the Target timeline.

To manually choose which source grades should be copied to which target clips:

1	 Click any blue clip thumbnail in the Target timeline.

Revealing a number of different possible correspondences in the Matching Source Clips Timeline

A collection of clips with overlapping timecode and reel names appears. If you want to ignore the 
reel names because you believe they might be in error, turn on the Ignore Reel Names checkbox.

2	 If a comparison of the Source and Target thumbnails doesn’t make the choice obvious, then click 
any of the clips in the Matching Source Clips timeline to view its metadata for comparison in the 
source/target columns below.

Source and Target clip metadata for comparison
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3	 Once you’ve decided on a clip correspondence, double-click the Matching Source Clip thumbnail 
you want to copy from. If no clip in the Matching Source Clip pane is a good match, double-click 
the “Set As New Shot” box.

The Source and Target thumbnails both turn purple, to show that you’ve 
created a correspondence.

The matching Source and Target clips now both marked with purple outline

Continue working your way through every thumbnail with Blue and Red Xs until you’ve found 
matches for every clip in the Timeline for which it’s possible.

4	 When you’re finished, click Copy Grades & Exit.

Using ColorTrace in Manual Mode
Manual mode is ideal for situations where you want to copy grades between programs with clips that 
have no timecode or reel name correspondence at all. The Manual ColorTrace interface is designed to 
let you move through two different timelines, either a clip at a time, or in matching multiples of clips, 
copying grades from the Source timeline to the Target timeline.

For example, if you’re trying to copy grades from a timeline that was conformed from individual media 
files, to another timeline that was conformed from a flattened master media file, you can use the 
ColorTrace Manual mode to accomplish this.

The manual interface consists of two sets of controls that correspond to the Source timeline (labeled 
“Timeline to copy from”), and the Target timeline (labeled “Timeline to paste to”). The general idea is 
that you move through both sets of timelines one clip at a time, or in matching multiples of clips at a 
time, and copy grades from the “Copy from” timeline to the “Paste to” timeline.
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ColorTrace Manual window

Manual mode has the following controls:

	— Source timeline: Shows all clips in the Source timeline you selected; the clips you’re copying 
grades from. Click any one clip thumbnail to select it, or click a thumbnail, and then Shift-click 
another thumbnail to select a contiguous range of clips. You cannot select a noncontiguous range 
of clips.

	— Copy Range controls: Two fields show the range of clips in the current selection that you’ll be 
copying from, referred to by their numeric position in the Source timeline. You can change the 
range numerically by either entering new numbers in the fields, or by using the up/down arrow 
buttons to alter the value by one. The First button automatically adds all clips from the first one in 
the Timeline into the current selection. The Last button automatically adds every clip going to the 
last one in the Timeline to the current selection.

	— Target timeline: Shows all clips in the Target timeline you selected; the clips you’re pasting 
grades to. Selecting clips works identically as with the Source timeline.

	— Paste Range controls: Two fields show the range of clips in the current selection that you’ll be 
pasting to, referred to by their numeric position in the Source timeline. All controls work identically 
to the Copy Range controls.

	— Attributes and options checkboxes: Turn off the checkboxes of any clip characteristics that 
you don’t want to copy as part of the ColorTrace operation. A more complete description of these 
options appears in the section on the Automatic ColorTrace mode.

	— Paste button: Once you’ve selected one or more source clips and a matching number of target 
clips, clicking Paste copies the grades, PTZR settings, and marks (depending on the corresponding 
checkboxes).

	— Undo Last: Lets you undo the most recent paste action.

	— Undo All: Lets you undo all paste actions in Manual mode.

	— Done: Finishes the operation and closes the ColorTrace window.

If you’re cherry picking individual grades from one timeline to paste into shots in another, you can 
copy grades one at a time.
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To copy one source grade to one target clip:

	— Click a thumbnail in the Source timeline (on top) to copy from, then click a thumbnail in the Target 
timeline (on the bottom), and click Paste.

You can also simultaneously copy the grades of entire scenes of clips from one timeline to another. 
For example, if you’re copying grades from an originally graded timeline to a re-edited version of the 
same program, you can copy every grade from a 10-clip scene in the Source timeline to the same 10 
clips in the Target timeline which have been pushed back later in the Timeline.

To copy a group of source grades to a group of target clips:

1	 Choose a continuous range of source clips by doing one of the following:

	— Click the first clip in the range, and then Shift-click the last clip in the range.

	— Enter the clip number of the first clip in the left “Copy Range” field, and then enter the clip 
number of the last clip in the right field.

	— Click a clip, and then click First to select every clip from that one to the first clip in the Timeline.

	— Click a clip, and then click Last to select every clip from that one to the last clip in the Timeline.

2	 Choose a continuous range of Target clips by using the same procedures as in the previous step, 
but using the “Paste Range” controls.

IMPORTANT:  You must select the same number of target clips as you did source clips 
for the Paste button to become enabled.

Group copy and paste of grades

3	 When you’ve made your selections, click Paste.

The grade settings from the source clips are pasted to the destination clips, in order. In other 
words, if you copy from clips 5 through 9 to clips 11 through 15, then grade 5 is copied to shot 11, 
grade 6 is copied to shot 12, grade 7 is copied to shot 13, and so on.
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Importing CDL Data 
Using ColorTrace
The ColorTrace CDL command lets you import ASC CDL file formats from other applications into 
DaVinci Resolve. DaVinci Resolve also has the ability to read DRX filenames from CDL files, allowing a 
CDL to load exported DaVinci Resolve grades.

There are three supported file formats:

	— CMX EDL: An EDL with comments referring to CCC/CDL XML files, or even Slope, Offset, and 
Power (SOP) data within the comment area.

	— CCC and CDL XML: A file format that contains various color correction looks, and 
even references.

To import CDL data into DaVinci Resolve:

1	 If you’re importing CCC/CDL XML correction looks:

	— Open the Gallery page, right-click anywhere within the Stills tab, and choose Import from the 
contextual menu. 

	— When the Import Stills dialog appears, open the CDL/CCC files. When these are finished 
importing into the Gallery, an ASC logo will appear along with them.

2	 Open the Edit page and select the Timeline you want to use ColorTrace with in the Timeline list.

3	 Right-click anywhere within the Timeline, and choose ColorTrace from CDL.

4	 Select an EDL using the Select EDL dialog, and click Open.

5	 Select its corresponding CDL and CCC files using the Select CDL Files dialog. If there are no 
CDL or CCC files (which is the case if there are inline SOP comments within the EDL), you should 
click Cancel.

6	 Using the ColorTrace With CDL window, copy the source grades from the CMX EDL/CCC & CDL XML 
files to the Target timeline.

At this point, the ColorTrace window works identically as previously described.

For formatting reference, here are some examples of CMX, CCC, and CDL files.

Example CMX EDL File

TITLE: Final EDL FCM: NON-DROP FRAME 010 001 V C 01:19:28:16 01:19:28:16 
01:00:41:18 01:00:42:18 *ASC_CC_XML test_cc.102 011 001 V C 00:00:00:00 
01:19:28:16 01:00:42:18 01:00:43:18 *ASC_SOP (0.9 1.2 0.5)(0.4 -0.5 0.6)(1.0 0.8 1.5)

Example CCC File

<ColorCorrectionCollection xmlns:”urn:ASC:CDL:v0.5” >

<InputDescription> test corrections for ref_input_image.1920

</InputDescription> <ViewingDescription>

for mathematical analysis only </ViewingDescription>

<ColorCorrection id=”test_cc.100”> <SOPNode>

<Description> for ref_output_image.0100 </Description> <Slope> 1.0 1.0 1.0 
</Slope> <Offset> 0.0 0.0 0.0 </Offset> <Power> 1.0 1.0 1.0 </Power>

</SOPNode> </ColorCorrection>
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<ColorCorrection id=”test_cc.101”> <SOPNode>

<Description> for ref_output_image.0101 </Description> <Slope> 1.0 1.5 0.6 
</Slope> <Offset> 0.0 -0.1 0.01 </Offset> <Power> 1.0 1.5 0.5 </Power>

</SOPNode> </ColorCorrection>

</ColorCorrectionCollection>

Example CDL File

<ColorDecisionList xmlns=<94>urn:ASC:CDL:v0.5<94> >

<InputDescription> GeneralProducts M1 std thru GP M1 LUT4 </
InputDescription> <ViewingDescription> GP P1, DCI P3, Pathe color emul </
ViewingDescription> <ColorDecision>

<MediaRef ref=<94>/some/Project/frame%250900-0954%5B.dpx<94>/> 
<ColorCorrection id=”cc03340”>

<SOPNode> <Description>change +1 red, contrast boost</Description> 
<Slope>1.2 1.3 1.4</Slope> <Offset>0.3 0.0 0.0</Offset> <Power>1.0 1.0 1.0</
Power>

</SOPNode> </ColorCorrection>

</ColorDecision> </ColorDecisionList>

Using CDL Adjustments
Once you’ve imported a CDL (Color Decision List), then the CDL adjustment for each clip is made 
available to you via a contextual menu command in the Thumbnail timeline of the Color page.

Calculating CDL Functions
To turn the SOP values into a primary correction, the following math is used by DaVinci Resolve:

Output = (Input * Slope + Offset)Power

Output refers to the final grade. Input is the value of each pixel within each color channel (on a 
scale from 0–1). The detent value for Slope is 1. The detent value for Offset is 0. The detent value for 
Power is 1.
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Chapter 147

Using LUTs
Lookup Tables, also known as LUTs, are one of the most ubiquitous 
means of creating, exchanging, and applying image processing 
operations there is for purposes of color management, display 
calibration, look management, and general-purpose processing of 
image color and contrast. DaVinci Resolve has robust support for 
LUTs throughout its image processing pipeline.
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What is a LUT?
LUTs are simply files, similar to plugins but far more focused and with no user interface, that specify 
image processing operations. These operations are accomplished in a variety of ways. The traditional 
approach is to use a 1D table or 3D “cube” of pre-calculated values to perform an image color 
transform. However, newer LUT formats including CLF and DCTL let you use mathematical scripts to 
process an image.

Whatever type of LUT you use, these files can be loaded into DaVinci Resolve and applied at different 
points of the image processing pipeline to apply image processing operations for different purposes. 
There are several well-known uses of LUTs, but the important thing you should take away is that LUTs 
are simply color transform operations that can be used for many things, and there’s no single use of a 
LUT that’s more or less important than any other.

Here are some frequent uses for LUTs:

	— While optionally superseded by Resolve Color Management (RCM), lookup tables (LUTs) have been 
frequently used to create a starting point adjustment for media acquired with some logarithmic 
encoding. DPX log film scans, digital media using the ARRI ALEXA’s Log-C encoding, Sony’s 
S-Log exposure setting, or RED R3D media that is debayered using the REDFilmLog setting are 
all examples of media using a logarithmic exposure curve, designed to protect as much detail in 
the highlights and shadows of a digitally encoded image as possible. While log-encoded media 
retains a lot of image data, the picture is initially flat and unsuitable for use without grading. 
The exposure and color must be adjusted to “normalize” the media, making it look closer to the 
way it’s supposed to, in order to start grading. While you can do this manually, it’s usually faster 
to use a LUT that’s tailored to your type of media and the exposures you’re using. Alternately, you 
can also use Resolve Color Management to accomplish this.

	— LUTs are commonly used in onset workflows where dailies for different scenes are managed with 
corresponding LUTs. These LUTs were used to monitor the media as it was being recorded to 
define a baseline reference for how each scene is meant to look, at least so far as field monitoring 
is concerned. In more advanced workflows, LUTs are used as a baseline look, defined prior to the 
shoot and used during the shoot, that then defines the creative starting point for different scenes 
once grading begins after the shoot.

	— LUTs are frequently used as a stylistic component of a grade, or “look” that gives users a quick 
start when desiring some manner of creative adjustment. Over the years, companies and 
individuals have created an ecosystem of such looks that are disseminated and sold in various LUT 
formats supported by DaVinci Resolve.

In all of these instances, LUTs are simply image processing adjustments that are applied to affect 
the color and contrast of a clip, in much the same way as you’d make adjustments using any of the 
contrast or color controls in the Color page. 
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Supported LUT Formats
DaVinci Resolve uses both 1D and 3D LUTs, and supports LUTs in a variety of formats.

	— .cube: DaVinci Resolve uses both 1D and 3D LUTs in the .cube format. 3D LUTs can be exported 
as 17x17x17, 33x33x33, or 65x65x65 cubes with 32-bit floating point processing. DaVinci Resolve 
can also read and use Shaper LUTs in the .cube format, but these must also be created outside 
of DaVinci Resolve. You should note that while 17-point LUTs are not recommended to use for 
grading, they are useful when exporting LUTs for on-set monitoring, to accommodate different 
display, calibration, and signal conversion devices.

	— Panasonic VLUT format: DaVinci Resolve can both read and generate this LUT format, designed 
for use in the Panasonic VariCam camera ecosystem.

	— Video Range LUTs: Beginning with DaVinci Resolve 17, support was added for importing LUTs that 
include additional metadata specifying them as processing image data in Video Range, rather than 
Full Range. More information about how to format LUTs as Video Range is included in the Developer 
Documentation available from the Help menu. Being able to specify whether a LUT is meant to be 
Video or Full Range allows LUT processing to automatically accommodate DaVinci Resolve’s data 
range setting pipeline for clip attributes, project settings, and output settings.

	— CLF (common LUT format): CLFs use an XML format that is capable of encompassing a limited 
number of mathematical transforms in addition to traditional lookup-tables to do image 
processing. Promoted by the academy as the ideal LUT format for use with ACES, LMTs for ACES 
are recommended to be in the CLF format due to its increased precision and flexibility.

	— DCTL: DCTL files are actually color transformation scripts that DaVinci Resolve sees and applies 
just like any other LUT. Unlike other LUTs, which are 1D or 3D lookup tables of values that 
approximate image transformations using interpolation, DCTL files are actually comprised of 
computer code that directly transforms images using combinations of math functions that you 
devise. Additionally, DCTL files run natively on the GPU of your workstation, so they can be fast. 
For more information on DCTL, see Chapter 197, “Creating DCTL LUTs.”

What’s the Difference Between a LUT and a Shaper LUT?
DaVinci Resolve is capable of importing and using LUTs within its 32-bit floating point image 
processing pipeline. The .cube format can be used as either a simple 33x33x33 3D LUT, 
or as a shaper LUT, which is actually a method of using two LUTs, a 1D LUT and a 3D LUT 
together, that addresses signal processing issues that 3D LUTs alone can’t handle.

For processor efficiency, 3D LUTs are designed with reasonable lower and upper limits for 
the data they will handle. It’s well known that when a 3D LUT is fed values that are outside 
of the range that LUT is designed to handle, the out-of-range data will be clipped. Since 
many LUTs are designed with digital cinema workflows in mind, the practical result is that 
feeding a video signal with super-white in it to a 3D LUT that’s designed for full-range data 
(0–1) will clip the super-white part of the signal.

Shaper LUTs handle this issue by first using a 1D LUT to process video signals with out-of-
range data, fitting the signal into a range that the 3D LUT won’t clamp. The output of the 
3D LUT includes the reverse transformation, to effectively zero out the 1D LUTs transform, 
while retaining whatever processing the 3D LUT was meant to apply.
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Shaper LUTs are also useful for dealing with extremely large data sets, such as OpenEXR 
files that can theoretically handle an image data range of –infinity to +infinity. Using a 
Shaper LUT, you can remap the incoming data to fit more precision in the 0–1 range, leaving 
less important data outside the range.

LUTs and ACES
The academy that promotes the correct use of ACES strongly recommends that LUTs be processed in 
the ACES color space. For this reason, two project settings let you choose how this will be done:

	— ACEScc AP1 Timeline Space: This setting works for either the ACEScc or ACEScct Color Science 
settings depending on what you’ve selected in the Color Science pop-up at the top of the Color 
Management panel in the Project Settings. This setting lets you use LUTs that were created for ACES 
workflows that are similar to (but not the same as) LUTs you would create and use in a traditional 
log-encoded workflow. LUTs designed for working with this setting should have a range of –0.358 to 
1.468 so that grading operations that clip an image from 0 to 1 won’t destroy the look being applied. 

The “ACEScc AP1 Timeline Space” setting is also good for workflows where you want to use 
conventional LUTs that were designed for Rec. 709 workflows using the ResolveFX “ACES 
Transform” plugin, which over a series of three nodes lets you transform the image from ACES to 
709, apply a Rec. 709-designed LUT, and then convert the image from 709 back to ACES.

	— ACES AP0 Linear: This setting requires you to apply an LMT LUT that has been specifically created 
for ACES image data. Only use this setting if you’re using CLFs that are designed for ACES using a 
range of –65504 to 65504, as specified by SMPTE 2065.

Adding Lookup Tables of Your Own
The menus in the Color Management panel of the Project settings include a series of factory preset 
LUTs that were installed with DaVinci Resolve, along with any LUTs that have been generated by 
DaVinci Resolve, or that you’ve imported into the proper directory for your operating system for 
your own use. 

By default, LUTs are saved to the following locations:

	— On OS X: Library/Application Support/Blackmagic Design/DaVinci Resolve/LUT/

	— On Windows: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\LUT

	— On Linux: /home/resolve/LUT

Custom LUT Paths
A list in the General panel of the DaVinci Resolve System Preferences lets you add multiple file paths 
for loading LUTs that you want to use in DaVinci Resolve. This works for network volumes for facilities 
where multiple workstations are accessing a central collection of LUTs to be shared among multiple 
artists. Clicking the Add button lets you add a file path to this table from a dialog. Selecting a location 
in this list and clicking Remove removes that location.
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A list in the General panel of the System Preferences lets you add multiple locations 
where LUTs you want to use from within DaVinci Resolve are located.

LUT Paths for the macOS App Store 
Version of DaVinci Resolve
If you downloaded the non-studio version of DaVinci Resolve from the Apple App Store, LUTs are 
saved in a different location in order for DaVinci Resolve to remain totally self-contained. In this case, 
you can click the Open LUT Folder button in the Lookup Tables panel of the Project Settings, to open 
up a Finder window at the location these LUTs are stored. You can use this window to copy LUTs that 
you want DaVinci Resolve to have access to, or delete LUTs that you no longer need.

If you add a LUT to one of these directories after DaVinci Resolve has been opened, you can click the 
Update Lists button to refresh the contents of the pop-up menus. 

LUT Controls in the Project Settings
While there’s an entire group of LUT controls in the Color Management panel of the Project Settings, 
those are designed to apply LUTs, at different parts of the image processing pipeline, to the entire 
Timeline. This is useful when you want to apply a single color and contrast transformation to the 
entire program at once, but less so if you want to apply different LUTs on a per clip basis. For more 
information on using the Lookup Table settings, see Chapter 4, “System and User Preferences.”

Applying LUTs to Source Clips
Another way of applying a LUT to a clip is to apply it directly to the source clip, which you can do to 
any clip in the Media Pool, or in the Thumbnail Timeline of the Color page. This can be convenient, but 
keep in mind that source clip LUTs cannot be copied from one timeline to another using ColorTrace, 
so using source clip LUTs limits your potential workflows. For most workflows, it’s better to apply LUTs 
directly in the Node Editor so they live in each clip’s grade.

To apply a LUT to one or more selected clips in the Media Pool:

	— Right-click one of the selected clips, and choose a LUT from the 1D LUT or 3D LUT submenus.
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To apply a LUT to one or more selected clips in the Thumbnail Timeline of the Color page:

	— Right-click one of the selected thumbnails, and choose a LUT from the 1D LUT or 
3D LUT submenus.

TIP:  If you’re wanting to apply an image transformation to normalize log-encoded source 
clips, you may also consider using Resolve Color Management (RCM). Depending on your 
source media, it may be an easier and more automated process. For more information, 
see Chapter 8, “Data Levels, Color Management, and ACES.”

Using the Color Page LUT Browser
The LUT Browser on the Color page provides a centralized area for browsing and previewing all of the 
LUTs installed on your workstation. All LUTs appear in the sidebar, by category.

By default, all LUTs appear with a test thumbnail that give a preview of that LUT’s effect, but you can 
also get a live preview of how the current clip looks with that LUT by hover scrubbing with the pointer 
over a particular LUT’s thumbnail (this is described in more detail below).

The LUT Browser

To open the LUT Browser:

	— Click the LUT Browser button in the UI Toolbar at the top of the Color page.

Methods of working with the LUT Browser:

	— To see the LUTs in any category: Click on a LUT category to select it in the sidebar, and its 
LUTs will appear in the browser area.

	— To make a LUT a favorite: Hover the mouse over a LUT and click the star badge that appears at 
the upper right-hand corner, or right-click any LUT and choose Add to Favorites. That LUT will then 
appear when you select the Favorites category in the Node Editor contextual menu for nodes.

	— To search or filter for specific LUTs: Open a bin that has the LUT you’re looking for, then click 
the magnifying glass icon to open the search field, and type text that will identify the LUTs 
you’re looking for.
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	— To see LUTs in Column or Thumbnail view: Click the Column or Thumbnail buttons at the top 
right of the LUT Browser to choose how to view LUTs in the browser area.

	— To sort LUTs in Thumbnail view: Click the Thumbnail Sort pop-up menu and choose which 
criteria you want to sort LUTs by. The options are filename, type, relative path, file path, usage, 
date modified. There are also options for ascending and descending sort modes.

	— To sort LUTs in Column view: Click the column header to sort by that column. Click a header 
repeatedly to toggle between ascending and descending modes.

	— To update the thumbnail of a LUT with an image from a clip: Choose a clip and frame that 
you want to use as the new thumbnail for a particular LUT, then right-click that LUT and choose 
Update Thumbnail With Timeline Frame.

	— To reset the thumbnail of a LUT to use the standard thumbnail: Right-click a LUT and choose 
Reset Thumbnail to go back to using the standard test image.

	— To refresh a LUT category with new LUTs that may have been installed: Select a LUT 
category, then right-click anywhere within the browser area and choose Refresh to refresh the 
contents of that category from disk.

Enabling and Disabling the LUT Viewer live preview:

1	 Open the LUT Viewer’s option menu and choose Live Preview. 

The Live Preview option for the LUT browser lets you hover 
over a LUT to preview it on the current clip in the Viewer

2	 Click a node in the Node Editor you want to preview applying a LUT to. The live preview will display 
how the current clip will appear with the LUT you select applied to the currently selected node of 
the current grade, which will affect the result.

3	 Move the pointer over the LUT you want to preview. 

The Viewer image updates to show how that clip would look with that LUT applied to the currently 
selected node.

To apply a LUT from the LUT Browser to a specific node, do one of the following:

	— Right-click a LUT and choose Apply LUT to current node. 

	— Drag a LUT from the LUT Browser and drop it onto the node you want to apply a LUT to. If you drag 
a LUT onto a node that already has a LUT, the previous LUT will be overwritten by the new one.

Applying a LUT Within a Node
DaVinci Resolve lets you apply LUTs within a grade by connecting a LUT to a particular node in the 
Node Editor. This gives you the greatest amount of control over where the LUT is applied in your 
image processing pipeline, and it also gives you the opportunity to apply image adjustments prior to 
the LUT, and after the LUT, as you require.
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To apply a LUT within a node, do one of the following:

	— Right-click any node, and choose a LUT from the 1D Input LUT, 1D Output LUT, 3D LUT, DCTL, or 
CLF (common LUT format) submenus of the LUT submenu. The LUT submenus list whichever LUTs 
have been installed on your workstation. For more information on installing LUTs, see Chapter 4, 
“System and User Preferences.”

	— Right-click any node, and choose a LUT from the LUT > Favorites submenu.

	— Use the LUT Browser to find a LUT you want to use, and then drag and drop that LUT onto the 
node you want to apply it to

TIP:  If you hold down the Option key while scrolling through the submenu of LUTs in a 
Corrector node’s contextual menu, you’ll get a live update in the Viewer of how each LUT 
affects the image.

To reveal a selected node’s LUT:

For any node in the Node Editor with a LUT applied to it, you can right-click that node and choose 
Reveal Selected LUT to automatically open the LUT viewer and select that LUT.

LUTs Are the Last Operation Within a Node
Each node in the Node Editor is capable of performing multiple operations, and these operations 
occur in a specific order. LUTs that you add to a node impose their transformation as the last 
operation within that node, after all other Color page adjustments applied by that node. 

Practically, this means that you can use a node’s Color and Contrast controls to trim the image data 
that will be fed into a LUT applied to that same node. For example, if a LUT’s contrast adjustment 
clips the highlights of the image too much, you can use that node’s Contrast controls to lower the 
highlights of the image prior to the LUT, restoring detail to the image.

Favorite LUTs Submenu in Node Editor
When you “star” a LUT as a favorite in the LUT Browser, those favorite LUTs appear in a submenu of 
the contextual menu that appears when you right-click on a node in the Node Editor. This makes it 
easy to create a short list of your go-to LUTs for various situations, for rapid application right in the 
Node Editor.

A Favorite LUTs submenu in the Node Editor contextual menu gives you a short list
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Missing LUTs
Clips with missing LUTs show an overlay at the bottom right of the screen indicating the name of the 
LUT if a single LUT is missing, or an indicator that multiple LUTs are missing. This allows for quick 
previews of missing LUTs without interruption. Multiple missing LUTs can be seen and managed from 
the Missing LUTs tab in the LUT Browser, which only appears if you have one or more LUTs missing.

Exporting LUTs
If you find it necessary to exchange image adjustments with other grading applications, compositing 
applications, or NLEs, often the easiest inter-application solution is to export a LUT. This can be done 
whether your grade consists of one node or several nodes, so long as they contain only Primaries 
palette adjustments, Custom Curves palette adjustments, and compatible ResolveFX plugins that 
include Color Space Transform, ACES Transform, and Gamut Mapping. All nodes with compatible 
functions will be mathematically combined and translated into a LUT.

Keep in mind that any nodes that use Qualifiers, Windows, incompatible filtering operations (such as 
sharpening or blurring), or incompatible Resolve FX or Open FX will be completely ignored, as will all 
other correction operations made within these nodes.

To export a LUT:

1	 Right-click a clip thumbnail in the Timeline of the Color page, and choose an option from the 
Generate LUT submenu:

	— Generate 3D LUT (17 Point Cube): A DaVinci-developed LUT format

	— Generate 3D LUT (33 Point Cube): A DaVinci-developed LUT format

	— Generate 3D LUT (65 Point Cube): A DaVinci-developed LUT format

	— Generate 3D LUT (Panasonic VLUT): A LUT format associated with 
Panasonic VariCam cameras

2	 Choose a location for the resulting LUT file in the file dialog. The default file path depends on your 
operating system; saving it here will make it available to DaVinci Resolve for future use.

	— On OS X: Library/Application Support/Blackmagic Design/DaVinci Resolve/LUT/

	— On Windows: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\LUT

	— On Linux: /home/resolve/LUT

If you like, you can create a new folder in which to save your custom LUTs.

3	 Enter a name into the Save As field, and click Save. A LUT file is saved.

Once created, you can use an exported LUT from within DaVinci Resolve, applying it to a 
clip or node directly, or applying it to the entire project using the settings found in the Color 
Management panel of the Project Settings. You can also copy the LUT to a memory stick to give 
to someone for monitoring or previewing in an onset workflow, or to someone using another 
grading application that can read this LUT format.
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Chapter 148

DaVinci Resolve 
Control Panels
The DaVinci Resolve control panels make it easier to make more 
adjustments in the same amount of time than using a mouse, pen, 
or trackpad with the on-screen interface. 

Additionally, using a DaVinci Resolve control panel to control the Color page provides vastly superior 
ergonomic comfort to clutching a mouse or pen all day, which is important when you’re potentially 
grading a thousand shots per day.

This chapter covers details about the three DaVinci Resolve control panels that are available, and how 
they work with DaVinci Resolve.
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About The DaVinci Resolve 
Control Panels
There are three DaVinci Resolve control panel options available and each are designed to meet 
modern workflow ergonomics and ease of use so colorists can quickly and accurately construct both 
simple and complex creative grades with minimal fatigue.

This chapter provides details of the each of the panel functions and should be read in conjunction with 
the previous grading chapters to get the best from your panel.

DaVinci Resolve 
Advanced Panel

DaVinci Resolve  
Micro Panel

DaVinci Resolve  
Mini Panel
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The DaVinci Micro Panel
The DaVinci Resolve Micro Panel is ideal for edit suites that need a professional grading panel for 
occasional grades or quick adjustments to shots. You will also find it on DIT carts and in video 
village situations on set where its small size, portability, and low power needs are ideal for teams 
on the move.

DaVinci Resolve Micro Panel 

The DaVinci Resolve Mini Panel
For many facilities and individual operators, the DaVinci Resolve Mini Panel is a compact yet powerful 
grading panel that’s fully featured despite its small size. The bottom half of this panel is identical to 
the Micro Panel, making it easy for people upgrading from the Micro to leverage their existing muscle 
memory. However, the top half of this panel adds direct-selection palette keys, dynamically remapped 
soft knobs and buttons, and a paged menu system that offers considerably more flexibility than the 
Micro Panel, and a better overall grading experience as a result.  

DaVinci Resolve Mini Panel 

3212Color  |  Chapter 148  DaVinci Resolve Control Panels



The DaVinci Resolve Advanced Panel
The ultimate grading panel to give you the speed for long and complex grading sessions, and to make 
a lasting impact on clients visiting your suite or looking in on you as they’re videoconferencing during 
a remote grading session. The DaVinci Resolve Advanced control panels features dozens of fixed 
palette keys and menu driven soft knobs and buttons so most grading operations are just a keystroke 
or two away. High resolution liquid crystal displays (LCD) and backlit keys accommodate a typical 
darkened grading environment, with LCD panel and key color and intensity being user customizable, 
so each colorist can set up their preferred panel configuration.

DaVinci Resolve Advanced Panel 

The original key configuration for the DaVinci Resolve Advanced Panel was updated in late 2020 to 
add new features and capabilities, while eliminating redundancy and making better use of the full 
complement of available buttons. Owners of the original panel can update to the new layout, but both 
the original and new layout are described in separate sections of this chapter.

Updating the Control 
Panels Firmware
From time to time, Blackmagic updates the functionality of the Control Panels through firmware 
changes. New firmware for the Micro and Mini Panels can be checked for and installed by opening the 
separate DaVinci Control Panels Setup utility that is installed by default with DaVinci Resolve. Firmware 
for the Advanced Panel is updated directly from DaVinci Resolve automatically.
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Using the DaVinci Resolve 
Micro Panel
The Micro Panel features a row of direct control knobs at the top of the panel, three trackballs with 
rings for color grading, and to the right, transport and commonly used keys to speed up your grading 
session. Above the trackballs are reset buttons and also mode selection buttons for Log, Offset, and 
the Viewer selector. When selecting the Viewer mode, the full display will switch to the Cinema Viewer, 
which is ideal for playback and review of clips. The Log and Offset selections are described below.

Primary Trackball Mode
This is the default mode for the panels with the Log, Offset, and Viewer keys off (unlit). The three 
trackballs, from left to right, are in the traditional DaVinci format of Lift, Gamma, and Gain when 
DaVinci Resolve is set for Primary grading. Rotating the trackball performs a color balance adjustment 
for the range, changing its RGB parameters. The colors are set by moving the trackball in the 
direction corresponding to the color rings in the Primaries Wheels interface. Rotating the ring 
around each trackball adjusts the range’s Master Wheel, which allows you to control the contrast via 
YRGB adjustments. 

Primary Trackball Mode controls

Lift AmplitudeLift Color Gain AmplitudeGain Color

Gamma AmplitudeGamma Color

Log Trackball Mode
Log Trackball mode can be entered using the Log key just above the center trackball. When in Log 
grading, the trackballs shift to the Log Control’s Shadow, Midtone, and Highlights parameters. 
Rotating the trackball performs a color balance adjustment for the range, changing its RGB 
parameters. The colors are set by moving the trackball in the direction corresponding to the color 
rings in the Primaries Log interface. Rotating the ring around each trackball adjusts the range’s 
Master Wheel, which allows you to control the contrast via RGB adjustments.
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Log Trackball Mode controls

Shadow AmplitudeShadow Color Highlights AmplitudeHighlights Color

Midtone AmplitudeMidtone Color

Log Button

Offset Trackball Mode
You can also select the Offset button whether in Primary or Log modes. This is a toggle operation, 
and when selected, the left hand side ring surrounding the trackball controls the color temperature of 
the image, the center trackball ring the color tint, and the right hand side trackball controls the image 
offset balance and master exposure with the ring. 

Offset Trackball Mode controls

Temperature Master ExposureMaster Color

Tint

Offset Button
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Above the three trackballs are three buttons for resetting the grade:

	— RGB: This key only resets the RGB balance to default detent.

	— All: Select All to reset both RGB and level.

	— Level: Select the Level key to reset the level while maintaining RGB differential.

Log, Offset, and Viewer ButtonsReset Buttons

Control Knobs
The top of the panel features 12 high-resolution endless turn optical encoder control knobs with 
detent resets. These are spaced in groups of three for fast operation in dark suites. From left to right, 
the knobs control:

	— Y Lift: This knob is for adjusting the contrast of the image in the darker areas. The midtone, and to 
a lesser amount the brighter areas of an image, will also change.

	— Y Gamma: Use the gamma knob for primarily midtone contrast changes with some influence on 
the darker and brighter sections.

	— Y Gain: The Y Gain control influences the brighter parts of the image at a greater extent to the 
mid and darker portions.
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	— Contrast: This one parameter lets you increase or reduce the distance between the darkest and 
lightest values of an image, raising or lowering image contrast. The effect is similar to using the 
Lift and Gain master controls to make simultaneous opposing adjustments.

	— Contrast Pivot: Changes the center of tonality about which dark and bright parts of the image 
are stretched or narrowed during a contrast adjustment.

	— Midtone Detail: When this parameter is raised, the contrast of regions of the image with high 
edge detail is raised to increase the perception of image sharpness, sometimes referred to as 
definition. When lowered to a negative value, regions of the image with low amounts of detail are 
softened while areas of high detail are left alone.

	— Color Boost: Lets you naturalistically raise the saturation of regions of low saturation, sometimes 
referred to as a vibrance operation. Can be used also to lower the saturation of regions of low 
saturation.

	— Shadow: Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow 
detail recorded below 0 percent, while leaving the midtones alone. 0 is unity.

	— Highlight: Makes it easy to selectively retrieve blown-out highlight detail in high dynamic range 
media by lowering this parameter, and achieves a smooth blend between the retrieved highlights 
and the unadjusted midtones for a naturalistic result.

	— Saturation: Increases or decreases overall image saturation. At higher values, colors appear 
more intense, while at lower values, color intensity diminishes until, at 0, all color is gone, leaving 
you with a grayscale image.

	— Hue Rotation: Rotates all hues of the image around the full perimeter of the color wheel. The 
default setting of 50 shows the original distribution of hues.

	— Luminance Mix: Lets you control the balance between YRGB contrast adjustments you’ve 
made using the Master Wheels or ganged Custom curves, and Y-only adjustments to contrast 
made using the Y channel Lift/Gamma/Gain controls of the Primaries palette or the unganged 
Luma curve. 

Additional detail can be found in the Color page basics chapter, and each of these operations can be 
seen on the Primary palette of the user interface.

Control Buttons
On the right-hand side of the trackballs there are three groups of control buttons. 

Top group

Middle group

Bottom group

Control buttons
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The top group includes:

	— Grab Still: At any time when you are grading, selecting the Grab Still key automatically grabs a 
full resolution frame from the Timeline and attaches the node graph metadata for later display 
and use.

	— Undo: Undo is one of the favorite keys of colorists. Try any grade, and if you don’t like it, simply 
undo. There are multiple steps of undo available within the page.

	— Redo: Sometimes you hit undo once too many times. Redo will put back into effect the last item 
you undid. As with undo, there are multiple levels of redo.

	— Play Still: Using Play Still, DaVinci Resolve will automatically display a wipe on the Viewer between 
the current scene and the current still. You can use your mouse on the Viewer to move the wipe 
position. Selecting Play Still a second time will toggle this mode off.

	— Prev Mem: Each clip, by default, has a memory of its grade, sizing, and so on, which is saved in 
reference to the source timecode. If you are grading a clip and move from it to another clip, the 
grade is saved automatically in a memory for that clip. If you come back to the clip and make a 
change to the grade, then decide you don’t like the change, select Prev Mem to return to the 
previous grade status you found when selecting the clip.

	— Reset: This key resets the grade of the current node. Holding down this key deletes all nodes in 
the clip except for the first node, resets the grades to default, and clears the keyframes.

	— Loop: You may wish to repeat a review of a grade of a clip, or a selection of clips on the Timeline; 
this Loop toggle key selects or deselects the Loop operation.

	— Bypass: This toggle selects the Node Graph Bypass mode.

	— Disable: This toggle enables or disables the current node.

The middle group of buttons include:

	— Prev Node: Within the Node Editor on the Color page, you are likely to have a number of nodes. 
These are numbered based on the order that you added them. DaVinci Resolve node graphs are 
completely user configurable, so you can add nodes anywhere and in any order you like. Thus, the 
Previous Node key selects the node one lower in numerical order.

	— Next Node: Similar to the Previous Node key, this selects the node adjacent to the current node, 
in this case the next higher numerical position.

	— Prev Frame: To step the Viewer one frame in reverse along the Timeline. Press and hold the Prev 
Frame button to go to the first frame of the clip.

	— Next Frame: A single frame step forward for each key press. Press and hold the Next Frame 
button to go to the last frame of the clip.

	— Prev Clip: Selects the first frame of the previous clip.

	— Next Clip: Selects the first frame of the next clip.

The bottom group includes the Timeline Transport buttons for reverse play, stop, and play.

	— Left Arrow: Select this key to play the clip/Timeline in reverse. Press the Left Arrow key multiple 
times to play in reverse at a faster speed.

	— Stop: You guessed it. This stops the playback.

	— Right Arrow: The forward key plays the clip/Timeline forward. Press the Right Arrow key multiple 
times to play forward at a faster speed.
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Using the DaVinci Resolve Mini Panel
The Mini Panel has an identical feature set and controls as the Micro Panel for the lower trackball deck. 
In addition, the panel has an upper sloped desk with dual high resolution LCD displays with eight soft 
knobs and keys that are menu driven. There are also two banks of control buttons, on the left-hand 
side for palette selection and on the right-hand side for commonly used operations.

Please refer to the Micro Panel details above for the lower deck features.

Data and Power Connections
The DaVinci Resolve Mini Panel has multiple ways to connect data and power in order for easy 
install in a wide variety of post-production environments. There is no power switch, and the panel is 
always on when connected to a power source. When DaVinci Resolve is closed, the LCD will display 
“No connection to DaVinci Resolve” and will turn off the LEDs and go dormant after approximately 
10 minutes.

Data Connections to the Computer

	— USB-C: The Mini Panel can be connected directly to the computer via a USB type C connection. It 
can not be powered by USB-C, however. If connected directly via USB C, DaVinci Resolve should 
see the panel automatically.

	— Ethernet: The Mini Panel can be connected to computer via an Ethernet network. This requires 
setting the up the panel to be on the same subnet as the host computer in the Network Settings. 
You will also need to connect to the panel using the DaVinci Resolve Mini Panel (Ethernet) option in 
the Color Grading section of the Control Panels pane of the System Preferences.

Power Connections

	— AC Power: The Mini Panel can be powered directly from a wall socket.

	— DC Power: The Mini Panel can be powered using a 12V battery and 4-pin XLR power connector 

	— PoE: The Mini Panel can be connected and powered with a single cable via Power over Ethernet 
(PoE) if your router supports this function.

 

Mains 100-240V AC Power DC Power Input

PoE Ethernet Ethernet

USB-C

The power and connection ports of the Mini Panel
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Palette Selection Buttons
On the left-hand side of the top deck you will find 15 palette selection buttons. To quickly select the 
main palette toolsets in DaVinci Resolve, simply select the appropriate button and the menus on the 
LCD screens will update to the correct display.

Palette selection buttons

	— Home: This key is used for the initial setup of the panel and also selects the top-most menu. 

	— Network: Exposes the Network Settings controls to set up the Mini Panel over Ethernet.

	— About: Displays the currently installed firmware version.

	— Left Arrow: A number of menus have multiple pages as indicated by the small dots in the center 
of the LCD displays. The Left Arrow moves the menu display left.

	— Right Arrow: The Right Arrow moves the menu display right.

	— Raw: This palette contains groups of parameters that correspond to every camera raw media 
format that’s supported by DaVinci Resolve.

	— Primary: The first grade for every clip will be likely be a primary. This is where you balance the clip 
and correct for offsets in the black and white balance. Selecting Primary switches DaVinci Resolve 
from other grading modes and automatically selects the Primary menus for the LCD displays. 
For more information on using these controls, see Chapter 129, “Primaries Palette.”

	— Primary: Exposes the Primary grading controls and opens the Primaries Wheels palette in the 
DaVinci Resolve interface.

	— Log: Exposes the Log grading controls and opens the Primaries Log palette in the 
DaVinci Resolve interface.

	— Offset: Exposes the Offset adjustment controls.

	— RGB Mixer: Exposes the RGB Mixer controls and opens the RGB Mixer palette in the 
DaVinci Resolve interface.
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	— Motion: The Motion Effects palette (only available in the Studio version) contains two sets of 
controls for applying optical-flow-calculated effects to clips in your program. These include 
enhanced Temporal and Spatial noise reduction, and motion-estimated artificial motion blur.

	— Curves: The Curves palette has modes that provide different curve-based methods of manipulating 
the color and contrast of an image. Each curve lets you adjust a customizable region of the image 
based either on image tonality (zones of lightness or darkness), hue (specific colors), or saturation 
(intensity of color). For more information on the specifics of curves, see Chapter 132, “Curves.”

	— Custom: Exposes the Custom curve controls and opens the Custom curve palette in 
DaVinci Resolve. In Custom mode, the first 6 knobs represent control points along the curve in 
20% increments. Rotating the knobs increases or decreases the position of the control point, 
and pressing in on the knob resets the control point to its default value. Using the arrow keys, 
you can also navigate to the Intensity and Soft Clip controls.

	— Tools: Allows you to gang or split the YRGB components of the curves, as well as provides 
access to the YSFX controls.

	— Hue vs Hue: Exposes the Hue vs Hue curve controls and opens the Hue vs Hue curve palette 
in DaVinci Resolve. In this mode, the first 6 knobs represent specific colors along the curve. 
The eighth knob (Input Hue) allows you to fine tune the selected color. Rotating the knobs 
increases or decreases the position of the control point, and pressing in on the knob resets 
the control point to its default value.

	— Hue vs Sat: Exposes the Hue vs Sat curve controls and opens the Hue vs Sat curve palette 
in DaVinci Resolve. In this mode, the first 6 knobs represent specific colors along the curve. 
The eighth knob (Input Hue) allows you to fine tune the selected color. Rotating the knobs 
increases or decreases the position of the control point, and pressing in on the knob resets 
the control point to its default value.

	— Hue vs Lum: Exposes the Hue vs Lum curve controls and opens the Hue vs Lum curve palette 
in DaVinci Resolve. In this mode, the first 6 knobs represent specific colors along the curve. 
The eighth knob (Input Hue) allows you to fine tune the selected color. Rotating the knobs 
increases or decreases the position of the control point, and pressing in on the knob resets 
the control point to its default value.

	— Lum vs Sat: Exposes the Lum vs Sat curve controls and opens the Lum vs Sat curve palette 
in DaVinci Resolve. In this mode, the first 4 knobs represent Black, Shadow, Highlights, and 
White along the curve. The eighth knob (Input Lum) allows you to fine tune the selected level. 
Rotating the knobs increases or decreases the position of the control point, and pressing in 
on the knob resets the control point to its default value.

	— Sat vs Sat: Exposes the Sat vs Sat curve controls and opens the Sat vs Sat curve palette in 
DaVinci Resolve. In this mode, the first 4 knobs represent Black, Shadow, Highlights, and 
White along the curve. The eighth knob (Input Sat) allows you to fine tune the selected level. 
Rotating the knobs increases or decreases the position of the control point, and pressing in 
on the knob resets the control point to its default value.

	— Sat vs Lum: Exposes the Sat vs Lum curve controls and opens the Sat vs Lum curve palette 
in DaVinci Resolve. In this mode, the first 4 knobs represent Black, Shadow, Highlights, and 
White along the curve. The eighth knob (Input Sat) allows you to fine tune the selected level. 
Rotating the knobs increases or decreases the position of the control point, and pressing in 
on the knob resets the control point to its default value.
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	— Qualifier: When you select and isolate a particular color, and change that color, you are making a 
secondary correction. The qualifier key updates the menus to provide all the Secondary controls, 
including the 3D, HSL, RGB, or Luma key, with which to isolate the correction you need. For more 
information on Qualifiers, see Chapter 134, “Secondary Qualifiers.”

	— HSL: Exposes the HSL qualifier controls and opens up the HSL Qualifier in DaVinci Resolve. 
The arrow keys cycle through all available controls of the qualifier including the Matte Finesse 
tools, and the knobs are used to make adjustments.

	— RGB: Exposes the RGB qualifier controls and opens up the RGB Qualifier in DaVinci Resolve. 
The arrow keys cycle through all available controls of the qualifier including the Matte Finesse 
tools, and the knobs are used to make adjustments.

	— LUM: Exposes the LUM qualifier controls and opens up the LUM Qualifier in DaVinci Resolve. 
The arrow keys cycle through all available controls of the qualifier including the Matte Finesse 
tools, and the knobs are used to make adjustments.

	— 3D: Exposes the 3D qualifier controls and opens up the 3D Qualifier in DaVinci Resolve. 
The panel controls give you access to the full parameters of the 3D qualifier. However, the 
unique nature of the 3D qualifier requires pointer input to select the color paths to key. The 
arrow keys will expose the Matte Finesse tools, and the knobs are used to make adjustments.

	— Tools: Exposes additional tools for all qualifiers, including Picker, Picker Subtract/Add, Feather 
Subtract/Add, and Invert.

	— Window: Power Windows are another way of making secondary correction, being essentially 
shapes you can use to isolate regions of the image. Different controls let you use oval, rectangular, 
polygonal, or custom curved shapes. Because you can isolate regions of the image by drawing, 
Power Windows produce exceptionally clean results, with edges that can be precisely positioned 
and feathered to achieve a variety of effects. For more information on Windows, see Chapter 135, 
“Secondary Windows.”

	— Linear: Exposes the Linear Window adjustment controls. It is possible to shape the window to 
your specifications using the eight control knobs. Pressing the knob resets the parameter.

	— Circle: Exposes the Circle Window adjustment controls. It is possible to shape the window to 
your specifications using the eight control knobs. Pressing the knob resets the parameter.

	— Polygon: Exposes the Polygon Window adjustment controls. The Polygon Window must first 
be created using the pointer in the Viewer; it is then possible to move the window to your 
specifications using the eight control knobs. Pressing the knob resets the parameter.

	— Curve: Exposes the Curve Window adjustment controls. The Curve Window must first be 
created using the pointer in the Viewer; it is then possible to move the window to your 
specifications using the eight control knobs. Pressing the knob resets the parameter.

	— Gradient: Exposes the Gradient Window adjustment controls. It is possible to shape the window 
to your specifications using the five control knobs. Pressing the knob resets the parameter.

	— Add Window: If you need to add another window of the same type (linear, circle, etc.) in the 
same node, you can press this button to add another one. Each specific window’s parameters 
can then be accessed by using the Left/Right Arrow keys on the Mini Panel.

	— Window On: Toggles the selected window on or off. The correct order to create a window 
using the Mini Panel is to select the window type first, and then press the Window On button 
to activate it. 

	— Tools: Exposes a common set of Window-related tools, including Invert, Mask Control, 
Window Copy/Paste, Convert to Curve, and a Delete button to remove a specific window from 
a set of window types created by the Add Window function.
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	— Tracker: The Tracker palette operates in Window mode, where the tracking controls let you 
match the motion of a window to that of a moving feature in the frame. The tracking controls 
are all accessed by the soft keys on top of the LCD panels; the knobs have no functionality in the 
tracker. You can track forward, reverse, and forward/reverse. You can access the Clip and Frame 
modes, as well as add and delete keyframes, copy and paste tracks, and select the included spatial 
parameters of the track. Toggling between the Tracker in frame mode and the Window panels 
allow you to manually track a window solely on the Mini Panel if necessary.

	— Blur: With the Blur palette controls you can apply an exceptionally high-quality Gaussian blur, or 
another equally high-quality sharpening operation to your image. For more information on how to 
use the Blur controls, see Chapter 151, “The Motion Effects and Blur Palettes.”

	— Blur: Exposes the Blur controls and opens the Blur palette in the DaVinci Resolve interface. 
The Radius and H/V Ratio amounts can be adjusted either simultaneously or on a per color 
basis by using the control knobs.

	— Sharpen: Exposes the Sharpen controls and opens the Blur palette in the DaVinci Resolve 
interface. The Radius and H/V Ratio, and Scaling amounts can be adjusted either 
simultaneously or on a per color basis by using the control knobs. Coring controls are 
accessible via the Left/Right arrows.

	— Mist: Exposes the Mist controls and opens the Blur palette in the DaVinci Resolve interface. 
The Radius and H/V Ratio, and Scaling amounts can be adjusted either simultaneously 
or on a per color basis by using the control knobs. Mix controls are accessible via the 
Left/Right arrows.

	— Keyer: Each color correction node’s key input and key output makes it possible to route key 
channel data from one node to another, so you can apply isolated corrections. These key levels are 
controlled in the Keyer palette and include the Key Input, Key Output, and Qualifier tools.

	— Sizing: DaVinci Resolve has a powerful toolset for making geometric transforms, using advanced 
algorithms for optical-quality sizing operations, and they are found in this palette.

	— Edit: Exposes the sizing controls to affect a specific clip on the Edit or Cut page and are linked 
to the transform values set in the Video Inspector.

	— Input: Exposes the sizing controls to affect a specific clip on the Color page only. The changes 
made here will be seen in the Timeline but will not be linked to the clip’s Video Inspector.

	— Output: Exposes the sizing controls to affect the entire timeline.

	— Node: Exposes the sizing controls to affect a specific node.

	— Reference: Exposes the sizing controls to affect the Gallery Still that is being used in 
a reference wipe.

	— Fx: This palette allows the control of Resolve FX plugins. Resolve FX plugins span the gamut from 
blurs and complex color adjustments to stylized image treatments and lighting effects to sharpen 
and repair operations that are too complex to accomplish using the palette controls of the Color 
page. Several of the most commonly used Resolve FX plugins are mapped to the soft buttons 
above the LCD panels. Pressing one of these buttons applies the plugin to the selected node. 
If the specific plugin you want is not assigned to the soft buttons, you can manually drag the 
Resolve FX to your node from the Open FX Library. Once placed, the parameters of that plugin will 
be available in the panel interface. see Chapter 149, “Using Open FX and Resolve FX.”

	— User: Additional palettes introduced in newer versions of DaVinci Resolve without their own direct 
access buttons will appear here.
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	— Stereoscopic: Exposes DaVinci Resolve’s extensive set of stereoscopic controls to use with 
3D images, including convergence, stereo alignment, and floating windows. If no clips have 
been marked as Stereo, this palette is inactive. For more information on the Stereoscopic 
tools, see Chapter 15, “Stereoscopic Workflows.”

	— HDR: Exposes the High Dynamic Range toolset and opens the High Dynamic Range palette 
in DaVinci Resolve. The HDR toolset provides a more nuanced, zone-based primary grading 
that is especially suited for HDR deliverables. The six default zones being Black, Dark, Shadow, 
Light, Highlight, and Specular. However, using the HDR palette with the Mini Panel creates 
some unique interface conventions to keep in mind: 

Each zone is mapped to an LCD panel, and a trackball and its ring.

	— The LCD Panel shows the Zone Name, and the four knobs control saturation, exposure, 
zone pivot, and zone falloff.

	— The Trackball controls the zone’s color balance showing angle and strength or XY coordinates.

	— The Ring controls the zone’s exposure.

There are six default zones (and the user can add more), but only three sets of trackballs, 
and two LCD panels, so the trackballs now shift zones up or down depending on the selected 
active zones, instead of being dedicated to a single zone like with lift, gamma, and gain.

Zones are shifted using the Prev Zone and Next Zone soft keys above the LCD panels. The 
current active zones are shown in the High Dynamic Range palette in DaVinci Resolve, and 
they are also indicated by the colored Zone bank controls on the top of the palette.

	— The left trackball is mapped to the left LCD panel.

	— The center trackball is mapped to the right LCD panel.

	— The right trackball is still active, but has no corresponding LCD, so the saturation, 
exposure, zone pivot, and zone falloff controls are not adjustable until you shift the zones 
down using the Previous Zone soft button. Then the zone that was on the right trackball is 
now remapped to the center trackball and the right LCD screen.

	— To access the highest zone’s LCD panel, you must navigate to the furthest zone bank to 
the right by using the Next Zone button until it reaches the end. Then you must press the 
Right Arrow key on the Mini Panel. The highest zone controls (by default specular) are now 
available in the Left LCD panel but are still linked to the right trackball.

	— Global is accessed via the Right arrows, the LCD is changed to allow the knobs control of 
the Black/Offset, Color Balance, Exposure, Temperature, and Tint, but the trackballs are still 
actively controlling the zones set in the zone bank.

For more information on using the HDR toolset, see Chapter 130, “HDR Palette.”

TIP:  The trackballs and rings are always active in their selected zones in the HDR 
palette, regardless of what is on the LCD screens at the time.
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	— Color Warper: Exposes DaVinci Resolve’s Color Warper controls. The Color Warper palette is 
a mesh-based warping tool that, instead of warping the spatial location of pixels, warps one 
set of colors into another. These adjustments, made using a grid of draggable control points, 
automatically have a smooth falloff from the colors you’re warping to other colors that are locked 
into place. The smoothness of this falloff depends on the distance between the warp points that 
are being adjusted and other warp points that are locked in place to prevent change.

The Color Warper controls in the Mini Panel are used in conjunction with the mouse and screen 
interface. Before using the Color Warper controls on the Mini Panel, you must first click on one or 
more control points in the user interface to select an area. Once selected you can then manipulate 
and modify that area using the control knobs and soft buttons on the Mini Panel.

For more information on using the HDR toolset, see Chapter 133, “Color Warper.”

	— Dolby Vision®: Exposes the Dolby Vision Trim control set. These controls let you automatically 
analyze your HDR material, and generate Dolby Vision trim metadata that will display your grade 
properly on SDR and HDR screens with a different brightness level than what you mastered on. 
If you purchased a Dolby Vision license, you can manually adjust your trims using the Mini Panel as 
well. The Primary trim controls are available in the first menu using the knobs, and the secondary 
trim controls are accessed by tapping on the Next Page button.

For more information on using Dolby Vision, see Chapter 10, “HDR Setup and Grading.”

Quick Selection Buttons
On the right-hand side of the top deck, you will find 15 quick selection buttons. These are for very 
commonly used selections that a colorist might use many times for each clip. 

Quick selection buttons
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	— Serial: The most common node to use on the node graph is a Serial node. A Serial node is a full-
featured color correction processor offering primaries, secondaries, windows, tracking, image 
stabilization, sharpening and blur, matte blur, and so on. Serial nodes are added one after the 
other in a cascade mode, similar to adding one layer of correction on top of the last. All grades in 
a preceding node(s) will impact the source image and therefore the grades in following nodes.

	— Parallel: Unlike adding a Serial node, adding a Parallel node first actually adds two nodes. One 
behaves like a Serial node with full color correction capabilities. The second is a Parallel Mixer 
node. This mixer accepts the image from the original Serial node and from the new Serial node 
and the output is a mix of these two. If the current node is one of the Serial nodes immediately 
preceding the Parallel Mixer node and you select Add Parallel again, another input to the mixer 
will be created as will another preceding Serial node. In each case, the input to these Serial nodes 
will be common, effectively making them in parallel to each other. The key advantage is that the 
source image is available to many nodes, whereas in a straight Serial node graph, each time you 
restrict a color in a node the following nodes have little ability or limited range to use that color.

	— Layer: The Layer node is similar to the Parallel node in that it accepts the image inputs from more 
than one node. The key difference to a Parallel node is that the mixing of the inputs in a Layer 
node is prioritized towards the latest additions to the input list. For example, select Add Layer 
and DaVinci Resolve will add a node in parallel to the current node and link the output of the 
current and the newly made Parallel node to the two inputs of the Layer Mixer node. The previous 
current node will have the lowest priority in the mix, and the newly made Parallel node the highest 
priority. Add one more Layer node, a third input node will be created with a higher mix priority 
than the first two nodes.

	— Node + Linear: Adds a Serial node after the current node on the node graph and simultaneously 
adds a Linear Power Window, thus reducing the number of keystrokes.

	— Node + Circle: Adds a node after the current node on the node graph and simultaneously adds a 
Circular Power Window.

	— Append: Often when navigating around the Node Editor and making correction trims, the colorist 
decides he/she needs an additional node for more correction. Using the Append Node key will 
always add a Serial node to the very end of the node graph, regardless of which node in the graph 
is the current node.

	— Copy: Used to copy a selected nodes grade to another node.

	— Paste: Use this key to complete the copy/paste of node grade.

	— Full Viewer: The Full Viewer display shows an enlarged Viewer and this includes transport 
controls at the bottom, timecodes and the selections for Reference Still modes, spilt screens, and 
Highlight modes.

	— Prev Still: If you have a still selected, the Previous Still key selects the one preceding.

	— Next Still: The next still is selected if this key is used.

	— Highlight: When in the Qualifier menus making secondary qualifiers, it’s common to select the 
Highlight key to show a high contrast separation of the qualified color and all other parts of the 
image. Toggle this key to turn off.

	— Prev KF: This key steps backward one keyframe on the Clip/Track Timeline display.

	— Next KF: For keyframe steps forward on the Clip/Track Timeline display.

	— Ref: This toggle key changes the reference wipe mode between Gallery, Timeline, 
and Offline sources.

3226Color  |  Chapter 148  DaVinci Resolve Control Panels



Using the DaVinci Resolve Advanced 
Control Panel (Legacy Layout)

IMPORTANT:  For information on the new version of the DaVinci Resolve Advanced control 
panel, see the next section. This section covers the previous version of the Advanced Panel 
for legacy owners.

There are three panels in the Advanced control panel set. The center Trackball panel is where the 
majority of controls and feedback for the colorist are found and it includes a slide-out keyboard.

On either side of the Trackball panel are two interchangeable panels, the position of which is 
determined by operator preference. The T-bar panel, shown above on the left, has a T-bar Mix/ Wipe 
control and a number of menu and function keys. The Search Dial panel, shown above on the right, 
has the Timeline Transport controls and a Jog/Shuttle control as well as a numerical keypad and 
associated function keys.

All panels have soft keys and variable control knobs within the LCD panel, which provide an accurate 
visual reference to the control without the risk of parallax errors.

A key feature of the panel design is real-time feedback, provided to the colorist via the full color LCD 
panels where you can see, at a glance, the relative settings of the controls and a highlight of the 
last control touched. For example, if a control is out of its default reset, the panels show this with a 
selectable color highlight.

Menus, Soft Keys, and Soft Knob Controls
The soft menu structure is designed to offer simultaneous control over multiple functions and a 
fast, logical, and efficient way to move between the menus. These soft menus, the soft keys, and the 
operation of these in conjunction with the variable knobs are covered in the preceding chapters of this 
manual as their state changes depending on the operation being performed.

You will find the LCD on each of the panels has a two-line title description of the menu’s main function 
and there are two lines of text above each pot or switch describing the control. The T-bar and 
Search Dial panels also have a “More” key to the bottom right of the LCD which will select a second 
layer of menus.

The T-bar and Search Dial panels have quite independent controls compared to the Trackball panel. 
For example, the T-bar panel’s default menu is for Windows adjustment while the default menu for 
the Search Dial panel is Sizing. This allows users to control windows or sizing at any time, regardless 
of the Trackball panel mode and eliminates the need to change the work surface to adjust window 
position or input sizing.

While the menus change with the UI, the hard keys, trackballs, T-bar, and shuttle control remain 
relatively constant, so the majority of this chapter describes groups and individual key functions. 
At the end of this chapter are details on copying forward, scrolling, and rippling changes using the 
Advanced control panel.
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Shift Key Convention
Before describing the hard key operation, it is important to understand two keys on the left and right 
panels. These keys, Shift Up and Shift Down, provide access to potentially two more functions on each 
of the next key selected.

For example, on the T-bar panel, next to the Shift Up key is the Base Mem key. The term “Base Mem” is 
a legacy DaVinci colorist description to revert to the default memory, so there is no grade or sizing on 
that node. (There is an exception discussed later in this chapter.)

If you select Shift Up and then Base Mem, the All operation is to Base Mem All or reset the current 
color correction of every node in the node graph for the current clip, leaving the nodes in place. To 
“Reset” the selected node graph or “Reset Grades and Nodes,” first select Shift Down, then Base Mem.

To permit a fast and single-handed operation, this function does not require you to hold the Shift Up 
or Shift Down key while selecting the second key; just select them sequentially, first the Shift key, then 
the function.

Trackball Panel
The Center panel has the traditional four trackballs, each with a surrounding control ring and no 
end stop in either direction. Three variable knob controls are on each side of the panel, three keys 
above the trackballs, three below the leftmost and rightmost trackballs. On the LCD panel, there are 
three LCD displays, each with eight knob controls and four keys. The LCD screens are menu driven 
and thus the knobs, soft keys, and the display itself depends on the application’s current operation. 
The Center panel also offers a slide-out keyboard for naming files, stills, and nodes, as well as for a 
number of other operations.

The Trackball panel includes a slide-out keyboard

The three trackballs, from left to right, are in the traditional DaVinci format of Lift, Gamma, and 
Gain when DaVinci Resolve is set for Primary grading; when in Log grading they are Lowlights, 
Midtones, and Highlights.
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By rotating the trackballl the colorist can alter the balance between the red, green, and blue levels 
of the image. Using the vectorscope as a rough guide, moving the trackball towards the three-thirty 
clock position adds more blue while reducing the red and green.

The control ring surrounding these trackballs provides a master amplitude control of the 
associated trackball.

Above the three leftmost trackballs you will see three buttons for resetting the grade:

	— RGB: This key only resets the RGB balance to default detent.

	— All: Select All to reset both RGB and level.

	— Level: Select the Level key to reset the level while maintaining RGB differential.

The rightmost (fourth) trackball has a number of modes. It operates similar to a mouse for moving the 
onscreen cursors, Color curve control point position, and Power Windows position, and can also act as 
a primary grade Offset control.

Under the leftmost and rightmost trackballs there are three unmarked buttons.

On the left hand side of the panel, the right-most of the three unlabelled buttons below the trackball 
toggles the right hand side (fourth) trackball in and out of offset adjust mode.

The keys under the right-hand side trackball provide left, center, and right mouse buttons.

Above the rightmost trackball, the three keys have two modes.

When used in conjunction with the Shift Down button, the three buttons above the trackball function 
as resets, as per the buttons above the other trackballs.

	— Shift Down Adjust Window: Only resets the RGB balance to default detent.

	— Shift Down Modes: To reset both RGB and level.

	— Shift Down Cursor: To reset the level while maintaining RGB differential.

In their normal operation they select:

	— Adjust Window: Selection turns on the Viewer Shape cursors for the current node and allows the 
trackball to position the current window.

	— Modes: This key allows access to a number of menus and acts as an on/off toggle.

	— Display (Shift Up Cursor): This shift function changes the cursor views on the main monitor. 
The user can select the cursor display, including: Windows, Off, On the UI but not the main 
SDI monitor, or displayed on both.

	— Cursor: The Cursor is used for the color picker when in Curves and Vector/Secondary modes. This 
key also controls the Window display.

On the left side of the panel are three luminance knobs. From top to bottom they are Luminance Gain, 
Gamma, and Lift.

On the right side there are three more controls, from top to bottom: Saturation, Hue (has the effect of 
hue rotation), and Luminance Mix.
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T-bar Panel
The T-bar panel, typically located on the left for a right-handed colorist, has an LCD display with four 
variable controls and nine soft keys. The lower section of the panel houses the T-bar and six groups of 
hard keys. Each group and their keys are described below.

Mode Control Group
The Mode Control group provides navigation to a number of the GUI pages and a few 
commonly used functions.

	— Config: This key opens the Project Setting window where you will set up DaVinci Resolve for each 
project. Select again to close the window without saving.

	— Browse: Select Browse to call the Media page where you can review files on attached storage and 
review the Media Pool.

	— VSR (Shift Down Browse): This selection is reserved for future use.

	— Conform: Selects the Lightbox display on the Color page.

	— Shift Up Conform: Toggles the display of the Lightbox on the SDI output.

	— Deck (Shift Up Revival): The Deck key selects the Capture mode for importing a batch 
list from an EDL.

	— Revival: This key opens the Revival Dirt and Dust-busting window.

	— Scene (Shift Down Revival): To select the Scene Cut Detection window, select the Shift Down key 
followed by the Revival key.

	— Current ~ Viewer: This key toggles between the Color page and the Enhanced Viewer page.

	— Object Track Mode: This key selects the Tracking menus.

	— Clip/Track/Unmix: This is a toggle key between the Clip/Timeline modes of the node graph and 
the Unmix mode.

	— User (Shift Up Cache Mode): This marks a clip for render cache of the clip output.

	— Cache: This key is a toggle function to turn the render cache on or off.

	— Editor: Selects the Edit page where you can edit the Timeline, import AAF, EDL or XMLs and apply 
speed changes, Composite and Dissolve/Wipe effects, and so on.

	— Proxy On/Off: This key toggles the proxy mode on and off.

	— Auto Color: This is a popular key. Using this key, DaVinci Resolve will automatically make a basic 
primary color correction to balance the blacks and whites of your image.

	— Page Up (Shift Up Gallery): In larger projects you may have a number of gallery albums holding 
stills. This key changes the Gallery page to the next higher album on the list.

	— Gallery: Used to select the Gallery UI page where you can manage, import, and export your stills.

	— Page Down (Shift Down Gallery): The inverse of the Shift Up Gallery function, this selects the 
Gallery album one lower than the current.

	— A/C Mode: This toggle key displays the clips in the Timeline in the order of the EDL (the record 
order, often referred to as C Mode), or the ascending order of the source clip timecode, 
called A Mode.

	— Handles Mode: This selection exposes the handles of the selected clip to allow tracking and 
grading outside the I/O selections of the current edit.
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Timeline Management Group
When grading clips, colorists often try different looks. This group of keys offers a quick way to 
navigate through these versions and to split and join clips on the Timeline.

	— Split (Shift Up Undo): This key splits the clip at the position of the cursor on the Timeline.

	— Undo: Undo is one of the favorite keys of colorists. Try any grade, and if you don’t like it, simply 
undo. There are multiple steps of undo available within the page.

	— Join (Shift Up Redo): The reverse of split. Place the Timeline cursor at the junction of two clips 
that have sequential timecode and select Join to make just one clip.

	— Redo: Sometimes you hit undo once too many times. Redo will put back into effect the last item 
you undid. As with undo, there are multiple levels of redo.

	— Restore Point: This selection is reserved for future use.

	— Save: Remember this key; it’s your friend. Save often, and also consider the auto save options 
found in the User Preferences.

	— Add Version: When you make a grade on any clip, DaVinci Resolve stores the parameters for that 
clip. If you want to try different grades, don’t lose your good grades, just use the Add Version 
feature. This key makes a second, third, or higher version of the grade for that clip.

	— Default Version: If you have multiple versions of grades for a clip, this key is used to select the 
Default version, regardless of which version is currently displayed.

	— Previous Version: This selects the grade one version lower in order. For example, if you are on 
version three, select Previous Version to get to version two. Once the Default version is reached, 
selecting Previous Version again will select the highest version.

	— Next Version: Use this key to select the next higher version of the grade. Once the top version is 
reached, selecting Next Version again will select the lower version.

Keyframing Group
On the bottom right of the Color page is the Keyframe timeline for the current clip. The Keyframing 
group of keys is used in association with the Keyframe timeline and controls the selection of marks for 
the start and end of dynamic transitions of the grade.

	— Start Dynamic: Use Start Dynamic to select the first keyframe in a transition. The transition may 
be a grade change, resizing, the addition of a matte, or any number of 100 variables, all of which 
are associated with the node graph and the Clip or Track timeline.

	— Ripple Value: If you have a grade or effect, or just an adjustment, and you would like to ripple this 
effect over another effect or over a large number of other clips, use Ripple Value.

	— Delete: This key deletes the selected keyframe.

	— Lift Mark: If you place a keyframe in the wrong spot, put your cursor on the keyframe and 
use Lift Mark to remove it.

	— Trim: This key is used with the numerical keypad to trim a keyframe’s position.

	— Mark: Like the Start Dynamic key, Mark is a major key. It places a Static keyframe on the 
Keyframe timeline.

	— Scene (Shift Down Mark): This selection opens the Scene Cut Detector.
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Memory Access Group
DaVinci Resolve has a number of hot keys, called Mems, where you can store a grade for quick 
reference. In fact, every time you make a grade for a clip, a memory of the grade is kept. While you 
could save a still for each clip, having thousands of stills to scroll through would take time, so there are 
26 quick and easy memory locations to store a grade, called A–Z Mems.

Every clip has its own metadata for the grade that is stored by DaVinci Resolve as a memory. There 
are a number of keys available to select or revert to these stored metadata memories, or to clear the 
metadata to revert to a base grade or no grade state.

	— All (Shift Up Base Mem): This is used to reset the current color correction of every node in the 
node graph for the current clip, leaving the nodes in place.

	— Base Mem: Used to reset the grade of the current node.

	— Reset (Shift Down Base Mem): Used to reset the grades of the current clip.

	— Please note that there is an exception to the rule to clear the Base Mem. It is possible, in fact 
very helpful sometimes, to have a clip preset that is not cleared when you select Base Mem. 
For example, when a film is over scanned and the frame edges are shown as well as the image. 
Instead of making an input resize adjustment for every clip to remove the framing, a preset resize 
can be made and stored, with a label, and this preset is not deleted when using Base Mem.

	— Preview Mem: To preview one of the Memory grades on any clip, select the clip on the Timeline, 
select Preview Mem and then the Memory letter. This key is a toggle so if you do not like the grade 
on the memory for that clip, select Preview Mem again and the grade will revert to the original.

	— Original Mem: Each clip by default has a memory of its grade and sizing, etc. If you are grading a 
clip and move from it to another clip, the grade for the first clip is saved automatically in a memory 
for that clip. If you come back to that clip and make a change to the grade, then decide you don’t 
like the change, select Original Mem to return to the grade status you found originally.

	— Scroll: When you select Scroll you can navigate up and down the Timeline to find and select a clip 
and its grade to recall to the current clip.

	— View (Shift Up Current): The Color page has two display modes. The normal mode includes the 
viewer, stills, and node graph on the top of the page. Selecting View toggles to the alternate page 
with a wide Node Graph view and stills but no viewer. Select View again to toggle back to the 
normal mode.

	— Crnt: Select Current before selecting a Mem key (A, B, C to Z) and the current grade on the active 
Timeline clip will be stored in the memory selected.

	— Shift Up: The Shift Up key permits the operator to select the upper secondary function of keys on 
the control panel. This operation does not require you to hold the Shift Up key, just select it prior 
to the second key.

	— Shift Down: The Shift Down key permits the operator to select the lower secondary function of 
keys on the control panel. This operation does not require you to hold the Shift Down key, just 
select it prior to the second key.

	— Macro: This key displays the Split Screen controls on the T-bar panel LCD display.

	— Memory Keys: The A, B, C to Z keys, selected directly or with the appropriate Shift Up or Shift 
Down preselection will recall the grade stored in this memory and will apply it automatically to the 
clip that is active on the Timeline.
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Menu Navigation and Node Control Group
DaVinci Resolve is a nodal-based color enhancement system. Grades are not stored in layers, but in 
nodes. In operation they can appear to be in layers if you select the Serial nodes, but greater grading 
flexibility is available by using the Parallel and Layer nodes.

This group also gives you quick access to the main menus to control primaries, secondaries (known 
here as Vectors), image sizing, and windows. It also offers a quick way to add and manage nodes. 

All three panels have LCD panels which display the menus

	— Primary: The first grade for every clip will be likely be a primary. This is where you balance the clip 
and correct for offsets in the black and white balance. Selecting Primary switches DaVinci Resolve 
from other grading modes and automatically selects the Primary and Custom Curve menus for 
the LCD displays.

	— Vectors: When you select and isolate a particular color, and change that color, you are making a 
secondary correction. The Vectors key updates the menus to provide all the Secondary controls, 
including the hue selection and control.

	— Sizing: The input and output image resizing engines are controlled using the 
menus selected by Sizing.

	— Windows: The Windows key opens the menus for Circular, Linear, Polygon, PowerCurve, and 
Gradient windows that can be used as a matte or mask for primary and secondary grades.

	— Outside Node: Selecting the Outside Node key adds another node after the current node and 
automatically link both image and key paths. If the original node has a grade within the matte 
shape the new Outside node would control the grade in the inverse (i.e., outside the matte).

	— Add Matte: Selecting this key displays the Matte node on the node graph for the selected node 
and the default matte selected.

	— Disable Current: This key is a toggle key and it disables or enables the grade on the current node.

	— Delete Current: To delete the current node. Remember to use undo if you had the 
wrong node selected.

	— Bypass (Shift Up Disable Current): This toggle selects the bypass mode.

	— Enable/Disable All (Shift Down Disable Current): This toggle enables or disables all nodes.

3233Color  |  Chapter 148  DaVinci Resolve Control Panels



	— Node + CPW: Adding a Serial node is a one button selection, Add Serial, but to also add a window 
requires a number of extra key selections. The Node + CPW key adds a node after the current 
node on the node graph and simultaneously adds a Circular Power Window, thus reducing the 
number of keystrokes.

	— Node + LPW: As above, adds a Serial node after the current node with a Linear Power Window.

	— Node + PPW: A Polygon Power Window is also selected when adding a Serial node.

	— Node + PCW: This key, like the others above, adds a Serial node after the current node, but also 
sets up the PowerCurve Window to permit the marking of freeform shape points and Bezier spline 
curves on the viewer to construct a freeform window.

	— Add Serial: The most common node to use on the node graph is a Serial node. A Serial node is a 
full-featured color correction processor offering primaries, secondaries, windows, tracking, image 
stabilization, sharpening and blur, matte blur, and so on. Serial nodes are added one after the 
other in a cascade mode, similar to adding one layer of correction on top of the last. All grades in a 
preceding node(s) will impact the source image and therefore the grades in following nodes.

	— Shift Down Add Serial (Add Serial Before): This adds a serial node before the current node.

	— Add Parallel: Unlike adding a Serial node, adding a Parallel node first actually adds two nodes. 
One behaves like a Serial node with full color correction capabilities. The second is a Parallel Mixer 
node. This mixer accepts the image from the original Serial node and from the new Serial node 
and the output is a mix of these two. If the current node is one of the Serial nodes immediately 
preceding the Parallel Mixer node and you select Add Parallel again, another input to the mixer 
will be created as will another preceding Serial node. In each case, the input to these Serial nodes 
will be common, effectively making them in parallel to each other. The key advantage is that the 
source image is available to many nodes, whereas in a straight Serial node graph, each time you 
restrict a color in a node the following nodes have little ability or limited range to use that color.

	— Add Layer: The Layer node is similar to the Parallel node in that it accepts the image inputs from 
more than one node. The key difference to a Parallel node is that the mixing of the inputs in a 
Layer node is prioritized towards the latest additions to the input list. For example, select Add 
Layer and DaVinci Resolve will add a node in parallel to the current node and link the output of the 
current and the newly made Parallel node to the two inputs of the Layer Mixer node. The previous 
current node will have the lowest priority in the mix, and the newly made Parallel node the highest 
priority. Add one more Layer node, and a third input node will be created with a higher mix 
priority than the first two nodes.

	— Append Node: Often when navigating around the Node Editor and making correction trims, the 
colorist decides he/she needs an additional node for more correction. Using the Append Node key 
will always add a Serial node to the very end of the node graph, regardless of which node in the 
graph is the current node.

Reference Configuration Group
This area of the T-bar panel includes six keys and the fader T-bar. It is primarily used for control of stills 
display with and without reference wipes. The fader bar controls the mix or wipe position when the 
appropriate mode is active.

	— Key: This key adds and Alpha output on the node graph.

	— Circle: This key is not yet implemented.

	— Wipe: The Wipe key selects a wipe for reference comparison with the current image.

	— H/V: This key toggles the wipe between horizontal and vertical.
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	— Box: This key is not yet implemented.

	— Mix: Select this key to mix in preference to wipe.

	— Still: The Still key permits comparison of the current clip with the selected still.

	— Memory: Use this key to compare the current clip with a memory.

	— Highlight: When in the Qualifier (Vector) menus making secondary qualifiers, it’s common to 
select the Highlight key to show a high contrast separation of the qualified color and all other 
parts of the image. Toggle this key to turn off. Highlight is used so often it’s also on the T-bar panel 
and, when in Vectors mode, on the Trackball panel.

	— Mode (ShiftDownHighlight): Used to toggle the Highlight mode from gray to high contrast.

	— Timeline: Select the Timeline key when you want to compare the current to the Timeline image.

	— Offline: Select the Offline key when you want to compare the current to the Offline image.

	— Reference On/Off: This toggle key will turn the reference view on or off. When on, you can see 
the current clip in comparison to a reference.

Search Dial panel
The Search Dial panel, typically located on the right for a right-handed colorist, has an LCD display with 
four variable controls and nine soft keys. The lower section of the panel houses the Jog/Shuttle knob 
and six groups of hard keys. Each group and their keys are described below.

Reference Configuration Group
Located at the top left-hand side of the Search Dial panel are the Deck and Still selection keys. These 
are all related to controlling the tape deck and to grabbing and selecting stills. There is also an Undo 
and Redo key, a Shift Up and a Save key.

	— Split (Shift Up In): DaVinci Resolve associates grading information based on source timecode so 
it’s important to have each source clip identified as a different clip from the others. The Split key 
will split one clip into two on the frame selected. Each can therefore have its own grade. This is a 
quick, accurate, and easy way to split a long image sequence into multiple clips.

	— In: When marking an In point you can use the UI, a keyboard shortcut, or this key.

	— Join (Shift Up Out): Join is the reverse of the Split key. If you have clips with contiguous timecode, 
place the playhead on the first frame of a clip and select Join to merge the preceding clip.

	— Out: The Out key is used to select an Out point on the Timeline or deck.

	— Duration: To define a duration, first select the time using the numerical keypad (the colon 
separates the hours, minutes, seconds, and frames), and then select Duration.

	— Gang: This key is not implemented.

	— Undo: The colorist’s friend. DaVinci Resolve has virtually unlimited undo steps available within the 
page you are working in.

	— Redo: If you want to redo a step, use redo. Ideal when used with undo to compare 
two grades quickly.

	— Source (L): This key is not implemented.

	— Place (Shift Up A ( R )): This key is not implemented.

	— A ( R )): This key is not implemented.

	— F: This key is not implemented.

	— Place (Shift Up B): This key is not implemented.
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	— B: This key is not implemented.

	— G: This key is not implemented.

	— Place (Shift Up C): This key is not implemented.

	— C: This key is not implemented.

	— H: This key is not implemented.

	— D: This key is not implemented.

	— I: This key is not implemented.

	— E: This key is not implemented.

	— J: This key is not implemented.

	— Shift Up: Use the Shift Up key as a pre-selector for the keys with an upper option. Select the keys 
sequentially and do not hold the Shift Up key while selecting the second key.

	— Preroll: The Preroll key is used in conjunction with the numerical keypad to select a preroll time 
for tape operations.

	— Cue: Selecting Cue will force the transport to the preroll position.

	— Previous Still: If you have a still selected, the Previous Still key selects the one preceding.

	— Next Still: The next still is selected if this key is used.

	— Play Still: Using Play Still, DaVinci Resolve will automatically display a wipe on the Viewer between 
the current scene and the current still. You can use the fader T-bar to move the wipe position 
and in the Reference Wipe menus change the reference image as required by moving or resizing. 
Selecting Play Still a second time will toggle this mode off.

	— Save: The most important key on the panel. Besides using the auto-save feature, you can 
and should consistently save your project with this key. It only takes a few seconds and can 
save you hours.

	— Grab Still: At any time when you are grading, selecting the Grab Still key will automatically 
grab a full resolution frame from the Timeline and attach the node graph metadata for later 
display and use.

Transport Control Keys Group
Most colorists will use the Transport Control keys every minute of every grade, so they are located 
for quick and easy access. While not technically within this key group, the Jog/Shuttle knob is directly 
above these keys.

	— Jog: Rotate the Jog control to step forward or backward a few frames at a time.

	— Shuttle: On the outside of the Jog rotary control is the Shuttle knob. This knob has a detent at 
the null position and is turned clockwise or counter clockwise to shuttle the Transport/Timeline 
forward or reverse at the rate selected by the rotation of the Shuttle knob.

	— Loop: You may wish to repeat a review of a grade of a clip, or a selection of clips on the Timeline; 
this Loop toggle key selects or deselects the Loop operation.

	— Render: Once you have finished your grade, the Render key selects the Deliver page used for 
configuring the render parameters for your project and starting the render.

	— Rec: (Shift Down Render) This key is not yet implemented.
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	— Previous Node: Within the Node Editor on the Color page you are likely to have a number of 
nodes. These are numbered based on the order that you added them. DaVinci Resolve node 
graphs are completely user configurable, so you can add nodes anywhere and in any order you 
like. Thus, the Previous Node key selects the node one lower in numerical order.

	— Next Node: Similar to the Previous Node key, this selects the node adjacent to the current node, 
in this case the next higher numerical position.

	— Highlight: When in the Qualifier palette making secondary qualifiers, it’s common to select the 
Highlight key to show a high contrast separation of the qualified color and all other parts of the 
image. Toggle this key to turn on or off. Highlight is used so often it’s also on the T-bar panel.

	— Mode: (Shift Down Highlight) Used to toggle the Highlight mode from gray to high contrast.

	— Shift Down: This is the preselection key for functions indicated on the lower portion of the second 
keys legend.

	— First Frame: Selects the first frame of the current clip.

	— Last Frame: Selects the last frame of the current clip.

	— Step Reverse: To step the viewer one frame in reverse along the Timeline.

	— Step Reverse Keyframe: (Shift Down Step Reverse) This key steps backward one keyframe on the 
Clip/Track Timeline display.

	— Step Forward: A single frame step forward for each key press.

	— Step Forward Keyframe: (Shift Down Step Forward) For keyframe steps forward on 
the Clip/Track Timeline display.

	— Previous Scene: Selects the first frame of the previous scene.

	— Next Scene: Selects the first frame of the next scene.

	— Rewind: Places the Transport, or Timeline, in rewind.

	— Reverse: Select this key to play the Clip/Timeline in reverse.

	— Stop: You guessed it. This stops the current transport operation.

	— Forward: The Forward key will play the Clip/Timeline forward. Pressing Forward multiple times on 
the Advanced panel lets you use multiple playback speeds. Pressing Forward once gives 1x, then 
2x, then 3x, and then goes up to 5x speed.

	— Fast Forward: The inverse of the Rewind key; fast forward shuttles along the Timeline/Transport.

Memory Access Keys Group
For fast and direct access to A to Z Memories, or Mems, use this section of the Search Dial panel. 
This is an extremely powerful feature. With any clip selected on the Timeline, with a single key press, 
for example “A,” the grading parameters stored in memory A, including the node structure, sizing, 
and so on are automatically applied to the current clip.

	— O (Shift Up A): Selects memory O.

	— A: Selects memory A.

	— I (Shift Down A): Selects Memory I.

	— R (Shift Up B): Selects memory R.

	— B: Selects memory B.

	— J (Shift Down B): Selects Memory J (and so forth).

	— All (Shift Up Base Mem): This function returns all grades for all nodes on the clip to the default 
grade/settings and clears dynamic keyframes. 

3237Color  |  Chapter 148  DaVinci Resolve Control Panels



	— Base Mem: The Base Mem key clears the current node of all its grades and keyframes. 
Again, with the preset exception noted above.

	— Reset (Shift Down Base Mem Crnt): This key deletes all nodes in the clip except for the first node 
and resets the grades to default and clears the keyframes.

	— Preview Mem: To preview one of the memory grades on any clip, select the clip on the Timeline, 
select Preview Memory and then the memory. This key is a toggle, so if you do not like the grade 
on the memory for that clip, select Preview Mem again and the clip’s grade reverts to the original.

	— Original Mem: Each clip, by default, has a memory of its grade, sizing, and so on. which is saved 
in reference to the source timecode. If you are grading a clip and move from it to another clip, the 
grade is saved automatically in a memory for that clip. If you come back to the clip and make a 
change to the grade, then decide you don’t like the change, select Original Mem to return to the 
previous grade status you found when selecting the clip.

	— Scroll: The Scroll key selects a soft menu on the Trackball panel so clips or frames can be scrolled 
via the rotary control in the soft menu.

Numerical Entry Key Group
On the center right-hand side of the Search Dial panel is the Numerical Entry key group. Here you will 
find numbers 0 to 9 and associated keys for entering timecode and clip numbers. You will notice the 
numbers you type are displayed in a scratchpad area at the bottom of the Keyframe palette.

	— Current: To store a new grade in any memory, first select the Current key and then the memory 
of your choice.

	— All Color PTZR: This key is a toggle that selects the parameters that will be copied when 
updating a grade. Generally, all aspects of the grade are copied, including the pan, tilt, zoom, 
and rotation sizing transforms, but on occasion you may wish to copy only the grade and 
not the sizing parameters. In this case, use the All/Color/PTZR to select the mode you need. 
You can see the Keyframe Timeline toggle between the master or the node selected and the 
input PTZR parameters.

	— Select Node: Use this key in conjunction with the numerical keys to select any node on the 
current node graph. First, select the node number, and then Select Node. The current node 
changes to the selected node.

	— Backspace: The Backspace key moves you one item left in the numerical scratch pad display. 
This permits correction of your numerical entries.

	— 0 to 9: You guessed it. These are the numbers!

	— >, (Comma): The comma is used just before the frame count if you wish to indicate a 
drop frame timecode.

	— : (Colon): When typing in timecode, the convention is to type the hours followed by a colon, then 
the minutes, a colon, the seconds, a colon, and finally the frames. DaVinci Resolve does not need 
to have leading numbers entered where they offer no value and the default value is 0, so to type 
one hour, three minutes, zero seconds, and sixteen frames, you do not need to type 01:03:00:16. 
Simply type 1:3::16 and then press Enter. This speeds timecode entry.

	— Clear: Clears the scratchpad number.

	— – (Minus): Select the Minus key prior to the number to reduce the number.

	— + (Plus): Select the Plus key prior to a number to increase the number.

	— Take/Enter: Select the Take/Enter key to accept or enter any input.
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Keyframing Group 
The Keyframe keys are on the bottom right-hand side of the Search Dial panel. The functions are 
replicated on the T-bar panel. On the bottom right of the Color page is the Keyframe timeline for the 
current clip in the Timeline. The Keyframe group of keys is used in association with the Keyframe timeline 
and controls the selection of keyframes for the start and end of dynamic transitions of the grade.

	— Start Dynamic: This key is used to select the first point in a transition, a Dynamic keyframe. The 
transition may be a grade change, a sizing or reposition, or the addition of a matte or any number of 
100 variables, all of which are associated with the Node Editor and the Clip or Track Keyframe timeline.

	— Ripple Value: If you have a grade or effect, or just an adjustment and you would like to ripple this 
effect over another effect or a large number of other clips, use Ripple Value.

	— Delete: This key deletes the keyframe.

	— Lift Mark: If you place a keyframe in the wrong spot, put your cursor on the keyframe and use Lift 
Mark to remove it.

	— Trim: This key is used with the numerical keypad to trim a keyframe position.

	— Mark: Like the Start Dynamic key, Mark is a major key. It places a Static keyframe on the Clip timeline.

	— Scene (Shift Down Mark): This selection is reserved for future use.

Copying Grades Using the Advanced Control Panel
There are a number of methods of copying grades that are exclusive to the Advanced control panel.

Copy Forward Keys
The simplest way of copying grades using the control panel is to use the comma and colon keys on the 
keypad of the Search Dial panel to copy grades from one or two clips behind the currently selected 
clip. This is a great way to copy grades in scenes with a shot-reverse-shot structure, where you’re 
cutting between two angles of coverage, each of which uses the same grade.

	— To copy a grade from one clip back: Press Comma (,).

	— To copy a grade from two clips back: Press Colon (:).

Scroll
Scroll mode lets you quickly preview the effects of many different grades applied to clips in the 
Timeline on the currently selected clip, with the option to either accept or reject the previewed grade 
to which you’ve “scrolled.” This can be useful for checking to see if any of the previous grades you’ve 
created in a scene will work for the currently selected clip.

To use Scroll mode:

1	 Move the playhead to the clip to which you potentially want to copy a new grade. You can use the 
PREV SCENE and NEXT SCENE buttons to move quickly.

2	 Do one of the following to enter Scroll mode:

	— Press SCROLL on the Search Dial panel.

	— Press MODES, above the fourth trackball on the Center panel, then press the 
SCROLL MODE soft key.
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3	 Now, do one of the following to preview different grades from other clips:

	— Press the PREVIOUS SCENE and NEXT SCENE soft keys to move from clip to clip in the 
Timeline, previewing each grade to the current clip.

	— Turn the SCROLL SCENES knob to scroll smoothly along multiple clips in the Timeline.

	— Turn the SCROLL FRAMES knob to scroll along different frames of any clip, previewing the 
effects of keyframed grades at different points in time.

	— Press the TOGGLE DECK KEYS soft key to use the transport controls on the Search Dial panel 
to play through the Timeline, previewing grades as you go.

	— Press a number on the keypad of the Search Dial panel, and then the SCENE NUMBER soft key, 
to jump to a clip and preview its grade.

	— As you scroll from clip to clip, a red outline indicates the clip with the grade being 
previewed, and an orange outline indicates the current clip to which you’re previewing 
each scrolled grade.

4	 When you’re finished, do one of the following to either accept or reject a scrolled grade:

	— Press EXIT AS WAS if none of the grades you scrolled through was suitable. This exits Scroll 
mode and leaves the clip as it was previously.

	— Press EXIT AS IS if you’ve found a grade that works for the current clip. This exits Scroll mode 
and copies the scrolled grade.

When you press the TOGGLE DECK KEYS soft key in Scroll mode, each of the Transport Control buttons 
on the Search Dial panel functions as a means of previewing the grades of other clips in the Timeline.

	— STEP FWD: Move to the next clip and preview its grade.

	— STEP REV: Move to the previous clip and preview its grade.

	— FWD: Plays (scrolls) forward at 1 scene per second, previewing each new grade as it appears.

	— REV: Play (scrolls) the clips in reverse at 1 scene per second, previewing each new grade 
as it appears.

	— FFWD: Shuttles (scrolls) forward through the Timeline at 4 scenes per second, previewing each 
new grade as it appears.

	— RWD: Shuttles (scrolls) reverse through the Timeline at 4 scenes per second, previewing each new 
grade as it appears.

Rippling Changes Using the Advanced Control Panel
DaVinci Resolve has a mechanism for rippling specific changes made to one clip to a range of 
other clips in the Timeline. This is only possible using the controls of the DaVinci Resolve Advanced 
control panel.

The general idea of the ripple function is that you select a clip, make a change, and then ripple that 
change to a range of other clips. This rippled change can be applied to the same node in each clip, or 
the change can be added as an appended node within each rippled clip.

The Ripple mode that’s used when you press the RIPPLE VALUE button can be changed in the 
Color≈panel of the User Preferences. There are four options.
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	— Exact values changed: Changes made to the current clip are rippled to the specified clips using 
the exact parameters that were changed. For example, if Lift in the current clip is changed to 
0.75 of its range, each clip you ripple will have a Master Gain setting of 0.75. Only parameters you 
adjust are rippled.

	— Percent value changed: Changes made to the current clip are rippled to the specified clips by the 
percentage of change you made to the altered parameters. For example, if the current clip has a 
Lift level of 1.00 and is changed to 0.90 units, then the Lift setting of each clip you ripple will have 
a relative reduction of 10% relative to its previous value.

	— Unit value changed: Changes made to the current clip are rippled to the specified clips by the 
same delta of change, using whichever units make sense for the affected parameter. For example, 
if the current clip had a Lift of 0.80 and you increased it to 0.90, each rippled scene’s master gain 
level increases by 0.10.

	— All values are copied: The current clip’s grade is rippled to the specified clips in its entirety. No 
comparison is made with the original clip’s parameters, and all memory parameters are rippled.

The following procedure describes in detail how you can use the control panel to ripple a change to 
a range of other clips. While this procedure may appear complicated, it’s just that there are several 
options. Once you learn the sequence of commands, this process is actually quite fast.

To ripple a change using the Ripple Mode soft key commands:

1	 (Optional) Press MODES, then press RIPPLE MODES. Four commands appear mapped to the 
middle soft keys of the Center panel, which can be used later to execute different types of ripple 
operations.

2	 Move the playhead to the clip you want to adjust.

3	 Adjust the current clip that you want to ripple to other clips in the Timeline.

4	 Define the range of clips you want to ripple to using the number pad on the Search Dial panel. 
The following combinations will work:

	— An absolute range of clips is defined by entering two clip numbers separated by a comma. 
For example, if you want to ripple the current change to clips 10 through 15, you’d press “10, 15”

	— To specify every clip from the beginning of the Timeline, use the Minus (–) key. For example, to 
specify a range of clips from the beginning to clip 20, you’d press “–, 20”

	— To specify every clip to the end of the Timeline, use the Plus (+) key. For example, to specify a 
range of clips from the clip 50 to the end, you’d press “50, +”

	— To specify every clip in the whole Timeline, press “–, +”

5	 (Optional) You can control whether the rippled change is applied in an appended node, or an 
existing node, in every rippled clip:

If you want to apply the rippled change as a new node that’s appended to the end of every rippled 
clip’s grade, press SHIFT DOWN.

Otherwise, the rippled change will be applied to the same node in every rippled clip that you 
made your adjustment to in the current clip. In other words, if you made a change to Node 2, it 
would be rippled to Node 2 of all the clips you specified. If one of the rippled clips doesn’t have the 
same number of nodes, you may get an error.
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6	 To execute the ripple, do one of the following:

Press RIPPLE VALUE on the Search Dial panel to ripple a change using the currently selected 
Ripple Mode in the Color panel of the User Preferences.

Press one of the Center panel soft keys corresponding to the ripple function you want to perform. 
There are four soft keys:

	— Static Ripple: Changes made to the current clip are rippled to the specified clips using the 
exact parameters that were changed. For example, if Lift in the current clip is changed to 0.75 
of its range, each clip you ripple will have a Master Gain setting of 0.75. Only parameters you 
adjust are rippled. Identical to the “Exact values changed” ripple setting.

	— Relative Ripple: Changes made to the current clip are rippled to the specified clips by the 
percentage of change you made to the altered parameters. For example, if the current clip 
has a Lift level of 1.00 and is changed to 0.90 units, then the Lift setting of each clip you ripple 
will have a relative reduction of 10% relative to its previous value. Identical to the “Percent 
value changed” ripple setting.

	— Absolute Ripple: Changes made to the current clip are rippled to the specified clips by the 
same delta of change, using whichever units make sense for the affected parameter. For 
example, if the current clip had a Lift of 0.80 and you increased it to 0.90, each rippled scene’s 
master gain level increases by 0.10. Identical to the “Unit value changed” ripple setting.

	— Forced Ripple: The current clip’s grade is rippled to the specified clips in its entirety, 
overwriting all previous nodes and parameters in the rippled clips.

The adjustment you made in step 4 is applied to the designated range of clips.

Admittedly, that was a long and detailed procedure, but the actual button sequences are 
straightforward once you put them together. Here are some examples of button sequences that 
ripple an adjustment you’ve just made in different ways:

	— “10, 15” then SHIFT DOWN then RIPPLE VALUE: Copies the change you’ve made to the current 
clip, and applies it as a new node that’s appended to the end of clips ten through fifteen.

	— MODES then RIPPLE MODES then “34, 45” then FORCED RIPPLE: Copies the entire grade of the 
current clip, using it to overwrite the grade of clips 34 through 45.

	— MODES then RIPPLE MODES then “–, +” then SHIFT DOWN then RELATIVE RIPPLE: Copies 
the change you’ve made to the current clip as a relative percentage, and applies it as a new node 
appended to the end of every single clip in the entire Timeline.

WARNING:  Once you ripple a change in this manner, there is no going back. Since undo is a 
per-clip operation, there is no global undo for changes made to the entire Timeline. Proceed 
with caution.

3242Color  |  Chapter 148  DaVinci Resolve Control Panels



Using the DaVinci Resolve Advanced 
Control Panel (2020 Layout)
In late 2020, an updated and radically re-imagined key layout was introduced for the DaVinci Resolve 
Advanced Control Panel. This updated layout accounts for new features and controls, updates 
command terminology, eliminates redundancy, and takes fuller advantage of every key on every panel. 
The result is to provide maximum functionality, so you can work faster and more efficiently.

1 2 3

1. T-bar panel  2. Trackball panel  3. Search Dial panel

All three panels have LCD panels that display menus for the soft knobs and buttons.

Three Panels Working Together
The Advanced control panel set consists of three modular panels that work together to provide full 
functionality. The biggest panel with the trackballs is meant to sit in the center, while the two smaller 
panels are interchangeable depending on operator preference. These three panels are:

	— Trackball panel: This central panel is where the majority of controls for the colorist are found. 
In addition to the trackballs, fixed keys, and fixed rotary knobs on the bottom portion, there are 
soft keys and rotary knobs on the top angled portion. The Trackball panel also includes a slide-out 
keyboard underneath.

	— T-bar panel: Shown at the left, this smaller panel has a greater concentration of fixed keys and a 
T-bar Mix/Wipe control that can be used for a variety of different functions on the bottom portion, 
and a smaller set of soft keys and rotary knobs on the top angled portion.

	— Search Dial panel: Shown at the right, the bottom portion of this smaller panel also has 
a greater concentration of fixed keys, a Jog/Shuttle control with fixed Timeline Transport 
buttons underneath, and a fixed button numeric keypad that can be used for node and shot 
navigation, timecode entry, and which can also be used for whole, half, and quarter Printer Points 
adjustments when the P/Lite mode is activated. The top angled portion has a smaller set of soft 
keys and rotary knobs.
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The smaller two panels connect to the Center panel via an integrated USB hub, and the Center panel 
connects to your workstation via USB 2.

On all three panels, the fixed keys and specialized mechanical/optical controls are located on the 
bottom flat area. The operator-facing top area has all of the dynamically assigned soft keys and 
rotary controls, located atop an LCD panel which provides dynamic labeling and visual references for 
each soft control, all angled to be visible to the operator without parallax errors. These soft control 
displays also provide real-time feedback where you can see the relative settings of each variable 
control knob at a glance.

The Trackball panel includes a slide-out keyboard

Using Fixed Keys and Shift Up/Shift Down Functions
As the name implies, fixed keys offer unchanging functionality for frequently used functions. 
They’re arranged in clusters of like-minded functionality in an effort to make it easy to access a variety 
of related controls in one place that’s easier to remember. For example, all the keyframing controls are 
clustered together at the bottom-right of the Search Dial panel, next to the fixed transport controls 
which are clustered together at the bottom-left of the Search Dial panel (under the Jog/Shuttle wheel).

However, just because they’re fixed doesn’t mean they’re limited. Many, if not most, of the fixed keys 
offer one or two alternate functions, appearing above and below the primary function.

Each fixed key can list as many as three different 
functions; the main function appears at the center, the 
SHIFT‑UP function appears at the top of the key, and the 
SHIFT-DOWN function appears at the bottom of the key.
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The primary function of each fixed key, which is what happens when you simply press it, is displayed 
at the center in slightly larger text. Every key has at minimum one primary function. In the key shown 
above, ADD GROUP is the primary function that will be executed when you press the key once, so 
selecting a number of clips in the Thumbnail Timeline and then pressing this key would create a new 
group containing all selected clips.

For keys that have them, the alternate commands of fixed keys are accessed using SHIFT UP and 
SHIFT DOWN keys, a pair of which are located on each of the three panels. 

Shift keys shown under the left-most trackball let you access secondary 
functions; the T-Bar and Jog/Shuttle panels each have shift keys.

Pressing SHIFT UP gives you access to whichever alternate fixed key commands are displayed at the 
top. To help you see which keys have SHIFT UP functionality, pressing SHIFT UP illuminates all keys 
having an alternate function with a different color. In the key shown previously, pressing SHIFT UP 
will illuminate this key with another color to let you know it’s ready to use, and then pressing this 
key executes the JOIN function, adding the currently selected clip in the Thumbnail Timeline to the 
current group.

Pressing SHIFT DOWN works similarly, to illuminate and give access to alternate fixed key commands 
displayed at the bottom of buttons that have them. In the key shown previously, pressing SHIFT 
DOWN and then this key would execute the REMOVE function, removing the currently selected clip in 
the Thumbnail timeline from whichever group it belonged to.

3245Color  |  Chapter 148  DaVinci Resolve Control Panels



(Top) The default lit keys of the Search Dial panel, (Bottom) Pressing SHIFT DOWN highlights all 
keys with alternate SHIFT DOWN functions so you can instantly see which keys are selectable.
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In many cases, including the previous examples, the multiple functions assigned to a particular 
fixed key are related to one another to make them easier to remember. The primary function of each 
key is usually the most common function you’d want to perform, while the alternate functions are 
related to it.

In other cases, alternate functions aren’t directly related to the primary function, but they’re in the 
same general category of activity. This is true of the “Pages and Layout” group of buttons at the top-
left of the T-bar panel, for which the primary function of each button gives access to the main pages of 
DaVinci Resolve you might want to switch among (this is particularly useful if you’re hiding the bottom 
button bar of the user interface in order to get more screen real estate while working), while the SHIFT 
UP and SHIFT DOWN functions let you access specific GUI panels or page customization options that 
are related to those pages.

Soft Menus, Including Soft Keys 
and Soft Rotary Controls
Each of the three panels have soft controls. These controls appear on top of an LCD display that 
provides a top-most two-line title/description of each soft menu’s main function, along with two lines 
of text above each soft rotary control or soft key that describes that control’s specific function. 

The soft controls on the center Trackball panel typically update to show context-specific controls for 
whichever mode and palette is currently selected. The buttons and rotary controls are designed to 
offer simultaneous control over multiple related functions in each palette. They also provide a logical 
way to navigate among multiple sets of controls in palettes that have many modes or in modes that 
have more controls than can be represented on the Center panel’s 24 rotary and 12 key controls. 

(Top) The Trackball panel’s soft menu controls corresponding to the Primaries palette, 
(Bottom) the soft menu controls corresponding to the Motion Effects palette; note how 
all the controls update to be contextual to the palette that’s currently in use
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The T-bar and Search Dial panels each have soft controls consisting of four rotary and eight key 
controls, plus one additional unlabeled “More” key at the bottom right of the LCD. Ordinarily, the 
More key toggles between the default layout for that panel and additional sets of controls that there 
isn’t room for.

The unlabeled “More” key 
found to the bottom left 
of each of the side panel 
soft menu controls lets 
you choose an alternate or 
second set of controls for 
that panel’s current menu.

One of the nicest aspects of the soft controls is that the T-bar and Search Dial panels provide 
simultaneous access to the controls of other palettes than the currently selected palette displayed 
in the Trackball panel. For example, the T-bar panel’s default soft menu is the Sizing palette, while 
the default soft menu for the Search Dial panel is the Curves palette. These defaults let you make 
adjustments to image sizing or contrast curves at any time, regardless of what’s currently displayed on 
the Trackball panel’s soft controls, giving you access to multiple palettes’ worth of controls at once for 
the ultimate in efficiency.

Changing Which Palettes Appear in the Side Panel Soft Controls
However, there’s another benefit to the soft controls on these side panels; you can choose which Color 
page palette’s controls appear on each side panel, directly from the control surface.

To change a side panel’s soft controls to another palette:

1	 Press SHIFT UP on any panel.

2	 Press the MORE key on the T-Bar panel or the Search Dial panel. 

Once you do so, the fixed keys corresponding to palettes that can be displayed on the side panels 
are highlighted on the Trackball and T-bar panels. This shows you which palettes can be assigned.

3	 Press the key corresponding to the palette you want to assign. For example, if you want to expose 
the controls of the Qualifier palette, press the QUALIFIER button.

The selected side panel soft menu updates to show the controls of the palette that you assigned. If 
there are more controls on that palette than can be displayed at once (which is likely), press the MORE 
key to cycle among all of the available controls in that palette.

For example, if you want to assign the Motion palette’s controls to the T-bar panel because you’re 
adding a lot of noise reduction to the clips of the program you’re working on, simply press SHIFT 
UP, then the T-bar panel’s MORE key, then the MOTION key on the Trackball panel. Now the Motion 
palette’s controls appear on the soft menu of the T-bar panel, and you can use the MORE button to 
cycle among each page of available controls. If you want to go back to the default arrangement, the 
two default assignments are the Sizing palette on the T-bar panel, and the Curves palette on the 
Search Dial panel.
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Why Aren’t the Soft Panels Specifically Documented
Because of their dynamically remappable nature, the soft controls will continue to evolve 
over subsequent versions of DaVinci Resolve along with the palettes and functions they 
control. For this reason, soft control assignments are not presented in-depth as the fixed 
keys are. Instead, you’re best off referring to the Color page documentation in the Color 
Page section of the DaVinci Resolve User Manual to figure out what each identically named 
control is used for. All you need to know for now is that the soft controls change depending 
on which palette is selected, the mode of each palette, and the operation being performed.

The Trackball Panel
The focus of the Center panel is four trackballs that work as color balance controls in various palettes 
of the DaVinci Resolve Color page. Their functionality depends on which palette is currently open. 
Each trackball has a surrounding control ring that has no end stop in either direction, letting you do 
continuous rotary adjustment. The rings typically are for adjusting image lightness and contrast in 
different ways but are sometimes used for other functions, depending on which Color page palette 
you have selected. 

Additional buttons above and below the trackballs, and fixed-function rotary controls to the left and 
right, complete the center control cluster that provide a predictable set of central controls for making 
color and contrast adjustments.

The controls surrounding the trackball/ring controls of the Center panel
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Using Trackballs
The principal palettes you’ll use the trackballs with are the Color Wheels and Log Wheels modes of the 
Primaries palette, and the Global and Zones controls of the HDR palette. Whichever of these modes 
and palettes is selected will determine the functionality of the trackballs and rings.

However, keep in mind that whichever color controls the trackballs are assigned to, the topmost soft 
controls on the Trackball palette can be switched to work with other palettes, such as the Motion, 
Curves, or Qualifier palettes, for example. This means you can adjust the controls of a second palette 
while simultaneously making color and contrast adjustments with the trackballs and ring controls. This 
is exceptionally useful when making two kinds of adjustments that interact with one another.

Summarizing the Top Fixed Keys
Each of the four trackball/ring controls has three fixed keys above it. Individually, these keys provide 
separate Y and RGB reset controls for each trackball/ring pair. However, the first nine of these keys 
also collectively serve as a fast and convenient way of navigating the principal panels of grading 
functionality in the Color page. 

Additionally, the left-most trackball has a pair of shift keys underneath it for choosing which button 
function to trigger, giving you fast access.

Shift keys under the left-most trackball  
let you access secondary functions.
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Trackball and Ring Reset Controls
Each trackball’s reset controls are protected by having to press SHIFT UP to use them. This may 
feel like an extra step at first, but now that this top row of keys is also used to quickly switch among 
different palettes on the Color page, using SHIFT UP protects you from accidentally pressing a reset 
when you meant to switch to another palette. If you’re used to the prior layout, this will take a bit if 
getting used to, but it isn’t so bad once you’ve built up the muscle memory.

Reset controls above each trackball when pressing SHIFT UP:

	— RGB: Resets red, green, and blue channel adjustments while leaving master level (luminance or Y) 
adjustments alone.

	— All: Resets both RGB channel and master level adjustments.

	— Level: Resets master level adjustments while maintaining the differential between the RGB 
channels (aka color balance).

Navigation controls above each trackball 
(primary and SHIFT DOWN functions)
One of the biggest departures from the previous layout is the introduction of palette switching 
functions on the top row of fixed keys. This makes it faster to switch among different sets of controls 
as you work, and frees up additional buttons on the T-bar panel to do other things, adding to the 
utility of the DaVinci Resolve Advanced panel.

The first nine fixed keys above the trackballs work together 
to provide palette and mode switching.
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Key Shift Up Primary Function Shift Down

RAW/USER (RGB) Resets red, 
green, and blue channel 
adjustments only 
leaving master level 
adjustments alone

(RAW) Opens the 
Camera Raw palette

(USER) Not yet 
implemented at the 
time of this writing

LOG/S3D (ALL) Resets all 
YRGB adjustments

(LOG) Opens the 
Log mode of the 
Primaries palette

(S3D) Opens the Stereo 
3D Palette for Stereo 
3D timelines

PRIMARY/>SDR (LEVEL) Resets master 
level adjustments, 
leaving the differential 
between red, 
green, and blue 
channels unchanged

(PRIMARY) Opens the 
Color Wheels mode (Lift, 
Gamma, and Gain) of 
the Primaries palette

(>SDR) Opens the 
Dolby Vision™ palette 
if it’s enabled in the 
Project Settings

HDR/MIXER (RGB) Resets red, 
green, and blue channel 
adjustments, only 
leaving master level 
adjustment alone

(HDR) Opens the 
High Dynamic Range 
(HDR) palette

(MIXER) Opens the 
RGB Mixer palette

MOTION/OPEN FX (ALL) Resets all 
YRGB adjustments

(MOTION) Opens the 
Motion Effects palette

(OPEN FX) Opens the 
Magic Mask palette

CURVES/WARPER (LEVEL) Resets master 
level adjustments, 
leaving the differential 
between red, 
green, and blue 
channels unchanged

(CURVES) Opens the 
Curves palette to the 
last used curve (all other 
curves can be accessed 
via soft menu buttons)

(WARPER) Opens the 
Color Warper palette

QUALIFIER/BLUR (RGB) Resets red, 
green, and blue 
channel adjustments, 
only leaving 
luminance channel 
adjustment alone

(QUALIFIER) Opens 
the Qualifier palette to 
the last used Qualifier 
(you can choose which 
qualifier to use via soft 
menu buttons)

(BLUR) Opens the 
Blur palette

WINDOW/TRACKER (ALL) Resets all YRGB 
adjustments

(WINDOW) Opens the 
Window palette

(TRACKER) Opens the 
Tracker palette to the 
last used mode

SIZING/KEY (LEVEL) Resets master 
level adjustments, 
leaving the differential 
between red, green, 
and blue channels 
unchanged

(SIZING) Opens the 
Input Sizing mode of the 
Sizing palette (Edit and 
Output Sizing can be 
accessed via soft menu 
buttons)

(KEY) Opens the 
Key palette
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The Tools Button
A TOOLS button at the bottom center of the left-most trackball provides fast access to a soft menu 
that provides addition options using the soft controls. This is a future-proofing feature and exposes 
no additional functionality at the time of this writing.

The TOOLS button under the left-most trackball

The Fourth Trackball
Depending on which palette you’re using in the Color page, the rightmost (fourth) trackball can be 
used for color adjustment in conjunction with the first three when acting as an Offset control in the 
Color Wheels and Log Wheel mode of the Primaries palette, or it can be toggled between Global 
controls or being the fourth Zone color control in the HDR palette. 

However, the fourth trackball can also be set to perform many other functions using the three keys 
above and three keys below it. By choosing the appropriate palette and mode, it can be used as an 
eyedropper when sampling colors for qualification, it can be used to create, select, and adjust the 
control points of adjustment curves, or it can be used to adjust the position and rotation of Power 
Windows. All of these functions are described in the following table.
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The fourth trackball gives access to additional 
functionality via the fixed keys above and below it.

Key Shift Up Primary Function Shift Down

RGB/ADJ WIN/SDI ZM” (RGB) Resets red, 
green, and blue channel 
adjustments, only 
leaving master level 
adjustments alone

(ADJ WIN) Lets the 
trackball adjust the 
position of the selected 
window, while the 
ring adjusts window 
angle. This key remains 
illuminated as long as 
this mode is enabled

(SDI ZM) Toggles 
“Gang viewer zoom 
with video output” on 
and off, letting the 
SDI output mirror pan 
and zoom being done 
in the Viewer

ALL/OVERLAY/VIEWER (ALL) Resets all 
YRGB adjustments

(OVERLAY) Toggles 
onscreen control 
overlays, such as 
window outlines on 
and off for the Viewer 
and for video output. 
This key remains 
illuminated as long as 
this mode is enabled

(VIEWER) Sets onscreen 
control overlays, such as 
window outlines to be 
GUI only, so they only 
appear in the Viewer 
and not on video output
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Key Shift Up Primary Function Shift Down

LEVEL/CURSOR/CURVE (LEVEL) Resets master 
level adjustments, 
leaving the differential 
between red, 
green, and blue 
channels unchanged

(CURSOR) Toggles the 
eyedropper on and off 
for supporting palettes. 
In the Qualifier palette, 
the cursor lets you 
sample the image to 
create a key by pressing 
the SELECT button. In 
the Curves palette, you 
can sample the image 
to add a control point 
to the currently visible 
curve. This key remains 
illuminated as long as 
this mode is enabled.

(CURVE) Opens the 
Custom Curve and 
selects a control point 
to be freely adjusted 
(up, down, left and 
right) using the fourth 
trackball as you would 
the pointer in the GUI. 
Turning the ring to the 
left selects the next 
control point to the left, 
turning it to the right 
selects the next control 
point to the right.

SELECT/ALL – (SELECT) Used in 
conjunction with the 
CURSOR mode of the 
fourth trackball to 
sample a value for 
keying or for adding a 
control point to a curve

(ALL) Selects all clips in 
the Thumbnail Timeline

GLOBAL OFFSET – (GLOBAL OFFSET) In 
the Primaries palette, 
this sets the fourth 
trackball to adjust 
Offset color balance 
and Master levels. In 
the HDR palette, this 
sets the fourth trackball 
to adjust the Globals 
controls. This key 
remains illuminated 
as long as this 
mode is enabled.

–

AFTER/ENABLE/
BYPASS

(AFTER) Disables/
re-enables all nodes 
after the currently 
selected node

(ENABLE) Toggles the 
currently selected node 
(or nodes) off and on

(BYPASS) Toggles 
Bypass Grade on and off
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Hard-Coded Rotary Knobs
There are an additional six rotary knob controls to either side of the trackballs, arranged three to the 
left and three to the right. 

	— On the left side, from top to bottom, the rotaries control Y-only luminance Gain, Gamma, and 
Lift settings of the Color Wheels and Color Bars modes of the Primaries palette that control lift, 
gamma, and gain. If you have any other palettes or modes open, using these three knobs will 
continue to affect the Lift, Gamma, and Gain controls of the currently selected node.

	— On the right side, from top to bottom, the rotaries control Saturation, Hue, and Luminance mix. 
If you have any other palettes or modes open, using these two knobs will continue to affect 
the Saturation and Luminance Mix controls of the Color Wheels and Color Bars modes of the 
Primaries palette. The Hue knob will affect the hue of either the Primaries Palette mode or HDR 
palette, whichever was selected last.

Six Rotary  
Knob Controls

Two sets of three rotary controls to the left and right of 
the trackballs provide additional functionality.

Keyboard
The Center panel also offers a slide-out keyboard for naming files, stills, and nodes, triggering 
keyboard shortcuts, and writing novels about the innocence of newly hired colorists lost in the 
maelstrom of the film, television, and streaming industries.
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The T-bar Panel
The T-bar panel, typically located on the left for a right-handed colorist, has an LCD display with four 
variable controls and nine soft keys. The lower section of the panel houses the T-bar control and six 
groups of hard keys. Each group and their keys are described below.

Pages and Layout Group
The Pages and Layout control group at left provides navigation to a number of the GUI pages and a 
few commonly used methods of opening and closing different panels to customize the Color page UI.

Pages and Layout Keys

The Pages and Layout keys make it easy to open different 
pages and panels of the graphical interface.

Key Shift Up Primary Function Shift Down

SETTINGS/PROJECT/NOTES (SETTINGS) Opens 
and closes the 
Project Settings

(PROJECT) Opens 
and closes the 
Project Manager

(NOTES) Opens and 
closes the Project 
Notes window

STORAGE/MEDIA/METADATA (STORAGE) Opens 
and closes the Disk 
Storage panel of the 
Media page

(MEDIA) Opens 
the Media page

(METADATA) Opens 
and closes the 
Metadata Editor on 
any page it appears
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INSP/CUT/MEDIA (INSP) Opens and 
closes the Inspector 
on any page it 
appears

(CUT) Opens the 
Cut page

(MEDIA) Opens and 
closes the Media 
Pool on any page it 
appears

INDEX/EDIT/LIBRARY (INDEX) Opens and 
closes the Edit Index

(EDIT) Opens 
the Edit page

(LIBRARY) Opens 
and closes the Sound 
Library on any 
page it appears

K/FM/FX/SPLINE (K/FM) Opens and 
closes the Keyframe 
Editor on any 
page it appears

(FX) Opens and closes 
the Effects Library.

(SPLINE) Opens and 
closes the Spline 
Editor on any page it 
appears

DUAL VIEW/FUSION/NODES (DUAL VIEW) Toggles 
between dual viewers 
mode and single 
viewer mode

(FUSION) Opens 
the Fusion page

(NODES) Opens and 
closes the Node Editor 

GALLERY/COLOR/LUTS (GALLERY) Opens and 
closes the Gallery

(COLOR) Opens 
the Color page

(LUTS) Opens 
and closes the 
LUT Browser

MIXER/FAIRLIGHT/METERS (MIXER) Opens and 
closes the Mixer 
panel on any page it 
appears

(FAIRLIGHT) Opens 
the Fairlight page

(METERS) Opens 
and closes the Audio 
Meters panel on any 
page it appears

BURN/DELIVER/REMOTE (BURN) Opens and 
closes the floating 
Data Burn In window

(DELIVER) Opens 
the Deliver page

(REMOTE) Turns on 
Remote Rendering 
for the current 
workstation

OFX/SCOPES/INFO (OFX) Opens and 
closes the OFX 
Library/Settings 
panel on the Color 
page; when an 
effect is applied to 
the current node, 
toggles between the 
Library (list of OFX) 
and Settings (for the 
currently applied OFX)

(SCOPES) Opens 
and closes the 
Video Scopes window

(INFO) Opens the 
Clip Info palette
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Layout and Modes Group
The Layout and Modes control group at right provides access to additional ways of customizing the UI 
and toggling different modes of functionality while you work.

Layout and Modes Keys

The Layout and Modes keys give quick access to specialized Color page functions.

Key Shift Up Primary Function Shift Down

CLIPS/CLIP FILTER/– (CLIPS) Turns the 
Thumbnail Timeline 
on and off in the 
Color page

(CLIP FILTER) Toggles 
the Thumbnail 
Timeline’s clip filtering 
between All Clips 
and whichever filter 
is currently selected; 
for example, if you 
choose “Selected 
Clips,” this toggles 
between All Clips and 
Selected Clips

–

PROXY/CACHE/OPTIMIZE (PROXY) Toggles 
“Use proxy media if 
available” off and on

(CACHE) Toggles the 
effects cache among 
Smart Cache, User 
Cache, and Off

(OPTIMIZE) Toggles 
“Use optimized media 
if available” off and on

ACTUAL/DISPLAY MODE/FIT (ACTUAL) Sets the size 
of the image in the 
Viewer to 100% so you 
can see the actual size 
of the image

(DISPLAY MODE) 
Toggle Display Mode 
switches between 
hiding and showing the 
Viewer to make more 
room for the Color 
page Node Editor

(FIT) Fits the entire 
image into the current 
size of the Viewer, 
zooming down or up 
as necessary
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–/SWITCH TIMELINE/LOCK – (SWITCH TIMELINE) 
Cycles among all 
available timelines in 
the current project

(LOCK) Not yet 
implemented at the 
time of this writing

–/MIX UNMIX/HIDE TRK – (MIX UNMIX) Toggles 
Unmix on and off; 
when Unmix is on, 
each clip in the 
Color page is shown 
without transitions 
or compositing 
effects, making it 
easier for you to see 
your grade in effects 
heavy programs

(HIDE TRK) Hides all 
clips on whichever 
timeline track is 
currently displayed 
from the Thumbnail 
Timeline, so they’re 
ignored by the 
playhead, but 
continue to appear 
in video out; to show 
clips on that track 
again, you must 
Option-click the 
number of the track 
in the Mini Timeline to 
turn it back on

–/SCOPES MODE/SCALE – (SCOPES MODE) 
Cycles among all the 
available video scopes 
when the scopes 
are docked in the 
palette area

(SCALE) Toggles the 
video scopes between 
showing graphs with 
Video or Data levels

–/DUAL MON/PICKER – (DUAL MON) Turns 
the Workspace > Dual 
Screen option on 
and off

(PICKER) Toggles the 
RGB color picker value 
option between 8- 
and 10-bit

ENHANCED/LIGHTBOX/
SDI OUT

(ENHANCED) Turns 
on Enhanced Viewer 
mode in the Color 
page, with the Viewer 
shown atop the 
palette controls

(LIGHTBOX) Toggles 
the Thumbnail 
Timeline Lightbox 
mode on and off

(SDI OUT) Toggles 
video output of the 
thumbnail Lightbox 
on and off

FLAGS OP/A/C MODE/SAFE (FLAGS OP) Toggles 
the display of clip 
flags on SDI output

(A/C MODE) Toggles 
between A-sort and 
C-sort mode in the 
Thumbnail Timeline; 
in C-sort mode, 
clips are sorted by 
source timecode so 
similar clips appear 
together, in A-sort 
mode clips are sorted 
by record timecode 
so they appear in 
program order.

(SAFE) Toggles title 
safe on and off in the 
Viewer; options for 
title safe appear in 
the soft menu of the 
trackball panel
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–/HANDLES/CODEC – (HANDLES) Turns 
“Show current clip 
with handles” on 
and off; this lets you 
see the currently 
specified handles for 
the current clip in the 
Timeline, so you can 
track windows and 
other effects into 
the handles of media 
being rendered for 
round-trip workflows.

(CODEC) Cycles among 
clips in the Thumbnail 
Timeline, showing 
the File Name, the 
Codec, and the 
Version number

Utility Functions Group
This group of keys offers quick access to commonly used commands for saving, 3D functionality, 
Macros, and copy/paste functions for grading.

Utility Functions Keys

The Utility Functions keys provide access to a variety of frequently used 
utilitarian grading, Stereo 3D, and Macro commands.
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ESCAPE/SAVE/SAVE AS (ESCAPE) The 
Escape key on a 
computer keyboard

(SAVE) Issues the 
Save command for 
the current project; 
this is identical to 
pressing Command-S

(SAVE AS) Opens the 
Save Current Project 
As dialog, so you can 
save a duplicate of 
the currently open 
project; change the 
name and click Save 
when you’re done.

TAB/MUTE/DIM (TAB) The Tab key on a 
computer keyboard

(MUTE) Mutes audio 
monitoring; often 
useful when grading 
terrible programs

(DIM) Toggles 
between reducing and 
boosting the volume 
by 10dB; useful when 
the client wants to 
describe their next 
vacation

LINK ZM/LEFT/RIGHT/OTHER (LINK ZM) For 
Stereo 3D timeline, 
toggles Convergence 
between Linked Zoom 
and Opposite

(LEFT/RIGHT) For 
Stereo 3D timelines, 
toggles between 
monitoring the Left or 
Right eye images

(OTHER) For Stereo 
3D timeline, to 
“use the other eye”

L>R/GANG/SOLO/R>L (L>R) For Stereo 3D 
timelines, copies 
the left-eye grade to 
the right eye

(GANG/SOLO) For 
Stereo 3D timelines, 
toggles between 
ganging left- and 
right-eye grades 
together so changes 
to one are made 
to both, or soloing 
the left- and right-
eye grades to 
make independent 
adjustments to each

(R>L) For Stereo 3D 
timelines, copies the 
right-eye grade to the 
left eye

LEARN/RECALL MACRO/– (LEARN) Not yet 
implemented at the 
time of this writing

(RECALL MACRO) Not 
yet implemented 
at the time of 
this writing

–

START/END MACRO/– (START) Not yet 
implemented at the 
time of this writing

(END MACRO) Not yet 
implemented at the 
time of this writing

–
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COPY – (COPY) Copies the 
grade of the current 
clip in its entirety, 
including all parts 
of group grades; 
you control what 
part of the copied 
grade is pasted using 
different commands.

–

GRADE/PASTE/APPEND (GRADE) Pastes the 
entire copied grade 
to overwrite the 
previous grade; if you 
copied a group grade, 
the Pre-Clip, Clip, 
and Post-Clip grades 
are all pasted.

(PASTE) Pastes 
whichever node 
was the current 
node when the 
grade was copied to 
overwrite the current 
node’s settings; 
the current node is 
outlined orange.

(APPEND) Appends 
every node of the 
entire copied grade 
after the last node 
of the current 
grade; if you copied 
a group grade, the 
Pre-Clip, Clip, and 
Post-Clip grades are 
all appended as a 
flattened collection 
of nodes.

Clip and Version Group
These keys, at the bottom left of the T-bar panel, are used to manage clips and their grades in 
different ways, by creating and managing group assignments, clip attributes, and grade versions.

Clip and Version Keys

The Clip and Version keys let you manage groups and grade versions with ease.
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JOIN/ADD GROUP/REMOVE ( JOIN) Adds the 
current clip (or 
currently selected 
clips) to the current 
group (which is 
based on whichever 
group the last 
“grouped clip” you 
selected belonged to)

(ADD GROUP) Creates 
a brand new group 
and opens the Group 
Name dialog for you 
to type into (click 
OK to save the new 
group)

(REMOVE) Removes 
the current clip (or 
currently selected 
clips) from whichever 
group it belongs to

–/CLIP ATTRIB/DETAILS – (CLIP ATTRIB) Opens 
the Clip Attributes 
window for the 
currently selected clip

(DETAILS) Toggles the 
floating Clip Details 
window open and 
closed, with which you 
can see various clip 
and grade properties 
for reference 

–/FIND IN M/POOL/LIST – (FIND IN M/POOL) 
Selects the source 
clip in the Media Pool 
that corresponds to 
the current clip in the 
Timeline; opens the 
Media Pool to show 
the clip

(LIST) Switches the 
Media Pool to List 
view; the Media 
Pool does not 
automatically open if 
closed.

PREV VERSION – (PREV VERSION) 
Cycles the grade 
of the current clip 
to the previously 
numbered version

–

NEXT VERSION – (NEXT VERSION) 
Cycles the grade of 
the current clip to 
the next numbered 
version

–

LABEL/ADD 
VERSION/≥LOCAL

(LABEL) Opens the 
Version Name dialog, 
so you can rename 
the current version of 
the current clip; click 
OK when you’re done.

(ADD VERSION) Adds 
an additional version 
of the grade for the 
current clip; you 
can create multiple 
versions of a grade 
to save variations for 
future recall.

(>LOCAL) Toggles 
between Use Local 
Grades and Use 
Remote Grades; 
switching between 
Local and Remote 
grades doesn’t 
change or copy either 
set of grades.
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Utility Group
This group of keys, in the center of the T-bar panel, includes commands for tracking and stabilization, 
enabling/disabling grades and nodes and OFX, and bypassing Fusion effects and Grades. These keys 
can also function as a numeric keypad for future features.

Utility Keys

The Utility keys provide controls for tracking and stabilization, as well 
as disabling and bypassing various grading controls.

Key Shift Up Primary Function Shift Down

SHIFT UP – (SHIFT UP) Enables 
use of any of the 
SHIFT UP key 
functions at the top of 
various keys

–

1/CLIP/FM/+KF (1) The one key; can be 
used in conjunction 
with SELECT NODE to 
jump to a particular 
node

(CLIP/FM) Switches 
the mode of 
motion tracking or 
keyframing of window 
shape and position 
in the tracking graph 
between Clip mode 
(where adjustments 
are made globally to 
the entire duration 
of a window) and 
Frame mode (where 
adjustments are made 
at specific frames, 
adding keyframes to 
the Tracker graph to 
animate a window)

(+KF) Adds a keyframe 
to the tracking graph, 
typically used while 
in Frame mode where 
keyframes are added 
while rotoscoping 
image movement with 
a window
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2/TRACK REVERSE/COPY (2) The two key; 
can be used in 
conjunction with 
SELECT NODE to jump 
to a particular node

(TRACK REVERSE) 
Initiates motion 
tracking in reverse 
for the currently 
selected window

(COPY) Copies 
track data from the 
currently selected 
window

3/TRACK FORWARD/PASTE (3) The three key; 
can be used in 
conjunction with 
SELECT NODE to jump 
to a particular node

(TRACK FORWARD) 
Initiates motion 
tracking forward 
for the currently 
selected window

(PASTE) Copies track 
data to the currently 
selected window

–/STEP REVERSE/SHOW – (STEP REVERSE) 
Initiates window 
tracking in reverse by 
one frame and then 
stops, giving you time 
to evaluate the result

(SHOW) Toggles 
Show Track on 
and off; shows the 
motion path of the 
currently selected 
motion tracking data 
in the Viewer

4/STEP FORWARD/RESET (4) The four key; 
can be used in 
conjunction with 
SELECT NODE to jump 
to a particular node

(STEP FORWARD) 
Initiates window 
tracking forward by 
one frame and then 
stops, giving you time 
to evaluate the result

(RESET) Resets all 
motion tracking in the 
Tracking graph

5/PREV TRK K/FM/DEL KF (5) The five key; can be 
used in conjunction 
with SELECT 
NODE to jump to a 
particular node

(PREV TRK K/FM) 
Moves the playhead to 
the previous keyframe 
in the Tracker graph

(DEL KF) Deletes 
the keyframe at 
the position of the 
playhead in the 
Tracker graph

6/NEXT TRK K/FM/CL ALL (6) The six key; can be 
used in conjunction 
with SELECT 
NODE to jump to a 
particular node

(NEXT TRK K/FM) 
Moves the playhead 
to the next keyframe 
in the Tracker graph

(CL ALL) Deletes all 
keyframes in the 
Tracker palette

AUTO/MODE/SEARCH (AUTO) Performs an 
Auto Balance function 
in the Primaries 
palette

(MODE) Turns on the 
Modes soft menu on 
the Trackball panel, 
so you can choose 
different functions 
including OBJECT 
TRACKING, PROXY 
ON/OFF, POTS, RIPPLE 
mode, WIPE mode, 
SWITCH SESSION, 
SAFE AREA, CACHE 
mode, CUE mode, 
SCROLL mode, and 3D

(SEARCH) Not yet 
implemented at the 
time of this writing
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7/STABILIZE/BYPASS (7) The seven key; 
can be used in 
conjunction with 
SELECT NODE to jump 
to a particular node

(STABILIZE) Initiates 
image stabilization for 
the current clip, using 
the current settings in 
the Tracking palette’s 
Stabilizer mode

(BYPASS) Toggles 
image stabilization off 
and then on again, so 
you can compare the 
stabilized image to 
the original

8/DISABLE OFX/DEL (8) The eight key; 
can be used in 
conjunction with 
SELECT NODE to jump 
to a particular node

(DISABLE OFX) 
Toggles OFX on 
and off if one has 
been applied to the 
current node

(DEL) Removes an 
OFX effect that’s been 
added to a node

9/DISABLE ALL/– (9) The nine key; can 
be used in conjunction 
with SELECT NODE to 
jump to a particular 
node

(DISABLE ALL) Toggles 
all nodes for the 
current clip off and 
then on

–

SHIFT DOWN – (SHIFT DOWN) 
Enables use of any 
of the SHIFT DOWN 
key functions at the 
bottom of various 
keys

–

*/BYPASS FUSION/EXTRACT (*) The Asterisk key (BYPASS FUSION) 
Toggles all Fusion 
page effects off 
and then on for the 
current clip

(EXTRACT) 
Disconnects the 
selected node from 
the node graph, 
but leaves it in the 
Node Editor, ready 
to be reconnected 
somewhere else

0/BYPASS TRIMS/CLEAN UP (0) The zero key; can 
be used in conjunction 
with SELECT NODE to 
jump to a particular 
node

(BYPASS TRIMS) 
Toggles all Color page 
effects off and then 
on for the current clip

(CLEAN UP) Cleans up 
unruly node graphs to 
be more ruly

#/BYPASS ALL/– (#) The Hash key 
(or Pound sign)

(BYPASS ALL) Toggles 
both Color and Fusion 
page effects off 
and then on for the 
current clip

–

Node Control Group
This group of keys, at the bottom center of the T-bar panel, lets you quickly create the many different 
kinds of nodes that are available with which to organize your grades in the Node Editor of the 
Color page. 

The DaVinci Resolve Color page is a node-based grading system, where the adjustments you make 
appear as nodes in the Node Editor. Each node contains one or more adjustments that work together. 
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This is similar to the layers that appear in other applications, however nodes provide the flexibility to 
route image data nonlinearly within a grade, connecting the output of one node to the input of any 
other node farther down the tree of nodes, branching image processing operations or recombining 
them via parallel or serial layer nodes to combine Color page functions in creative ways to create 
sophisticated operations.

Node Control Keys

The Node Control keys let you create a wide variety of nodes for grading.

Key Shift Up Primary Function Shift Down

+INPUT/ADD OUTSIDE/
OFX ALPHA

(+INPUT) Lets you add 
inputs to any mixer 
node, including the 
Parallel Mixer, the Layer 
Mixer, and the Key Mixer

(ADD OUTSIDE) Adds a Corrector 
node in serial that connects both 
its RGB and KEY inputs to the 
outputs of the node before it, with 
the KEY input inverted, so you 
can make adjustments to parts 
of an image that are outside the 
preceding node’s qualified or 
windowed area.

(OFX ALPHA) Turns on 
“Use OFX Alpha” to enable 
the selected node to 
output whatever

SWAP/>SHARED/
KEY MIXER

(SWAP) Does “Morph 
into Layer Mixer Node” 
or “Morph into Parallel 
Mixer Node” if a relevant 
Mixer node is selected; 
Changes a Parallel Mixer 
into a Layer Mixer and 
vice versa

(>SHARED) Turns the currently 
selected node into a Shared node; 
Shared nodes automatically ripple 
adjustments other grades that 
use the same Shared node.

(KEY MIXER) Adds a Key 
Mixer node with its first 
KEY input attached to the 
currently selected node’s 
KEY output; Key Mixer 
nodes let you combine 
multiple keys.
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–/NODE+POLYGON/ 
+POLY

– (NODE+POLYGON) Adds a 
Corrector node in serial with a 
polygon window automatically 
enabled for fast isolation; you 
can begin drawing a polygon 
immediately in the Viewer.

(+POLY) Turns on the 
polygon window for the 
currently selected node.

PRECLIP/CLIP/TL/
POSTCLIP

(PRECLIP) Opens the 
Pre-Clip group grade 
mode of the Node 
Editor; only works when 
a clip is part of a group

(CLIP/TL) Toggles between the Clip 
and Timeline grade modes of the 
Node Editor

(POSTCLIP) Opens the 
Post-Clip group grade 
mode of the Node Editor; 
only works when a clip is 
part of a group

NODE+CIRCLE/+CIRCLE – (NODE+CIRCLE) Adds a Corrector 
node in serial with a circular 
window automatically enabled for 
fast isolation

(+CIRCLE) Turns on the 
circular window for the 
currently selected node

NODE+LINEAR/ 
+LINEAR

– (NODE+LINEAR) Adds a Corrector 
node in serial with a linear 
window automatically enabled for 
fast isolation

(+LINEAR) Turns on the 
linear window for the 
currently selected node

NODE+CURVE/+CURVE – (NODE+CURVE) Adds a Corrector 
node in serial with a circular 
window automatically enabled 
for fast isolation. You can begin 
drawing a custom curve shape 
immediately in the Viewer.

(+CURVE) Turns on the 
curve window for the 
currently selected node

NODE+GRADIENT/ 
+GRAD

– (NODE+GRADIENT) Adds a 
Corrector node in serial with a 
gradient window automatically 
enabled for fast isolation

(+GRAD) Turns on the 
gradient window for the 
currently selected node

–/APPEND CIRCLE/
LABEL

– (APPEND CIRCLE) Appends a 
Corrector node in serial with a 
circular window enabled at the 
end of your node tree

(LABEL) Lets you type a 
label above the selected 
node to identify what it 
does

+SPLIT/APPEND 
LINEAR/–

(+SPLIT) Adds a Splitter 
node to your node tree, 
which splits the red, 
green, and blue image 
channels into separate 
outputs for separate 
processing

(APPEND LINEAR) Appends a 
Corrector node in serial with a 
linear window enabled at the end 
of your node tree

–
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+COMB/APPEND 
CURVE/POLY

(+COMB) Adds a 
Combiner node to 
your node tree, which 
combines red, green, 
and blue image 
channels that have been 
split back into a single 
image

(APPEND CURVE) Appends a 
Corrector node in serial with a 
Custom Curve window enabled 
at the end of your node tree. You 
can begin drawing a custom curve 
shape immediately in the Viewer.

(POLY) Appends a 
Corrector node in serial 
with a custom curve 
window enabled at 
the end of your node 
tree. You can begin 
drawing a polygon shape 
immediately in the Viewer.

APPEND GRADIENT – (APPEND GRADIENT) Appends a 
Corrector node in serial with a 
gradient window enabled at the 
end of your node tree

–

ADD SERIAL/+BEFORE – (ADD SERIAL) The most common 
way of adding Corrector nodes is 
in serial, where each new node’s 
input is connected to the previous 
node’s output, one after another. 
Adjustments in preceding 
nodes will be the starting point 
for subsequent nodes, so they 
all work together to combine 
different sets of adjustments in 
serial order, similar to layers in a 
layer-oriented system. 

(+BEFORE) Adds a 
corrector node in serial 
prior to (before) the 
currently selected node

ADD PARALLEL/+FIRST – (ADD PARALLEL) Adds a Corrector 
node in parallel underneath the 
currently selected node, with 
both connected to a multi-input 
Parallel Mixer node (creating one if 
necessary) so that all input images 
are mixed together. Each node 
in parallel shares the same input 
image, so you can perform multiple 
operations to the same image and 
combine them back together.

(+FIRST) Adds a Corrector 
node before the currently 
selected parallel node, so 
that both nodes sit within 
the same parallel branch 
of the node tree, with the 
new node preceding the 
original one.

ADD LAYER – (ADD LAYER) Adds a Corrector 
node as a layer underneath 
the currently selected node, 
connected to a multi-input Layer 
Mixer node (creating one if 
necessary) so that its output has 
higher mix priority than any other 
nodes previously connected to 
the same Layer Mixer. The Layer 
Mixer node combines the outputs 
of multiple nodes such that the 
image output by lower nodes takes 
priority over images output by 
higher nodes. Layer Mixer nodes 
can also be set to use different 
composite modes to combine 
images together in different ways.

–
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APPEND NODE – (APPEND NODE) Adds a corrector 
node serially to the very end of 
the node graph.

–

The T-Bar Control
The T-bar control is a vertical lever that you can push and pull up and down. Functioning as a fader, it’s 
mainly used to control the mix or wipe of a reference image against the current clip being evaluated. 

Which reference is being compared, and the method of comparison, is controlled by the Viewer and 
Reference Group of fixed keys immediately below it.

The T-Bar Control

Viewer and Reference Keys

The T-bar control is a vertical lever that controls Reference Wipes or Split 
Screen comparisons. The Viewer and Reference keys let you choose how to set 
up comparison wipes and split-screen effects to help you grade.

Viewer and Reference Group
This area below the T-bar includes six keys that let you choose among different reference modes for 
the Viewer, different Viewer modes, and the Highlight mode. When an appropriate mode is active, the 
fader bar controls the mix or wipe position for that mode.
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Key Shift Up Primary Function Shift Down

MENU/SPLIT SCREEN/CLEAN (MENU) Press to show 
a row of Split Screen 
view options in the 
Trackball panel soft 
buttons, with which 
to compare multiple 
clips

(SPLIT SCREEN) 
Toggles a split screen 
comparison on and 
off, with which to 
compare multiple 
clips in different ways

(CLEAN) Toggles Video 
Clean Feed on and off 
(Workspace > Video 
Clean Feed)

ENHANCED/FULL SCREEN/
CINEMA

(ENHANCED) Sets the 
Viewer to Enhanced 
mode

(FULL SCREEN) Sets 
the Viewer to Full 
Screen mode

(CINEMA) Sets 
the Viewer to 
Cinema mode

B&W/HIGHLIGHT/DIFF (B&W) Toggles the 
Highlight between 
high-contrast Black 
and White mode 
and the regular 
gray modes

(HIGHLIGHT) Toggles 
the Highlight on and 
off; used to see the 
resulting matte when 
adjusting a Qualifier 
or Window isolation

(DIFF) Toggles the 
Highlight between 
Difference and the 
regular gray modes

GALLERY/REF INVERT/RGB (GALLERY) Sets the 
currently selected clip 
in the gallery as the 
reference image

(REF INVERT) Inverts 
the left and right 
halves of the images 
being compared

(RGB) Shows an 
individual red, green, 
or blue channel in 
the Viewer; press 
SHIFT DOWN, then 
REF INVERT, then the 
1 (labeled Green), 3 
(labeled Blue), or 5 
(labeled Red) buttons 
on the Search Dial 
panel. Press REF 
INVERT to go back to 
viewing RGB.

TIMELINE/REF STYLE/– (TIMELINE) Lets you 
compare the current 
still in the Gallery to 
the Timeline image

(REF STYLE) Cycles 
among all the 
different split-screen 
wipe styles, so you 
can choose how to 
compare the current 
and reference images

–

OFFLINE/REF ON (OFFLINE) Compares 
the current frame at 
the playhead to the 
currently assigned 
Offline Reference 
Movie frame at the 
same timecode

(REF ON) Toggles a 
Gallery wipe on and 
off, with which to 
compare a saved still 
to the current clip

–
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The Search Dial panel
The Search Dial panel, typically located on the right for a right-handed colorist, has an LCD display with 
four variable controls and nine soft keys. The lower section of the panel houses the Jog/Shuttle knob 
and six groups of hard keys. Each group and their keys are described below.

Memories Group
The first group of keys is the Memories group. These include the grade reset controls, buttons for 
storing and recalling memories (by letter), and controls for grabbing and browsing stills, applying 
grades, and controlling looping for playback.

The letter keys in this group are called “memories” or MEMs, which save stills and grades that you can 
quickly apply to another clip to overwrite its previous grade. There are 26 MEMs, labeled with letters 
from A to Z. To apply a MEM to another clip, simply press the letter corresponding to the MEM with the 
grade you want to apply. To save a grade to a MEM, press CRNT and then the letter of the MEM you 
want to save to. More information appears in the table of key functionality below.

Memories Keys

The Memories keys let you save and recall memories for quick grade propagation, 
grade reset buttons, and other grade management functions.

Key Shift Up Primary Function Shift Down

ALL/RESET NODE/GRADES (ALL) Reset All Grades 
and Nodes; resets 
the entire grade of 
the current clip back 
to the default of one 
unadjusted node

(RESET NODE) Reset 
Selected Node Grade; 
resets all adjustments 
that have been made 
to the currently 
selected node

(GRADES) Reset 
Grades and Keep 
Nodes; resets each 
node of the current 
clip’s grade but keeps 
the node structure 
intact
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Key Shift Up Primary Function Shift Down

Q/A/I (Q) Loads or saves 
memory Q

(A) Loads or saves 
memory A

(I) Loads or saves 
memory I

R/B/J (R) Loads or saves 
memory R

(B) Loads or saves 
memory B

(J) Loads or saves 
memory J

S/C/K (S) Loads or saves 
memory S

(C) Loads or saves 
memory C

(K) Loads or saves 
memory K

T/D/L (T) Loads or saves 
memory T

(D) Loads or saves 
memory D

(L) Loads or saves 
memory L

CRNT – (CRNT) Press CRNT 
and then any 
letter key to save 
the image and grade 
at the current frame 
to that memory 
for recall

–

INFO/DISPLAY GRAPH/MEMS (INFO) Toggles the Still 
Properties window 
open and closed; 
the Still Properties 
window shows 
information about the 
currently selected still 
in the Gallery

(DISPLAY GRAPH) 
Displays the node 
graph of the selected 
still in the Gallery 
(only while the Gallery 
is open) or hides a 
displayed node graph

(MEMS) Toggles 
open and closed 
the memories section 
of the Gallery

U/E/M (U) Loads or saves 
memory U

(E) Loads or saves 
memory E

(M) Loads or saves 
memory M

V/F/N (V) Loads or saves 
memory V

(F) Loads or saves 
memory F

(N) Loads or saves 
memory N
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Key Shift Up Primary Function Shift Down

W/G/O (W) Load or save 
memory W

(G) Loads or saves 
memory G

(O) Loads or saves 
memory O

X/H/P (X) Loads or saves 
memory X

(H) Loads or saves 
memory H

(P) Loads or saves 
memory P

+POWER/+PAGE/LABEL (+POWER) Adds 
another Power Grade 
album to the Gallery

(+PAGE) Adds another 
project album to the 
Gallery

(LABEL) Selects the 
name of the currently 
selected album of the 
Gallery so you can 
change it

INSERT/APPLY GRADE/LABEL (INSERT) Not yet 
implemented at the 
time of this writing

(APPLY GRADE) 
Applies the grade of 
the selected still in the 
Gallery to overwrite 
the grade of the 
current clip

(LABEL) Selects the 
label of the selected 
still in the Gallery so 
you can add one or 
change it

APPEND GRADE/DEL – (APPEND GRADE) 
Appends all nodes 
from the grade of the 
selected still in the 
Gallery after the last 
node of the grade of 
the current clip

(DEL) Deletes the 
selected still in 
the Gallery

-2/PREV PAGE/MATCH FM (–2) Copies grade 
from two clips before 
the current clip to 
overwrite the grade in 
the current clip

(PREV PAGE) Selects 
the previous Album 
in the Album list of 
the Gallery

(MATCH FM) Performs 
a Match Frame 
operation that moves 
the playhead to the 
frame of the Timeline 
that matches the 
currently selected still 
in the Gallery

-1/NEXT PAGE (–1) Copies grade from 
the clip just before 
the current clip to 
overwrite the grade in 
the current clip

(NEXT PAGE) 
Selects the next 
Album in the Album 
list of the Gallery

–

NONE/USE SRC TC/START FM (NONE) Changes the 
“Apply Grades Using” 
option in the Gallery 
to No Keyframes

(USE SRC TC) Changes 
the “Apply Grades 
Using” option 
in the Gallery to 
Keyframes Aligning 
Source Timecode

(START FM) Changes 
the “Apply Grades 
Using” option in the 
Gallery to Keyframes 
Aligning Start Frames
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Key Shift Up Primary Function Shift Down

GROUP/RIPPLE SEL/APPEND (GROUP) Ripple Node 
Changes to Group, 
when you select a clip 
that’s part of a group 
and make a change to 
one node, that change 
is rippled to the same 
node of every clip in 
the group

(RIPPLE SEL) Ripple 
Node Changes to 
Selected Clips, when 
you select multiple 
clips and make a 
change to one node, 
that change is rippled 
to the same node of 
every selected clip

(APPEND) Append 
Node to Selected 
Clips, when you select 
multiple clips and 
make a change to a 
new node, that node 
is appended to the 
end of the grade of 
every selected clip

MISSING/GRAB STILL/
MIDDLE

(MISSING) Saves a still 
for every clip in the 
timeline that does not 
already have a still in 
the currently selected 
Album of the Gallery

(GRAB STILL) 
Saves the currently 
displayed still in 
the Viewer, and 
its grade, to the 
currently selected 
Album of the Gallery

(MIDDLE) Saves one 
still for every clip in 
the timeline at the 
middle of each clip

P/PONG/LOOP/PLAYHEAD (P/PONG) Toggles 
looping mode 
between ping-pong 
and loop forward

(LOOP) Toggles 
playback looping on 
and off

(PLAYHEAD) Press 
to add an Active 
Playhead to the 
Mini Timeline using 
the highlighted 
the A/B/C/D keys 
above; once added, 
pressing PLAYHEAD 
and a letter switches 
playback control to 
that playhead

	— Duration: To define a duration, first select the time using the numerical keypad (the colon 
separates the hours, minutes, seconds, and frames), and then select Duration.

	— Cue: Selecting Cue will force the transport to the preroll position.

Management and Modes Group
This group of keys gives access to a wide variety of functions that, due to their diversity, are difficult to 
generalize. They include everything from the all-important Undo and Redo commands, to splitting and 
rejoining clips, setting and clearing In and Out points to control playback and looping, and commands 
for reverting to the Original Memory, using Preview Memory, and using Scroll (which is described in 
more detail later in this chapter).
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The Management 
and Modes Keys

The Management and Modes keys provide Undo/Redo, range,  
Flag and Marker, printer lights, and grade management functionality.

Key Shift Up Primary Function Shift Down

SCENE/UNDO/ 
NEXT CLIP

(SCENE) Opens the 
Scene Detect Window

(UNDO) Triggers 
one step of undo; 
DaVinci Resolve 
supports unlimited 
steps of undo

(NEXT CLIP) Not yet 
implemented at the 
time of this writing

SPLIT/REDO/JOIN (SPLIT) Splits one 
clip into two at the 
frame under the 
playhead, so each split 
clip can be graded 
independently

(REDO) Triggers 
one step of redo; 
DaVinci Resolve 
supports unlimited 
steps of undo

(JOIN) The reverse of 
the Split key; move the 
playhead to an edit 
point with contiguous 
timecode, and press 
JOIN to merge the clips 
into one.

IN/CLEAR I – (IN) Sets a timeline 
In point to use when 
looping playback

(CLEAR I) Clears the 
timeline In point
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DUR/OUT/CLEAR O (DUR) If you’ve set In 
and Out points, this key 
lets you create a marker 
with duration.

(OUT) Sets a timeline 
Out point to use when 
looping playback

(CLEAR O) Clears the 
timeline Out point

SHOW/FLAG/CLIP (SHOW) Press to show 
a row of flag colors in 
the Trackball panel soft 
buttons with which to 
filter the Thumbnail 
Timeline by. < and > 
buttons let you page 
among all 16 colors, 
and EXIT lets you finish. 
Press SHOW ALL CLIPS 
in the soft menu to 
stop filtering.

(FLAG) Press to show a 
row of colors with which 
to flag the current clip in 
the Trackball panel soft 
buttons. < and > buttons 
let you page among all 
16 colors, and EXIT lets 
you finish.

"(CLIP) Press to show a 
row of colors with which 
to color code the current 
clip in the Trackball 
panel soft buttons. 

SHOW/MARKER/NODE (SHOW) Press to show 
a row of marker colors 
in the Trackball panel 
soft buttons with which 
to filter the Thumbnail 
Timeline by. < and > 
buttons let you page 
among all 16 colors, 
and EXIT lets you finish. 
Press SHOW ALL CLIPS 
in the soft menu to 
stop filtering.

(MARKER) Press to 
show a row of colors 
with which to mark the 
current frame in the 
Trackball panel soft 
buttons. < and > buttons 
let you page among all 
16 colors, and EXIT lets 
you finish.

(NODE) Press to show 
a row of colors with 
which to color code 
the current node in the 
Node Editor using the 
Trackball panel soft 
buttons. < and > buttons 
let you page among all 
16 colors, and EXIT lets 
you finish.

1/2/P/LITE/1/4 (1/2) Sets printer points 
adjustments to be 
made in “half-point” 
increments

(P/LITE) Toggles 
“Printer Lights” on 
or off. When on, the 
Jog/Shuttle panel’s 
number keys are used 
to make printer point 
adjustments in “whole 
points” increments 
(shown on each 
number key’s “shift 
up” position). This key 
remains highlighted 
while P/LITE is on.

(1/4) Sets printer points 
adjustments to be 
made in “quarter-point” 
increments

FLAG/DELETE/MARKER (FLAG) Deletes all flags 
on the current clip

(DELETE) Deletes the 
currently selected node 
in the Node Editor

(MARKER) Deletes any 
marker at the position 
of the playhead
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ORIG MEM – (ORIG MEM) If you 
select a graded clip, 
then change the grade 
and decide you don’t 
like the change, press 
ORIG MEM to return 
to original state (or 
memory) of that 
clip when you first 
selected it.

–

PVW MEM – (PVW MEM) To preview 
how a saved memory 
looks when applied to 
the current clip, press 
PVW MEM and then 
any memory key. If you 
don’t like the result, 
press PVW MEM again 
to toggle the grade to 
how it was before.

–

SCROLL – (SCROLL) The Scroll key 
opens a row of controls 
on the Trackball panel 
soft buttons that lets 
you preview how 
grades on neighboring 
clips would look on 
the current clip, with 
the option to then 
copy a grade (EXIT AS 
IS) or cancel without 
doing anything 
(EXIT AS WAS).

–

SAME/SELECT NODE/
LAST ADJ

(SAME) Changes 
the “Switching Clips 
Selects” option to 
“Same Node” so that 
moving to another clip 
selects the same node 
in the Node Editor that 
was selected in the 
previous clip

(SELECT NODE) Press 
after typing a node 
number to change the 
currently selected node

(LAST ADJ) Changes 
the “Switching Clips 
Selects” option to “Last 
Adjusted Node” so that 
moving to another clip 
selects whichever node 
in the Node Editor was 
previously adjusted for 
that clip
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Jog/Shuttle Control
The Jog/Shuttle control is actually two controls in one. The Shuttle control is the outer knob, which 
rocks to the left and right and controls real-time or fast playback. The Jog control is an inner wheel 
that spins freely and controls the playhead in slow motion, a frame or two at a time.

	— Shuttle: The Shuttle control is the outer knob, which rocks to the left and right. This knob has a 
detent at the center position which stops playback. Turning this control counter-clockwise shuttles 
among a variety of reverse speeds, with reverse playback going faster the farther left you turn. 
Turning this control clockwise shuttles among a variety of forward speeds, with playback going 
faster the farther right you turn.

	— Jog: The Jog control is an inner wheel that spins freely. Rotate the Jog control to step forward or 
backward a few frames at a time.

Jog/Shuttle Control

Transport Control Keys

The Jog/Shuttle control lets you control playback and playhead position. The Transport Control 
keys let you control playback, navigate stills in galleries, and navigate nodes in the Node Editor.
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Transport Control Keys Group
This group of keys is found beneath the Jog/Shuttle control. These keys are all about controlling 
playback and moving the playhead around your timeline.

Key Shift Up Primary Function

SHIFT UP – (SHIFT UP) Enables use of any of 
the SHIFT UP key functions at the 
top of various keys

SHIFT DOWN – (SHIFT DOWN) Enables use of any 
of the SHIFT DOWN key functions 
at the bottom of various keys

FLAG/PREV STILL (FLAG) Go to previous flagged 
still; not yet implemented at the 
time of this writing

(PREV STILL) Selects the previous 
still in the currently selected 
Album of the Gallery

FLAG/NEXT STILL (FLAG) Go to next flagged still; 
not yet implemented at the time 
of this writing

(NEXT STILL) Selects the next still 
in the currently selected Album of 
the Gallery, for use with the REF 
ON or SPLIT SCREEN keys

CUE/FIRST FRAME (CUE) Go to first frame of pre-roll; 
not yet implemented at the time 
of this writing

(FIRST FRAME) Selects the first 
frame of the current clip

CUE/LAST FRAME (CUE) Go to last frame of pre-roll; 
not yet implemented at the time 
of this writing

(LAST FRAME) Selects the last 
frame of the current clip

FIRST/PREV NODE (FIRST) Selects the first node in 
the Node Editor

(PREV NODE) Selects the 
previously numbered node in the 
Node Editor

LAST/NEXT NODE (LAST) Selects the last node in the 
Node Editor

(NEXT NODE) Selects the next 
numbered node in the Node 
Editor
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Key Shift Up Primary Function

MARKER/PREV FRAME (MARKER) Moves the playhead 
back to the last previous marker

(PREV FRAME) Moves the 
playhead backward a single 
frame in the Timeline

MARKER/NEXT FRAME (MARKER) Moves the 
playhead forward to the next 
existing marker

(NEXT FRAME) Moves the 
playhead forward a single frame 
in the Timeline

START/PREV CLIP (START) Moves the playhead to 
the first frame of the current clip

(PREV CLIP) Selects the first 
frame of the previous clip

END/NEXT CLIP (END) Moves the playhead to the 
last frame of the current clip

(NEXT CLIP) Selects the first 
frame of the next clip

FAST REVERSE – (FAST REVERSE) Shuttles 
backward along the Timeline 
at fast speed; pressing multiple 
times increases speed.

SLOW/REVERSE (SLOW) Plays in slow motion 
reverse (Edit page only)

(REVERSE) Plays the Clip/Timeline 
in reverse at 100%.

REVIEW/STOP (REVIEW) Initiates Review 
playback; not yet implemented at 
the time of this writing

(STOP) Stops the current 
transport operation

SLOW/FORWARD (SLOW) Plays in slow motion 
forward (Edit page only)

(FORWARD) Plays the Clip/
Timeline forward at 100% speed

FAST FORWARD – (FAST FORWARD) Shuttles 
forward along the Timeline at 
fast speed; pressing multiple 
times increases speed.
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Numeric Entry Group
On the center right-hand side of the Search Dial panel is the Numerical Entry key group. Here you will 
find numbers 0 to 9 and associated keys for entering timecode and clip numbers. You will notice the 
numbers you type are displayed in a scratchpad area at the bottom of the Keyframe palette.

Numeric Entry Keys

The number keys group provides access to multiple overlapping functions, 
including Printer Points adjustment when the P/LITE mode is enabled.

Key Shift Up Primary Function Shift Down

+R/NUM LK +R (Plus Red in 
P/LITE mode)

(NUM LK) Locks 
these keys to their 
numeric functions, 
useful for entering 
timecode for navigation

–

+G/ / +G (Plus Green in 
P/LITE mode)

(/) The Forward 
Slash key

–

+B/ * +B (Plus Blue in 
P/LITE mode)

(*) The Asterisk key –
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+MASTER/BACKSPACE +MASTER (Plus Master 
RGB in P/LITE mode)

(BACKSPACE) Moves 
the text or numeric 
cursor one character 
left so you can correct 
numeric entries

–

–R/7/CHR LT –R (Minus Red in 
P/LITE mode)

(7) The seven key (CHR LT) Loads 
the Chroma Light 
Qualifier preset

–G/8/CHR DK –G (Minus Green in 
P/LITE mode)

(8) The eight key (CHR DK) Loads 
the Chroma Dark 
Qualifier preset

–B/9/LT DARK –B (Minus Blue 
in P/LITE mode)

(9) The nine key (LT DARK) Loads the 
Chroma Light and 
Dark Qualifier preset

–MASTER/ ‘ –MASTER (Minus Master 
RGB in P/LITE mode)

(‘) The Apostrophe. 
When pressed by itself, 
copies the grade from 
one clip to the left to the 
current clip

–

+C/4/MAGENTA +C (Plus Cyan or 
Green+Blue in 
P/LITE mode)

(4) The four key (MAGENTA) Loads the 
Magenta Qualifier 
preset

+M/5/BLUE +M (Plus Magenta 
or Red+Blue in 
P/LITE mode)

(5) The five key (BLUE) Loads the Blue 
Qualifier preset

+Y/6/CYAN +Y (Plus Yellow 
or Red+Green in 
P/LITE mode)

(6) The six key (CYAN) Loads the Cyan 
Qualifier preset

: – (:) The Apostrophe key. 
When pressed by itself, 
copies the grade from 
two clips to the left to the 
current clip. When used 
after typing numbers, 
delineates timecode 
number positions 
(hr:min:sec:frm).

–
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–C/1/GREEN

 

–C (Minus Cyan 
or Green+Blue in 
P/LITE mode)

(1) The one key (GREEN) Loads the 
Green Qualifier preset

–M/2/YELLOW –M (Minus Magenta 
or Red+Blue in 
P/LITE mode)

(2) The two key (YELLOW) Loads the 
Yellow Qualifier preset

–Y/3/RED –Y (Minus Yellow 
or Red+Green in 
P/LITE mode)

(3) The three key (RED) Loads the Red 
Qualifier preset

CLOSE/CLEAR (SHIFT UP CLOSE) (CLEAR) Clears 
all numbers you 
were typing in case 
of mistakes

–

+ – (+) The Plus key, use 
for entering relative 
timecode, such as +10 
to move the playhead 
forward 10 frames

–

0 – (0) The zero key –

– – (–) The Minus key, use 
for entering relative 
timecode, such as –10 
to move the playhead 
backward 10 frames

–

ENTER – (ENTER) The Enter 
key, use after you’ve 
typed a timecode value 
to execute moving 
the playhead

–
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Keyframing Group 
The Keyframe keys are on the bottom right-hand side of the Search Dial panel. The functions are 
replicated on the T-bar panel. On the bottom right of the Color page is the Keyframe timeline for the 
current clip in the Timeline. The Keyframe group of keys is used in association with the Keyframe 
timeline and controls the selection of keyframes for the start and end of dynamic transitions of 
the grade.

Keyframing Keys

The number keys group provides access to multiple overlapping functions, 
including Printer Points adjustment when the P/LITE mode is enabled.

Key Shift Up Primary Function Shift Down

–/RIPPLE VALUE/
APPEND

– (RIPPLE VALUE) Lets 
you ripple a change 
made to the currently 
selected node to the 
same node within a 
specified range of clips; 
for more information 
see “Rippling Changes 
Using the Advanced 
Control Panel” later 
in this chapter

(APPEND) Lets you 
ripple a change made to 
the currently selected 
node as an appended 
node to a specified 
range of clips; for 
more information see 
“Rippling Changes Using 
the Advanced Control 
Panel” later in this 
chapter
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LOCK/KEYFRAME 
MODE/AUTO

(LOCK) Locks the 
keyframe track of the 
currently selected node

(KEYFRAME MODE) 
Toggles among 
restricting keyframing 
to All (every keyframe 
track in a grade), Color 
(the currently selected 
Corrector node), or 
Sizing (sizing only). 
The Keyframe mode 
also determines which 
adjustments are copied 
when you copy grades 
from one clip to another.

(AUTO) Toggles Auto 
Keyframing on and off 
for the keyframe track 
of the currently selected 
node

EXPAND/LIFT KF/DEL 
KF

(EXPAND) Toggles the 
height of the Keyframe 
Editor while in Color 
or Sizing modes to 
show or hide all 
internal Corrector 
node keyframing 
tracks. Doesn’t work in 
All mode.

(LIFT KF) Not yet 
implemented at the 
time of this writing

(DEL KF) Deletes any 
and all keyframes at the 
playhead

–/PREV KF/ATTRIB – (PREV KF) Moves the 
playhead to the next 
previous keyframe in 
the Node Editor

(ATTRIB) Opens the 
Dissolve Type window 
that lets you add easing 
to a selected keyframe

ZOOM/ADD 
KEYFRAME/+STATIC

(ZOOM) Zooms into the 
Keyframe Editor; not 
yet implemented at the 
time of this writing

(ADD KEYFRAME) Adds 
a dynamic keyframe to 
the currently selected 
corrector node, for 
creating a gradual 
animated change to a 
grade

(+STATIC) Adds a 
static keyframe to 
the currently selected 
corrector node, for 
creating an abrupt one-
frame change to a grade

NEXT KF – (NEXT KF) Moves 
the playhead to the 
next keyframe in the 
Node Editor

–
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Auto Color Using the DaVinci Resolve 
Advanced Control Panel
To make an automatic correction to a clip, you can simply press SHIFT UP and then AUTO/MODE/
SEARCH on the T-bar panel. This will use the advanced algorithms of the DaVinci Neural Engine to 
automatically analyze the image and adjust color balance and contrast to produce a nice, neutral 
starting point.

However, if you crave a bit more control over how the automatic color adjustment is made, and you 
have a DaVinci control panel, you can use the cursor to choose which color values to sample when 
making an automatic color balancing and contrast adjustment. It’s like a cross between the Auto Color 
control and the White and Black Point controls found in the GUI. This additional bit of guidance can 
make the results a lot more predictable.

To use Auto Grade to sample a feature using the DaVinci control panel:

1	 Press the CURSOR button on the Trackball panel.

2	 Use the fourth trackball to move the cursor to a feature you want to use to define the automatic 
correction. Whichever color you move the cursor over will be sampled to form the basis of the 
resulting color and contrast adjustment. Ideally, you should place the cursor over a feature that’s 
supposed to be neutral, such as a black shadow, gray wall, or white T-shirt. Don’t place the cursor 
over a feature that actually consists of saturated color, or that happens to be overexposed, as 
DaVinci Resolve will overcompensate and you’ll get poor results.

3	 With the cursor placed over the desired neutral feature, press SHIFT UP and AUTO/MODE/SEARCH 
on the T-bar panel.

DaVinci Resolve calculates an appropriate correction, which is applied to the selected node.

Legacy Auto Color
The previous methods for doing Auto Color and Shot Match are available from the Color 
panel of the User Preferences, via two checkboxes named “Use Legacy Auto Color/Shot 
Match.” With these enabled, DaVinci Resolve looks for the darkest levels in the image to 
neutralize the RGB color balance in the blacks, and the brightest levels to neutralize the RGB 
color balance in the highlights. Furthermore, Master Lift and Master Gain are adjusted to 
maximize image contrast at the outer boundaries of 0 and 100 percent. Using this control 
with the Primaries Bars mode open makes it easier to see what’s been changed after these 
automatic adjustments are made.
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Adjusting Curves using the DaVinci 
Resolve Advanced Control Panel
The DaVinci Resolve Advanced Panel can be used to adjust curves in many different ways, keeping 
your hands on the control panel for fast and efficient adjustment.

Custom Curves Adjustments
The controls that correspond to the Custom curves on the DaVinci control panel are available when 
you press the CURVES button on the Trackball panel. They’re also the default mapping of the right-
hand side Search Dial panel soft menu.

To open the Primary Curve controls of the DaVinci Resolve Advanced control panel:

	— Press the CURVES soft key on the Trackball panel.

The rotary knobs on the Center panel update to show the 0% LUM, 20% LUM, 40% LUM, 60% LUM, 
80% LUM, and 100% LUM rotary knobs. These controls correspond to the following default control 
point positions on the Curve controls.

Each rotary curve control on the DaVinci control surface corresponds 
to one of these six default control point positions

By default, all adjustments you make using these controls are ganged across all four YRGB curve 
controls. However, if you turn Custom curve ganging off by pressing the GANG soft key, then 
these controls only affect the curve you select using the LUM CURVE, RED CURVE, GREEN CURVE, 
and BLUE CURVE soft keys.

You also have the option of using the fourth trackball from the left to adjust individual control 
points on curves to any position you like. This works for all curves in DaVinci Resolve that have 
control surface mappings.

Methods of selecting and adjusting curve points using the fourth trackball:

1	 Press SHIFT DOWN and LEVEL/CURSOR/CURVE.

2	 Do one of the following to make adjustments:
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	— To select a control point to adjust: Spin the fourth ring control to the left or right to select 
the next control point in that direction (it takes about half of a turn to select another control 
point). Selected control points are highlighted in cyan.

	— To move a selected control point: Adjust the fourth trackball to move the control point up, 
down, left, or right. Selected control points are constrained between whichever control points 
are to the left and right.

To adjust the Curve Intensity sliders:

	— Adjust the MASTER INTENSITY, RED INTENSITY, GREEN INTENSITY, or BLUE INTENSITY 
soft knobs.

To make YSFX adjustments:

1	 Press the SOFT CLIP soft key.

2	 Adjust the LUM YSFX, RED YSFX, GREEN YSFX, or BLUE YSFX soft knobs.

Soft Clipping Adjustments
The soft clipping controls can also be manipulated using the DaVinci Resolve Advanced control panel, 
which provides separate controls for ganged and individual color channels.

To open the soft clipping control on the DaVinci Resolve Advanced control panel:

	— Press the CURVES key on the Trackball panel, then press the SOFT CLIP soft key.

To exit the soft clipping controls:

	— Press the MAIN soft key on the Center panel.

To make a ganged soft clipping adjustment:

	— Adjust the MASTER CLIP or MASTER SOFT soft knobs of the SCENE BLACK CLIPS or SCENE WHITE 
CLIPS control groups.

	— These controls adjust all four corresponding Master-RGB High Soft, High Clip, Low Soft, or 
Low Clip parameters simultaneously.

To adjust soft clipping for individual color channels:

	— Adjust the MASTER/RED/GREEN/BLUE CLIP or MASTER/RED/GREEN/BLUE SOFT rotary knobs of 
the SCENE WHITE CLIPS or SCENE BLACK CLIPS control groups (there are 12 individual knobs).

HSL Curves Controls
The HSL curves can also be adjusted using the DaVinci Resolve Advanced Panel.

To open the soft clipping control on the DaVinci Resolve Advanced Panel:

1	 Press the CURVES key on the Trackball panel.

2	 Press the CURVES soft key on the soft menu.

3	 Press the soft key that corresponds to the HSL curve you want to adjust, HUE•HUE, HUE•SAT, 
HUE•LUM, LUM•SAT, SAT•SAT, SAT•LUM.

4	 Use the RED, YELLOW, GREEN CYAN, BLUE, and MAGENTA, or the LOW, LOW-MID, MID-HIGH, and 
HIGH soft knobs to adjust the particular slice of hue or image tonality you want, using the method 
you’ve selected.
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The Advanced Panel Number Pad Does Many Things
The number keys serve a wide number of uses. This section describes them all in one place.

Navigating Clips by Clip Number
You can move the playhead to the first frame of any clip in the Timeline by typing that clip’s number 
(listed above the upper left-hand corner of each thumbnail in the Thumbnail Timeline) using the 
number keys, and then pressing ENTER. 

Navigating Clips by Timecode
To type timecode instead of a clip number, you need to add colons to signify that you’re entering 
hours followed by a colon, then the minutes followed by a colon, the seconds with a colon, and finally 
the frames followed by the ENTER key. As you enter timecode on the Color page, the timecode values 
you type appear in the lower right-hand corner of the DaVinci Resolve window, to the left of the 
Project Manager and Project Settings buttons.

DaVinci Resolve does not need to have leading numbers entered where they offer no value and the 
default value is 0, so to type one hour, three minutes, zero seconds, and sixteen frames, you do not 
need to type 01:03:00:16. Simply type 1:3::16 and then press Enter. This speeds timecode entry.

Moving the Playhead Using Relative Frame Numbers
If you type a + or – and a number of frames, the playhead will move forward or backward by that 
number of frames relative to its prior position.

Selecting Specific Nodes in the Node Editor
You can select specific nodes in the current node tree by typing the node’s number and then 
pressing SELECT NODE.

Making Printer Points Adjustments
You can use the number keys to make controlled Printer Points adjustments by pressing the 
P/LITE button (found in the group of keys just above the number keys). The P/LITE button remains 
highlighted as long as printer points adjustment using the number keys is active. Press P/LITE again 
to toggle printer points mode off.

The P/LITE button toggles printer points mode on and off in the default “whole point” mode. You can 
also press SHIFT UP P/LITE 1/2 to work in “half point” mode, or SHIFT DOWN P/LITE 1/4 to work in 
“quarter point” mode. 

In Printer Points mode, you have three sets of controls:

	— Plus and minus Red, Green, and Blue to adjust color balance in the additive manner, by raising or 
lowering specific color channels

	— Plus and minus Master to raise or lower RGB equally to adjust luminance

	— Plus and minus Cyan, Magenta, and Yellow to adjust color balance in the subtractive manner, 
by raising or lowering pairs of color channels corresponding to Cyan (Blue and Green), Magenta 
(Red and Blue), and Yellow (Red and Green)

Viewing Individual Red, Green, and Blue Channels in the Viewer
You can use the number keys to choose individual channels to evaluate in the Viewer, in order to more 
closely evaluate noise or image quality on a per-channel basis. 
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First, press SHIFT DOWN, then press the GALLERY/REF INVERT/RGB button on the T-bar panel to 
trigger the RGB function. Three number keys are then highlighted, 1 (labeled GREEN), 3 (labeled 
BLUE), AND 5 (labeled RED). Pressing any of these keys sets the Viewer to show only that channel as a 
grayscale image.

To go back to viewing full-color RGB, press REF INVERT.

Adding Tracking Points in Interactive Mode
The DaVinci Resolve Advanced control panel has a full set of tracking controls. However, there’s also 
the ability to manually add tracking points one by one while in Interactive Object Tracking mode. 

To add a single tracking point:

1	 Select a window you want to track.

2	 Press SHIFT DOWN and ALL/WINDOW/TRACKER.

3	 Press the INTERACTIVE soft key.

4	 Using the DaVinci Resolve Advanced control panel, press the CURSOR button above the fourth 
trackball of the Center panel, and move the onscreen cursor to the detail of the image that you 
want to add a tracking point to.

5	 Click the SET TRACK POINT soft key, within the Interactive mode controls of the Tracker palette. 

This adds a tracking point corresponding to the feature of the image that you clicked, and you’re 
ready to start tracking.

Copying Grades Using the Advanced Control Panel
There are a number of procedures for copying grades that have specific implementations on the 
Advanced control panel.

Copy Forward Keys
The simplest way of copying grades using the control panel is to use the comma and colon keys on 
the keypad of the Search Dial panel, or the –1 and –2 SHIFT UP functions on the memory keys area of 
the Search Dial panel, to copy grades from one or two clips behind the currently selected clip. This is a 
great way to copy grades in scenes with a shot-reverse-shot structure, where you’re cutting between 
two angles of coverage, each of which uses the same grade.

	— To copy a grade from one clip back: Press the Comma (,) or –1 buttons.

	— To copy a grade from two clips back: Press Colon (:) or –2 buttons.

Scroll
Scroll mode lets you quickly preview how different grades on a variety of other clips in the Timeline 
would look on the currently selected clip. As you preview the grade of each other clip, you have the 
option to either accept or reject the previewed grade to which you’ve “scrolled.” Accepted grades (EXIT 
AS IS) overwrite the previous grade of the current clip, while rejecting the scrolled grade (EXIT AS 
WAS) cancels the entire operation. 

Scroll mode can be useful for checking to see if any of the previous grades you’ve created in a scene 
will work for the currently selected clip.
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To use the Scroll mode:

1	 Move the playhead to the clip to which you potentially want to copy a new grade. You can use 
the PREV SCENE and NEXT SCENE buttons to move around neighboring clips, or you can use the 
number keys to jump to a specific clip number or timecode value of the Timeline.

2	 Do one of the following to enter Scroll mode:

	— Press SCROLL on the Search Dial panel.

	— Press MODE on the T-bar panel, then press the SCROLL MODE soft key.

	— Once you’re in Scroll mode, the Center panel soft menu displays a row of commands with 
which to control scrolling through previews of possible grades to copy.

3	 Now, do one of the following to preview different grades from other clips:

	— Press the PREVIOUS SCENE and NEXT SCENE soft keys to move from clip to clip in the 
Timeline, previewing each grade to the current clip.

	— Turn the SCROLL SCENES knob to scroll smoothly along multiple clips in the Timeline.

	— Turn the SCROLL FRAMES knob to scroll along different frames of any clip, previewing the 
effects of keyframed grades at different points in time.

	— Press the TOGGLE DECK KEYS soft key to use the transport controls on the Search Dial panel 
to play through the Timeline, previewing grades as you go.

	— Enter a number on the keypad of the Search Dial panel, and then the SCENE # soft key, to 
jump to a clip and preview its grade.

As you scroll from clip to clip, a purple outline indicates the clip with the grade being 
previewed and an orange outline indicates the current clip to which you’re previewing each 
scrolled grade.

When you’re finished, do one of the following to either accept or reject the currently previewed 
grade that you’ve scrolled to:

	— Press EXIT AS WAS if none of the grades you scrolled through was suitable. This exits Scroll 
mode and leaves the clip as it was previously.

	— Press EXIT AS IS if you’ve found a grade that works for the current clip. This exits Scroll mode 
and copies the scrolled grade.

When you press the TOGGLE DECK KEYS soft key in Scroll mode, each of the Transport Control buttons 
on the Search Dial panel functions as a means of previewing the grades of other clips in the Timeline.

	— NEXT CLIP: Move to the next clip and preview its grade.

	— PREV CLIP: Move to the previous clip and preview its grade.

	— FWD: Plays (scrolls) forward at 1 scene per second, previewing each new grade as it appears.

	— REV: Play (scrolls) the clips in reverse at 1 scene per second, previewing each new 
grade as it appears.

	— FFWD: Shuttles (scrolls) forward through the Timeline at 4 scenes per second, previewing 
each new grade as it appears.

	— RWD: Shuttles (scrolls) reverse through the Timeline at 4 scenes per second, previewing 
each new grade as it appears.
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Rippling Changes Using the Advanced Control Panel
DaVinci Resolve has a mechanism for rippling specific changes made to one clip to a range of other clips 
in the Timeline. This is only possible using the controls of the DaVinci Resolve Advanced control panel.

The general idea of the ripple function is that you select a clip, make a change to one or more nodes 
in its grade, and then ripple that change to a range of other clips. This rippled change can be applied 
to the same node in each clip, or the change can be applied as an appended node within each 
rippled clip.

The following procedure describes in detail how you can use the control panel to ripple a change to 
a range of other clips. While this procedure may appear complicated, it’s just that there are several 
options. Once you learn the sequence of commands, this process is actually quite fast.

To ripple a change using the Ripple Mode soft key commands:

1	 (Optional) On the T-Bar panel, press MODES, then in the soft menu of the Trackball panel press 
RIPPLE MODES. Four selectable modes appear mapped to the soft keys of the Trackball panel, 
which can be used later to execute different types of ripple operations. Press the mode you want 
to use for rippling.

	— Ripple Static: (Exact values changed) Changes made to the current clip are rippled to the 
specified clips using the exact parameters that were changed. For example, if Lift in the 
current clip is changed to 0.75 of its range, each clip you ripple will have a Master Gain setting 
of 0.75. Only parameters you adjust are rippled.

	— Ripple Relative: (Percent value changed) Changes made to the current clip are rippled to the 
specified clips by the percentage of change you made to the altered parameters. For example, 
if the current clip has a Lift level of 1.00 and is changed to 0.90 units, then the Lift setting of 
each clip you ripple will have a relative reduction of 10% relative to its previous value.

	— Ripple Absolute: (Unit value changed) Changes made to the current clip are rippled to the 
specified clips by the same delta of change, using whichever units make sense for the affected 
parameter. For example, if the current clip had a Lift of 0.80 and you increased it to 0.90, each 
rippled scene’s master gain level increases by 0.10.

	— Ripple Forced: (All values are copied) The current clip’s grade is rippled to the specified clips 
in its entirety. No comparison is made with the original clip’s parameters, and all memory 
parameters are rippled.

2	 Move the playhead to the clip you want to adjust.

3	 Adjust the grade of the current clip in the manner you want to ripple to other clips in the Timeline.

4	 Now, you must define the range of clips you want to ripple to using the number pad on the 
Search Dial panel. The following combinations will work:

	— An absolute range of clips is defined by entering two clip numbers separated by a comma. 
For example, if you want to ripple the current change to clips 10 through 15, you’d press “10, 15”

	— To specify every clip from the beginning of the Timeline, use the Minus (–) key. For example, 
to specify a range of clips from the beginning to clip 20, you’d press “–, 20”

	— To specify every clip to the end of the Timeline, use the Plus (+) key. For example, to specify a 
range of clips from the clip 50 to the end, you’d press “50, +”

	— To specify every clip in the whole Timeline, press “–, +”

5	 (Optional) You can control whether the rippled change is applied in an appended node, or an 
existing node, in every rippled clip by pressing the SHIFT DOWN key of any panel.
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If you don’t press SHIFT DOWN, the rippled change will be applied to the same node in every 
rippled clip that was adjusted in the current clip. In other words, if you made a change to Node 4, 
it will be rippled to Node 4 of all clips specified for rippling to. If one of the rippled clips doesn’t 
have the same number of nodes (in this case if there’s no node 4), you may get an error.

6	 To execute the ripple, do one of the following:

	— Press RIPPLE VALUE on the Search Dial panel to ripple a change to the selected node 
in each clip’s grade, using the currently selected Ripple Mode in the Color panel of the 
User Preferences.

	— Press SHIFT DOWN and APPEND to ripple to add the change via an appended node at 
the end of each clip’s grade

	— Press one of the Center panel soft keys corresponding to the ripple function you 
want to perform. 

There are four soft keys;

a)	 Static Ripple: Changes made to the current clip are rippled to the specified clips using the 
exact parameters that were changed. For example, if Lift in the current clip is changed to 0.75 
of its range, each clip you ripple will have a Master Gain setting of 0.75. Only parameters you 
adjust are rippled. Identical to the “Exact values changed” ripple setting.

b)	 Relative Ripple: Changes made to the current clip are rippled to the specified clips by the 
percentage of change you made to the altered parameters. For example, if the current clip 
has a Lift level of 1.00 and is changed to 0.90 units, then the Lift setting of each clip you ripple 
will have a relative reduction of 10% relative to its previous value. Identical to the “Percent 
value changed” ripple setting.

c)	 Absolute Ripple: Changes made to the current clip are rippled to the specified clips by 
the same delta of change, using whichever units make sense for the affected parameter. 
For example, if the current clip had a Lift of 0.80 and you increased it to 0.90, each rippled 
scene’s master gain level increases by 0.10. Identical to the “Unit value changed” ripple setting.

d)	 Forced Ripple: The current clip’s grade is rippled to the specified clips in its entirety, 
overwriting all previous nodes and parameters in the rippled clips.

Now, the adjustment you made in step 4 is applied to the designated range of clips.

Admittedly, that was a long and detailed procedure when spelled out in text, but the actual button 
sequences are straightforward once you put them together. Here are some examples of button 
sequences that ripple an adjustment you’ve just made in different ways:

	— “10, 15” then SHIFT DOWN then RIPPLE VALUE: Copies the change you’ve made to the current 
clip and applies it as a new node that’s appended to the end of clips ten through fifteen.

	— MODES then RIPPLE MODES then “34, 45” then FORCED RIPPLE: Copies the entire grade of the 
current clip, using it to overwrite the grade of clips 34 through 45.

	— MODES then RIPPLE MODES then “–, +” then SHIFT DOWN then RELATIVE RIPPLE: Copies 
the change you’ve made to the current clip as a relative percentage and applies it as a new node 
appended to the end of every single clip in the entire Timeline.

WARNING:  Since undo is a per-clip operation, there is no global undo for changes made 
to the entire Timeline. This means that once you ripple a change in this manner, there is no 
going back. Proceed with caution.
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